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Installation and Setup Guide for HP Web
Jetadmin 10.0

When you install HP Web Jetadmin 10.0, you only need to install it on one hardware platform that meets
the recommended minimum requirements (Minimum System Requirements for HP Web

Jetadmin 10.0 on page 2) and is centrally accessible on the network. You may then access the
software from any supported Windows desktop on the network and manage all supported network-
connected peripherals.

HP Web Jetadmin 10.0 offers several installation options. If you have installed a previous version of
HP Web Jetadmin 10.0, you can choose to upgrade the previous version or install a new copy. Upgrading
an older version preserves your settings for discovery options and groups and is most likely the best
choice if you have already been using HP Web Jetadmin 10.0.

NOTE: HP recommends that you fully test HP Web Jetadmin 10.0 in environments where earlier
releases have been integrated into critical business operations. HP Web Jetadmin device management,
alerting, and other features have been greatly improved with the introduction of HP Web Jetadmin 10.0
and, prior to implementing this software into full production, HP recommends that you fully test and
qualify the application.

Please read all support materials when implementing HP Web Jetadmin 10.0. For current information
regarding HP Web Jetadmin 10.0 software, see the documents on http://www.hp.com/go/
webjetadmin_software titled Late Breaking News, Supported Devices on HP Web Jetadmin 10.0,
and Differences Between HP Web Jetadmin 10.0 and HP Web Jetadmin 8.1.

NOTE: If the installation stops with a warning that a reboot is required, reboot the host on which the
HP Web Jetadmin 10.0 installer is running. Then relaunch the installer to continue to installation.
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Minimum System Requirements for HP Web Jetadmin 10.0

Table 1-1 Technical specifications for HP Web Jetadmin 10.0 (Product number: J6052AA)

2

Supported network operating systems

Microsoft Windows XP Professional (with SP 2 and above),
Server 2003, Windows Vista Business Edition and Enterprise
Edition (Windows 2000 Professional with SP 4 is supported as
a Smart Client client). Print management features are
supported with Microsoft Windows XP Professional (with SP 2
and above), Server 2003, and Windows 2000 Professional and
Server.

NOTE: All operating supported operating systems are 32 bit
only.

Supported browsers

Microsoft Internet Explorer 6.0 or above (client host
requirement)

Shared print queue creation support

Windows XP Professional, Server, or Advanced Server

Network peripheral management supported printers

HP Web Jetadmin 10.0 supports HP and non-HP printers
connected through HP Jetdirect print servers and standard
printer MIB-compliant third-party network connected printers.
The capabilities available for third-party printers will vary from
basic to more robust capabilities when the devices are used
with HP-certified HP Web Jetadmin 10.0 plug-ins.

Active network connection

HP Web Jetadmin 10.0 must be on a host that has an active
IPv4 network connection.

Supported network protocols

IPv4

Software update and migration

HP Web Jetadmin 7.8, 8.0, and 8.1 are supported with either
update or migration path installation to HP Web Jetadmin 10.0.
(Operating systems and host requirements for software update
are the same as those required for new installation. Operating
systems and host requirements for software migration are the
same as those required for new installation and have Windows
2000 Professional and Server as additional supported
platforms.)

Database support

SQL Server 2005 Express included in application installation
(requires SP 2 when installed on Windows Vista)

File system type

NTFS (no FAT support)

Virtual Machine (Optional Platform)

VMWare Server

NOTE: For a VMWare server, the virtual machine network
must be set to bridged to facilitate HP Web Jetadmin 10.0
communications.

When VMWare HP Web Jetadmin 10.0 host is running NAT
mode, the remote Smart Client will not connect to the HP Web
Jetadmin 10.0 host, alerts are not received, and configuring
devices prompts the user for V1 credentials when no
credentials are set on the device.

Any feature that responds back to the host requires this
configuration.

Host access requirements

Application host: local administrator required for installation or
application upgrade; Client host: local user access required for
ClickOnce client application; Administrator required for .NET
installation
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Table 1-1 Technical specifications for HP Web Jetadmin 10.0 (Product number: J6052AA) (continued)

System requirements: Server

PC with 1.0 GHz or higher processor (2.4 GHz recommended),
1 GB RAM, 2 GB available disk space (minimum
recommended, will vary depending on data migrated from
older HP Web Jetadmin and data storage needs required by
device data collections), .NET 2.0 or higher (if not detected the
software will provide assistance for steps to install .NET 2.0).

NOTE: If both server and client will be run from the same
machine or if the server will be run from a virtual machine, the
minimum requirement should be increased to improve
response times from the HP Web Jetadmin server.

System requirements: Client

PC with 1.0 GHz or higher processor (2.4 GHz recommended),
1 GB RAM, .NET 2.0 or higher (if not detected the software will
provide assistance for steps to install .NET 2.0), 1024 by 768
client display resolution (minimum). Optimized for Normal font
size.

Minimum System Requirements for HP Web Jetadmin 10.0

3



Steps to Install HP Web Jetadmin 10.0

To begin the installation, follow these steps:

1.  Access http://www.hp.com/go/webjetadmin to get the HP Web Jetadmin 10.0 software.

2. Runwjasetup.exe.
3. Follow the instructions as each page is displayed.
4

When the installation is complete, click Close.

4 Chapter 1 Installation and Setup Guide for HP Web Jetadmin 10.0 ENWW
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Installing HP Web Jetadmin 10.0 from a Command Line or

Script
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Sometimes it is required to install software from a command line, through a script, or some automation.
Use these steps:

1.

Create a SetupProperties.xml file using the -x option: WjaSetup.exe -
x=SetupProperties.xml.

If desired, use a text editor or an xml editor of your choice and edit the SetupProperties.xml file you
just added.

Validate the SetupProperties.xml file using the -v option, to make sure that the manual editing was
done correctly: WjaSetup.exe -v=SetupProperties.xml.

Run WjasSetup.exe in silent mode using the -s option: WjaSetup.exe -
s=SetupProperties.xml.

When running HP Web Jetadmin install executable in silent mode at a command prompt, use the /
wait option. This will cause the command line to wait until the install process exits before continuing.
Here is an example:

start /wait WjaSetup.exe -s=Properties.xml

When invoking WjaSetup . exe from other launch points or programs, these must have appropriate
wait parameters or methods established to allow the install.exe to complete.

If desired, look at the log file created in the Document and Settings folder when WjaSetup.exe
runs (for example C:\Documents and Settings\{username}\Local Settings\Temp
\hp\wja\WjaSetup\WjaSetup.log).

Installing HP Web Jetadmin 10.0 from a Command Line or Script 5



Upgrade versus Migrate

6

In HP Web Jetadmin 10.0 you have the ability to either upgrade from earlier revisions of the software

on the same system hosting the application, or you can migrate settings from another system hosting

an earlier release to a new system where HP Web Jetadmin 10.0 will be installed. Upgrades should be
performed when an HP Web Jetadmin 10.0 installation is planned and can be supported on the same
host without interrupting critical business operations. Migration should be performed when the software
is being evaluated or when a newer hardware platform is required.

Evaluation is key in testing and qualifying new software. HP Web Jetadmin (versions 7.8 or 8.x) settings
can be harvested using the Migration Tool and then migrated into a system hosting HP Web Jetadmin
10.0. In these cases, alerting and reports settings are left enabled on the older HP Web Jetadmin and
not migrated into the system hosting HP Web Jetadmin 10.0. In this case, fleet management is still active
on the older HP Web Jetadmin installation while a few test printers are setup to evaluate alerts and
reporting features.

Deployment of HP Web Jetadmin 10.0 may require a newer hardware platform and also that alerts and
reports settings can be migrated. In these cases, the older HP Web Jetadmin host can be left in a
disabled state by using an option within the Migration Tool and then these same alerts and reports
settings can be migrated into the new system hosting HP Web Jetadmin 10.0. Migration for the purpose
of deploying HP Web Jetadmin 10.0 can also be performed as a next-step after evaluating the software.
Simply perform the steps outlined below a second time with a new HP Web Jetadmin 10.0 installation.
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When installing HP Web Jetadmin 10.0 on a system where an earlier release of HP Web Jetadmin
(versions 7.8 or 8.x) is running, the installer dialog box allows the system to be upgraded using settings
and data collected during the previous version of HP Web Jetadmin (versions 7.8 or 8.x) or it may be
installed using default settings for HP Web Jetadmin.

NOTE: Only upgrade HP Web Jetadmin on supported hardware and operating system platforms
(see Minimum System Requirements for HP Web Jetadmin 10.0 on page 2). If newer software
requirements can only be met with a new host a migration may be needed (see Migrating to HP Web
Jetadmin 10.0 on page 8).

If you select: Collect Settings from my previous version, the installer gathers all of the settings and
data from the earlier release of HP Web Jetadmin and stores them in an encrypted file that is readable
by the HP Web Jetadmin 10.0 release. Then, once HP Web Jetadmin 10.0 installation is initially
launched on this HP Web Jetadmin 10.0 server, the settings and data are automatically imported. Device
groups, devices, and other details will appear within the HP Web Jetadmin 10.0 client soon after the
initial launch. The older HP Web Jetadmin service is stopped, the local service “HP Web Jetadmin” is
switched from AUTOMATIC to MANUAL, and the older HP Web Jetadmin directories and files are left
intact.

If you do not select: Collect Settings from my previous version, the HP Web Jetadmin 10.0 installer
is launched. Installation proceeds without migrating settings and data from the previous versions of
HP Web Jetadmin into the new HP Web Jetadmin 10.0 instance on this same server. The older HP Web
Jetadmin service is stopped, the local service “HP Web Jetadmin” is switched from AUTOMATIC to
MANUAL, and the older HP Web Jetadmin directories and files are left intact.

Upgrades 7



Migrating to HP Web Jetadmin 10.0

It is possible to upgrade from earlier releases of HP Web Jetadmin software by installing HP Web
Jetadmin 10.0 on a host that has an earlier version of HP Web Jetadmin installed. It is also possible to
migrate settings collected from an earlier release of HP Web Jetadmin. This is done by using a utility
called Migration Tool that is available at http://www.hp.com/go/webjetadmin_software.

HP Web Jetadmin 10.0 supports upgrade and migration from these earlier releases of software:
e HP Web Jetadmin 7.8
e HP Web Jetadmin 8.0
e HP Web Jetadmin 8.1

Ef NOTE: Limited settings will be transferred through an upgrade or migration (Migrated Settings
on page 9).

Data and settings migration from an older off-host installation of HP Web Jetadmin 7.8, 8.0, or 8.1 to a
new HP Web Jetadmin 10.0 installation are possible by first using Migration Tool. Migration Tool is
an executable that is run on the system hosting the older version of HP Web Jetadmin and creates a
migration bundle file that is used at the new HP Web Jetadmin 10.0 installation. Migration Tool
(hpwja MigrateCollectSettings.exe)can be downloaded fromthe HP Web Jetadmin Download
Drivers and Software page at http://www.hp.com/go/webjetadmin_software.

Steps for Collecting Settings and Data to Migrate

Here are the steps for collecting settings and data from the remote host where the older version HP Web
Jetadmin resides:

1. Obtain the Migration Tool (hpwja MigrateCollectSettings.exe)from http://www.hp.com/
go/webjetadmin_software.

2. Save hpwja MigrateCollectSettings.exe in any empty directory to the hard drive for the
system hosting HP Web Jetadmin (version 7.8, 8.0, or 8.1).

Bf NOTE: The Migration Tool will display a timeout failure if HP Web Jetadmin or the Report
Generation Plug-in is currently performing a data collection on devices. If this occurs, run the
Migration Tool only when there is no collection activity. Asset Utilization - Data Collection
Schedules within the Report Generation Plug-in can be used to determine if any data collections
are currently running and also to determine existing data collection schedules.

3. Runhpwja MigrateCollectSettings.exe. The wizard starts and provides a summary.
Click Next.

4. You are asked if the HP Web Jetadmin 10.0 service should be re-started. Select or deselect
Restart. Choose Next.

B NOTE: The executable hpwja MigrateCollectSettings.exe stops the service during the
migration and will not restart the service unless you answer yes.

/A WARNING! Be sure the HP Web Jetadmin 7.8, 8.0, or 8.1 host is not currently providing support
for critical processes. Alerts, Reporting and other HP Web Jetadmin features will be interrupted by
running Migration Tool.

8 Chapter 1 Installation and Setup Guide for HP Web Jetadmin 10.0 ENWW
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You are asked to supply a Bundle Password. This password protects sensitive data that may be
a part of the migration bundle file. Knowledge of this password is required when using the bundle
file in the HP Web Jetadmin 10.0 installation. Type the password and click Next.

The migration starts and displays progress.

When the migration is completed, the location of the migration file (SettingsBundle.cab)is
displayed. This should be the same location as where the executable
(hpwja MigrateCollectSettings.exe) was launched.

The bundle migrations file (SettingsBundle. cab) will contain most of HP Web Jetadmin
settings and all of the device addresses as well as the MS Access (.mdb) file if Access was used
with Report Generation Plug-in. Once the bundle file is collected and moved to the correct directory
on the new HP Web Jetadmin 10.0 installation host, you are ready to begin the installation. To
complete this portion of the migration, see the instructions at Installing HP Web Jetadmin 10.0
Using a Migration Bundle File on page 12.

Migrated Settings

ENWW

The following settings are migrated:

Alerts

o Alerts settings

o Custom email templates

o HP Web Jetadmin current subscriptions
Credentials

o Device SNMPv1 Authentication

° Device SNMPv3 Authentication

0 Device File System Password

° Device EWS Username and Password
Device Cache Export

o Created export schedules

0 All Export parameters

Device Configuration

o Custom Field Columns

° Retry Count

o Retry Interval

Devices

0 Devices present in PDS cache are migrated over if the device is connected to the network
and “discoverable”

Migrating to HP Web Jetadmin 10.0 9



e Discovery
° Discovery Schedules
o Multicast Routers To Cross
o Background Discovery
° Discovery SNMPv3
o Hosts File
o Discovery Method
° Manual Discovery Settings
e Filters
o Filters that do not contain wildcards
e Groups
o Groups with or without subgroups
° Auto Groups (Group bound with filter)
e RGP
° Current data collections
° Scheduled Reports
° Historical Data
e Views
° Device List views
Migrating Reports Generation Plug-in Data: Preparing an HP Web Jetadmin
10 Install Host to Connect to an SQL Server

Read and follow this section when the SettingsBundle.cab file was taken from an HP Web Jetadmin
7.8/8.x host where the Reports Generation Plug-in was connected to MySQL or SQL Server. The
Reports Generation Plug-in data will not transfer unless these steps are followed.

SQL Server

B NOTE: Itis helpful to have the HP Web Jetadmin Reports Generation Plug-in Data Connector
Settings screen available when configuring these settings.

1. Onthe host where HP Web Jetadmin 10.0 is to be installed, open Control Panel > Administrative
Tools.

2. Open Data Sources (ODBC).
3. Under the System DSN tab, select Add.

4. Within the Create New Data Source wizard, select SQL Server. Then select Finish.
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5. Provide a name and a description and select the correct server name or IP address on which the
Reports Generation Plug-in data resides. Then select Next.

6. Atthe screen labeled How should SQL Server verify the authenticity of the login ID?, select
With SQL Server authentication using a login ID and password enter by the user. Uncheck
the box for Connect to SQL Server to obtain default settings for the additional configuration
options. Then select Next.

7. Check the box for Change the default database to: and add the name of the Reports Generation
Plug-in database on SQL. Leave the rest of the options at default. Select Next.

Bf NOTE: For HPWebJetadminDB, be sure to match the name displayed in Reports Generation
Plug-in Database Connector settings.

8. Leave everything unchecked with the exception of Perform translating for character data.
Select Finish.

You are now ready to begin the migration (see Installing HP Web Jetadmin 10.0 Using a Migration
Bundle File on page 12).

MySQL

The setup procedure is similar to the steps required to originally install RGP on HP Web Jetadmin 8.x.
In HP Web Jetadmin 8.x, you installed the MyODBC Connector v3.51 ODBC drivers from
http://dev.mysql.com/downloads/connector/odbc/3.51.html. When configuring RGP to use MySQL,
RGP asks for some basic information. With this information, RGP in HP Web Jetadmin 8.x configures
a System DSN profile in the MyODBC drivers.

In the upgrade case where you will be installing HP Web Jetadmin 10.0 over HP Web Jetadmin WJA
8.x, and you are using MySQL with RGP, the MyODBC drivers will have already been installed. The RGP
migration component will attempt to connect to the MySQL database via the DSN profile. In a migration
case, you will need to install the MyODBC Connector v3.51 drivers, and set up a System DSN profile
manually.

1. Install the MyODBC Connector v3.51 drivers from http://dev.mysqgl.com/downloads/connector/
odbc/3.51.html, using the Windows MSI Installer version. Choose all default options during
installation.

Navigate to Control Panel > Administrator Tools > Data Sources (ODBC).
Open Data Sources (ODBC).
Under the System DSN tab choose, Add.

o > 0 N

Scroll down to select the MySQL ODBC 3.51 Driver option. Then select Finish. A new window
should pop up with several empty fields; this is where we set up the System DSN profile:

° Data Source Name: enter WJADB.

e Description: leave it empty.

ENWW Migrating to HP Web Jetadmin 10.0 11
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e  Server: enter the server hostname or IP address of where the MySQL server is that contains

the RGP database tables.

e  User: enterthe user name that was used when initially configuring RGP in WJA 8.x. (In MySQL

this may be ‘root’, etc.) For the “Password” field, enter the password that was used when
initially configuring RGP in HP Web Jetadmin 8.x.

6. When you have entered the correct information, click on the Database pull-down menu. The default

name for this table is HPWebJetadminDB. Select the proper table and click OK. The System

DSN profile is now configured.

B

NOTE: If no items (database tables) are listed, check your settings and try again. The database

table that you created in HP Web Jetadmin 8.x should be present in the pull-down menu.

Once the System DSN profile is configured, you can place the Migration Settings Bundle in the
folder Documents and Settings\All Users\Application Data\Hewlett-Packard\HPWebJetadmin
\config\, and then begin the installation of HP Web Jetadmin 10.0 (see Installing HP Web Jetadmin 10.0
Using a Migration Bundle File on page 12.).

Installing HP Web Jetadmin 10.0 Using a Migration Bundle File

For an installation using a migration bundle file, the file (SettingsBundle. cab)is required and would

have

been created under the steps outlined in Steps for Collecting Settings and Data to Migrate

on page 8. If the file was not created, go back to that section and review the instructions for using
Migration Tool.

To migrate using a migration bundle file, follow these steps:

Bf NOTE: Insome cases, the migration can last as long as several hours. For example, if there are large
amounts of the Report Generation Plug-in (RGP) data, the migration could take longer. This is also true
for installations that contain several thousand devices.

1.

12 Chapter 1

Place the file SettingsBundle. cab in the same directory where you have placed the HP Web
Jetadmin 10.0 installer (wJasetup . exe). This file will be copied to the local directory DRIVE :
\Documents and Settings\All Users\Application Data\Hewlett-Packard
\HPWebJetadmin\config\SettingsBundle.cab where DRIVE indicates the location of the
user documents and settings directories. The file will not be removed as part of the install-migration;
the user may remove this file if they choose to do so.

Start the installation of HP Web Jetadmin 10.0 by launching wjasetup.exe. Follow all installer
steps. Bundled data and settings contained in the SettingsBundle. cab will not be imported
during the installation. Instead, bundle data and settings are imported on first-run of the HP Web
Jetadmin 10.0 client when the SettingsBundle. cab file is present.

After the installer is finished, launch the HP Web Jetadmin 10.0 client. Once the client has started,
a Migrate Web Jetadmin Settings pop-up window is displayed. This pop-up requests that you
provide the password and also enable the options for Alerts or Reports data and settings.

NOTE: Selecting Cancel within this pop-up will cause the Migration process to stop. Migration is
a one-time process; by selecting Cancel, you are agreeing that HP Web Jetadmin 10.0 should
never again attempt migration. If Cancel is selected and if Migration is desired at a future time, you
must un-install HP Web Jetadmin 10.0 and then reinstall it with the SettingsBundle. cab file
correctly placed (see Step 1. in this section).

Installation and Setup Guide for HP Web Jetadmin 10.0 ENWW



NOTE: The migration screen is offered only one time for each HP Web Jetadmin 10.0 installation
where a SettingsBundle. cab file is detected during a client launch. The option to select Alerts,
Reports data, or Alerts and Reports data is only offered one time; you will not receive the option

to go back through the Migration Tool and select different options. If you complete the migration
process and would like to change your selection for migration options, you need to uninstall HP Web
Jetadmin 10.0, reinstall a new copy of HP Web Jetadmin 10.0, then proceed with a new migration.

4. Provide the password requested by the client (this was supplied in step 6 (Steps for Collecting
Settings and Data to Migrate on page 8).

e The checkbox next to Migrate Alerts Subscriptions will cause the migration to establish
Alerts subscriptions in the HP Web Jetadmin 10.0 installation based on Alerts subscriptions
that were established on the older HP Web Jetadmin installation. It will also cause HP Web
Jetadmin 10.0 to modify traps destination tables on devices that have these Alerts
subscriptions established. The trap destination table entry for the older HP Web Jetadmin will
be removed.

Ef NOTE: The checkbox next to Migrate Alerts Settings should only be checked if you
understand and agree that Alerts on the older HP Web Jetadmin host will be decommissioned
as a requirement to migrate alerts subscriptions to the new HP Web Jetadmin 10.0 server.

e The checkbox next to Migrate Report Data will cause the migration to import all historic data
from the Report Generation Plug-in source that was in use on the older HP Web Jetadmin
installation. In the case where Microsoft Access was in use on the older installation, an MDB
file will be extracted from the migration bundle file and then imported into the HP Web Jetadmin
10.0, SQL 2005 Server Express database.

In the case where the source was either Microsoft SQL Server, Microsoft SQL Server 2005,
MySQL or Microsoft SQL Server Desktop Engine (MSDE), the migration will use Report
Generation Plug-in database connection settings that were gathered by the Migration Tool.
These connection settings will be used by HP Web Jetadmin 10.0 migration for the purpose
of connecting to the database and gathering all the historic reports data. This reports data is
then imported into the HP Web Jetadmin 10.0, SQL 2005 Server Express database.
Connection to the remote database will require that the user running the HP Web Jetadmin
10.0 installation is logged onto the network/domain in such a way that facilitates authentication
between HP Web Jetadmin 10.0 and the system hosting the database. The data and/or
collections settings for Report Generation Plug-in will not be interrupted by this process. Once
the Migrate reports data and Migrate alerts subscription choices are complete, click Next.

5. A settings confirmation screen will appear; choose Migrate if you agree to proceed. Settings will
start to be migrated and progress will be displayed. During the migration process, the HP Web
Jetadmin 10.0 server will perform a specified address Discovery for all devices brought forward
during the migration process; this step ensure the new server is storing the most current information
about the managed devices. The duration to run this discovery will be one variable that may
increase the time to complete the HP Web Jetadmin migration process. Discovery progress will
display separately while the discovery portion of migration takes place.

B NOTE: Settings and data import will vary depending on the migration bundle file and whether the
user chose Migrate reports data and/or Migrate alerts subscriptions.

6. When the migration is complete, use the Details button to review Migration Results.

ENWW Migrating to HP Web Jetadmin 10.0 13



14 Chapter 1

NOTE: During the Migration device Discovery process, one or more devices in a "communication
error" state may have been detected. These devices are added to HP Web Jetadmin 10.0 based
on their presence in the HP Web Jetadmin 7.8/8.x cache. These devices are added to the HP Web
Jetadmin 10.0 discovery to cover a case where HP Web Jetadmin 7.8/8.x Report Generation Plug-
in data is present and where this data should be retained. The devices can be found easily in

the Error Devices listing found beneath the All Devices listing in the HP Web Jetadmin 10.0
navigation tree. As these devices come back online, the HP Web Jetadmin poller will add column
data to lists and the devices will be removed from the Error Devices list. A device found in this list
can be quickly refreshed by using a right-click menu item named Refresh Selection (Full). If device
communication occurs, the "communication error” is lifted.

Click Done.
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Post-Installation Actions

Bf NOTE: The HP Web Jetadmin 10.0 server will start automatically as a Microsoft Service. The HP Web

Jetadmin 10.0 server cannot accept HP Web Jetadmin client connections until the HP Web Jetadmin
server has fully loaded all services into memory. Dependent upon your HP Web Jetadmin server
available system resources, it may take 1-2 minutes for all services to completely load after initial server
installation or server reboot.

The first time you launch HP Web Jetadmin 10.0 after installation, a pop-up dialog is displayed stating
that no devices have been discovered. You can opt to launch discovery settings at this point.

Once the installation is complete, HP Web Jetadmin 10.0 can be launched from a supported browser
by entering the hostname or IP address of the computer on which it is installed, followed by the port
number and path. Typical default port numbers for Web services have a value of 80. Since HP Web
Jetadmin 10.0 may be running simultaneously with another Web service on the same computer, HP Web
Jetadmin 10.0 uses a port number of 8000. If desired, the port value may be altered.

Here is an example of the URL used to activate HP Web Jetadmin 10.0 on a supported Windows
desktop: http://myhost:8000. In most cases, the browser will auto-launch the Smart Client file
download and on first-run will present a Run dialogue (Smart Client Deployment on page 16). Choose
the Run button to activate the .NET Smart Client application loader. A short time will elapse while Smart
Client installs the application to your desktop system. In some cases, you might have to click Click
Here in the browser window before the download process is started.

Restarting the HP Web Jetadmin Service

ENWW

It may be necessary to stop and restart the HP Web Jetadmin 10.0 service. An example of this would
be when a network is switched from hard-wired to wireless. Once the network is switched, HP Web
Jetadmin 10.0 must be restarted in order for the application to realize the change.

WARNING! Restarting HP Web Jetadmin 10.0 services may interrupt background tasks and user
sessions. Always check the application before restarting.

To script the stop of all HP Web Jetadmin 10.0 services, use these command strings in this order:
e Net stop HPWJAUpdateService

e Net stop HPWJAService

e Net stop mssql$HPWJA

To script the start of all HP Web Jetadmin 10.0 services, use these command strings in this order:
e Net start mssql$HPWJA

e  Net start HPWJAService

e Net start HPWJAUpdateService

You can revert back to an older version of HP Web Jetadmin (versions 7.8 or 8.x) from an upgrade if
needed. Follow these steps:

1. Uninstall HP Web Jetadmin 10.0.

2. Use Windows Service Manager to set the older HP Web Jetadmin service (listed as HP Web
Jetadmin in the Services MMC) to activate and to also start the service.

Post-Installation Actions 15



Smart Client Deployment

I’?{

HP Web Jetadmin 10.0 uses the Microsoft ClickOnce Smart Client technology to provide you with the
best application experience possible. This technology runs a .NET application by automatically
downloading and launching it through your web browser. The Smart Client runs as a local .NET
application on your computing host and communicates with the HP Web Jetadmin 10.0 service via .NET
Remoting. Once the Smart Client application is started, the browser is no longer needed. HP Web
Jetadmin 10.0 also uses the browser for online help and proactive Product Update notification but,
essentially, the client application runs locally on your computer (like many other applications). With this,
the URL form http://hostname: 8000 can be used to access HP Web Jetadmin 10.0 remotely from
anywhere on your intranet and/or WAN.

NOTE: When the HP Web Jetadmin 10.0 installer builds the shortcut on the install host (DRIVE:
\Documents and Settings\All Users\Start Menu\Programs\HP Web Jetadmin 10\) it
uses the default port number 8000 in the item URL. You can modify this if the port number of the HP Web
Jetadmin URL is altered. Simply change the URL http://localhost:8000 to http://
localhost : xxxx Where xxxx is the value of the new port number being used.

NOTE: Modification of the HTTP port used to launch the HP Web Jetadmin Smart Client is possible
through a configuration file change. The default port numbers are 8000 for HTTP and 8443 for HTTPS.
Port numbering is changed through a configuration file found on the HP Web Jetadmin directory:

DRIVE:\Documents and Settings\NetworkService\Local Settings\Application
Data\Hewlett-Packard\HPWebJetadmin\config\

File: HP. Imaging.Wjp.Core.WebServer.config.xml

NOTE: Either of the entries for HttpsPort or HttpPort can be altered. Here is an example of the entries:
<property name="HttpsPort">

<type> HP.Imaging.Wjp.Core.Framework.ConfigurationItemString </type>
<value> 8443 </values>

</property>

<property name="HttpPort">
<type>HP.Imaging.Wjp.Core.Framework.ConfigurationItemString </type>

<value> 8000 </values>

</propertys>

All that is needed to start the Smart Client session is a browser. Administrator rights are not required to
run Smart Client applications but .NET 2.0 is required to be installed; local administrator rights might be
required prior to the installation.

Some characteristics about Smart Client are:
e The HP Web Jetadmin 10.0 server is initially contacted through http/https.

e The server transfers about 2 MB of Smart Client application to the client where it is saved to disk
and runs as the user logged onto the computer. (In Internet Explorer, Run As can be used to run
Smart Client and the HP Web Jetadmin 10.0 client application as an alternate user.)
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e The Smart Client application, running on the client, executes commands to download the HP Web
Jetadmin 10.0 client files (about 50 MB) and starts UIExec . exe (browser is now inactive).

e UIExec.exe runs and opens the graphical user interface (the HP Web Jetadmin 10.0 client
application).

e The server downloads all relevant information to the client and then periodically pings the client
when new information exists for retrieval.

Bf NOTE: HP Web Jetadmin 10.0 will launch by authenticating the user who is logged onto the system
where the browser was launched. In cases where an alternate user (one who is not logged onto the
browser desktop) requires access to HP Web Jetadmin 10.0 the Windows Run As prompt can be
invoked. Open Start > Programs and right-click on the Internet Explorer icon. Choose Run As; a
dialogue box is opened and prompts for alternate users. See the Microsoft Windows documentation for
details about using Run As.

NOTE: In most cases, the Smart Client will auto-launch; in some cases local security settings on the
workstation may prevent the application from auto-launching. Use the Start HP Web Jetadmin button
to manually launch the Smart Client or refer to Microsoft documentation to adjust local security settings.

To run the Smart Client in a workgroup on Microsoft Windows XP, you need to adjust the Microsoft
security settings:

Bf NOTE: Consult Microsoft documentation to learn more about security policy settings.

1. Access the Control Panel.

2. Open Local Security Policy MMC > Local Security Policy MMC.

3. Navigate to Local Security Settings > Local Policies > Security Options.

4. Locate the item Network access: Sharing and security model for local accounts.
5. Change the setting to Classic local users authenticate as themselves.

To ensure this feature works properly, see Minimum System Requirements for HP Web
Jetadmin 10.0 on page 2 for HP Web Jetadmin 10.0.

Steps for Using Smart Client

If you are using Windows 2K3 as a client, it is recommended that you add the URL of the HP Web
Jetadmin 10.0 server as a Trusted Site.

Once the HP Web Jetadmin 10.0 installation is complete, a Smart Client session can be started in one
of two ways:

1. Look in the Start > Programs group on the computing host where HP Web Jetadmin 10.0 was
installed. A program group named HP Web Jetadmin 10.0 should have been created and should
contain a shortcut to HP Web Jetadmin 10.0 software. This launches a browser session that starts
a Smart Client session with HP Web Jetadmin 10.0.

2. Browse to the following URL at the computing host: http://localhost:8000. This also
launches a browser session that starts a Smart Client session.

Bf NOTE: Insome cases (for example, Windows 2003 server), the URL of HP Web Jetadmin 10.0 might
have to be added to browser trusted security zones.

ENWW Smart Client Deployment 17
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Default Settings

Table 1-2 Default Settings for HP Web Jetadmin 10.0

Configuration Item Value Where to change it

SNMPv1 Timeout Value 500ms Tools > Options > Application
Management > Network > SNMP

SNMPv3 Timeout Value 1000ms Tools > Options > Application
Management > Network > SNMP

SNMP Retries 3 Tools > Options > Application
Management > Network > SNMP

Application Log ‘Save log entries’ 30 days Tools > Options > Application

time Management > Application Log

SLP Multicast routers to cross 4 Device Discovery Wizard (must
change each time)

Configuration Retries 0 Tools > Options > Device
Management > Configuration >
General

Hours between configuration retries 8 Tools > Options > Device
Management > Configuration >
General

Alerts Polling Rate: Maximum 24 hours Tools > Options > Device

communication interval Management > Alerts > General

Device list polling rates: polling 2 seconds Tools > Options > Device

interval Management > Device Lists > Device
List Polling Rates

Device list polling rates: Maximum 2 Tools > Options > Device

devices to poll at one time Management > Device Lists > Device
List Polling Rates

Status polling rate: Poll interval 5 seconds Tools > Options > Device

Management > Status > Single Device
View

Tools > Options > Device
Management > Status > Multi Device
View

Status polling rate: Time between
polling intervals

Single: 5 seconds

Multiple: 10 seconds

Tools > Options > Device
Management > Status > Single Device
View

Tools > Options > Device
Management > Status > Multi Device
View

Status polling rate: Maximum devices
to poll at one time

Single: 2 devices

Multiple: 3 devices

Tools > Options > Device
Management > Status > Single Device
View

Tools > Options > Device
Management > Status > Multi Device
View

HTTP timeout

6 seconds

Tools > Options > Device
Management > Network > HTTP

Installation and Setup Guide for HP Web Jetadmin 10.0
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Table 1-2 Default Settings for HP Web Jetadmin 10.0 (continued)

Configuration Item Value Where to change it

Discovery history retention 90 days Tools > Options > Device
Management > Discovery > General

Firmware upgrade — maximum 8 Tools > Options > Device

concurrent upgrades Management > Firmware > Firmware
Upgrade Options

Firmware upgrade — retries 0 Tools > Options > Device
Management > Firmware > Firmware
Upgrade Options

Device filters — time period for device to 14 days Tools > Options > Device

remain “New” Management > Device Filters

Configuration history retention 30 days Tools > Options > Device
Management > Configuration >
General

Reports data retention 1 year Tools > Options > Device
Management > Reports > Data
Retention

Supply low threshold 25% Tools > Options > Device
Management > Supplies > General

Alerts history retention 30 days Tools > Options > Device
Management > Alerts > General

Critical alerts polling interval 5 minutes Tools > Options > Device

Management > Alerts > General
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Recommended Configuration Settings for HP Web
Jetadmin 10.0

Once HP Web Jetadmin 10.0 is installed, it is ready to run. Some of the initial steps you must take to
begin managing devices and the print environment are: application settings, discovery and various
features setup. Here are a few simple ideas around deploying HP Web Jetadmin 10.0 once an
installation has been completed. It may be necessary to use online help for HP Web Jetadmin 10.0 or
other documentation.

Application settings are options like email, SNMP, server, or HTTP. These are found in Tools >
Options from the HP Web Jetadmin 10.0 toolbar and then navigating the Application Management
category.

HP Web Jetadmin 10.0 is used to find devices on your networks. It may be as simple as enabling HP Web
Jetadmin 10.0 to simply listen for devices on the network passively or it may involve your working with
an IT team to map out your entire IP network. Once this network map is known, IP segments can be
entered into HP Web Jetadmin 10.0 IP Range discovery and a complete inventory of network connected
devices can be completed. PC-connected device discovery is also possible from within HP Web
Jetadmin 10.0. Many of the same settings and techniques can be used to perform this type of discovery
which can lead to an inventory of locally connected devices. HP Web Jetadmin 10.0 online help or other
documentation should be consulted prior to planning and implementing HP Web Jetadmin 10.0 device
discovery.

Feature setups such as Roles (or permissions), Users, Alerts (for devices, and Device Groups, all need
to be configured prior to the initial HP Web Jetadmin 10.0 implementation. Many of these features were
described in previous sections here and are discussed in more detail within the online help for HP Web
Jetadmin 10.0 and other documentation prior to configuration.
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Uninstalling HP Web Jetadmin 10.0

Uninstalling HP Web Jetadmin 10.0 from a computing host is quite simple. Removing HP Web Jetadmin
10.0 software also removes the Microsoft SQL Express 2005 instance of HP Web Jetadmin 10.0
database. Restoring the database is possible provided you have run the correct backup procedures and
have store the files securely.

Steps to Uninstall HP Web Jetadmin 10.0
To uninstall HP Web Jetadmin 10.0, follow these steps:

1. In your Control Panel, go to Add or Remove Programs.
2. Select HP Web Jetadmin 10.0 and click Remove.
3. Follow the instructions as each page is displayed.
4. When the uninstall is complete, click Close.
5

If desired, look at the log file created in the Document and Settings folder when WjaSetup.exe
runs (for example, C:\Documents and Settings\{username}\Local Settings\Temp
\hp\wja\Uninstaller\Uninstaller.log).

Steps to Uninstall HP Web Jetadmin 10.0 in Silent Mode

To safely remove HP Web Jetadmin 10.0 in silent mode, follow these steps:

1. To get the Uninstaller, access C: \Program Files\Hewlett-Packard\Web Jetadmin 10
\Uninstaller\Uninstaller.exe.

Bf NOTE: cC:\Program Files is the default location, but on any user system this could be a
different drive and/or folder.

2. Use the -x option to extract a properties file (Uninstaller.exe -x=properties.xml).

3. After manually editing the properties file, use the -v option to validate a properties file
(Uninstaller.exe -v=properties.xml).

4. Use the -s option to run the Uninstaller in silent mode using the given properties.xml file
(Uninstaller.exe -s=properties.xml).
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Backing Up and Restoring HP Web Jetadmin 10.0

° Script Files
° Backing Up HP Web Jetadmin 10.0 Settings and Database

° Restoring HP Web Jetadmin 10.0 Settings and Database

° Other Details and Notes for Backing Up and Restoring HP Web Jetadmin 10.0

Regular backups of HP Web Jetadmin 10.0 software are recommended to mitigate the risks of host and/
or application failure. Prior to using this information in a production environment, scripts and other
backup/restore details should first be tested in a non-production environment by the customer or
designated HP Web Jetadmin 10.0 administrator.

Script Files

The script examples for backup and restore of HP Web Jetadmin 10.0 can be found in the HP Web
Jetadmin 10.0 install directory (WJABackupRestore). These files are:

e backup.bat

e osql_backup.sql

e osql_restore.sql

e restore.bat

e WJABackupRestorelnstructions.txt

After you have located the files, copy them to another directory outside of the HP Web Jetadmin 10.0
install directory where you will create backup scripts.

Backing Up HP Web Jetadmin 10.0 Settings and Database

e Steps for Backing Up HP Web Jetadmin 10.0 Settings and Database

These items are required for backup:
e script files supplied by HP.
e HP Web Jetadmin 10.0 running on a supported host.

e administrative access to this host.

Steps for Backing Up HP Web Jetadmin 10.0 Settings and Database
To backup HP Web Jetadmin 10.0, follow these steps:

1. Copy the backup/restore files onto the host where HP Web Jetadmin 10.0 is installed. These files
should all reside in the same directory located on a local drive outside of the HP Web Jetadmin
10.0 directory (for example, ¢ : \BRWJA).

2. Choose Start > Run and type cmd. Then click OK. A command window is displayed.

3. Inthe command window, change the directory to the path where the backup/restore files exist.
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4. Atthe prompt, type backup.bat. The HP Web Jetadmin 10.0 service will automatically stop and
the backup process will begin.

5. The following disclaimer is displayed:

This batch file is for illustrative purposes only. If used in a production environment, this batch file
should first be tested in a non-production environment by the customer or designated HP Web
Jetadmin administrator in order to determine its effectiveness. Type Ctrl+C to quit. Press any
other key to continue.

6. Wait until the process is finished. The HP Web Jetadmin 10.0 service will automatically start.

7. Files have now been created as a file-set and exist in the same directory with the backup/restore
scripts.

The file-set should contain a file named “HPWJA DB_BACKUP.dat”, a file name
“osqgl_backup.log”, and a directory named “Settings” that contains several other files.

The file-set should be moved or stored elsewhere for safekeeping.

It might be important to record the state of HP Web Jetadmin 10.0 plug-ins. This can be done through
the Application Management > Product Update > Installed Packages. All plug-in and version
information should be recorded. This may be needed when restoring the application.

Restoring HP Web Jetadmin 10.0 Settings and Database
These items are required for restoring settings and data:

e file-set (including backup/restore scripts supplied by HP) from previously performed backup
procedure (‘HPWJA_ DB BACKUP.dat”, “osql_backup.log”, and a directory named “Settings” that
contains several other files).

e HP Web Jetadmin 10.0 running on a supported host and in the same state as was recorded in the
backup procedure.

e administrative access to this host.

/A WARNING! Restoring database and settings to HP Web Jetadmin 10.0 will cause any existing data
to be lost.

One of three restoration scenarios is possible:

1. HP Web Jetadmin 10.0 installed on the same host and same instance of Windows (supported)
from which the backup data was taken.

2. HP Web Jetadmin 10.0 installed on the same host that has a new instance of Windows (supported),
which is different from the instance of Windows where the backup data was taken.

3. HP Web Jetadmin 10.0 installed on a different host, not the host from which the backup data was
taken.

ENWW Backing Up and Restoring HP Web Jetadmin 10.0 23



Steps for Restoring HP Web Jetadmin 10.0 Settings and Database

To restore HP Web Jetadmin 10.0, follow these steps:

Copy the existing backup/restore file-set to a folder or drive local to the host where HP Web
Jetadmin 10.0 is installed.

Choose Start > Run and type cmd. Then click OK. A command window is displayed.

NOTE: Windows Vista requires that any script requiring administrative access and run from
Command Prompt must be executed using run as administrator. Since abackup and restore
script starts and stops the HP Web Jetadmin 10.0 service, administrative access is required. To
launch a Command Prompt window in this way, click Start > Programs and then right-click
Command Prompt and select Run as administrator from the right-click menu. When the
Command Prompt launches, the window title bar should read Administrator Command
Prompt.

In the command window, change the directory to the path where the backup/restore files exist.
At the prompt, type restore.bat and press Enter.
If using the script provided, the following disclaimer is displayed:

This batch file is for illustrative purposes only. If used in a production environment, this batch file
should first be tested in a non-production environment by the customer or designated HP Web
Jetadmin administrator in order to determine its effectiveness. Type Ctrl+C to quit. Press any other
key to continue.

The HP Web Jetadmin 10.0 service will automatically stop and the restore process will begin.

Wait until the process is finished. The HP Web Jetadmin 10.0 service will automatically start.

NOTE: Textinthe command window should report that a number of files were copied and that
an osql_restore.log file is available for viewing. No errors should be present.

Open HP Web Jetadmin 10.0 and verify that settings and data were restored.

Other Details and Notes for Backing Up and Restoring HP Web Jetadmin

10.0

Settings and data covered by backup/restore processes include:
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all current devices and device attributes.
all collected device metrics.
all stored reports and data export settings and archives.

all device credentials.

NOTE: When restoring settings and database information to the HP Web Jetadmin 10.0 host,
encrypted data will no longer function if the host or Windows OS instance is different from that
which was used to process the original file-set. In these cases, the encrypted data can be restored
manually through the HP Web Jetadmin 10.0 user interface (Backing Up and Restoring HP Web
Jetadmin 10.0 on page 22). A few examples of encrypted data include device passwords, SMTP
user/password settings, HTTP proxy user/password settings, and more.

all stored device configuration.

Installation and Setup Guide for HP Web Jetadmin 10.0 ENWW



e all Alerts settings including notification and supplies management details.
e all HP Web Jetadmin 10.0 Groups details and settings.
e all application history details.

e all application settings including templates, schedules, filters and views that were saved previously
by users.

e all application security settings including user roles and stored credentials.

Bf NOTE: When restoring settings and database information to the HP Web Jetadmin 10.0 host,
encrypted data will no longer function if the host or Windows OS instance is different from that
which was used to process the original file-set. In these cases, the encrypted data can be restored
manually through the HP Web Jetadmin 10.0 user interface (Backing Up and Restoring HP Web
Jetadmin 10.0 on page 22). A few examples of encrypted data include device passwords, SMTP
user/password settings, HTTP proxy user/password settings, and more.

The following settings and data are not covered by backup/restore processes:
e HP Web Jetadmin 10.0 client stored settings.
e HP Web Jetadmin 10.0 base installation.

e plug-ins and patch base installation (includes language support plug-ins).
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2 User Guide for HP Web Jetadmin 10.0
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Printing the User Guide

To access the HP Web Jetadmin 10.0 user guide, click hpwja_userguide.pdf.

If you do not have the free Adobe® Reader® installed on your system, click http://www.adobe.com/
products/acrobat/readstep2.html.
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3 Introduction to HP Web Jetadmin 10.0

° Product Support

° Differences Between HP Web Jetadmin Versions 8.x and 10

e Getting Around in HP Web Jetadmin 10.0

e The HP Web Jetadmin 10.0 Server

e The HP Web Jetadmin 10.0 Client

HP Web Jetadmin 10.0 increases business productivity by helping you manage supplies, proactively
address potential printing problems, automatically configure peripheral drivers, and update firmware.
HP Web Jetadmin 10.0 provides all of the peripheral management capabilities you need in one easy-
to-use Web browser interface. It is a is a free utility that you can download from http://www.hp.com/go/

webjetadmin.
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Product Support

This section contains information about getting online help and product support.

Online Help

The HP Web Jetadmin 10.0 help system includes detailed information to assist you in configuring and
managing your devices on a network.

The Help feature includes the following:

Help folder: the tree-structured Help folder contains conceptual information about HP Web
Jetadmin 10.0 features and may be accessed from anywhere within HP Web Jetadmin 10.0.
Expand the Help folder to access the Table of Contents and the HP Web Jetadmin 10.0 folder,
which provides access to the Index, Installation and Setup Guide, and License.

Context help: each page in HP Web Jetadmin 10.0 features a help icon (?) on the content toolbar.
When you click the help icon, HP Web Jetadmin 10.0 displays context help for that page. Context
help provides only the information you need for the displayed page or option.

NOTE: Inorderto use external links, your browser must have access to the public internet. If you
are behind an internet firewall, you may need to configure proxy servers. Consult with your network
administrator to determine the appropriate settings for your browser.

HP Web Jetadmin 10.0 Reviewer/Evaluator's Guide provides enough information for a successful
evaluation and also provides a list of what capabilities to consider when implementing a fleet
management software tool.

Direct Links to Support

ENWW

Hewlett-Packard maintains an extensive Web presence to provide information and assistance. To obtain
technical support for HP Web Jetadmin 10.0, go to http://www.hp.com/go/webjetadmin and click the link
to Technical Support. For phone support, available Monday through Friday, 6:00 am to 6:00 pm,
Mountain Standard Time, call 1-800-HPINVENT (1-800-474-6836).
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Differences Between HP Web Jetadmin Versions 8.x and 10

HP Web Jetadmin 10.0 has many significant improvements compared to HP Web Jetadmin 8.x. In
addition, some features have been discontinued.

e New or improved capabilities in HP Web Jetadmin 10.0:

o

[

Smart Client for easy access.

New built-in device view layouts include Active Directory, Asset, Detailed, Jetdirect, Security,
Status, and Warranty.

New application views include Device Management, Print Management, and Application
Management.

New device pruning and filtering capabilities.

Additional profiles management capabilities, including the ability to configure and save default
view to be associated with a user or group.

Policy-based auto group functionality.

Additional feedback on background tasks.

Additional batch configuration capabilities for authentication methods.
Export data cache by subgroup inheritance.

PC Discovery integration into more HP Web Jetadmin tasks.

IP Range shared between PC Discovery and Networked Devices.
Additional discovery analysis tools.

Native RGP and supplies integration.

Increased consumables alert reliability.

Ad-hoc consumables shopping list creation based upon needed supplies.
Device communication failure proactive alerting.

Improved print path management and queue creation including support for UPD.

Consolidation into one SQL Express database.

e HP Web Jetadmin 8.x plug-ins that are now core capabilities of HP Web Jetadmin 10.0:

[
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PC Printer Discovery Plug-in.
Report Generation Plug-in.

HP Driver Preconfiguration Plug-in.
Authentication Manager Plug-in.

Device Storage Manager Plug-in.
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HP Web Jetadmin 10.0 does not have the following capabilities that are currently in HP Web
Jetadmin 8.x:

o

o

Mapping capabilities.

Data Storage Manager’s downloadable fonts and macros capability.
Cancel print job.

Exportable log files.

MegaTrack In Printer Agent and MegaTrack In Printer Agent PIN plug-in.
HP Proactive Support plug-in.

Advanced support for HP CM8060 MFP with Edgeline Technology.

Capabilities that have been discontinued in HP Web Jetadmin 10.0:

o

PSA (Print Server Appliance) Device Support and Discovery.
HP Jetdirect Password.

Novell Print Path Creation.

Bootp Server Support.

Win2000 Server Support.

Remote Discovery Agent.

Proactive Cache Level.

Support settings like Admin, email, and URL.
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Getting Around in HP Web Jetadmin 10.0

e Application Views in HP Web Jetadmin 10.0

° Top Menu Bar Features

° Page Layout in HP Web Jetadmin 10.0

e Wizards
° Other Features

The user interface for HP Web Jetadmin 10.0 is designed to be efficient and intuitive, limiting the number
of steps required to complete a task and streamlining software operation.

Application Views in HP Web Jetadmin 10.0

HP Web Jetadmin 10.0 can be separated into three views accessible through the lower portion of the
left navigation pane:

° Device Management on page 50: used for all device-related functions.

e Print Management on page 224: used to manage print queues and drivers on remote servers and
workstations.

e Application Management on page 238: used for application functionality such as users and roles,
security, and software updates.

Top Menu Bar Features
e Preferences
e Device Filters

° Device Identification

e Application Logging

° Data Synchronization

The top menu bar is always present and changes depending on the application view, presence of plug-
ins, or the version of HP Web Jetadmin 10.0. This allows you to use functionality without having to
change to a different view.
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Across the top menu bar are four choices:

e File: add new groups, alerts, and configuration templates, print, and exit HP Web Jetadmin 10.0.

o

o

New: create groups (Create a New Device Group on page 89), alerts templates (Create a
Subscription Template on page 157), and configuration templates (Create a Configuration
Template on page 143).

Print: print the device list (Printing Device Lists on page 82).

Exit: exit HP Web Jetadmin 10.0.

e View: customize interface settings based on the user’s credentials:

o

Column Layouts: create custom views by identifying columns displayed for any device list
(Columns for Device Lists on page 68).

Filters: create and manage filters using the Filter Manager and Filter Editor (Filters and Device
Lists on page 71).

Refresh Selection: available on a device list page for single device views. This causes the
data for the selected device to be retrieved directly from the device. It is useful if you suspect
the data displayed for the device may be out of date.

Task Module docking area: manage the task modules you want to always be displayed
(Docking Task Modules on page 37).

Preferences: set preferences for data to be displayed in device lists (Device Lists
on page 67). See Preferences on page 33.

e Tools: manage global settings including:

o

Device Discovery: starts the Discovery wizard to locate network and PC-Connected devices
(Discover Devices (the Device Discovery Wizard) on page 121).

Application Log: you can view a log of all transactions that have occurred including the user,
what the activity was and its details, and when it happened (Application Logging

on page 34).

Data Synchronization: synchronize data between multiple installations of HP Web Jetadmin
10.0 (Data Synchronization on page 35).

Options: manage configuration settings for each view (Device Management Options
on page 52 and Application Management Options on page 243).

e Help: provides online help for this product (Online Help on page 29).

Preferences

Preferences for lists (in Device Lists on page 67 and Device Groups on page 85) lets you manage
data displayed in those lists. The top menu bar is always present and will change depending on the
application view, presence of plug-ins, or the version of HP Web Jetadmin 10.0. You can use
functionality without having to change views.

Device Filters

e Steps for Configuring Device Filters Through Preferences

You can select which device lists or filters are displayed in the left navigation pane.
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Steps for Configuring Device Filters Through Preferences

1. From the top menu bar, select View > Preferences > Device Filters. The Preferences page is
displayed with fields for device filters.

2. Move the filters from Available filters to Selected filters to display them in the left navigation pane
under All Devices.

To remove filters from the left navigation pane, select them in Selected filters and move them
to Available filters.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Device Identification

° Steps for Configuring Device |dentification Through Preferences

Space on device lists can be limited and the columns you select to display must be chosen carefully.
You can select columns to identify the devices on the Select Devices page, on the device list pages
in Device Lists (Device Lists on page 67) and in Device Groups (Device Groups on page 85) and
in the Status tab (Status Tab on page 54). This can be customized on a per-user basis. One user
may have a preference for asset number detail while another user may have a preference for only IP
address and IP hostname. Both of these users can customize device tools to reflect only the device
information that is most important to them.

Steps for Configuring Device Identification Through Preferences

1.  From the top menu bar, select View > Preferences > Device Identification. The Preferences
page is displayed with fields for device identification.

2. Move the fields from Available Fields to Selected Fields to display them as columns on device
lists throughout HP Web Jetadmin 10.0.

To remove columns from device lists, move the fields from Selected Fields to Available Fields.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Application Logging

In HP Web Jetadmin 10.0, you can view a log of all transactions that have occurred including the user,
what the activity was and its details, and when it happened.

1. From the top menu bar, select Tools > Application Log. The Application Log is displayed.
2. The following actions can be performed on the Application Log:
e Tore-sort the Application Log, click on any column header.

e To change the log settings, click on Edit Log Settings. You can change the length of time to
save log entries and also clear the log (Application Log on page 250).

e Toclear the log, click Clear Log.

e  Help: provides online help for this product (Online Help on page 29).
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Data Synchronization

Steps for Data Synchronization

You can synchronize data between HP Web Jetadmin 10.0 servers on your network.

You can either enter the hostname or IP address of the HP Web Jetadmin 10.0 server you want to
synchronize with, or you can discover all HP Web Jetadmin 10.0 devices on your network (in
Application Management under Web Jetadmin Management on page 275).

A local user must be in:

the user group on the HP Web Jetadmin 10.0 host and also be associated to a data synchronization
role on that host.

the user group on the HP Web Jetadmin 10.0 remote Smart Client.

the admin group on the data synchronization host.

Steps for Data Synchronization
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1.
2,

On the top menu bar, access Tools > Data Synchronization.
Select the HP Web Jetadmin 10.0 server you want to synchronize with:

e If you know the hostname or IP address for the HP Web Jetadmin 10.0 server you want to
synchronize with, enter it in WJA Quick Discovery.

e Ifyou do not know the hostname or IP address for the HP Web Jetadmin 10.0 server you want
to synchronize with, highlight the server or servers in the list.

You can:
e Synchronize: synchronize the HP Web Jetadmin 10.0 servers now. Click Synchronize.

e Schedule: set up a future time to synchronize the HP Web Jetadmin 10.0 servers. Click
Schedule.

B NOTE: If you schedule a task (for example, a discovery or a configuration or others) using
a corresponding template, the task uses the settings defined in the template at the time the
task starts. This makes it easy to redefine settings used in a regularly scheduled task without
having to delete and create a scheduled task.

NOTE: AllHP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin
install host. The client system being used to access HP Web Jetadmin may or may not be in
the same time zone as the HP Web Jetadmin install host. You should be aware of the time
and possible date differences when configuring HP Web Jetadmin 10.0 scheduling.

e Clear Schedule: clear any synchronization schedules that have been set up already. Click
Clear Schedule.

The Synchronization Credentials page is displayed. Enter your password and click Verify
Link to verify the authentication. The link must be verified before you can proceed.

To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.
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Page Layout in HP Web Jetadmin 10.0

° Left Navigation Pane

e Task Modules
e Workspace
Each page in HP Web Jetadmin 10.0 has the following features:

e aleft navigation pane that lists all functions for each separate view (Left Navigation Pane
on page 36).

e an area at the right to display content or task modules which provide access to related features or
tasks (Task Modules on page 36).

e work space: changes depending on the view and the feature selected (Workspace on page 37).

Columns for most lists can be resized by clicking and dragging the column headers.

Left Navigation Pane

HP Web Jetadmin 10.0 has a navigation pane on the left side of the user interface that displays a tree
for the current view (Device Management, Print Management, or Application Management). The
tree breaks up the view’s functionality into organized parts. The Device Management view contains
most of HP Web Jetadmin 10.0’s functionality and therefore has the most complex tree.

Many parts of the navigation tree have right-click functionality. An example of this is Discovery
on page 99, where the Discover devices right-click menu item can be selected.

Other parts of the tree have drag-and-drop functionality enabled such as Device Groups (Device
Groups on page 85). Devices can be selected in device lists within the workspace and dragged into
Device Groups; the selected devices are added as group members. Many top-level nodes can invoke
summary functionality in the workspace. By selecting a top-level node, such as Alerts, the workspace
in the right-hand portion of the interface contains a summary of the Alerts features. The task modules
that are specific to a feature (such as Alerts) will be displayed in the work space. The feature summary
can be altered by selecting or deselecting the task modules that are important to you. We will cover
more on this in the task module section.

Task Modules

Task modules are flexible blocks of specific or targeted functionality designed to help a user more quickly
perform a task or obtain feature information. These can be found in many of the workspace pages or
they can be found in the Task Module docking area. In either case, you can enable or disable task
modules on a per-user basis.

A Current Task task module is initially included in the task module docking for each section to provide
access to required tasks for that section. All task modules can be hidden or displayed and can be moved
within the content area. For example, in Device Groups, the Current Tasks - Device Groups task
module lists all tasks within Groups.
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Docking Task Modules

The task module docking feature is a powerful tool that enables you to do any of the following:

e  Customize a user-specific collection of task modules from a choice of any or all task modules
available in the application.

e View the collection of task modules regardless of the current focus of the application.

e  Undock the collection of task modules to maximize application space.

e Dock the task module to any one of four sides of the work space.

e Hide the collection of task modules beneath a tabbed control that enables access at any time.

e Viewa Current Tasks task module that changes depending on the focus (context) of the application.
e  Many task modules can be configured more than once within the docking area.

To display the Task Module docking area, click View > Task Module docking area. This is a toggle
selection; if you select it again it closes the Task Module docking area.

Workspace

The large area just right of the navigation tree is considered the HP Web Jetadmin 10.0 workspace.
This area changes depending on the View and Navigation tree elements selected. In many cases, the
focus of this area can be a summary of a feature space. You can obtain this summary by selecting any
top-level element within the navigation tree. Any element with the + symbol next it is a top-level element
and can invoke a summary focus. An exception to this rule is the All Devices list. When All Devices is
selected in the left navigation pane, the device list is displayed in the workspace. There are also other
exceptions that won't be covered here. The workspace can also reflect specific feature functionality.
Whenever a sub-level element (generally one that has no + symbol next to it) is selected, the workspace
reflects specific functionality. This can be seen in Discovery History (Discovery History

on page 125).

Wizards

Wizards provide a collection of steps in the required order for a user to accomplish a task successfully.
Every wizard launches in a separate window from the main application via many different controls
including right-click menu items and task modules. Many of the wizards within HP Web Jetadmin 10.0
are launched from multiple controls in different parts of the application. An example of a wizard is Create
Group (Create a New Device Group on page 89). After your start the wizard, you are asked to specify
the group type, the group name, and the group members; then you can continue with the displayed
steps until the task is successfully completed. Confirmation and results pages provide both a safeguard
and additional details about the task.

Other Features
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e Drag-and-drop: You can drag-and-drop various items (for example, devices) onto functionality
(reports, groups, and more) to save time and increase accuracy.

e Errors Encountered within HP Web Jetadmin 10.0: Errors exist on the page anytime the user
interface has an error or cannot understand input, it displays “error on page”. Hovering the mouse
over the error icon will give an indication of the problem that exists on that page.
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e Identification of the HP Web Jetadmin 10.0 Server: The title bar on the HP Web Jetadmin 10.0
client window always indicates the computer name of the system where HP Web Jetadmin 10.0 is
installed.

e Determining the Software Version: By using Help > About, an HP Web Jetadmin 10.0 logo page
can be launched. This contains the exact revision of the software in the xx.x.xxxxx format which
represents MajorApplicationVersion.MinorApplicationVersion.Buildnumber number.

e Client Performance: HP Web Jetadmin 10.0 provides a significant improvement in application
performance over earlier versions. The client application performs many tasks locally in order to
reduce traffic to the server thus improving client performance. Here are some points about how the
client application is leveraged to maximize performance:

o Round-tripping the client/server connection is a thing of the past thanks to a client application
that is built on .NET technology. The older, browser-based interface contacted the server
application for the majority of user actions.

0 All graphics are managed and reside with the client.
o Notification of change events from the server are performed on an as-needed basis only.
o Most list operations are performed by the client application and not at the server.

o Client performance benefits from virtualization in that only data needed for display is actually
passed from server to local host.

o All clients share update traffic from a single data set on the server.

° At times, the client performance can be impacted by one of or both of network and HP Web
Jetadmin 10.0 settings. HP Web Jetadmin 10.0 uses a very economic polling pattern when
gathering information from devices. When a Ul element is added that causes HP Web
Jetadmin 10.0 to retrieve information from devices, the result may be less than optimal.

e Running Multiple Clients: More than one HP Web Jetadmin client application can be run on a
single host. A number of client sessions communicating to different HP Web Jetadmin 10.0 server
applications at one time is possible. It is also possible to run multiple client sessions on a single
host that are connected to the same HP Web Jetadmin 10.0 server application.

e Smart Client File Cache: Smart Client cache is another name for the place where the client
application files are stored. Other .NET applications will also share this part of the user directory.

Characteristics of the Smart Client cache are:

° Files are stored in Documents and Settings\User Directory\Local Settings
\2pps\2.0.

° Installation and removal of these files and directories does not require administrative access
on the local machine.

o The Smart Client cache has a 200 MB limit imposed by the Microsoft .NET Framework.

o It contains client debug control file and trace log. These logs can be cleared manually with
the tool Mage.exe —cc Del *.* of Smart Client cache, and will reload during the next run.
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The HP Web Jetadmin 10.0 Server

° HP Web Jetadmin 10.0 and Distributed Environments

° Overview of Directories and Files

e SQL Database Overview

e Other Components and Services Details

° Ports

° Localization

° Client Support
° HP Web Jetadmin 10.0 Network Traffic and Behavior

HP Web Jetadmin 10.0 runs on a server host allowing remote access from HP Web Jetadmin host
clients. The following sections outline features and information about the HP Web Jetadmin 10.0 server
application.

HP Web Jetadmin 10.0 and Distributed Environments
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HP Web Jetadmin 10.0 is a scalable client/server designed to support distributed environments. HP Web
Jetadmin 10.0 can be installed on either a server or on a user’s desktop. It can be installed on multiple
servers and the user desktop can support multiple instances of the HP Web Jetadmin 10.0 client
application running at the same time.

The HP Web Jetadmin 10.0 server performs many background tasks such as discovery and
configuration of devices, firmware retrieval, application security, and more. HP Web Jetadmin 10.0 has
a robust client application that runs on Microsoft Windows desktops. The client application displays
device lists and groups and provides all the control interfaces needed to perform device management.
HP’s careful architecture of tasks that are performed by either the server or the client has given HP Web
Jetadmin 10.0 extraordinary performance improvements over earlier releases of the software.

Characteristics of the HP Web Jetadmin 10.0 server-based application are:
e Can run on remote server-host or locally on a client-host.
e  Supports multiple clients (up to 15 or more) accessing a single HP Web Jetadmin 10.0 server.

e  Supports multiple client sessions on a single desktop accessing separate HP Web Jetadmin 10.0
servers.

e Provides secure client application downloads through a Microsoft Smart Client connection that is
established via Internet Explorer.

e  Communication for both server and client applications is provided through Microsoft .NET
Remoting.

e Provides change event mechanism by the server to efficiently update application details at clients.

e Retrieves details by the server from http://www.hp.com facilitating updates to software, firmware,
and more.

e  Offers update service for obtaining application patches, plug-ins, and more from
http://www.hp.com.
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e Client updates happen automatically whenever newer server-based client components exist.
e Device credentials and user/roles details securely stored by the server.

e Provides HTML online help content to clients.

e Communicates to devices, both network and PC-Connected, from the server.

e Communicates from the server to other hosts (email, print queue, Active Directory, SNMP traps,
and more).

How it Works

Once HP Web Jetadmin 10.0 is installed, a variety of elements exist to support mainly the client,
application and device communication. HP Web Jetadmin 10.0 runs on the server as a service. It has
a simple http server that exists for the purpose of providing Smart Client application downloads (Smart
Client Deployment on page 16). The HTTP server also provides online user documentation.

The HP Web Jetadmin 10.0 service also takes care of all the details behind client-driven requests.
HP Web Jetadmin 10.0 communicates with devices in ways that are both user-driven and automated
as background activities. Some of these background activities include:

e slow polling: keeps network traffic to a minimum even when there are multiple client sessions
running.

e user-scheduled activities: includes discovery, firmware upgrades, and device configuration.

Br NOTE: All HP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin
install host. The client system being used to access HP Web Jetadmin may or may not be in the
same time zone as the HP Web Jetadmin install host. You should be aware of the time and possible
date differences when configuring HP Web Jetadmin 10.0 scheduling.

Backup and restore of all HP Web Jetadmin 10.0 settings can be accomplished by following procedures
outlined in the Installation and Setup chapter. All HP Web Jetadmin 10.0 user settings and data that are
not stored in the database exist in files stored in the directories Drive: \Documents and Settings
\NetworkService\Local Settings\Application Data\Hewlett-Packard
\HPWebJetadmin\.

Characteristics of the HP Web Jetadmin 10.0 service are:

e  Once the software is installed, the HP Web Jetadmin 10.0 service (HPWJAService) runs in the
background.

° Different communication interfaces exist:

o http

° https
° tftp

o snmp

o .NET Remoting
o .NET Listen
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0 TFTP send/receive
° SLP

The client application is first downloaded via a Smart Client connection that is launched through
Internet Explorer.

Client communication works over .NET remoting which provides both authentication and
encryption.

HP Web Jetadmin 10.0 communication to devices and other hosts can be both user driven or driven
by automated processes

.NET Framework 2.0

HP Web Jetadmin 10.0 is dependent on Microsoft’'s .NET Framework 2.0. HP Web Jetadmin 10.0, during
install time, will direct the user to Microsoft's .NET Framework 2.0 resources if they are not already
installed on the server host.

Overview of Directories and Files
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On the server file system, HP Web Jetadmin 10.0 resources can be found in the following places:

Drive:\Documents and Settings\NetworkService\Local Settings\Application
Data\Hewlett-Packard\HPWebJetadmin

Drive:\Program Files\Hewlett-Packard\Web Jetadmin 10

Drive:\Program Files\Microsoft SQL Server\MSSQL.1 (SQL Database instance for
HP Web Jetadmin 10.0).

Drive:\Documents and Settings\All Users\Start Menu\Programs\HP Web
Jetadmin 10 (contains URL for launching HP Web Jetadmin 10.0).

HP Web Jetadmin 10.0 services include:

HP Web Jetadmin 10.0 Core Service:

Drive:\Program Files\Hewlett-Packard\Web Jetadmin 10\bin
\HPWJAService.exe

Display name: HPWJAService

HP Web Jetadmin 10.0 Update Service:

C:\Program Files\Common Files\Hewlett-Packard\WJA Update Service
\HPWJAUpdateService.exe

Display name: HPWJAUpdateService

NOTE: HP Web Jetadmin 10.0 Update service provides Product Update on page 270 features
for managing client and server components.

MSSQLSHPWJA (must be started before HPWJAService):

c:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Binn\sglservr.exe-
sHPWJA

Display name: SQL. Server (HPWJA)
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Files and directories added to different directories include:

Table 3-1 HP Web Jetadmin 10.0 Files and Directories

Files and Directories Details

Program Files e  Core application components, DLLs, and more.
e HP Web Jetadmin 10.0 service executable.
e Files downloaded via Smart Client application install.
e  Universal Print Driver.
e  Certificates.
e EULAs (end user license agreements).

e  Other documents such as the release notes and online
user documentation.

Documents and Settings e All application settings (file based)
e  Trace control file for debug mode

e  Trace file when debug mode (server) is enabled

Backup and restore of all HP Web Jetadmin 10.0 settings can be accomplished by following procedures
outlined in the Installation and Setup Guide for HP Web Jetadmin 10.0 or in the Installation and Setup
chapter of the User Guide for HP Web Jetadmin 10.0. All HP Web Jetadmin 10.0 user settings and data
that are not stored in the database, exist in files stored in the Drive: \Documents and Settings
\NetworkService\Local Settings\Application Data\Hewlett-Packard
\HPWebJetadmin\ directory.

SQL Database Overview

HP Web Jetadmin 10.0 uses a local SQL database instance. This database instance, named “HP Web
Jetadmin 10.0: database engine” within SQL components, is where HP Web Jetadmin 10.0 stores and
manages all captured device data. HP Web Jetadmin 10.0 does not require that SQL Server Express
is installed prior to the HP Web Jetadmin 10.0 installation. HP Web Jetadmin 10.0 installs Microsoft SQL
Server 2005 Express Edition as part of initial application install when this version of MS SQL Server
does not exist. HP Web Jetadmin 10.0 is able to coexist with other versions of Microsoft SQL server if
they happen to be installed on the same host. During the HP Web Jetadmin 10.0 installation, OSQL
commands are executed which install the database components including HP Web Jetadmin 10.0
database instance and data structures. There are no user-specified attributes for any of the SQL
elements at install time.

e HP Web Jetadmin 10.0 installs and utilizes the Microsoft SQL Server 2005 Express Edition.
e The database instance is “HP Web Jetadmin 10.0: database engine”.

e HP Web Jetadmin 10.0 along with its database instance can coexist on the same host with other
versions and instances of SQL server.

e HP Web Jetadmin 10.0 contains the full Microsoft SQL Server 2005 Express Edition installation.

e During application install, OSQL commands are executed to install the database components
including HP Web Jetadmin 10.0 database instance and data structures.
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Microsoft SQL Server 2005 Express Edition

Microsoft makes available a free edition of SQL Server named SQL Server 2005 Express Edition. The
previous name for this free SQL server was MSDE (Microsoft Data Engine). These are both Microsoft’s
lightweight version of the for-fee products SQL Server and SQL Server 2005. They can be embedded
into other applications like HP Web Jetadmin 10.0 software. SQL Server Express requires .NET
framework, has a 4 GB database size limitation, and can exist on a host with any other MSDE or MS
SQL Server implementation.

HP Web Jetadmin 10.0 Database Instance

The database instance for HP Web Jetadmin 10.0 as it is installed on the host is named “HP Web
Jetadmin 10.0: database engine”. It is also a service that runs in the Windows Service Manager MMC
as “SQL server (HPWEBJETADMIN)” This service has a dependency on the HP Web Jetadmin 10.0
service which can also be observed in the Windows Service Manager MMC. The service “SQL server
(HPWEBJETADMIN)” cannot be stopped without first having the “HPWJAServices” service stopped.

Characteristics of the HP Web Jetadmin 10.0 database are:
e HP Web Jetadmin 10.0’s SQL database instance: “HP Web Jetadmin 10.0: database engine”.

e The service, “SQL server (HPWEBJETADMIN)” has a dependency on the HP Web Jetadmin 10.0
service: HPWJAServices.

e Removing the HP Web Jetadmin 10.0 SQL server instance by using Add/Remove Programs,
renders the HP Web Jetadmin 10.0 service effectively disabled.

HP Web Jetadmin 10.0 Data Managed within the Database

Data managed within the database instance used by HP Web Jetadmin 10.0 includes:

e  Application logs (Application Logging on page 34)

e User/Role Association (User Security on page 260)

e User preferences (Users on page 266)

° Role Permissions (Roles on page 263)

e Credentials (Credentials for Devices on page 84)

e Device Groups (Device Groups on page 85)

e  Tasks (throughout HP Web Jetadmin 10.0)
e Templates (throughout HP Web Jetadmin 10.0)

e Devices and supported device objects (Device Lists on page 67)

° Data collections (Data Collection on page 185)

Supporting the HP Web Jetadmin 10.0 Database
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The HP Web Jetadmin 10.0 database is fully managed by the HP Web Jetadmin 10.0 application. The
application should be the only entity connecting to the database. No user-accessible detail exists within
the database and the database should not be considered a source of raw content for other user-
processes. The database should be considered proprietary.
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External Database Support

HP Web Jetadmin 10.0 supports the local instance data base for SQL Server Express. This database
instance is created by the HP Web Jetadmin 10.0 install executable when the application is installed.
Connecting HP Web Jetadmin 10.0 to an external database is not supported and no features exist within
HP Web Jetadmin 10.0 that facilitate this connection. HP will review external databases at a future time
and could possibly implement a feature/solution for this functionality.

Other Components and Services Details

° Low privileged service account

° HTTP Service

Following are other components and services information.

Low privileged service account

HP Web Jetadmin 10.0 running as a service runs authorized under the NT AUTHORITY
\NetworkService account. This is a built-in, low-privilege account.

HTTP Service

HP Web Jetadmin 10.0 contains a small and embedded http/https service. This service exists for three
reasons:

e Smart Client application delivery (initial client access).

e Help content delivery (during client session).

e Device application file hosting (devices get jar file when directed by Device Management features).
A few key points about this http service include:

e The integrated http service is simple and only exists for the purpose of distributing files.

e This service contains no script execution interpreters or cgi-bin capability.

e The service does not allow file navigation.

e The service does not execute read/write calls to HP Web Jetadmin 10.0’s database.

e The http/https server is integrated into the HP Web Jetadmin 10.0 service which runs as a low-
privilege account on the local host.

e http service does not run in kernel mode.

HTTPS

The http service can be configured to run default https and uses certificates which are obtained through
a local certificate-authority. When https is enabled, it enforces authentication between the users IE
browser and the local http service. This provides tighter security for initial HP Web Jetadmin 10.0 client
launch than is provided by http. Some environments may require that all http servers enforce and run
default https.
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Characteristics of the http service are:

e  https can be enabled as part of a post install procedure with HP Web Jetadmin 10.0 security
settings.

e htips requires that the user obtain a certificate from a certificate-authority.

e https can only be enabled through a client running on the local system hosting HP Web Jetadmin
10.0 software.

HTTP and HTTPS Ports Adjustments

Ports
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Some customers may require a different port number on the HTTP server thatis embedded into HP Web
Jetadmin 10.0. The default port numbers are 8000 for HTTP and 8443 for HTTPS. Port numbering is
changed through a configuration file found on the HP Web Jetadmin 10.0 directory:

DRIVE:\Documents and Settings\NetworkService\Local Settings\Application
Data\Hewlett-Packard\HPWebJetadmin\config
\HP.Imaging.Wjp.Core.WebServer.config.xml

Either of the entries for HttpsPort or HttpPort can be altered. Changing these ports requires restarting
HP Web Jetadmin 10.0.

NOTE: Open Start > Programs > HP Web Jetadmin 10.0 and then alter the program link by right-
clicking it and then choosing Properties. The port number within the link variable must be changed to
match the new port number being used.

HP Web Jetadmin 10.0 listens on several ports continuously and opens other ports for specific
functionality. Below are the ports used by the system hosting HP Web Jetadmin 10.0:

Table 3-2 Server Required Ports

Port Number Type /10 Details

0 UDP 1/0 TFTP send/receive request
handling

0 UDP o SNMP

0 TCP (6] WMI Communication

0 TCP (0] Firmware upgrade

69 UDP | TFTP incoming port

427 UDP | SLP Listen

3702 UDP | WS Discovery Listen”

4088 TCP 110 Client Remoting

8000 UbDP | Web Jetadmin Discovery
Listen”

8000 TCP | WebServer (http)

8443 TCP | WebServer (https)

27892 UDP | Traps Listener

for the discovery of other HP Web Jetadmin servers
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Below are the ports used by clients to receive:

Table 3-3 Client Receive Ports

Port Number Type /10 Details

161 UDP | SNMP

445 UDP | WMI Communication

9100 TCP | Firmware
Localization

HP Web Jetadmin 10.0 will be released in 19 localized languages later in 2007. At that time you will
have the option of installing one base language. You can update the server to any of the other 19
languages but only by using the Product Update on page 270 feature. Client locale settings will
determine if HP Web Jetadmin 10.0 displays in a localized language (providing a language update is
available on the server) or the client will display in English (when language support is lacking on the
server).

Client Support

Smart Client is a Microsoft .NET term that describes a clients initial request for a .NET application (Smart
Client Deployment on page 16).

HP Web Jetadmin 10.0 Network Traffic and Behavior

HP Web Jetadmin 10.0’s server application performs a number of actions including:

Client Event Notification: When users are logged into the application, a separate client application
is running on the local desktop host. HP Web Jetadmin 10.0 server uses a TCP connection to notify
the client application when changes exist. This notification drives the client application to connect
to the server .NET Remoting channel and order updated information. Notification happens only
when:

° changes in data exist for client retrieval.

° the server has not heard any communication from the client over a predetermined period of
time.

Supplies Alerts Polling: When devices exist in supplies groups, supplies Alerts are enabled
(Alerts on page 148). The Alerts features drive both user alerts (via email or a log) and other
supplies-related reports. All of the alerts are based on user-selected threshold values. When a
device exists with a supply level value that is not very close to the specified supply threshold,

HP Web Jetadmin 10.0 polls that device more slowly, taking up less network bandwidth. When a
device exists with a supply value that is very close to the specified supply threshold, HP Web
Jetadmin 10.0 polls that device more often. This smart-polling mechanism ensures that the supply
level alert is delivered in a timely manor while limiting the polling that is done on the network.
Supplies Alerts polling is integrated with other kinds of polling within the HP Web Jetadmin 10.0
system which means that polling is only performed when stale information is detected.

Slow Polling: HP Web Jetadmin 10.0 uses a slow-polling mechanism that queries for device
information. This mechanism is user configurable; the faster it is set for will put a larger load on the
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network (see documentation on application settings and/or the training module on application
maintenance). This slow-polling mechanism is used for a variety of tasks listed here:

o Users are viewing lists and one or more information attributes displayed has become stale.

° Automatic Device Groups exist (Device Groups on page 85).

° Supplies Device Groups exist (Supplies on page 212).

Background Tasks: Many features in HP Web Jetadmin 10.0 can be launched automatically or
manually by a user logged into a client application session. In either case, these can become tasks
and can be run without a user being logged into a client application session. These are called
background tasks and are managed centrally by HP Web Jetadmin 10.0 software. In fact, these
can be displayed and reviewed by the user at any time through a task manager interface. The
Active Tasks task module is one way users can view running tasks.
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The HP Web Jetadmin 10.0 Client

Host Requirements

ClickOnce Software Installation and Launch

Users gain access to HP Web Jetadmin 10.0 through a local .NET client application. The application
runs on any supported client desktop. The first time the HP Web Jetadmin 10.0 server is accessed by
a client, client application files are installed and launches a Windows client session. This client session
communicates with the HP Web Jetadmin 10.0 application as it runs on the server. Client application
files are left in the users’ Local Settings directory and are updated on the fly as needed. The server and
client applications can be run on the same or different hosts.

Host Requirements

The following are required by the HP Web Jetadmin 10.0 host:

Operating systems supported for running client application

o WinXP Professional

o Windows Server 2003

° Vista Business Edition and Enterprise Edition

o Windows 2000 Professional SP4

NET Framework 2.0

o Install requires Administrator rights

° Smart Client provides direction to Microsoft's .NET 2.0 Installer
° Non-IE browsers will not detect the absence of .NET 2.0 Framework
Other requirements

- 200 MB

° Network

o User logged in to local host, or user with local administrator rights when using “Run
As” (Internet Explorer)

ClickOnce Software Installation and Launch

The following sequence occurs when you start the Smart Client installation and launch:

1.
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Client using Internet Explorer browses http service (URL: http://server:8000)

e  Server detects .NET on browser client (Page linked to dotnetfx.exe download at
Microsoft.com).

° Browser is redirected to HP Web Jetadmin 10.0.

Introduction to HP Web Jetadmin 10.0
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e  Browser passes .application to .NET Framework (dfshim).
e .NET Framework verifies signature, reads the xml and performs a Smart Client launch.
2.  Smart Client is launched.
e  For the first run, an Application Run dialog box is displayed to client.
e 2.0 MB files are downloaded via the http service.
e UlExec.exe is launched on client host.
3. .NET remoting begins (port 4088).
e  For the first run, 50 MB files downloaded.
e The HP logo page is visible.
e The client files are updated if a newer version is detected.
4. HP Web Jetadmin 10.0 Client application is started.
e The client begins detecting events, executing calls, and more.
e Help content traverses the http service.

e  All other client communication is via .NET remoting.

.NET Need Notification

The HP Web Jetadmin 10.0 server will detect a host that does not have .NET 2.0 Framework installed.
When it detects this, a message id displays asking you to install the .NET Framework or start HP Web
Jetadmin 10.0.

Users are able to install the .NET Framework with the admin privileges. The Start HP Web Jetadmin
link is used to launch the client once .NET Framework is in place.
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4 Device Management

e  All About Device Management

° Device Lists
° Device Groups
° Discovery

e  Configuration
e Alerts

° Firmware

° Reports
e  Supplies
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All About Device Management

° Device Management Task Modules

e Device Management Options

° Device Tabs on Device List Pages

The Device Management view provides many features that help you configure and manage devices
on your network. The Overview page can provide you access to all of these features through the various
task modules (Device Management Task Modules on page 51).

Device Management Task Modules

The following task modules can be displayed or hidden in the Overview section of Device
Management and also in the corresponding functional area within HP Web Jetadmin 10.0 by right-
clicking within the page and selecting the specific task module.

Bf NOTE: Any task module within HP Web Jetadmin 10.0 can be displayed throughout HP Web Jetadmin

ENWW

10.0 by docking it (Docking Task Modules on page 37).

Table 4-1 Device Management Task Modules

Device Lists on page 67

° Device Lists - Current Tasks and Common Tasks Task Modules on page 79

° Device Lists - Summary Task Module on page 79

Device Groups on page 85

° Device Groups - Current Tasks and Common Tasks Task Modules on page 88

° Device Groups - Summary Task Module on page 88

° Device Groups - Management Task Module on page 88

Discovery on page 99

° Discovery - Current Tasks and Common Tasks Task Modules on page 117

° Discovery - Summary Task Module on page 118

° Discovery - Active Discoveries Task Module on page 118

° Discovery - Scheduled Discoveries Task Module on page 118

° Discovery - Templates Task Module on page 118

° Discovery - Quick Monitor Task Module on page 119

Configuration on page 130

° Configuration - Common Tasks Task Module on page 133

e  Configuration - Recent Configurations Task Module on page 133

e  Configuration - Active Configurations Task Module on page 133

e  Configuration - Scheduled Configurations Task Module on page 134

e  Configuration - Templates Task Module on page 134

Alerts on page 148
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Table 4-1 Device Management Task Modules (continued)

Alerts - Current Tasks and Alerts - Common Tasks Task Modules on page 150

Alerts - Recent Alerts Task Module on page 151

Alerts - Alert Subscriptions Task Module on page 151

Alerts - Subscription Templates Task Module on page 151

Firmware on page 164

Firmware - Current Tasks and Common Tasks Task Modules on page 166

Firmware - Active Tasks Task Module on page 166

Firmware - Scheduled Tasks Task Module on page 166

Reports on page 173

Reports - Current Tasks and Report Management - Common Tasks Task Modules on page 177

Reports - Report Templates Task Module on page 178

Reports - Archived Reports Task Module on page 178

Reports - Data Collection - Management Task Module on page 178

Reports - Data Collection - Templates Task Module on page 179

Reports - Scheduled Reports Task Module on page 179

Supplies on page 212

Supplies - Current Tasks and Supplies - Common Tasks Task Modules on page 213

Supplies - Group Summary Task Module on page 213

Supplies - Group Tools Task Module on page 213

Device Management Options

The following options can be set in Device Management:

Table 4-2 Device Management Options

Functional Area Available Options

Discovery e  General on page 120

e Blocked Devices on page 81

Device Lists ° Hidden Devices on page 79

Status e Single Device View on page 56

° Multiple Device View on page 56

Device Filters e New (Time Period) Filter on page 82
Configuration e  General Configuration Settings on page 134
Reports e  General on page 180

° Data Retention on page 180
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Table 4-2 Device Management Options (continued)

Functional Area Available Options
Supplies e  General on page 214
Alerts e  General on page 151

° Template Settings on page 152

Device Tabs on Device List Pages

When you select a device list, a group, or a filtered list, the lower portion of the page displays device
tabs that provide additional functionality that can be performed on the devices selected in the displayed

list:

Status Tab on page 54: shows the status of the selected device or devices depending on list
selection.

Config Tab on page 57: allows device configuration for one or more devices, depending on the
current selection in the device list.

Alerts Tab on page 58: shows alert subscription and template tools for a single device or multiple
devices, depending on list selection.

Groups Tab on page 59: lists devices that have been selected in the list and their groups (if any).
Also allows easy access to add devices to an existing or new group.

Reports Tab on page 60: allows easy access to report functionality for the selected device or
devices.

Supplies Tab on page 61: displays supplies information for the selected device or devices. Links
are also provided for you to shop online for supplies.

Storage Tab on page 62: controls secure disk erase and disk initialize operations on either single
device or multiple devices, based on the list selection.

Applications Tab on page 63: lists, adds, and removes device based application files.

Detailed Information Tab on page 64: provides information on many device attributes related to
diagnostics and troubleshooting device issues.

Capabilities Tab on page 64: provides information about device features and capabilities.

Troubleshoot Tab on page 64: provides information to allow you to troubleshoot one or more
devices.

Firmware Tab on page 65: updating is performed on either a single device or multiple devices
depending on list selection (printer and HP Jetdirect firmware updating is available).

Showing and Hiding Device Tabs

ENWW

The device tabs are displayed in the lower portion of any device list page to provide you with more
detailed information about the devices. The device tabs are enabled by default but can be disabled at
any time. The advantage of displaying the device tabs is to enable quick access to all device data by
simply selecting the device in the device list and then clicking on the desired tab.
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To hide the device tabs, use the Hide Device Tabs tool (the up/down arrow button on the toolbar on
any device list page). This offers more room to display the device list itself. Hiding device tabs can also
reduce network traffic and improve performance while working with large lists of devices.

Status Tab
° Parts of the Status Tab Page

° Related Application Options for the Status Tab

Device status can appear for a single device or multiple devices depending on list selection. Device
status polling rates can be altered for both multiple and single status modes. The number of devices
that can concurrently display status through Status tab is limited to ten by default but can be increased
or decreased (Multiple Device View on page 56). These settings can be accessed in Tools >
Options > Device Management > Status.

The Status tab shows real-time status messages and graphics that indicate device issues for the
selected device or devices. While the status tab is being shown, the device status is updated regularly.
Use the Status tab to quickly assess the current status of one or more devices.

The polling rate of the devices is set in Tools > Options > Device Management > Status > Single
Device View (Single Device View on page 56).

The Status tab has three possible views:

e Single device view (most common): When a single device is selected, the single device view is
shown. The toolbar on the Status tab links to the embedded web server for the selected device (if
the device supports this feature). Device identification information such as device model, host
name, IP address, and system contact information is also displayed (as requested through the top
menu bar on View > Preferences > Device identification). Current supply levels, including the
name of the consumable and a percentage level are shown. Additional information on all supplies
is available on the device’s Supplies tab at the bottom of any device list.

e Multiple device view: When between 2 and 10 devices are selected, the multiple tiled view is
shown. Device identification information such as device model, host name, and IP address is also
displayed. Current supplies levels are shown. Additional information on all supplies is available on
the device Supplies tab.

The number of devices shown is determined by the configuration setting in Tools > Options >
Device Management > Status > Multi Device View (Multiple Device View on page 56). If the
number is set to 5, and you have selected more than 5 devices, status for the first 5 devices is
shown.

e Composite device view: When more than 10 devices are selected, the composite view is shown.
The number of selected devices is shown along with how many are in an OK, Error or Caution
state on the device Status tab at the bottom of any device list.
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Parts of the Status Tab Page

Options on the Status tab page include:

For single device view:

o

Embedded Web Server (only enabled in Single device view): brings up a web browser that
takes you to the device’s embedded web server, if the device has one.

Configure Page: shows the Config tab; you can change or add configuration information for
devices.

Online or Offline (only enabled in Single device view): shows whether the selected device is
online or offline. You can actually change the status for the device remotely using this option.

For multiple device view (2-10 devices):

o

Configure Page: shows the Config tab; you can change or add configuration information for
devices.

For composite device view (over 10 devices):

o

Configure Page: shows the Config tab; you can change or add configuration information for
devices.

Parts of the Status tab page include:

Single device view (one selected device):

o

o

Status: shows the status of the selected device.

Information: shows device identification information as requested through the top menu bar
on View > Preferences > Device Identification.

Front Panel Messages: shows the front panel message currently displayed on the selected
device.

Supply levels: shows the ink levels remaining for the selected device.

Multiple device view (2-10 selected devices):

o

o

Status: shows the status of the selected devices.

Information: shows device identification information as requested through the top menu bar
on View > Preferences > Device Identification.

Front Panel Messages: shows the front panel message currently displayed on the selected
devices.

Supply levels: shows the ink levels remaining for the selected devices.

Composite device view (10 or more selected devices):

o

Status summary: The number of selected devices is shown along with how many are in
an OK, Error or Caution state.

Related Application Options for the Status Tab
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Single Device View

Multiple Device View
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Single Device View

Settings here dictate how the status for a device is displayed when you click the Status tab in the lower
portion of any device list. For information about how multiple devices are displayed when you click
Status, see Multiple Device View on page 56.

Follow these steps:

1. On the top menu bar, access Tools > Options and expand Device Management.
Expand Status and then select Single Device View.

2. Configure the desired settings:

e Polling interval: select the period of time in seconds in which HP Web Jetadmin 10.0 can
send device requests onto the network.

e Time between polling intervals: select an inactive period (time in seconds) where the
application does not send device queries.

e Maximum devices to poll at one time: select the number of devices that can be queried
concurrently. HP Web Jetadmin 10.0 will place X device queries onto the network in a poll
burst and wait for responses. HP Web Jetadmin 10.0 will continue to place X device queries
onto the network each time a burst of queries is satisfied with response packets. It will continue
to do this until the Polling interval time is expired and then will wait until the number of
Maximum devices to poll at one time is satisfied before sending any new device queries.

B NOTE: Toresetall values to defaults, check the Reset to Default Values box. For default values,
see Default Settings on page 18.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Multiple Device View

Settings here dictate how the statuses for devices are displayed when you click the Status tab in the
lower portion of any Device list. For information about how a single device is displayed when you
click Status, see Single Device View on page 56

Follow these steps:

1. On the top menu bar, access Tools > Options and expand Device Management.
Expand Status and then select Multi Device View.

2. Configure the desired settings:

e Maximum number of devices to show: enter the maximum number of devices to display in
the lower portion of any Device list, if multiple devices are selected in the Device list. For
example, if 20 devices are selected on a Device list and you enter 10 as the maximum number
to show, the status for the first 10 is displayed.

e Polling interval: select the period of time in seconds in which HP Web Jetadmin 10.0 can
send device requests onto the network.
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e Time between polling intervals: select an inactive period (time in seconds) where the
application does not send device queries.

e Maximum devices to poll at one time: select the number of devices that can be queried
concurrently. HP Web Jetadmin 10.0 will place X device queries onto the network in a poll
burst and wait for responses. HP Web Jetadmin 10.0 will continue to place X device queries
onto the network each time a burst of queries is satisfied with response packets. It will continue
to do this until the Polling interval time is expired and then will wait until the number of
Maximum devices to poll at one time is satisfied before sending any new device queries.

Bf NOTE: To reset all values to defaults, check the Reset to Default Values box. For default
values, see Default Settings on page 18.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Config Tab

° Parts of the Config Tab Page

The Config tab allows device configuration for the selected device or devices. A list of configuration
items is displayed and is based on the configuration items supported for the devices selected. You can
change one or more configuration items and apply the settings to the device or devices selected.

If a single device is selected, the configuration items in the tab are shown with the current device settings.
If multiple devices are selected, configuration items in the tab are shown with unspecified or blank
settings. The list of configurable options varies by the devices selected. With multiple devices selected,
all configurable items will probably not apply to all devices. Only settings that apply to a device will be
set on that device. Some options may be repeated multiple times because different settings are
supported on different devices. If it is not clear which device or device model a particular setting applies
to, holding the mouse over the name in the configuration settings displays a tooltip with additional
information.

Parts of the Config Tab Page
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Features on the Config tab page include:

e Customize: create or view your personalized list of favorite configuration settings in the My
settings category; this provides fast access.

e Apply Template: select a previously created configuration template to apply to the currently
selected devices.

e View History: displays a list of recent configurations that have occurred on one or more of the
selected devices (View Configuration History on page 138).

Options on the Config tab page include:

e Settings category tree: configuration items are organized into categories to make them easier to
find. Within each category, items are sorted alphabetically. My Settings is a special category that
can be defined according to each user’s preference.

e Configuration settings: make changes to device configuration settings in this section. Each item
you change should show a check mark automatically, indicating that it will be included in this
configuration. You can manually uncheck items to reset their values and exclude them from the
configuration. Any changes made to these settings will not take effect until they are applied and
confirmed.
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e Refresh: gets the current settings from a single device, or the unspecified settings for multiple
devices. Any pending changes which have not been applied will be lost.

e Save as Template: used to capture the selected configuration into an HP Web Jetadmin 10.0
configuration template. This can be done for a variety of reasons:

0 A backup of the device configuration is needed to manage maintenance and risk.

° A device configuration is deemed as “release accepted” and a template is needed to configure
other devices with like-settings.

Schedule: schedule this configuration for later (Schedule a Device Configuration on page 139).

Apply: apply all of the settings to the device or devices now.

The configuration template only captures configuration options that are selected.

Alerts Tab

° Parts of the Alerts Tab Page

The Alerts tab allows easy access to alerts settings for a particular device or set of devices. Device
alerts provide the ability for the device to proactively notify you when a problem occurs with the device.

You can set alerts using the Alerts tab or by selecting Alerts from the menu at the left. Using the
Alerts tab can be faster since you have already selected the device or devices.

The Alerts tab has two possible views:

e Single device view: the current set of subscribed alerts is displayed. You can subscribe to alerts,
change alert subscriptions, or remove alert subscriptions.

e Multiple device view: a summary view of how many devices have alerts subscriptions and how
many do not. The same quick access to alerts subscriptions, change alert subscriptions, or remove
alert subscriptions is provided.

Parts of the Alerts Tab Page
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Options on the Alerts tab page include:
e Group By: the different ways you can choose to group alerts:

° Device: displays devices that can be individually expanded to show each applied subscription
and corresponding Alerts detail.

° Subscription: displays subscriptions by name that can be individually expanded to show
devices to which the subscription has been applied.

° Solution Type: displays one or any of the three types of Alerts that have been configured.
These can be expanded to show individual subscriptions and devices to which the subscription
has been applied.

e + (Expand All): view detail.
e - (Collapse All): view summary information only and no detail.

e Subscribe: create an alert subscription.
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e Apply Subscription Template: use alert subscription settings to apply to additional devices.
The Alert History option allows you to view the alerts history for the selected set of devices.

e Alert History: view alerts history; can group by device or by alert.
Parts of the Alerts tab page include:

e Device Model

e [P Hostname

e [P Address

e Advanced Settings

Bf NOTE: There are two threshold settings that can be set through Advanced Settings; Count
threshold and Percent threshold. When Count threshold is enabled, the Alert will trigger as the
increasing device counter matches the value (number) applied here. This is only visible when Page
Count Alerting is enabled.

Percent threshold supplies a common threshold value (percentage) that can apply to threshold
Alerts. This is a decreasing percentage and is set on an integer value. This is a percentage based
on decreasing supplies. This setting is only applicable to supplies that are depleting or depleted
and need replacing.

e Notification Type
e  Subscription Type
e Linked to Template

This page displayed is identical to the page displayed when you select Alerts - All Subscriptions in
the left navigation pane (All Subscriptions on page 162).

Features on the Alerts tab page include:

e Save As Template: save the current settings as an alerts template (Create a Subscription
Template on page 157).

e Unsubscribe: remove devices from this alerts template (Edit an Alert Subscription Template
on page 160).

e Edit Subscription: make changes to an alerts subscription (Edit an Alert Subscription Template
on page 160).

Groups Tab
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° Parts of the Groups Tab Page

This tab reflects the group or groups to which a device has membership, when a single device is
selected. The tab re-displays all selected devices from any device list showing all columns specified
in View > Preferences > Device ldentification, and the Groups column when multiple devices are
selected.

These devices will be added to any group created from the Groups tab, Add devices to group, or Add
devices to new group. In the single device mode, Remove From Group can be used to remove the
selected device from any manual group.
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Parts of the Groups Tab Page
Parts on the Groups tab page include:
e Add devices to group: easily add devices to an existing group.
e Add devices to new group: conveniently create a group and immediately add devices to it.
Columns on the Groups tab page include:
e Group: lists the name of the group for the selected devices.

e Description: shows the description of the corresponding group as entered while creating a group
with the Create new device group wizard or while editing a group with the Edit device group
wizard.

e Contact: shows contact information of the corresponding group as entered while creating a group
with the Create new device group wizard or while editing a group with the Edit device group
wizard.

Features on this page include:

e Remove From Group: remove a device from the selected group (Remove Devices from a Manual
Group on page 93).

e View: view the devices in the selected group (View a Device Group on page 98).

Bf NOTE: You must select a group before clicking View. If you are in a group and click View in
the Groups tab, you must have a row selected with a group other than the one you are in.

Reports Tab
e Parts of the Reports Tab Page

The Reports tab allows easy access to report functionality for a device or set of devices.
The two main areas of this feature allow you to access the two main reporting tasks:

e Data Collection: must be enabled for devices to ensure the raw data is present to generate reports.
Turning on data collection (by checking the check box and clicking Apply) enables this process.
The Job Data collection option enables the Jobs by user: color/mono report. The Device Data
collection enables the Device pages: color/mono report.

e Report Generation: select the type of report to generate.

Parts of the Reports Tab Page
Parts on the Reports tab page include:
e Group By: the different ways you can choose to group data:

° Device: orders the tab-list by each device displayed in the list selection. Expanding the list
shows each device and its collection state for each data collection type.

o Data Collection: orders the tab-list by data collection type and shows devices beneath each.
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0 Enabled: shows two groups of devices. One is Enabled which are devices that have by-user
data collection enabled. The other one is Disabled, which are devices that do not have by-
user data collection enabled.

o None: shows a tab-list of all devices selected with their data collection states appearing within
columns.

+ (Expand All) or - (Collapse All): show all details or show only summary information.

Add devices to data collection: add devices to a data collection that have been defined (Add
Devices to Data Collection on page 188).

Apply data collection template: apply a data collection template (Apply a Data Collection
Template on page 190).

Generate report: produce a report after data collection has completed (Generate a Report
on page 197).

Schedule report: schedule this report to be generated at a specific time (Schedule a Report
on page 201).

Supplies Tab

Parts of the Supplies Tab Page

The Supplies tab page provides a quick way to let you review supplies information on a device or set
of devices. The devices selected to view supplies information do not have to be tracked for supplies
usage.

Parts of the Supplies Tab Page
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Options on the Supplies tab page include:

Group By: controls how the supplies information is presented: by device, urgency, HP part number,
or none.

o Device: shows devices in a collapsed state. Expanding one or more devices reveals supply
detail.

o Urgency: groups the devices by Out, Warning and OK supply status categories. Expanding
these reveals device and supply detail.

° Part number: groups the devices by collapsed supply part number categories. Expanding
these reveals device and supply detail.

° None: reveals supply detail in an expanded device list.

View: choose between two views of the supplies data: the default view or the details view, which
includes serial number of the supply, install date, and last used date.

+ (Expand All): view detail.
- (Collapse All): view summary information only and no detail.

Shop for supplies online: easy access to HP SureSupply to shop for all supplies or just needed
supplies (the default). After this selection is made, you are connected to the HP SureSupply web
site with either needed or all supplies categories pre-selected to order. You are notified that
information will be transferred to the HP SureSupply web site and can approve or disapprove of
the information being sent to that web site.
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e Show all and Show only needed: turn on or off supplies tracking. When a device is tracked for
supplies, the device is automatically included in the supplies needed list when supplies are needed.
Turning tracking off on the device causes the product to never include the device in the supplies
needed list.

Bf NOTE: The Show only needed state is dictated by the setting in Tools > Options > Device
Management > Supplies (General on page 214).

e Print shopping list (icon): prepares a printout of the device list as it is currently displayed.

Storage Tab

° Parts of the Storage Tab Page

° Device File System Password

° Fonts, Macros, and Stored Jobs

Storage management functionality is used to manage objects on device storage facilities such as disk
or flash devices. Currently, Storage Management features can control three storage related items on
devices. This functionality can be viewed from any device list with one or more devices selected and
then choosing the Storage tab.

All selected devices are displayed in the Storage tab list with Media Type, Description, and
Capacity defined. Used space and Read/Write accessibility are displayed for each device in the list. In
addition, grouping controls exist for multiple devices enabling a variety of storage analysis and storage
configuration access.

Parts of the Storage Tab Page
You can display device information on the Storage tab page:

e Group By: devices displayed on the Storage tab page can be grouped as follows:

Bf NOTE: Switching between Group By options does not uncheck the storage facility checkboxes.

o Group By Device: lists one device per line. Individual lines can be expanded to view and
select the different Media Types that reside on the device. Once Media Types are selected
by using the corresponding checkbox, devices can be selected setting up storage facilities
for Storage configuration actions.

° Group By Media Type: lists the devices under three media types, including Hard Disk, No
Media, and Other. Devices grouped in No Media have no storage facilities on which
Storage features can function. Devices that exist in the other two Media types can be selected
using the corresponding checkbox and then the media type can be selected setting up storage
facilities for Storage configuration actions.

o Group By None: lists device storage facilities one per line. Selecting the corresponding check
box sets up the specific storage facility for Storage configuration actions.

e + (Expand All): view detail.
e - (Collapse All): view summary information only and no detail.

Features on the Storage tab page include:
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NOTE: Once storage facilities are checked, storage configuration controls become selectable and can
be used to activate storage features on the device. All storage features are device-based; HP Web
Jetadmin 10.0 is only a configuration agent.

e Write Protection: enables or disables write functionality on the selected storage facility. This
makes a device read-only or read-write capable.

e Initialize File System: causes the device user-directory structure to initialize. The file system will
vary depending on device or storage type; please see device-specific documentation. An option to
enable write-protect can be set to leave the device in read-only mode once the file system has
initialized. This feature can be scheduled as a one-time or recurring operation.

e Secure Storage Erase: starts the devices secure storage erase action. One of three secure modes
can be set for the storage erase action. These modes are Non-secure fast erase, Secure fast
erase, and Secure sanitizing erase. The extent of security in the secure erase feature on the
device will depend on device model and firmware. See device documentation regarding Secure
Storage erase features for more details. An option to enable write-protect can be set to leave the
device in read-only mode once secure storage erase has completed. This feature can be scheduled
as a one time or recurring operation.

Device File System Password

If a file system password exists on the device and if it is not captured in HP Web Jetadmin 10.0’s
Credential Store, you will be prompted for the password when attempting to perform any configuration
action. Device file system passwords can be configured on the devices from HP Web Jetadmin 10.0.
When these are configured, they are also placed into the Credential Store. Global file system
credentials can be added to HP Web Jetadmin 10.0 through Tools > Options > Application
Management > Credentials > File System (File System Password on page 258). These are used
when no password exists in the store and one is required by the device.

Fonts, Macros, and Stored Jobs

Earlier releases of HP Web Jetadmin along with the Device Storage Manager plug-in had features to
manage fonts, macros and jobs stored on devices. At this time, HP Web Jetadmin 10.0 does not have
features for managing fonts, macros and jobs stored on devices. A newer release of HP Web Jetadmin
10.0 will someday support this functionality. When necessary, you should continue to use the latest
version of HP Web Jetadmin 8.x and Device Storage Manager plug-in for managing fonts, macros, and
stored jobs.

Applications Tab

B
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Device applications can be downloaded and executed onto devices to facilitate an embedded runtime
environment. These applications support a variety of operations and run much like programs and
services on PCs. Applications can be developed to provide additional functionality such as address
books, digital send features, and more. One key application is the Manager application that must be
loaded onto the device before HP Web Jetadmin 10.0 can view and modify applications.

One or more devices selected from any list will appear under the Applications tab. Each device will
appear with any resident applications. Again, the Manager application must be loaded onto the device
before HP Web Jetadmin will list resident applications. Some device models have the Manager
application embedded into firmware making it resident.

NOTE: Some HP Web Jetadmin 10.0 configuration options require device applications. These include
all configuration options for either EWS or digital send functionality. When this type of configuration is
either viewed or changed via HP Web Jetadmin 10.0 software, device applications are automatically
installed.
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Features on the Applications tab page include:

e Install Manager: For devices that do not already have the Manager application installed or do not
have a firmware embedded Manager application, the Install Manager function must be used.
Devices that do not have the Manager installed will appear in the Applications list with the
indication (Manager not installed). To install the Manager, select the device or devices from the
Applications list and choose Install Manager.

e Install Applications: Once the Manager application is installed on the device, other resident
applications are listed. New device applications can be removed or added at this time. Install
Applications is used to push device applications onto the device.

e Application Repository: Device applications that are available on the HP Web Jetadmin 10.0 host
system can be viewed by using Application Repository. When launched, this interface lists all
applications that are ready to be installed on devices. You can also use the following to manage
the applications:

° Upload: upload application files from the client host onto the HP Web Jetadmin 10.0 host.
° Delete: remove applications from the HP Web Jetadmin 10.0 host.

e Credentials: Device credentials can be used to protect against unauthorized downloading and
manipulation of device resident applications. The EWS password is used for this purpose and is
managed within the HP Web Jetadmin 10.0 Credential Store. This device credential can also be
set on one or many devices through HP Web Jetadmin 10.0 Configuration on page 130.

Detailed Information Tab

The Detailed Info tab page shows many points of device information that are typically of interest to
people in charge of device uptime. You can refresh this information by clicking Refresh.

Capabilities Tab

The Capabilities tab page shows a list of capabilities information for either a single device or multiple
devices, depending on the devices selected in the device list. Device capabilities are displayed in two
columns: capabilities name and capabilities value. An alphabetic sort can be done on the capabilities
name.

Troubleshoot Tab
° Parts of the Troubleshoot Tab Page

The Troubleshoot tab page provides several features that can be used to remotely control devices and
analyze other areas for troubleshooting purposes. The features available change depending on the
device or devices selected in the device list.

Parts of the Troubleshoot Tab Page
Options on the Troubleshoot tab page include:

e Embedded Web Server: available only when a single device is selected in the device list; launches
the selected device’s resident http interface.

e Online/Offline: available only when a single device is selected in the device list; remotely toggles
the selected device between online and offline.
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e HP Support: available only when a single device is selected in the device list; launches the product
page content from http://www.hp.com for the selected device. HP Instant Support pages are
launched when the device supports this type of http://www.hp.com content.

e Reset Device: available only when a single device is selected in the device list; launches controls
to remotely reset the device or to remotely restore the device to factory defaults.

e Print Test Page: available for both single and multiple device selections on the device list; can
launch a local device configuration page or send a file from the client to host to the device’s 9100
print port.

The file must be in a file format that the printer natively knows how to print; this varies by printer.
For example, most printers can accept simple .txt files and pjl formatted files. Some printers can
natively print pdf files, and so forth.

Parts of the Troubleshoot tab page include:
e Detailed status: available for both single and multiple device selections on the device list.

Single device selections: HP Web Jetadmin 10.0 reflects all status messages for the selected
device. This is different from a single device status view where only the most severe message is
displayed.

Multiple device selection: HP Web Jetadmin 10.0 reflects status counters for selected devices in
the device list.

e Troubleshooting tools: provide historical information for single or multiple device selection and
include:

o Recent Alerts: shows all recent alerts for the device selected.
° Recent Configurations: shows the recent configuration for the device selected.

° Firmware Updates: shows all available firmware updates for the selected device.

Firmware Tab

° Parts of the Firmware Tab Page

The Firmware tab page can be activated on any device list. Both single and multiple devices can be
displayed within this tab and can be sorted by Device or Firmware Type.

Parts of the Firmware Tab Page
Options on the Firmware tab page include:
e Group By: devices displayed on the Firmware tab page can be grouped as follows:
° By Device: lists one device per line. Individual lines can be expanded to view.
o By Firmware Type: lists the devices sorted by firmware type.

o By None: lists all selected devices and corresponding data, uncategorized. When this option
is used with any other option, it categorizes the data under device. To see the data, select +
next to the device.

e + (Expand All): view detail.

e - (Collapse All): view summary information only and no detail.
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From any of these lists Upgrade device, Upgrade Jetdirect, or Schedule upgrade, actions can be
launched. In all cases, you can select Automatic (recommended versions) or Custom (select the
firmware version to use, for example, if you want to select an older firmware image if one happens to
exist on the HP Web Jetadmin 10.0 host).

Bf NOTE: You can change the default for the number of retries HP Web Jetadmin 10.0 will attempt before
stopping (Firmware Upgrade Options on page 167).

NOTE: When HP Jetdirect firmware upgrades, a device can be left in short stack if it is accidentally
disconnected during the upgrade or if some other fatal error occurs. HP Web Jetadmin 10.0 will detect
that error condition and attempt the upgrade again to ensure the device is not left in a bad state. A
condition on HP Jetdirect cards is NLS Missing which happens if the card needs to be upgraded once
for English, and then again for localized languages; HP Web Jetadmin 10.0 will detect this situation as
well.
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Device Lists

e All About Device Lists

e Task Modules for Device Lists

° Related Application Options for Device Lists

° Printing Device Lists

° Deleting Devices from Device Lists

° Refreshing Devices

° Find More Devices

e Credentials for Devices

All About Device Lists

° Pre-Defined Device Lists

e Columns for Device Lists

e  Customizing Layouts for Device Lists

° Filters and Device Lists

e  Searching in Device Lists

° Exporting Device Data

HP Web Jetadmin 10.0 Device Lists and related features such as sorting and filtering lets you easily
locate, manage, and analyze device fleets. Batch configuration, fleet upgrades, reporting and other
powerful HP Web Jetadmin 10.0 features all start with the basic list of devices.

For example, Pete is an HP Web Jetadmin 10.0 user who understands that all devices of a certain model
and in a certain geographical location require firmware updates. These updates are required to enhance
the device functionality and increase performance. Using advanced filtering, Pete can get a list of
devices that match both the model and geographical location criteria. Pete can then export the details
from this list and use the contact information to begin communicating a timeframe in which the firmware
updates will occur. After a time, the contacts are all aware of the firmware update activity that will happen
after hours when most devices are not in use. Then, using a device list and firmware updating, Pete can
schedule the fleet updates for these devices. Later, again using HP Web Jetadmin 10.0 lists, Pete can
view all of the devices that have or have not completed the firmware update process. A common theme
in this scenario is device lists and filtering. (See Filters and Device Lists on page 71.)

To ensure this feature works properly, see Minimum System Requirements for HP Web
Jetadmin 10.0 on page 2 for HP Web Jetadmin 10.0.

Pre-Defined Device Lists

ENWW

The following pre-defined device lists show devices on your network that are not marked as hidden:
e All Devices list: displays a list of all discovered devices.
e Error Devices list: displays a list of discovered devices in an error state.

e Warning Devices list: displays a list of discovered devices in a warning state.
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New (Last Discovery) list: displays all devices that were discovered for the first time by the last
discovery.

New (Manual) list: displays all devices considered new.

New (Time Period) list: displays all devices that were discovered for the first time within the last
14 days (number of days can be set in Tools > Options > Device Management > Device
Filters > New Devices Filter) (New (Time Period) Filter on page 82).

Ungrouped Devices list: shows all devices not assigned to any group.

Plus the first four lists included under PC-Connected Devices list: shows all printers that are
connected to a PC rather than directly to the network.

B NOTE: If the Device Model column is blank, that device has a model name that HP Web Jetadmin
10.0 does not recognize. If Unknown (Disconnected) appears in the Device Model column, the
HP Jetdirect print server does not have a printer connected to it.

Groups lists are the Device Lists that display when a group is selected. These lists can be searched
or filtered just as the All Devices list can be searched or filtered (Searching in Device Lists
on page 74 or Filters and Device Lists on page 71). For more information about Groups, see Device

Groups on page 85.

Columns for Device Lists

Columns Dependent on HP Web Jetadmin 10.0 Data

Manipulating Columns in Device Lists

Steps for Adding or Removing Columns for Device Lists

Columns in Device Lists contain device data or device properties. Most of the data displayed in these
columns is obtained by queries to the devices themselves while some of the data is specific to HP Web
Jetadmin 10.0. Columns can be used to sort data and also can be customized in a variety of ways.
(See Manipulating Columns in Device Lists on page 69 and Customizing Layouts for Device Lists

on page 70.)

You can select columns to view on the Device Lists from a static list of columns. However, if your device
does not support a column you have selected, the column will report Unavailable on the Device
Lists for that device.

Column types are added to HP Web Jetadmin 10.0 as newer device models release with new and
different data objects available. At this writing, there are about 300 column types; this number grows
with the addition of new device updates, new functionality, and other plug-ins.

Columns Dependent on HP Web Jetadmin 10.0 Data

Some column data is internal to HP Web Jetadmin 10.0 and is not obtained from the device, such as
device status or other data specific to the local application. Examples of these columns dependent on
HP Web Jetadmin 10.0 data are:

User Defined Settings: custom columns that can be created by users and then populated with
data that is only resident on the application. (In previous versions of HP Web Jetadmin 10.0, this
used to be called custom fields or custom settings.)

Acknowledged: shows if you have defined the device as Acknowledged. Acknowledging devices
can be done by right-clicking any selection of devices in any devices list. “Acknowledge” only affects
the count of devices in the New (Manual) list.
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e Credentials Required: shows requests for required credentials that were not met.
e Discovery Date/Time: time and date of the last discovery.

e Last Communication: time and date of the last communication.

e Last Discovered: time and date of the last discovery that found this device.

e PC-Connected: if a device is locally connected to a PC.

e  Status: HP Web Jetadmin 10.0 status message about the device.

e  Severity: severity rating of status for the device.

e Device Groups: shows the group membership for a device, listing ether a single group or the word
“‘multiple”. If you hover-over it with your mouse a listing of all groups is displayed.

B NOTE: You can enable two different columns that help track discovery and communication and
represent internal device date/time tracking: Last Communication and Last Discovered. These time
stamps are updated whenever a discovery has occurred in which the device was discovered or re-
discovered.

Manipulating Columns in Device Lists
You can manipulate columns on the device lists in HP Web Jetadmin 10.0:

e Selecting Devices: selecting a device means performing some action that causes the device to
become selected which sets up the device or devices for some further action. Click to select one
device or Shift+Click to select multiple devices.

e Resize columns: to set the width of a column, click and drag the column marker in the list header
to the desired width. Or, to resize the column to the broadest width required to display the data,
double-click on the column header.

e Sort columns:

o to sort the entire device list by a specific column, click in the header for that column. Click
again to reverse the sort.

° to perform a secondary sort on a list, use Shift+Click on a different column after the initial sort.
° to perform additional sorts, hold down Shift while clicking on different column headers.

e Display or hide columns: to display or hide columns, right-click on the column header. The
columns that are currently displayed have a checkmark next to them; the ones that are not
displayed (or hidden) have nothing next to them. Click on the columns to display or hide.

e Right-click menus: various kinds of right-click menus are displayed based on whether something
is selected and what list is displayed. For example, if a device is selected on a device list, right-
clicking within the device list causes different menu options to be displayed than right-clicking when
no devices are selected.

e Re-order columns: move columns around in device lists by dragging-and-dropping them in the
header to where you want them.

Bf NOTE: The column IP Hostname, which is enabled by default, is dependent on DNS on page 245
lookups. For security and performance reasons, you can turn them off.
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Steps for Adding or Removing Columns for Device Lists

1.

3.

Access any Device List. Right-click in any column header and select Customize. The Select
Columns wizard is started.

Select the column by highlighting it and clicking the arrow buttons between the two lists. To select
multiple columns, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons.

You can select the columns displayed on this page by choosing:

e Basic: provides the same selection as those displayed when you are in a Device List, right-
click the column header, and select Customize (which displays the Select Columns wizard).

e Standard: provides a selection of choices more commonly used.
e Advanced: provides a selection of all choices.

Click OK. The changes should be reflected on the Device Lists.

Customizing Layouts for Device Lists

Steps for Adding a Customized Device List

Steps for Editing a Custom Device List

In addition to the Default layout which is always available (it cannot be deleted), you can create different
layouts to apply to any Device List. At the top of each Device List is a Layouts field with a drop-down
list from which you can select any custom layout or default layout or create a layout. The layouts can

be:
[

Shared: any user can access them.

Private: cannot be accessed by other users.

Steps for Adding a Customized Device List

1.

2
3.
4

In the toolbar, click View > Column Layouts. The Column Layout Manager page is displayed.
Click New. The Column Layout Editor page is displayed.
Type the name of the custom view in Name.

Select the column to display on the device lists by highlighting it and clicking the arrow buttons
between the two lists.

To show all columns, select the radio button Advanced. Advanced columns are those that are
rarely used. Then select the columns as you did earlier.

NOTE: To select multiple columns, use either Ctrl+Click or Shift+Click. To move the order of the
visible columns, use the up/down arrows.

If this view can be seen or used by other users, check the box for Shared (or public).

Click OK. The Column Layout Manager page is displayed. Click Close. The view you just edited
is available to select on the device lists.
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Steps for Editing a Custom Device List

1.

In the toolbar, click View > Column Layouts. The Column Layout Manager page is displayed.
Highlight the view to edit and then click Edit. The Column Layout Editor page is displayed.

Select the column to display or remove from the device lists by highlighting it and clicking the arrow
buttons between the two lists.

To show all columns, select the radio button Advanced. Advanced columns are those that are
rarely used. Then select the columns as you did earlier.

NOTE: To select multiple columns, use either Ctrl+Click or Shift+Click. To move the order of the
visible columns, use the up/down arrows.

If this view can be seen or used by other users, check the box for Shared (or public).

Click OK. The Column Layout Manager page is displayed. Click Close. The view you just added
is now available to select on the device lists.

Filters and Device Lists

ENWW

Built-in Filters

Filter Manager and Editor

Filters are used to limit the content of any list based on a specified criteria. Filters can also be applied
to other features such as Automatic device groups (Manual versus Automatic Device Groups

on page 86).

Characteristics of filters are:

Multiple layers of filtering can be created by using AND/OR operators.
Filters can be stored and also shared with other users.

There are a few built-in filters that exist when HP Web Jetadmin 10.0 is first installed (Built-in
Filters on page 72).

Filters can be added as filtered lists in the left navigation pane.

Available actions for filters listed on the Filters menu (accessible from the toolbar) are:

Built-in: apply a built-in filter to a displayed device list; built-in filters include Color Devices, Error
Devices, PC-Connected Devices, Ungrouped Devices, and Warning Devices (Built-in Filters

on page 72).

Shared: (if there are shared filters); lists any filter that has been designated as “shared” in the
Filter Editor.

Private: access all filters that are not shared (as specified in the Filter Editor).

Clear: clears filters from devices selected in the device list. Highlight a device, click Filters and
select Clear. The filters will be cleared from that device.

New: create a filter using the Filter Editor (Steps for Creating (or Adding) Filters on page 72).

Edit: edit an existing filter using the Filter Editor (Steps for Editing Existing Filters on page 73).
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Built-in Filters

Save As: save an existing filter with another name to make two filters using the Filter Editor (Steps
for Editing Existing Filters on page 73).

Manage: create a filter, edit a filter, or delete a filter using the Filter Manager (Managing Filters
on page 74).

Built in filters are listed as Built-in under the Filter menu:

Error Devices: any devices with a severity of “Error”.

Warning Devices: any devices with a severity of “Warning”.

New (Last Discovery): any devices that were added to the All Devices list since last discovery.
Ungrouped Devices: any device that is not a member of a group.

PC-Connected Devices: any device that was discovered through PC-Connected device
discoveries.

Color Devices: any device with color capability.

New (Time Period): any device that falls into the “new” state based on the days setting within
Tools > Options > Device Management > Device Filters > New Devices Filter (New (Time
Period) Filter on page 82).

New (Manual): list of new devices until you flag each as “acknowledge”. Acknowledging devices
can be done by right-clicking any selection of devices in any devices list. “Acknowledge” only affects
the count of devices in the New (Manual) list.

Filter Manager and Editor

Steps for Creating (or Adding) Filters

Steps for Editing Existing Filters

“Save As” Filters

Managing Filters

Steps for Applying Filters for Device Lists

Other Ways to Access Filters

The Filter Manager and the Filter Editor are two filtering features in Device Lists that work together
to help you add and manage filters:

Filter Manager: displays all filters in HP Web Jetadmin 10.0; through the Filter Manager you can
add a new filter, edit an existing filter, or delete a filter.

Filter Editor: invoked when you choose to add or edit any filter; you can also delete filters using
this tool.

Steps for Creating (or Adding) Filters

1.
2,

Access a device list. In the toolbar click Filters and then click New. The Filter Editor is displayed.

Type the name for this new filter in Name.
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3. To make this filter visible to other users, select Shared. If the filter is not shared, it is only visible
to the user who created it.

4. If the filter is shared, you can choose to have it display in the left navigation pane under the All
Devices list by selecting Available Under All Devices.

5. Ifyou select Advanced, a text-field area is displayed for you to manipulate filter attributes that are
expressed in explicit text rather than through a graphical interface. An example of this content is
show here: Contains ("Asset Number", "2") AND Contains ("Asset Number", "1",
MatchCase).

An invalid string should be blocked from being applied to settings. An Insert feature is provided to
place operators and functions into the advanced filter content. A Validate feature is provided to
report problems with the advanced filter content if any exist.

6. To add this filter, click Add. Now you can specify:

e Device Property: device and system attributes which are the same as HP Web Jetadmin
10.0 columns. The list can be expanded or compressed by using the radio controls Basic
(provides the same selection as those displayed when you are in a Device List, right-click
the column header, and select Customize (which displays the Select Columns wizard)),
Standard (choices more commonly used), or Advanced (all choices).

e Not: checkbox that invokes “not” filtering. When an attribute matches the filter functions, the
device will NOT be shown in the list.

e Filter Function: a set of standard operators that give flexibility to the device property
definition. These operators will change depending on the Device Property selected.

Once multiple selections are chosen and displayed in Filter Function, you can choose “AND”
or “OR” (the default is “AND”).

e Value: provides an entry point to define the Filter Function and Device Property value. This
can either be a free text field or a pre-populated drop-down menu depending on the Device
Property selected.

e Options: contains features that further describe the content of free text. Examples are “Match
Case” and “Ignore Case”. This feature is only active when free text fields are available.

7. When done, click OK. The Filter Editor is displayed with your selections.
8. When done, click OK. The device list is displayed.

Steps for Editing Existing Filters

1. Access a device list. In the toolbar click Filters and then click Manage. The Filter Manager is
displayed.

Bf NOTE: You can also edit filters through the top menu bar View > Filters.

2. Make the changes to the existing filter.
3.  When done, click OK. The Filter Editor is displayed with your selections.

4. When done, click OK. The device list is displayed.
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“Save As” Filters

1. Access a device list. In the toolbar click Filters and then select Save As. The Save Filter As is
displayed.

2.  You can save a copy of a filter under a new name or edit an existing filter definition.

Managing Filters

1. Access a device list. In the toolbar click Filters and then select Manage. The Filter Manager is
displayed.

2. Select the filter and then click:

e New: create a filter (Steps for Creating (or Adding) Filters on page 72).

e Edit: edit an existing filter (Steps for Editing Existing Filters on page 73).

e  Copy: copy an existing filter to create a new filter.
e Remove: delete a filter.

3. Follow the steps for the action requested.

Steps for Applying Filters for Device Lists
1. Display the device list on which you want to apply the filter.
2. In the toolbar click Filters and then click one of the following:

e Built-in: apply a built-in filter to a displayed device list; built-in filters include Color Devices,
Error Devices, PC-Connected Devices, Ungrouped Devices, and Warning Devices (Built-in
Filters on page 72).

e Shared: (if there are shared filters); lists any filter that has been designated as “shared” in
the Filter Editor.

e Private: access all filters that are not shared (as specified in the Filter Editor).

3. Select the filter from the list. The device list will automatically display only those devices that match
the criteria in the selected filter.

4. To view all devices again, click Filters and then select Clear.

Other Ways to Access Filters

1. Access a device list. In the toolbar click Filters and then click Manage. The Filter Manager is
displayed.

2. Access a device list and right-click. Then select Filters.

Searching in Device Lists

° Steps for Searching in Device Lists

e Advanced Searches

You can search any device list quickly for a device that meets specified criteria. As your device lists
grow, this Search capability becomes more valuable. HP Web Jetadmin 10.0 supports regular
expressions. For more flexible searches, see Advanced Searches on page 75.
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B NOTE: The first time you search through a device list will take longer than subsequent times.

This feature provides a method of searching all visible data fields in the displayed device list. The quick
feature or a more complex advanced feature exist, both providing different levels of auto-select. Search
Text is found on the toolbar in any device list and is a simple entry point for searching text. Typing search
text into this field and using Enter causes the search feature to begin parsing text from all exposed
column data. A simple scenario uses the string “color” in the Quick Search field. Once entered, the
search finds the next occurrence of “color” from the present list position. F3 and Shift-F3 can be used
to advance or backup the search operation.

Steps for Searching in Device Lists

1. At the top-right of any device list is a Search box. Type the search criteria there and then press
Enter.

2. Thefirstinstance of your search criteria is selected and its status is displayed in the bottom portion
of the device list page.

3. To go to the next occurrence, press F3. To go backwards through the found matches, press Shift-
F3.

Advanced Searches
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° Reqular Expressions

e Steps for Advanced Searches

The Advanced Search feature is useful if you want to add flexibility to your search.
Using the Advanced Search feature, you can:
e Match case: finds only the exact matches for the string entered as well as upper and lower case.

e Add to selection: the next matching string will be selected and strings that you have previously
selected remain selected as well.

e Use regular expression: a string that describes or matches a set of strings, according to certain
syntax rules. When this option is selected, the string typed in Find what is treated as a search
pattern and not as exact text to match. The content of the text in Find what must follow the standard
Microsoft definition of a pattern.

For example, gr (a | e) y can be used to search for both grey and gray without having to perform
two searches.

For more information about regular expressions, see Regular Expressions on page 76.

The Find options provide you with the capability to find:

e Next: find and highlight the next occurrence of the string typed in Find what.

e Previous: find and highlight the previous occurrence of the string typed in Find what.
e Find All: find and highlight all occurrences of the string typed in Find what.

Wrap at end of list allows the search to continue to the end of the Device list and then continue at the
top until the point in the list where the search was started. This feature only applies when using Next
or Previous.
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The Search column selection box allows you to select which columns to search for the string you have
entered. All columns displayed on the device list are displayed in Search column.

B NOTE: The first time you search through a device list will take longer than subsequent times.

Regular Expressions

On the Advanced Search page, if you check Use regular expression you can use the Find what like
a search pattern to look for (rather than searching for exact text to match). The content of the text follows
the standard Microsoft definition of a regular expression pattern which consists of the following:

Table 4-3 Regular Expressions for Advanced Searches

Expression

Syntax

Description

Any character

N/A

Matches any single character except a
line break.

Zero or more

Matches zero or more occurrences of the
preceding expression, making all
possible matches.

One or more

Matches at least one occurrence of the
preceding expression.

Beginning of line

Anchors the match string to the
beginning of a line.

End of line

Anchors the match string to the end of a
line.

Beginning of word

&lt;

Matches only when a word begins at this
point in the text.

End of word

Matches only when a word ends at this
point in the text.

Line break

\n

Matches a platform-independent line
break. In a Replace expression, inserts a
line break.

Any one character in the set

Matches any one of the characters within
the []. To specify a range of characters,
list the starting and ending character
separated by a dash (-), as in [a-Z].

Any one character not in the set

"]

Matches any character not in the set of
characters following the *.

Or

Matches either the expression before or
the one after the OR symbol (|). Mostly
used within a group. For example,
sponge |mud bath matches sponge
bath and mud bath.

Escape

Matches the character that follows the
backslash (\) as a literal. This allows you
to find the characters used in regular
expression notation, such as { and . For
example, \" Searches for the ” character.

Tagged expression

¢

Matches text tagged with the enclosed
expression.

C/C++ Identifier

Matches the expression ([a-zA-Z_$][a-
ZA-Z0-9_$1).
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Table 4-3 Regular Expressions for Advanced Searches (continued)

Expression Syntax Description

Quoted string :q Matches the expression ((""[*"T*")|('[™]
)

Space or Tab b Matches either space or tab characters.

Integer z Matches the expression ([0-9]+).

Steps for Advanced Searches
1. At the top-right of any Device List, click the (show) binoculars icon.
2. Type the search criteria in Find what.
3. Select which matches to find in Find options:

e Match case: only finds matching text where the case of the letters matches the search string
when it is checked. Finds matches with both matching case and mismatched case when this
option is not checked.

e Add to selection: the next matching entry found is selected, but any previously selected
entries also remain selected. When this is not selected, the next matching entry will be
selected, but any previously selected entries will be unselected.

e Use regular expression: the Find what string acts as a search pattern to look for (rather
than the exact text to match) (Regular Expressions on page 76).

4. Select how to find matches in Find:

e Next: search in a forward direction looking for the next occurrence of the string to be found.
When starting a new search, this includes the device that currently has focus. When continuing
a search it starts with the next device that matches.

e Previous: search in a reverse direction looking for the previous occurrence of the string to be
found. When starting a new search, this includes the device that currently has focus. When
continuing a search it starts with the next device that matches.

e Find All: searches all devices starting with the first device.

e Wrap at end of text: only applies when using Next or Previous; indicates whether or not the
search should wrap back around to the start of the device list when it reaches the last device
and continue until it reaches the device that had focus when the search was started. If this
box is checked the search wraps, otherwise when it reaches the end of the list it will stop.
When using Previous, the search will continue to the end of the device list after it reaches
the first entry in the list.

5. If applicable, select the search column.

6. Click Find.

Exporting Device Data

° Steps for Exporting Device Data

Data representing device attributes can be exported to a file and then stored on a disk or sent via email
through SMTP. Export data is the same as column data. Many data elements exist within HP Web
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Jetadmin 10.0 but the data that is actually available on devices will vary depending on model and device
firmware revision.

Steps for Exporting Device Data

1. Access any device list. Then right-click anywhere within the list and select Export. The Export
Devices wizard is started with the Select columns page displayed.

2. Select the column by highlighting it and clicking the arrow buttons between the two lists. To select
multiple columns, use either Ctrl+Click or Shift+Click. To move the order of the visible columns,
use the up/down arrow buttons. To move all devices from one list to the other, use the middle arrow
buttons.

You can select the columns displayed on this page by choosing:

e Basic: provides the same selection as those displayed when you are in a Device List, right-
click the column header, and select Customize (which displays the Select Columns wizard).

e Standard: provides a selection of choices more commonly used.
e Advanced: provides a selection of all choices.

3. To schedule the export for a later time, click Schedule device list export.

B NOTE: If you schedule a task (for example, a discovery or a configuration or others) using a
corresponding template, the task uses the settings defined in the template at the time the task
starts. This makes it easy to redefine settings used in a regularly scheduled task without having to
delete and create a scheduled task.

NOTE: All HP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin
install host. The client system being used to access HP Web Jetadmin may or may not be in the
same time zone as the HP Web Jetadmin install host. You should be aware of the time and possible
date differences when configuring HP Web Jetadmin 10.0 scheduling.

4. Click Next. The Export Devices page is displayed.
5. Specify the destination:

e Save to file: when the export is complete, you are prompted for the location; the file will be
written to that location and the data is displayed on your page.

e Email: send the data to an email address. Type the email address on this page or browse for
the correct email address.

6. If emailing, type the file name. Then click Next; the Confirm page is displayed.

Task Modules for Device Lists

° Device Lists - Current Tasks and Common Tasks Task Modules

° Device Lists - Summary Task Module

The following task modules can be displayed or hidden in Device Groups.
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Device Lists - Current Tasks and Common Tasks Task Modules

The Device Lists - Current Tasks task module can be displayed on the Device List page and includes
the following tasks:

e Discover devices on my network (Discover Devices (the Device Discovery Wizard)
on page 121)

e Create new device group (Add Devices to a Group on page 92)

e Configure devices (Configure Devices on page 136)

The Device Lists - Current Tasks task module can be displayed in other areas of HP Web Jetadmin
10.0; in the other areas it is called Device Lists - Common Tasks.

Device Lists - Summary Task Module

The Device Lists - Summary task module can be displayed on the Overview - Device
Management page. This task module lets you access the All Devices list plus the first four lists included
under All Devices (in the left navigation pane).

B NOTE: The device lists included in the left navigation pane can be configured in View >
Preferences > Device Filters (Preferences on page 33).

Related Application Options for Device Lists

° Hidden Devices

° Polling Rates

° Blocked Devices

e New (Time Period) Filter

Bf NOTE: The column IP Hostname is dependent on DNS on page 245 lookups, which are enabled by
default. For security and performance reasons, you can turn them off (Columns for Device Lists

on page 68).

Hidden Devices

If device communication has not occurred within a specified number of days, HP Web Jetadmin 10.0
automatically lists that device on the Hidden Devices list so that it won’t show up in other Device lists
throughout the product. The number of days specified is actually counted starting at midnight after the
policy has been set and the device has not been communicated with.
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Follow these steps:

1. On the top menu bar, access Tools > Options > Device Management.
Expand Device Lists and then select Hidden Devices.

2. Configure the desired settings:

e Automatically hide devices in communication error after: Specify how many days should
pass with no communications from a device before that device should be hidden.

e Hidden devices: To show a device in the device lists even though it has not be communicated
with, highlight it in the Hidden devices list and click Show.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Polling Rates

Whenever you access a device list in HP Web Jetadmin 10.0, the devices on the network are polled.
You can determine how many devices and how often devices are polled by setting the rate on the Device
List Polling Rates page. This is useful because you can reduce network traffic by setting a polling rate
appropriate for your own environment.

HP Web Jetadmin 10.0 performs a slow-poll when users access device lists. Slow polling means that
HP Web Jetadmin 10.0 will only query a certain number of devices every X seconds and only for the
certain columns. The columns polled are based upon the union of all columns in the layouts currently
displayed on Device List pages on all currently connected clients. This polling rate can be changed
through Tools > Options > Device Management > Device Lists > Device List Polling Rates. List
performance can be improved by changing the polling rate while network traffic will increase.

NOTE: Another way to refresh the list more quickly is to highlight any or all devices where fast data is
desired. Selected devices in the currently visible portion of the device list are always polled at a faster
rate than non-selected devices.

Polling always occurs across all devices at the specified rate regardless of whether or not a device list
is being accessed by anyone. Accessing a device list only affects the columns which are polled for when
the polling does occur. Selecting devices within the visible portion of the list will cause those devices to
be polled for at a higher rate.

Polling is also affected by thresholds which are builtinto HP Web Jetadmin 10.0 and are not configurable.
For each column, HP Web Jetadmin 10.0 knows how long the data should be considered valid. If

HP Web Jetadmin 10.0 is about to poll for a particular column on a particular device, it goes through the
following steps:

e If HP Web Jetadmin 10.0 does not have any data for a specific value, it accesses the device. Any
value obtained from the device will be displayed in the device lists.

° If HP Web Jetadmin 10.0 cannot obtain the value, then it checks to see how old the information it
has is. If it is within the built-in threshold value for this column, then it considers the data valid.

° If the value is considered “old”, then HP Web Jetadmin 10.0 accesses the device to get a more
current value. Any value obtained from the device is displayed in the device lists. If HP Web
Jetadmin 10.0 cannot get the data from the device, the value is still listed as Unknown.

Thresholds are chosen based upon how stable the values are in the particular columns. For example,
the Severity of a device might be considered out-of-date after 15 seconds, whereas the System
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Contact (which is less likely to change) might only be considered out-of-date after 24 hours. The
device Model might never be considered out-of-date.

Bf NOTE: The 24 hour time on System Contact is not as long as it seems because if someone changes
this value for a device using HP Web Jetadmin 10.0, the data (and all clients) are updated immediately.
It is only in a case where someone changes this value through another mechanism that the slow polling
may not see the change for up to 24 hours. If this is happening, then you can always wait for HP Web
Jetadmin 10.0 to refresh the information about this device at any time (see Refresh Selection in Top
Menu Bar Features on page 32).

Follow these steps:

1. On the top menu bar, access Tools > Options and expand Device Management.
Expand Device Lists and then select Device List Polling Rates.

2. Configure the desired settings:

e Polling interval: select the period of time in seconds in which HP Web Jetadmin 10.0 can
send device requests onto the network.

e Time between polling intervals: select an inactive period (time in seconds) where the
application does not send device queries.

e Maximum devices to poll at one time: select the number of devices that can be queried
concurrently. HP Web Jetadmin 10.0 will place X device queries onto the network in a poll
burst and wait for responses. HP Web Jetadmin 10.0 will continue to place X device queries
onto the network each time a burst of queries is satisfied with response packets. It will continue
to do this until the Polling interval time is expired and then will wait until the number of
Maximum devices to poll at one time is satisfied before sending any new device queries.

To reset all values to defaults, check the Reset to Default Values box. For default values, see
Default Settings on page 18.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Blocked Devices

The Blocked Devices list contains device addresses for which device discoveries are blocked. Devices
are added to this list in one of two ways:

e Devices can be deleted from the All Device list with the “Delete and Block” option; the devices are
then added to the Blocked Devices list.

e Devices can be added to (or removed from) the Blocked Devices listin Tools > Options > Device
Lists > Blocked Devices (see steps below).

If a device is on the Blocked Devices list, HP Web Jetadmin 10.0 cannot discover it. If you add a device
to this list through the Tools > Options > Device Lists > Blocked Devices, the device will still be
included on the All Devices list. Devices can be blocked via IP Address or Hostname. Hostname is the
preferred method, since IP Addresses on devices can change.
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Follow these steps:
1. On the top menu bar, access Tools > Options and expand Device Management.
Expand Device Lists and then select Blocked Devices. The Blocked Devices page is displayed.

2. To add a device to the blocked device list so that it will not be found during a discovery, click
Add.

To remove a device from the Blocked Devices list so that it can be found during a discovery,
click Remove.

3. To save these settings and close this window, click OK.

New (Time Period) Filter

You can determine how long a device is considered new in HP Web Jetadmin 10.0. “New” devices are
displayed on the New (Time Period) device list.

Follow these steps:

1. On the top menu bar, access Tools > Options and expand Device Management.
Expand Device Filters and then select New Devices Filter.

2. Configure the desired settings:

e Time period for device to remain “New”: Specify the number of days devices should be
considered “new”.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Printing Device Lists

° Steps for Printing Device Lists

You can print any device list. You can select specific devices or print the entire list.

Steps for Printing Device Lists
1. From the left navigation pane, access any device list.
2.  You can either print the entire list or just selected devices:

e To print the entire device list, you can choose to print the whole list or certain pages of it. Go
to the next step.

e To print specific devices on the list, highlight those devices and then go to the next step.

B NOTE: To select multiple devices, use either Ctrl+Click or Shift+Click.

To preview the list as requested, click File > Print > Preview > Device List.

3.

4. Onthe device list page, in the toolbar click File > Print > Device List. The Print page is displayed.
5. Select your printer and the page range (All, Selection, or Pages to identify certain page numbers).
6.

Click Print. The selected list will print to the specified printer.
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Deleting Devices from Device Lists

e Steps for Deleting Devices from Device Lists

You can delete any device from a device list.

Steps for Deleting Devices from Device Lists

1.  From the left navigation pane, access any device list.
2. Highlight the device or devices to delete and right-click to select Delete.

3. Select one of the following options:

Function Removes devices from Removes historical and Will be rediscovered the
device lists task data next time a discovery is
performed
Hide Yes No Yes

For more information, see
Hidden Devices

on page 79.
Delete Yes Yes Yes
Delete and block Yes Yes No; if they are removed from

the Blocked Devices

on page 81 list, they will be
rediscovered the next time a
discovery is performed.

4. Click OK.

Refreshing Devices

From any device list, you can refresh devices or the display of devices.

To refresh the device display from the HP Web Jetadmin 10.0 server, access any device list and select
a device. Then right-click on that device and select Refresh Selection.

To refresh the devices and the device display, you can request HP Web Jetadmin 10.0 to go out to the
network and get new device settings from the devices on that network. To do this, access any device
list and select a device. Then right-click on that device and select Refresh Selection (Full).

Find More Devices

ENWW

On the All Devices page (select All Devices from the left navigation menu) in the upper right corner is
a Start discovery button. When you click that button, the Device Discovery wizard starts to walk you
through the steps needed for a successful device discovery.

You will want to use this feature after you initially install HP Web Jetadmin 10.0 and then afterwards to
find additional devices. When you first install HP Web Jetadmin 10.0, no discovery has been run which
means the All Devices list will be empty.

For information about the Device Discovery wizard, see Steps to Discover Devices on page 122.
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Credentials for Devices

e Steps for Adding Credentials for a Device Using the Needed Credentials Wizard

Some devices use credentials, which must be entered into HP Web Jetadmin 10.0 for a user to access
that device. If the credentials entered by the user (when trying to access a device) do not match the
credentials entered HP Web Jetadmin 10.0, the device denies access.

The All Devices list has a Credentials Required column that shows which devices need
credentials. Yes in this column indicates that the corresponding device requires credentials; No
indicates that it does not need credentials. If a device requires credentials, you must add them before
users access that device. The Needed Credentials wizard will walk you through the steps to add
credentials. The pages displayed by the wizard will vary based on the specific credentials required by
the device or devices.

Steps for Adding Credentials for a Device Using the Needed Credentials Wizard

Bf NOTE: Throughout the Needed Credentials wizard there is a Skip button that can be used to not
enter credentials for devices if, for example, you are unsure of the required value for the device.

1. In the All Devices list, highlight the device or devices requiring credentials (those with a Yes in
the Credentials Required column).

2. Right-click and select Update Credentials.

3. Use the Needed Credentials wizard to enter the credential information for the device or devices.
Depending upon the credentials required by the device or devices, one or more of the following
pages will be displayed for you to complete:

e Enter SNMPv1 Get Community Name page: Select the device for the credential, supply the
Get Community Name (can be up to 256 characters), and click Set. Then click Finish, or
click Next and follow instructions in the wizard.

e Enter SNMPv1 Set Community Name page: Select the device for the credential, supply the
Set Community Name (can be up to 256 characters), and click Set. Then click Finish, or
click Next and follow instructions in the wizard.

e Enter EWS Password page: Select the device for the password, type the username and
password, and click Set. Then click Finish, or click Next and follow instructions in the wizard.

e Enter SNMPv3 Credential page: Select the device for the password and type the username,
the authenticated password, and the private password. Click Set and then click Finish.
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Device Groups

e All About Device Groups

e Task Modules for Device Groups

° Create a New Device Group

e Add Devices to a Group

° Remove Devices from a Manual Group

° Edit a Device Group

° Delete a Device Group

° Edit Device Group Policies

° Rename a Device Group

e View a Device Group

All About Device Groups
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° Manual versus Automatic Device Groups

° Group Policies

° Device Groups Security Restriction Settings

Device Groups lets you separate devices into subsets (or device groups) so that you can easily manage
them. You can add and delete groups, name and rename them, and add or remove devices from existing
groups. Putting devices in groups lets you configure multiple devices at the same time.

You can organize groups in a hierarchy to make it easier to manage them. It might be best to mirror an
existing structure you are using for groups of devices. For example, you can organize your groups by
geography, by building and floor, or by functional area (accounting, marketing, and so forth). Device
Groups can have the same name when they don’t exist within the same parent group.

Device groups can be either Manual, where you specify which devices belong to each group, or
Automatic, where you define filter criteria and devices are automatically added to and removed from
each group. You cannot manually change the membership of Automatic groups except by changing the
filter criteria. You can have both manual and automatic groups at the same time. (See Manual versus
Automatic Device Groups on page 86.)

Device groups can also be used to delegate device management responsibilities to specific users. A
user can be granted device management permissions for devices only in specific groups.

You can do the following with Device Groups:
e  Organize your devices into meaningful categories, for ease of management.
e Create a hierarchy of parent groups and subgroups.

Subgrouping is where a group exists as a member or subgroup of a parent group. The top-level
parent group in HP Web Jetadmin 10.0 is simply “Device Groups” This exists at the top-level node
in the left navigation pane and can only contain other groups
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Create Automatic groups, where membership is determined automatically according to defined
filter criteria.

Create Manual groups, where membership is determined manually.

Create policies for automatically applying various types of operations on devices when they are
added to and removed from a group.

Schedule various operations to happen on a group, rather than specific devices.

Apply security permissions for users, such that they can perform operations on some groups, but
not others.

Provide meaningful names up to 48 characters long.

The same device can be included in more than one device group.

A few common examples of HP Web Jetadmin 10.0 groups scenarios include:

a geographic representation of your device fleet.

parent groups representing buildings within a campus could contain subgroups that represent floors
or floor quadrants. This could ease finding devices within a campus setting.

parent groups reflecting how devices are dispersed among organizations.

To ensure this feature works properly, see Minimum System Requirements for HP Web
Jetadmin 10.0 on page 2 for HP Web Jetadmin 10.0.

Manual versus Automatic Device Groups

Device Groups can also be used to automatically categorize devices by some common criteria. For
example, an IP addressing scheme might be used to distinguish devices by the area in which they exist.
In HP Web Jetadmin 10.0, the Filter feature in automatic device groups and the ability to create manual
device groups provide powerful tools for managing group membership. (See Create a New Device
Group on page 89.)

In HP Web Jetadmin 10.0, groups can be set up with one of two different membership types:

Manual group: Each device is assigned manually to the group and remains in the group until you
remove it.

Automatic group: Devices are automatically assigned based on filter criteria within HP Web
Jetadmin 10.0. Many variations of filter criteria can exist. For example, you might want to
understand how many color devices exist on a specific network; you can build two filters: one to
describe the network and one to specify the color capability:

Table 4-4 Example of Criteria to Set Group Membership

Property Function Value
IP Address Contains 15.5
Color Equals Yes
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You can also edit this filter in advanced mode using the HP Web Jetadmin 10.0 filtering syntax.
These strings can have functions and values added and modified to affect the outcome of the
filtering action. Automatic group membership is updated when one or more of the following occur:

0 The Automatic Group has had a filter (or filter change) applied.
0 New devices enter the system running a device discovery.
o Device changes are realized by the system that either match or don’t match the filter criteria.

0 Devices are removed from the system by hiding or deleting them from the All Devices list.

Group Policies

Example for Group Policies

Policies are applied to groups for the purpose of applying a settings action (or actions) onto a device
when it becomes a member of the group or when it is removed from a group.

Many combinations of policy settings can be applied to a group. Multiples of the same policy types can
be applied to groups as well. A short definition for each policy type follows:

Enable data collection policy: If you have already defined a reports data collection template, this
policy will automatically apply that template to devices when they are added to the group, when
they are removed from the group, or both.

Subscribe to alerts or unsubscribe to alerts policy: If you have already defined an alert
subscription template, this policy will automatically apply that template to devices when they are
added to the group, when they are removed from the group, or both.

Configure devices policy: If you have already defined a device configuration template, this policy
will automatically apply that template to devices when they are added to the group, when they are
removed from the group, or both.

Add or remove devices to supply group policy: If you have already defined a supply group, this
policy will automatically add devices to that supply group when they are added to the group, when
they are removed from the group, or both.

Example for Group Policies

Following is a simple example of applying a configuration template to a group:

An administrator is named Pat.
Pat has an HP Web Jetadmin 10.0 group named “Pat’s Devices”.

One policy setting on the group is a configuration template that sets the System Contact to “Pat”
and the Device Location to “Building 3.

Device Groups Security Restriction Settings
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It is possible to restrict device management capabilities to specific groups in User Security (User
Security on page 260). To accomplish this, you can create a Role that specifies a restriction type of

Device Group in User Security in the Application Management view. You can then choose from a
subset of permissions that can be allowed/denied by device group. After the restricted role is created,
it can be assigned to a Windows user or user group. When you grant a restricted role to a user you can
choose which device groups the user should have access to.
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B NOTE: Devices can exist in multiple groups. If the device is in a group the user has access to, the
user can access the device in any group.

For example, you want to give user Lisa rights to configure devices in Group A but not Group B:
1. Create a restricted role with Configure Devices checked.
2. Assign the newly created restricted role to Lisa and add Group A to the list of groups.

Result-User Lisa can configure devices in Group A but not devices in Group B (unless the device
exists in both Group A AND Group B).

Task Modules for Device Groups

° Device Groups - Current Tasks and Common Tasks Task Modules

° Device Groups - Summary Task Module

° Device Groups - Management Task Module

The following task modules can be displayed or hidden in Device Groups.

Device Groups - Current Tasks and Common Tasks Task Modules

The Device Groups - Current Tasks task module can be displayed on the Device Groups page and
includes the following tasks:

e Create new device group (Create a New Device Group on page 89)

e Add devices to groups (Add Devices to a Group on page 92)

e Remove devices from group (Remove Devices from a Manual Group on page 93)

e Edit device group (Edit a Device Group on page 94)

e Delete device group (Delete a Device Group on page 96)

e Edit device group policies (Edit Device Group Policies on page 96)

The Device Groups - Current Tasks task module can be displayed in other areas of HP Web Jetadmin
10.0; in the other areas it is called Device Groups - Common Tasks.

Device Groups - Summary Task Module

The Device Groups - Summary task module can be displayed on the Device Groups page. This task
module lets you easily review how many devices are assigned to a group and how many are not. It also
displays how many groups have devices in either an error or warning state. You can use the status
indicators on the groups in either the left navigation pane or the Device Groups - Management task
module to find out which groups contain the error or warning devices. You can also select the Error
Groups or Warning Groups nodes under All Devices in the left navigation tree, to see which devices
have errors or warnings.

Device Groups - Management Task Module

The Device Groups - Management task module shows the groups that exist and their hierarchy. It also
provides a shortcut to most features available through Common Tasks. This task module is handy if
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you want to hide the Common Tasks task module from the Device Groups page. Tasks accessible
through this task module include:

e New Group (Create a New Device Group on page 89)

° Edit (Edit a Device Group on page 94)

e Add Devices (Add Devices to a Group on page 92)

° Remove Devices (Remove Devices from a Manual Group on page 93)

° Delete (Delete a Device Group on page 96)

e View (View a Device Group on page 98)

Create a New Device Group

e Steps for Creating a Device Group

e Other Ways to Create a Device Group

A device group is set of devices on your network. After you create a group, you can manipulate all of
the devices in that group. You can set up device groups so that device membership is either determined
manually by you (Manual group) or automatically based on criteria you specify (Automatic group).

Naming groups with meaningful descriptions makes it easier to find a specific device group in a list. For
example, instead of assigning Payroll and Receivables as device group names, you could
assign Accounts Payroll and Accounts Receivables. These two device groups would then
appear together in a sorted list.

The Manual group feature allows you to add discovered devices to a device group, thereby giving you
complete control over the group membership. This method can be cumbersome if you have a lot of
devices, and membership may need to be reevaluated manually when new devices are discovered or
added to the network. However, this method may be required in certain grouping strategies, where the
criteria cannot be evaluated automatically (such as “Marketing,” “Payroll”, and “Sales” devices).

The Automatic group feature allows HP Web Jetadmin 10.0 to automatically add newly discovered
devices to a device group if the devices meet specific criteria. Specify the filters that HP Web Jetadmin
10.0 uses to determine if a new device should be added to a device group. You can specify multiple
filters for the device group. You can also use the filters to remove devices from a device group when
filter criteria does not apply to a device. Automatic group membership is determined by filter settings;
devices cannot be added to or removed from these groups manually.

B NOTE: All primary device group criteria applies to subgroups.
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Steps for Creating a Device Group
1. Select Device Groups in the left navigation pane. The Device Groups page is displayed.

On the Device Groups page, click Create new device group. The Create Group wizard is started
with the Specify group options page displayed.

2. On this page you can specify:
e Group name:
o can be up to 48 characters.
0 can have alphabetic characters.
° can have numeric characters.

0 can have special characters (such as “” or “-").
0 can have Unicode characters.
° cannot contain a forward slash or a backward slash.

0 can have the same name as another group if the two groups with identical names are in
different parent groups.

0 naming is flexible and can be changed on existing groups.
e Parent group: select this from the drop-down box. Characteristics of parent groups are:

0 can contain a subgroup that has the same name as another subgroup in a different parent
group.

o no known limits exist for the depth of parent groups and subgroups or the number of
groups.

e Group membership type: determines how devices will be added to the group. Select:
° Manual group: each device is added to the group manually.

0 Automatic group: devices are added to the group automatically depending upon the
filters set for the group.

Bf NOTE: Automatic group membership is determined by filter settings; devices cannot be
added to or removed from these groups manually (Add Devices to a Group on page 92).

3. If you want to set the properties for the group you are creating, check the box for Configure group
properties now.

4. Click Next. If you are creating a manual group and chose not to configure properties for the group
now, the Confirm page is displayed. Review the group information entered; if it is correct, click
Create Group. The Results page is displayed giving you a choice to open the group when you
click Done.

If you chose to configure properties for the group now, proceed with these steps.
5. If you are adding a manual group and want to add devices to the group now:

e  Select the device by highlighting it and clicking the arrow buttons between the two lists. To
select multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list
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to the other, use the double arrow buttons. You can sort the list of available devices by clicking
the column headers, or view more columns by right-clicking the column headers.

Ef NOTE: The columns displayed on the Select Devices page are defined in View >

Preferences > Device Identification.

If you are adding an automatic group:

e The Specify filter criteria page is displayed for you to define the devices to include in this
automatic group. Set up filters so that only those devices are selected and assigned to this
group. Select the Edit mode (Basic or Advanced, at the bottom of this page).

After you click Add, the Basic edit mode lets you define filters using the Function page:
° Device property: Select the property from the drop-down list.

0 Not: Check this if the devices should not match the filter criteria. Otherwise, devices
matching the filter criteria will be assigned to this group.

° Filter Function: Select the way in which the devices should match the filter criteria from
the drop-down box (contains, ends with, equals, and so forth).

° Value: Type the value for the filter criteria.
° Options: Choose to ignore the case to determine a match or to match the case.

° Show device properties: Select Basic (most commonly used filters), Standard
(commonly used filters), or Advanced (all filters).

If you chose the Advanced edit mode, you can define filters this way:

° Type your own formula using the Insert button to insert various expressions.

° When you have finished, click Validate to ensure the formula for the filter is valid.
e Click Next.

The Specify group properties page is displayed. Enter the description and contact information
for this group and then click Next.

The Configure group policies page is displayed. Policies impact the device and HP Web
Jetadmin 10.0-based settings as they become members of the group. Select the policy from the
Policy column and click Add. Then click Next.

The Policy column lists policies based on the user’s permissions. This list is blank if there are no
user permissions configured (User Security on page 260).

The Confirm page is displayed. Review the group information entered; if it is correct, click Create
Group. The Results page is displayed giving you a choice to open the group when you click
Done.

Other Ways to Create a Device Group
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In the navigation pane, right-click on Device Groups and select New group.

In the navigation pane, expand the Device Groups tree and right-click on the parent group for the
new group and select New group.

In the navigation pane, right-click on Overview and select Device Groups > New group.
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From the top menu bar, select File > New > Group.

On the All Devices page, right-click on the device to add to a group and select Device
Groups > Add devices to new group. This allows you to create a group and add the selected
device or devices to that group at the same time.

On the All Devices page, highlight the device to add to a group and then, in the lower portion of
the All Devices page, click on the Device Groups tab. Click Add devices to new group.

In the Device Groups - Management task module, click New Group.

Add Devices to a Group

Steps for Adding Devices to a Group

Other Ways to Add Devices to a Group

Managing a group of devices can be easier than managing individual devices. Adding devices to a group
lets you manage all of the devices in that group at the same time. Removing devices from a group means
to delete them from the group, but they will remain in the All Devices list. You can only add devices to
a group that has been identified as a manual group; devices are automatically added to any group
identified as an automatic group based on filter criteria (Manual versus Automatic Device Groups

on page 86).

Steps for Adding Devices to a Group

1.

B

Select Device Groups in the left navigation pane. The Device Groups page is displayed.

On the Device Groups page, click Add devices to group. The Add Devices wizard is started
with the Select group page displayed.

Select the group to add devices to and click Next.

Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device Identification.

Click Next. A Confirm page is displayed.
If changes need to be made, click Back and make corrections.

If no changes need to be made, click Add Devices. The Results page is displayed. Click Done
to display the Device Groups page.

Other Ways to Add Devices to a Group

In the navigation pane, right-click on Device Groups and select Add devices to group.

In the navigation pane, under Device Groups right-click on the specific group to add devices to
and select Add devices to group.

In the navigation pane, right-click on Overview and select Device Groups > Add devices to
group.
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In the Device Groups - Management task module, select a device group and click Add
Devices.

To add devices to a group from the All Devices page, highlight the device or devices to add to a
group and drag-and-drop them onto the group in the left navigation pane (the Device Groups tree
must be expanded in the left navigation pane).

To add devices to a group from the All Devices page, right-click on the device to add to a group
and select Device Groups > Add devices to group

To add devices to a group from the All Devices page, highlight the device to add to a group and
then, in the lower portion of the All Devices page, click on the Device Groups tab. Click Add
devices to group.

You can also add devices using any of the methods to edit a group:

° In the navigation pane, right-click on Device Groups and select Edit group.

0 In the navigation pane, right-click on Overview and select Device groups > Edit group.
° In the Device Groups - Management task module, select a device group and click Edit.

° In the navigation pane, expand the Device Groups tree and right-click on the specific group
to edit and select Edit group.

Remove Devices from a Manual Group

Steps for Removing Devices from a Manual Group

Other Ways to Remove Devices from a Manual Group

You can delete any device from a device group that has been identified as a manual group (Manual
versus Automatic Device Groups on page 86).

Steps for Removing Devices from a Manual Group
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1.

Select Device Groups in the left navigation pane. The Device Groups page is displayed.

On the Device Groups page, click Remove devices from group. The Remove Devices wizard
is started with the Select group page displayed.

Select the manual group to remove devices from and click Next.

Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device Identification.

Click Next. A Confirm page is displayed.
If changes need to be made, click Back and make corrections.

If no changes need to be made, click Remove Devices. The Results page is displayed. Click
Done to display the Device Groups page.
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Other Ways to Remove Devices from a Manual Group

In the left navigation pane, right-click on Device Groups and select Remove devices from
group.

In the left navigation pane, under Device Groups right-click on the specific group to remove
devices from and select Remove devices from group.

In the left navigation pane, right-click on Overview and select Device Groups > Remove devices
from group.

In the Device Groups - Management task module, select a device group and click Remove
Devices.

In the left navigation pane, expand the Groups node and click the group you want to modify. The
list of devices in the group is displayed. Select the devices you want to remove and click Delete
on your keyboard.

In the left navigation pane, expand Groups and click the group you want to remove. The list of
devices in the group is displayed. Click Remove devices from group in the toolbar at the top of
the page.

In the All Devices page, select the device you want to remove from a group. Select the Groups
tab at the bottom of the page to see which groups the device belongs to. Select the appropriate
group and click Remove From Group.

You can also remove devices using any of the methods to edit a group:

o In the navigation pane, right-click on Device Groups and select Edit group.

0 In the navigation pane, right-click on Overview and select Device Groups > Edit group.
o In the Device Groups - Management task module, select a device group and click Edit.

0 In the navigation pane, expand the Device Groups tree and right-click on the specific group
to edit and select Edit group.

Edit a Device Group

Steps for Editing a Device Group

Other Ways to Edit a Device Group

After a device group has been created, you can change its name, the devices in the group, how the
devices are assigned to that group (manually or automatically), or any of its properties.

Steps for Editing a Device Group
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1.

Select Device Groups in the left navigation pane. The Device Groups page is displayed.

On the Device Groups page, click Edit device group. The Edit Group wizard is started with
the Select group page displayed.

Select the group to edit from the drop-down list.
Click Next. The Specify group options page is displayed.

On this page you can modify the group name, the parent group, or whether devices will be added
manually (Manual group) or automatically (Automatic group).
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NOTE: When you change a device group from Manual to Automatic, devices that meet the filter
criteria for the automatic group will replace any devices that had been in the group when it was a
manual group. Changing a device group from Automatic to Manual will not cause the device
membership to change; the devices present in the group will be retained and manual modifications
can be performed on those devices.

If you are renaming the group, remember a group name:
e must have a unique name within its parent group.

e can be up to 48 characters.

e can have alphabetic characters.

e can have numeric characters.

e can have special characters (such as “” or “-").

e can have Unicode characters.

e cannot contain a forward slash or a backward slash.
Click Next.

If you chose Manual group:

a. Select the device by highlighting it and clicking the arrow buttons between the two lists. To
select multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list
to the other, use the double arrow buttons. You can sort the list of available devices by clicking
the column headers, or view more columns by right-clicking the column headers.

Ef NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device Identification.

b. Click Next. The Specify group properties page is displayed. Type the description and
contact information for the devices. Click Next.

c. The Configure group policies page is displayed.
If you chose Automatic group:

a. The Specify filter criteria page is displayed. Complete this page when it's available. Click
Next.

b. The Specify group properties page is displayed. Complete this page when it's available.
Click Next.

c. The Configure group policies page is displayed. Complete this page when it's available.

Click Next. A Confirm page is displayed.

NOTE: Automatic group membership is determined by filter settings; devices cannot be added
to or removed from these groups manually.

If changes need to be made, click Back and make corrections.

If no changes need to be made, click Save Group. The Results page is displayed. Click Done to
display the Device Groups page.
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Other Ways to Edit a Device Group
e In the navigation pane, right-click on Device Groups and select Edit group.
e In the navigation pane, right-click on Overview and select Device Groups > Edit group.
e Inthe Device Groups - Management task module, select a device group and click Edit.

e Inthe navigation pane, expand the Device Groups tree and right-click on the specific group to edit
and select Edit group.

e If you are editing a group to move it to a different parent group, within the left navigation pane you
can highlight that group and drag-and-drop it onto the desired parent group.

Delete a Device Group

° Steps for Deleting a Device Group

e Other Ways to Delete a Device Group

You can keep your groups current by removing those groups that are no longer needed.

Steps for Deleting a Device Group
1. Select Device Groups in the left navigation pane. The Device Groups page is displayed.

On the Device Groups page, click Delete device group. The Delete Group wizard is started with
the Select groups page displayed.

2. Highlight the group or groups (must be at the same level) to delete.

Bf NOTE: Multiple groups, if at the same level, can be selected; use either Ctrl+Click or Shift
+Click.

3. Click Next. A Confirm page is displayed.
If changes need to be made, click Back and make corrections.

If no changes need to be made, click Delete. The Results page is displayed. Click Done to display
the Device Groups page.

Other Ways to Delete a Device Group
e In the navigation pane, right-click on Device Groups and select Delete group.
e In the navigation pane, right-click on Overview and select Device Groups > Delete group.

e Inthe navigation pane, expand the Device Groups tree, right-click on the group to delete, and
then select Delete group.

e In the navigation pane, expand the Device Groups tree, highlight the group to delete and click
Delete on your keyboard.

e Inthe Device Groups - Management task module, select a device group and click Delete.

Edit Device Group Policies

° Steps for Editing Device Group Policies
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Other Ways to Edit Device Group Policies

You can make changes to device group policies.

Steps for Editing Device Group Policies

1.

Select Device Groups in the left navigation pane. The Device Groups page is displayed.

On the Device Groups page, click Edit device group policies. The Edit Group Policies wizard
is started with the Select group page displayed.

Select the group or click Browse to find the group and click Next. The Configure group
policies page is displayed.

Select the policy to edit and click Add to add a new policy. Or to remove a policy, select it and
click Remove.

If you are adding a new policy, the Add Policy dialog box is displayed. Select the policy action and
then select a trigger; click Add.

After you edit or remove a policy, click Next. The Confirm page is displayed listing any policies
you have added or removed.

Click Save Policies. The Results page is displayed.
If you need to make changes click Back.

If no changes need to be made, click Done. The Device Groups page is displayed.

Other Ways to Edit Device Group Policies

In the navigation pane, right-click on Device Groups and select Edit group policies.

In the navigation pane, expand the Device Groups tree and right-click on the specific group to edit
and select Edit group policies. (This is only available for the following device lists: Error Devices,
Warning Devices, New (Last Discovery) Devices, and Ungrouped Devices.)

Rename a Device Group

Steps for Renaming a Device Group

Other Ways to Rename a Device Group

You can change the name of a group to give it a more meaningful name.

Steps for Renaming a Device Group

1.
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In the left navigation pane, expand the Device Groups node and right-click on the specific group
to rename; select Rename.

Type the new name and click Enter. A group name:

e must have a unique name within its parent group.
e can be up to 48 characters.

e can have alphabetic characters.

° can have numeric characters.
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e can have special characters (such as “” or “-”).

e can have Unicode characters.

° cannot contain a forward slash or a backward slash.

Other Ways to Rename a Device Group

e You can also rename a group using any of the methods to edit a group:

o In the left navigation pane, right-click on Device Groups and select Edit group.

o In the left navigation pane, right-click on Overview and select Device Groups > Edit

group.

o In the Groups - Management task module, select a device group and click Edit.

° In the left navigation pane, expand the Groups node and right-click on the specific group to

edit; then select Edit group.

View a Device Group

e Steps for Viewing a Device Group

° Other Ways to View a Device Group

You can view device groups that have been created.

Steps for Viewing a Device Group
1. Inthe left navigation pane, expand Device Groups.

2. Select the group you want to view.

Other Ways to View a Device Group

e Inthe Device Groups - Management task module, select a device group and click View.

e Inany device list, click the Groups tab. Select a group and then click View.

Bf NOTE: You must select a group before clicking View.
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Discovery

e All About Device Discovery

e Task Modules for Discovery

° Related Application Options for Discovery

e Discover Devices (the Device Discovery Wizard)

e Schedule a Discovery

° Discovery History

° Discovery Templates

All About Device Discovery
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° Discovering Devices with HP Web Jetadmin 10.0 through Firewalls

° Discovery Types and Methods

Discovery features enable HP Web Jetadmin 10.0 to find devices and then add them to the HP Web
Jetadmin 10.0 device lists. You might have information about the network that can be used in HP Web
Jetadmin 10.0 discovery settings, but some discovery features enable you to search for devices without
networking details.

A powerful discovery engine exists within HP Web Jetadmin 10.0 enabling you to locate most devices
on both small and large networks. HP Web Jetadmin 10.0 includes a new discovery for printers located
in Active Directories (Active Directory Discovery on page 114). Scheduling and discovery templates
allow you to tailor HP Web Jetadmin 10.0 features to any topology or geographically deployed printer
fleet. (See also Schedule a Discovery on page 123 and Create a Discovery Template on page 126.)

New discovery features in HP Web Jetadmin 10.0 include:

e Active Directory Discovery on page 114.

° Import and Export Features of IP Range Files on page 110.

e |IP Range calculator (Setting Realistic Ranges on page 108).

° Discovery History on page 125.

e Discovery Templates (Create a Discovery Template on page 126).

° Blocked Devices on page 81.

e Integrated PC-Connected device discovery (How HP Web Jetadmin 10.0 Discovers PC-Connected
Devices on page 102).

Network devices can be automatically discovered on multiple subnets and then managed. Seven types
of discovery are currently supported:

e  SLP Multicast Discovery on page 105: an SLP Multicast request is sent out on the network to
evoke a response from devices connected to HP Jetdirect print servers.

e |P Broadcast Discovery on page 106: an SNMP Broadcast is sent to the specified Broadcast
address. SNMP Devices respond.
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e |P Range Discovery on page 107: searches for devices within a range of IP addresses.

e  Specified Device Address Discovery on page 112: you can add address lists of known devices to
HP Web Jetadmin 10.0 to query only specific end nodes.

e Active Directory Discovery on page 114: queries Microsoft Active Directory using an Active
Directory starting point such as domain, organization units (OUs), or other Active Directory
containers.

e Domain Discovery on page 116: for PC-Connected devices, the domain is browsed to identify
Windows hosts on the network.

e  Quick Device Discovery on page 104 is also available to discover devices when you add the
hostname or IP address information to this feature anywhere in Device Management. Plus,
HP Web Jetadmin 10.0 can listen for SLP announcements that are propagated from HP Jetdirect-
connected devices. This passive mechanism requires no additional settings and only generates
network traffic when HP Web Jetadmin 10.0 receives an SLP announcement.

In addition to gathering devices that are directly connected to the network, HP Web Jetadmin 10.0 can
find PC-Connected devices. These are devices that are connected through USB or parallel connectors
to either desktops or servers on the network (Discovery Types and Methods on page 100).

When you initially install HP Web Jetadmin 10.0, you will be asked if you want to run a discovery
immediately. You can request to discover devices at any time. By default, HP Web Jetadmin 10.0 does
not listen for SLP broadcasts; when passive SLP is enabled, some devices may be found by this type
of discovery even if you do not initiate a discovery.

Discovering Devices with HP Web Jetadmin 10.0 through Firewalls

Although firewalls provide a secure perimeter for business resources, they can also present a barrier to
software products. HP Web Jetadmin 10.0 provides the ability to discover and manage devices
throughout a business network.

HP Web Jetadmin 10.0 uses Multicast and SLP techniques to discover devices on your network. Using
standard firewall configurations, multicasts are typically blocked because the communication port on
which it relies is blocked. To facilitate a broadcast discovery such as Multicast and SLP, HP Web
Jetadmin 10.0 uses the well-known static port, UDP port number 427. To enable this discovery
technique, the machine running HP Web Jetadmin 10.0 must unblock the port used from within the
firewall settings.

HP Web Jetadmin 8.0/7.8 (and earlier) use the same port numbers as HP Web Jetadmin 10.0. It is not
advised at this time to run HP Web Jetadmin 10.0 and HP Web Jetadmin 8.0/7.8 (and earlier) on the
same server machine. To unblock a particular port, consult your firewall protection product’s help.

To ensure this feature works properly, see Minimum System Requirements for HP Web
Jetadmin 10.0 on page 2 for HP Web Jetadmin 10.0.

Discovery Types and Methods

° How HP Web Jetadmin 10.0 Discovers Network Devices

° How HP Web Jetadmin 10.0 Discovers PC-Connected Devices

° Quick Device Discovery

° SLP Multicast Discovery

° IP Broadcast Discovery
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IP_ Range Discovery

Specified Device Address Discovery

Active Directory Discovery

Passive SLP Discovery

Domain Discovery

Following are the various types of discoveries performed by HP Web Jetadmin 10.0. There are two
distinct types of discoveries:

Network Connected Device Discoveries: find devices on your network. HP Web Jetadmin 10.0
always follows the node-discovery with SNMP queries in order to resolve devices. Once the SNMP
query resolves a device, it is placed in the All Devices list. Resolved devices include any

HP Jetdirect connected hardcopy device, any third party hardcopy device, some HP network
scanners, some HP network projectors, and more. See How HP Web Jetadmin 10.0 Discovers
Network Devices on page 101.

PC-Connected Device Discoveries: discovers PCs and then printers connected directly to them.
This discovery facilitates both learning about devices that are connected directly to PC hosts and
also gathers detailed information about those devices when the SNMP Proxy agent is being used.
This discovery facilitates both learning about devices that are connected directly to PC hosts and
also gathers detailed information about those devices when the SNMP Proxy Agent is being used.
SNMP Proxy Agent is a small software package that can be installed onto a PC and facilitates
HP Web Jetadmin communications with locally connected devices. PC-Connected device
discoveries can be performed without the SNMP Proxy Agent being installed onto remote hosts
but this type of discovery will only gather a minimal amount of device information. See How HP Web
Jetadmin 10.0 Discovers PC-Connected Devices on page 102.

Discovery methods are for the most part shared between PC-Connected and network device types. The
following table shows which discovery option can be selected for each of the two discovery methods:

Table 4-5 Discovery Options for Network Device Discoveries and PC-Connected Device Discoveries

Type of Discovery Network Device Discoveries PC-Connected Device Discoveries
Quick Device Discovery on page 104 Yes No

SLP Multicast Discovery on page 105 Yes No

IP Broadcast Discovery on page 106 Yes Yes

IP Range Discovery on page 107 Yes Yes

Specified Device Address Discovery Yes Yes

on page 112

Active Directory Discovery Yes Yes

on page 114

Domain Discovery on page 116 No Yes

How HP Web Jetadmin 10.0 Discovers Network Devices

HP Web Jetadmin 10.0 uses several methods to find devices connected directly to the network.
Regardless of the method used, HP Web Jetadmin 10.0 first gathers nodes from the network and then
determines which of those nodes is a qualified device. Qualification is always done using the SNMP
protocol. Nodes found are always queried for specific SNMP objects and then determined to be a
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qualified printing/imaging device. Once these devices are qualified, HP Web Jetadmin 10.0 places them
in the All Devices list. Each of the methods used to find network devices will be discussed in the following
sections.

Maintaining Accurate Address Information

HP Web Jetadmin 10.0 has the ability to adjust IP addresses stored for each device. In many cases, IP
addresses on devices will remain static and changes within the HP Web Jetadmin 10.0 device lists won’t
be needed. In a few cases, device addresses may change due to device moves or when device
addresses are assigned with DHCP. In these cases, HP Web Jetadmin 10.0 should be able to cope
with the changes and quickly change its internal record of a device’s IP address.

HP Web Jetadmin 10.0 will automatically change a devices IP address anytime it has realized a change
in that address. For example, a device might have been configured with the IP address 15.62.40.203
yesterday but today it has the IP address 15.62.42.198.

How HP Web Jetadmin 10.0 Discovers PC-Connected Devices

HP Web Jetadmin 10.0 can discover printers connected directly to PCs. This discovery facilitates both
learning about devices that are connected directly to PC hosts and also gathers detailed information
about those devices when the SNMP Proxy Agent is being used. The SNMP Proxy Agent is a small
software package that can be installed onto a PC and facilitates HP Web Jetadmin 10.0 communications
with locally connected devices. PC-Connected discoveries can be performed without the SNMP Proxy
Agent being installed onto remote hosts but this type of discovery will only gather a minimal amount of
device information. This discovery queries desktop and server hosts in order to find locally connected
devices. These are devices that are not connected directly to the network, they are connected to the
LPT ports or USB ports on the local host.

When one of the types of discoveries for PC-Connected devices is invoked, HP Web Jetadmin 10.0
communicates directly with the remote host in one of two ways:

e By looking for an SNMP Proxy Agent on the local PC if the agent exists, HP Web Jetadmin 10.0
begins to query the device through the proxy in much the same way as it queries devices directly
connected to the network. Through the agent, many pieces of information are available including
status, page count, supply levels, and more.

e  Through WMI (Windows Management Instrumentation): WMI is a Microsoft service that runs on
most Windows operating systems and is used by remote management applications to gather
information. HP Web Jetadmin 10.0 performs a query through WMI on workstations found by way
of its various discovery mechanisms. This query attempts to resolve Windows printer model details
for devices that are plug and play compatible. The WMI PC-Connected discovery solution does
not gather status or other details from the device. The WMI PC-Connected discovery also requires
administrator (local) credentials on each host queried.

PC-Connected device discoveries use different query protocols depending on the method used. The
table below shows differences in primary and secondary protocols. The primary protocol is used first
and if communication is possible through the protocol, devices are queried. The secondary protocol is
used when no communication was attained through the primary protocol.

Table 4-6 Primary and Secondary Protocols for PC-Connected Device Discoveries

PC-Connected Device Discovery Primary Protocol Secondary Protocol
Method

IP broadcast SNMP WMI

IP range SNMP WMI
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Table 4-6 Primary and Secondary Protocols for PC-Connected Device Discoveries (continued)

PC-Connected Device Discovery Primary Protocol Secondary Protocol
Method

Specified addresses SNMP WMI

Active Directory SNMP WMI

Domain SNMP WMI

It is important to remember that discovery through the WMI protocol requires administrative access to
the remote host being queried. The local admin password can be used but in many environments a
domain user is granted administrative privileges on local Windows hosts. Administrative credentials are
entered at the time of discovery by using the checkbox, Specify credentials for this discovery.

PC-Connected devices are added to the same All Devices list as are network connected devices.
Devices that are discovered via PC-Connected Devices can be distinguished from other devices.

SNMP Proxy Agent
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HP SNMP Proxy Agent is installed onto remote hosts (workstations or servers) and provides an SNMP
proxy on the remote host that facilitates communications for discovery of locally connected devices.
This proxy used in conjunction with the workstation’s SNMP service captures status, page count and
many other details on devices connected via LPT or USB ports. HP SNMP Proxy Agent is installed as
a service via an executable file or MSI installer that can be obtained from http://www.hp.com. HP SNMP
Proxy Agent can be deployed onto remote hosts through any combination of desktop management
applications or scripting.

e The HP SNMP Proxy Agent is available on the HP Web Jetadmin 10.0 Software and Drivers
downloads page.

e A companion readme.txt file describes agent installation details.
e Two installation types exist and can be run in “silent mode” to afford automation distribution.

e HP SNMP Proxy Agent discoveries only support read-only device queries, configuration, alerts,
and other HP Web Jetadmin 10.0 functionality is not available at this time for these devices.

e Only a single locally connected printer can be discovered.
e  Printers must have a DOT4 bi-directional-capable driver installed in order to be discovered.

e In most cases, the printer model name, engine page count, toner levels, serial number, and more
are available. Many recent enterprise devices support additional objects, while some of the lower
end personal printers may not support many objects at all.

Required settings are listed in the following table.

Table 4-7 Required Settings for HP SNMP Proxy Agent

Required e Intel® Pentium® or Celeron™ processor (Pentium Il or
higher recommended)

e 64 MB RAM (128 MB RAM or higher recommended)

° 10 MB available hard disk space
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Table 4-7 Required Settings for HP SNMP Proxy Agent (continued)

Supported Operating Systems e  Microsoft Windows 2000 (SP 4)
e  Microsoft Windows XP (SP 2)

e  Microsoft Windows Server 2003 Enterprise Edition

Required Operating System Settings and Components e  Microsoft Windows SNMP service must be installed and
configured to allow queries from the HP Web Jetadmin
10.0 server.

e  The community name should be set to public for read
access.

e  Firewall settings should be appropriately modified to
allow HP Web Jetadmin 10.0 to query the proxy agent (for
example, UDP port 161 should be open for SNMP
queries).

Supported Printers The HP SNMP Proxy Agent supports a wide variety of
HP printers as long as they are installed using a DOT4 bi-
directional capable driver.

Administrative Access Administrative rights on the remote Windows host are only
required when installing the HP SNMP Proxy Agent. The agent
remains open and administrative rights are not required for
HP Web Jetadmin 10.0 to perform queries through this agent.

Quick Device Discovery

° Steps for Quick Device Discovery

(For network device discoveries only.)

Quick Device Discovery is comparable to Quick Device Find in earlier versions of HP Web Jetadmin.
If you enter the IP hostname or IP address strings and select Go, this feature searches device addresses
in the HP Web Jetadmin 10.0 database first and then performs a network query. If a device is found at
the address provided, it is added to the HP Web Jetadmin 10.0 All Devices list.

Quick Device Discovery does not search the All Device listin HP Web Jetadmin 10.0; it only acts on
device address detail. Text Search and Advanced Search parses all the strings in the device list and
highlights devices that have a criteria match.

Use Quick Device Discovery if you want to find one device and know its IP address or hostname, or
if you are searching for only one device and do not want to run discovery on your entire network. Quick
Device Discovery is available on the navigation pane (in the left-hand corner at the bottom).

When the device is found, it is added to the All Devices list and selected.

=’ NOTE: IP Hostname can be used in Quick Device Discovery but requires that DNS on page 245
lookups be enabled (they are by default). For security and performance reasons, you can turn them off.

Steps for Quick Device Discovery
1. Start in the Quick Device Discovery box in the left-hand corner of the navigation pane.
2. Enter the device’s IP address or hostname and click Go.

3. The device is added to the All Devices list and selected for easy recognition.
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SLP Multicast Discovery

° Details About Running an SLP Multicast Discovery

(For network device discoveries only.)

A discovery using SLP multicast requires minimal settings to launch. SLP (service location protocol) is
used to cast a query onto the network for the purpose of finding HP Jetdirect devices. After initial device
response, SNMP follow-up queries are performed to learn more about devices and add them to the All
Device list in HP Web Jetadmin 10.0. This discovery mechanism finds HP Jetdirect devices on both
local and remote subnets.

Characteristics of an SLP Multicast discovery for network devices include:
e  Multicast packets are sent to the HP Jetdirect-specific multicast address: 224.0.1.60.

e  Packets contain a router hop-counter (IP time to live attribute) that can be set from within HP Web
Jetadmin 10.0 (default 4 hops).

e Packets expire when router hop-counter reaches zero.

e  The discovery mechanism is fast.

e The discovery presents low network traffic.

e  HP Jetdirect firmware must be at least x.06.00 or greater.
e  Only HP Jetdirect-connected printers will be discovered.
The reach of SLP multicast discovery will depend upon the:

e setting for Routers to cross (hops) (a configuration option for Discovery; see General
on page 120).

e configuration of the network routers; if the router is configured to pass multicast requests on to
other sections of your network, then a discovery could potentially discover devices on your entire
network.

The other option to control the reach of the discoveries is to configure the multicast request to span a
certain number of routers (General on page 120). Spanning routers will require the routers to be
configured to allow multicast request to be forwarded.

The discovery could also be affected by the configuration of your local firewall (Discovering Devices
with HP Web Jetadmin 10.0 through Firewalls on page 100).

If the router is configured to pass multicast requests on to other sections of the network, and
Discovery is configured to cross multiple routers, then a discovery could potentially discover devices
across multiple subnets and perhaps your entire network.

Details About Running an SLP Multicast Discovery
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(For network device discoveries only.)

If one of the discovery methods you choose is SLP multicast (while creating templates (Create a
Discovery Template on page 126), editing templates (Edit a Discovery Template on page 128), or
scheduling (Schedule a Discovery on page 123)), then the Choose SLP multicast settings page is
displayed. On this page, select the number of routers to cross (or hops) for the discovery. Increasing
the number of hops might increase the amount of time for the discovery to complete; plus, it generates
more network traffic than a discovery with fewer routers to cross.
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IP Broadcast Discovery

° IP Broadcast Discoveries for Network Devices

° IP Broadcast Discoveries for PC-Connected Devices

° Details About Running an IP Broadcast Discovery

IP Broadcast discoveries send SNMP query packets (in the form of IP broadcasts) to one or more IP
network(s). These are used in both PC-Connected and network device discoveries.

IP Broadcast Discoveries for Network Devices

An IP Broadcast discovery enables you to find devices or HP Web Jetadmin installations when IP
broadcast addressees are known. IP broadcast discoveries send SNMP query packets (in the form of
IP broadcasts) to one or more IP network(s). One network-specific broadcast address exists for each
IP subnet on an IP intranet. IP subnets are determined by the IP network number and the IP subnet
mask. IP calculators, available free on the Internet, are a great way to determine IP broadcast addresses.
An all 1s IP broadcast can also be used to query the entire intranet. Broadcasting is typically blocked
by routers due to traffic spike concerns.

Characteristics of IP broadcast discoveries for network devices include:

e Sends SNMP queries over one or more IP broadcasts.

e Listens for replies and then qualifies network connected devices.

e Default broadcast is the Global Broadcast Address (255.255.255.255).

e Can use one or more known |IP broadcast addresses with optional address descriptions.
e Limited checking is performed to determine if the broadcast address is valid.

e Fast and thorough, especially on a local segment.

° Most modern networks block broadcast traffic.

IP Broadcast Discoveries for PC-Connected Devices

IP broadcast discoveries for PC-Connected devices send an SNMP query to the IP broadcast address
specified. An all 1s broadcast is the default. Systems with the SNMP Proxy Agent first answer with the
operating system. HP Web Jetadmin 10.0 follows up with queries to both host and to printer specific
objects. IP Broadcast discovery does not attempt WMI queries when no SNMP proxy agent exists.

Characteristics of IP broadcast discoveries for PC-Connected devices include:
e  Settings are the same as network device.
e SNMP queries are attempted on discovered nodes.

e If no SNMP Proxy Agent response, WMI queries are performed when credentials exist in settings.

Ef NOTE: Microsoft Windows Server 2003 with the SNMP Proxy Agent does not always respond to IP
broadcasts from the HP Web Jetadmin server. It is recommended that alternate discovery methods be
used to find locally connected devices on Microsoft Windows Server 2003.
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Details About Running an IP Broadcast Discovery

1. Inthe left navigation pane, click Discovery and then click Discover devices on my network (in
the Discovery - Current Tasks task module). The Device Discovery wizard is started with the
Specify discovery options page displayed.

2. Select Specify settings and then select IP broadcast. Click Next. The Select IP broadcast
address page is displayed.

3. Youcan:
e Select a broadcast address.

e Add: add a broadcast. Type the address in Address and type a description (if desired) in
Description. Then click Add.

e Show favorites only: view only the broadcast addresses you have added by clicking Show
favorites only (at the bottom of the page).

e Remove: remove addresses from the list by highlighting the address and clicking Remove.

e Customize: add or remove addresses to favorites by clicking Customize. Then select an
address and click Add Favorite or Remove Favorite. When done, click OK (Customizing IP
Range Discoveries on page 111).

4. Click Next.

IP Range Discovery

e Setting Realistic Ranges

° Import and Export Features of IP Range Files

° IP_ Range Discoveries for Network Devices

° Customizing IP Range Discoveries

° IP_ Range Discoveries for PC-Connected Devices

° Details About Running an |IP_Range Discovery

In contrast to running a broadcast discovery (where all devices or HP Web Jetadmin installations in the
subnet are queried), you can choose to discover a specified IP range or a number of IP ranges. This
reduces network traffic and eliminates the possibility of having unwanted devices. HP Web Jetadmin
installations show up in the database. IP Range discovery searches for devices or HP Web Jetadmin
installations within a range of IP addresses. This type of discovery is accurate and thorough but can be
slow for large ranges.

IP Range Discovery is effective when the administrator has knowledge of IP segments. Administrators
use IP Range Discovery settings to map IP segments or groups of IP segments into HP Web Jetadmin
10.0 discovery. This method efficiently sweeps selected portions of the network or WAN. IP Range
address pairs consist of beginning and ending IP addresses. IP Range discoveries first ping specific IP
addresses as defined by range address pairs. If the device responds, HP Web Jetadmin 10.0 follows
with SNMP queries. Multiple ranges can be specified in IP Range discoveries. HP Web Jetadmin 10.0
pings in bursts of 30 queries to the first set of addresses from the first range and then waits one second
before sending the next burst of 30 queries.
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Setting Realistic Ranges

e Setting Ranges Based on Subnets or Contiguous Subnets

Most networks are divided up into subnets, which can be used to describe a network IP addressing
scheme and are sometimes referred to as IP maps. A subnet within a large network can be described
with a network number and a subnet mask. This is an example of one subnet with an IP range of
15.5.188.1 through 15.5.191.254:

e Network number example: 15.5.188.0
e  Subnet mask example: 255.255.252.0

There are 1,022 possible addresses on this subnet. It may take HP Web Jetadmin 10.0 only about 10
minutes to discover devices on this network depending on the network, the number of devices on that
network, and the host on which HP Web Jetadmin 10.0 is installed.

NOTE: IP address calculators are an easy way to analyze IP networks. Many free versions of IP
calculators exist and can be obtained on the Internet.

IP Range discovery can perform to expectations when the range data has been correctly developed. It
is easy to configure ranges that are larger than needed and actually cause the discovery to take a long
time and perhaps even yield little in the way of devices. For example, a class A range could easily be

developed for the HP intranet but would literally take weeks to complete. On most large networks, the

majority of the IP addresses won't answer the HP Web Jetadmin 10.0 query and will cause timeouts to
occur; these translate into very long discovery times.

If you specify an IP range that is very large, your network might crash if that IP range is for a class A or
class B network (when the first two octets of the IP range are not the same). HP Web Jetadmin 10.0 will
display a warning message stating that a large range might cause a large amount of network traffic; you
can choose to continue or change the range.

You can choose to specify a large subnet range using the larger subnet address feature (Tools >
Options > Application Management > IP Ranges > General). Large networks are considered any
network bigger than a Class B network, which has up to 65,000 nodes.

Setting Ranges Based on Subnets or Contiguous Subnets

By

Since large IP ranges can cause HP Web Jetadmin 10.0 discovery to take long periods of time to
complete, it can be useful to use subnet ranges rather than the entire network for a discovery. These
subnets, when put together into one list, represent an IP map. This type of a map can be obtained from
an IT or Network Infrastructure team. It is also a good idea to work with these teams to discuss plans
for implementing HP Web Jetadmin 10.0 discoveries.

NOTE: Hewlett-Packard strongly recommends that you discuss HP Web Jetadmin 10.0 discoveries
with your information technology or network administration team.

Here is an example of IP range planning. Assume we have 27 subnets on our hypothetical network. All
of these subnets use the same subnet mask of 255.255.255.0. Here are the network numbers that
represent our 27 subnets:

15.0.1.0, 15.0.2.0, 15.0.3.0, 15.0.4.0, 15.0.5.0, 15.0.30.0, 15.0.31.0, 15.0.32.0, 15.0.33.0, 15.0.34.0,
15.0.35.0, 15.0.36.0, 15.0.37.0, 15.0.38.0, 15.0.39.0, 15.0.55.0, 15.0.64.0, 15.0.65.0, 15.0.66.0,
15.0.67.0, 15.0.68.0, 15.0.69.0, 15.0.70.0, 15.0.71.0, 15.0.72.0, 15.0.73.0, 15.0.74.0
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From this information, we can formulate the following IP address ranges and import them into HP Web
Jetadmin 10.0:

15.0.1.1-15.0.1.254

15.0.2.1-15.0.2.254

15.0.3.1-15.0.3.254

15.0.4.1-15.0.4.254

15.0.5.1-15.0.5.254

15.0.30.1-15.0.30.254
15.0.31.1-15.0.31.254
15.0.32.1-15.0.32.254
15.0.33.1-15.0.33.254
15.0.34.1-15.0.34.254
15.0.35.1-15.0.35.254
15.0.36.1-15.0.36.254
15.0.37.1-15.0.37.254
15.0.38.1-15.0.38.254
15.0.39.1-15.0.39.254
15.0.55.1-15.0.55.254
15.0.64.1-15.0.64.254
15.0.65.1-15.0.65.254
15.0.66.1-15.0.66.254
15.0.67.1-15.0.67.254
15.0.68.1-15.0.68.254
15.0.69.1-15.0.69.254
15.0.70.1-15.0.70.254
15.0.71.1-15.0.71.254
15.0.72.1-15.0.72.254
15.0.73.1-15.0.73.254
15.0.74.1-15.0.74.254
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We can take the formulation one step further and simplify things. Some of the IP ranges are contiguous.
These contiguously-addressed subnets are one after the other, in order, making it easy to combine
them. The final result would look like this:

e 15.0.1.1-15.0.5.254

e 15.0.30.1-15.0.39.254
e 15.0.55.1-15.0.55.254
e 15.0.64.1-15.0.74.254

This has reduced the number of IP ranges from 27 to 4. We can build this into a form that is easily
imported into HP Web Jetadmin 10.0 and also reflects descriptions. Here is an example of data that can
be imported via a text file:

e 15.0.1.1-15.0.5.254 = subnet range for western area

e 15.0.30.1-15.0.39.254 = subnet range for central area
e 15.0.55.1-15.0.55.254 = subnet range for branch office
e 15.0.64.1-15.0. 74.254 = subnet range for eastern area

Consolidating ranges makes dealing with large quantities of data simpler but may not help when
descriptions are needed for the purpose of cataloging ranges.

Import and Export Features of IP Range Files

IP Range

IP range data can be developed in other tools and imported through text files. In fact, HP Web Jetadmin
10.0 can export IP range data to text files. This makes it easier to deal with large numbers of IP ranges,
manipulate complex data and archive data for use in multiple instances. Tile format for IP Range import
and export file format can be broken down as follows:

e 1 range perline
e Each IP address is separated by a hyphen character (-)
e Comment or description strings can be appended to the IP range by using an equal character (=)

Here is an example of 1 IP range with a comment: XXX.XXX.XXX.XXX-XXX.XXX.XXX.Xxx=descriptive text
string (where xxx represents an octet in the IP address).

There is no known limit to the number of IP ranges manageable within HP Web Jetadmin software. IP
ranges are also used by other features like PC-Connected printer discovery and HP Web Jetadmin
Installations discovery. All IP ranges entered into HP Web Jetadmin can also be managed globally from
within Tools > Options > Application Management > IP Ranges > IP Ranges.

Discoveries for Network Devices

IP Range discoveries for network devices or HP Web Jetadmin installations first send an SNMP query
to all addresses within the range. When nodes are discovered, HP Web Jetadmin 10.0 performs queries
to determine qualified devices. These qualified devices, when found, are added to the device lists.

Characteristics of IP range discoveries for network devices or HP Web Jetadmin installations include:
e |IP ranges are simply two addresses that represent range begin and end points.

e  Multiple ranges can be specified in an IP Range discovery.
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e |IP range data can be manually added through the user interface.
e [P ranges can be imported to HP Web Jetadmin 10.0 from text files.
e  Multiple IP ranges can be added and with optional, descriptive tags.
e HP Web Jetadmin 10.0 sends 1 query to each address represented by the range.
e HP Web Jetadmin 10.0 pings the device ranges in bursts of 30.
e HP Web Jetadmin 10.0 has features to calculate IP ranges based on:
° Local client host
o HP Web Jetadmin 10.0 server host
° Device
e HP Web Jetadmin 10.0 IP Range discoveries have proven to be effective, accurate and thorough.
e HP Web Jetadmin 10.0 IP Range discoveries can be very slow if not configured properly.

e HP Web Jetadmin 10.0 IP Range discoveries can draw security attention due to their scanning
action.

Customizing IP Range Discoveries

When you are setting up an IP Range discovery, you have the option to customize the IP Ranges. You
can customize IP Ranges in two places within HP Web Jetadmin 10.0. In Device Management >
Discovery, select IP Ranges as the type of discovery and then select Customize. In Application
Management > Web Jetadmin Management, in the Common Tasks task module click Find Web
Jetadmin installations and select IP ranges as the type of discovery; then select Customize. You can
choose to add or remove addresses to favorites by selecting an address and clicking Add Favorite
or Remove Favorite.

IP Range Discoveries for PC-Connected Devices

IP Range discoveries for PC-Connected devices first send an SNMP query to all addresses within the
range. If SNMP communication is possible on a device, the discovery attempts to find a locally connected
printer. If no SNMP communication is possible and if the user provided administrative credentials, the
discovery will attempt to find a locally connected printer on the device.

Characteristics of IP range discoveries for PC-Connected devices include:
e IP Range scanning is same as network connected.

e Nodes representing hosts are detected.

e  SNMP queries are attempted on discovered nodes.

e If no SNMP Proxy Agent response, WMI queries are performed when credentials exist in settings.

Details About Running an IP Range Discovery
The Select IP ranges page is displayed when you choose IP range as the discovery method while:

e creating discovery templates (Create a Discovery Template on page 126)

e editing discovery templates (Edit a Discovery Template on page 128)
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e scheduling a discovery (Schedule a Discovery on page 123)

e running a Web Jetadmin discovery (Find Web Jetadmin Installations on page 277)

On the Select IP ranges page, you can select the IP address ranges displayed or you can edit the
ranges.

1. Choose the action to take:
e Selectan IP range.

e Add: add an IP range by clicking Add. Type the range in First address and Last address;
then type a description (if desired) in Description. Click Add.

To calculate a range, click Calculate range. The Calculate IP Range page is displayed:

0 Subnet from my computer: automatically use |P address ranges currently found on the
local subnet of your computer. You can add a description in Description if desired.

0 Subnet from WJA server: automatically use IP address ranges currently found on the
subnet of the HP Web Jetadmin 10.0 server. You can add a description in Description
if desired.

o Subnet from network address: type a known IP address and subnet mask. You can
add a description in Description if desired.

e Edit: make changes to IP ranges by clicking Edit. Follow the steps in the bullet above for
“Add!!.

o Delete: remove addresses from the list by highlighting the address and clicking Delete.
e Import: if desired, import a range list by clicking Import and then browse for the range list.

e Export: if desired, export a range list by clicking Export and then browse for location you want
to store the range list.

e Show favorites only: view only the IP ranges you have added by clicking Show favorites
only (at the bottom of the page).

e Customize: add or remove addresses to favorites by clicking Customize. Then select an
address and click Add Favorite or Remove Favorite. When done, click OK.

2. Click OK.

Specified Device Address Discovery

° Specified Device Address Discoveries for Network Devices

e Specified Device Address Discoveries for PC-Connected Devices

° Details About Running a Specified Device Addresses Discovery

Sometimes there is enough information about your device fleet that enables building a base of device
addresses. These addresses can be added to HP Web Jetadmin through the Specified Address
discovery feature. Specified Device Address discoveries use an explicit list of device addresses. These
addresses can be IP hostnames or IP addresses. IP hostnames can have fully qualified domain
information appended. Address information can be both imported from and exported to text files.
Specified Device Address discovery works similarly to IP Range discovery; HP Web Jetadmin simply
moves down a list of addresses, performing queries and adding qualified devices to the all devices list.

112 Chapter 4 Device Management ENWW



Here is an example of a small specified address base:

15.5.2.1

15.5.62.4

15.5.8.3

15.5.8.7
BP005a.yourco.com
BP065

BP076.yourco.com

B NOTE: For PC-Connected device discoveries, HP Web Jetadmin 10.0 follows SNMP queries with
WMI queries when no SNMP Proxy Agent has been detected on the remote host.

Specified Device Address Discoveries for Network Devices

Network device discovery queries each address in the list specified. Devices qualified through these
queries are added to the All Devices list.

Characteristics of Specified Device Address discoveries for network devices include:

Specified device address discoveries find devices based on user supplied addresses.
IP address or hostnames are valid address forms.
HP Web Jetadmin 10.0 initially qualifies the device by using an SNMP query.

Follow-up queries through SNMP qualify the device and place it into the All Devices list if
appropriate.

This discovery is very fast and only hits the addresses specified by the user.
This discovery is only as accurate as the address base specified by the user.

Addresses can be entered into HP Web Jetadmin 10.0 one by one or they can be imported from
text file.

In HP Web Jetadmin 10.0, addresses can be exported to text file.

Specified Device Address Discoveries for PC-Connected Devices
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Specified Address discoveries for PC-Connected devices first send an SNMP query to all addresses
within the list of addresses. If SNMP communication is possible on a device, the discovery attempts to
find a locally connected printer. If no SNMP communication is possible and if the user provided
administrative credentials, the discovery will attempt to find a locally connected printer on the device
using WMI protocol.

Characteristics of Specified Device Address discoveries for PC-Connected devices include:

Specified address scan is the same as network connected.

Nodes representing hosts are detected.
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e  SNMP queries are attempted on discovered nodes.

e If no SNMP Proxy Agent response, WMI queries are performed when credentials exist in settings.

Details About Running a Specified Device Addresses Discovery

If one of the discovery methods you choose is Specified address (while creating templates (Create a
Discovery Template on page 126), editing templates (Edit a Discovery Template on page 128), or
scheduling (Schedule a Discovery on page 123)), then the Select addresses page is displayed. On
this page, you can select the IP address ranges displayed or you can edit the addresses:

1. In the left navigation pane, click Discovery and then click Discover devices on my network (in
the Discovery - Current Tasks task module). The Device Discovery wizard is started with the
Specify discovery options page displayed.

2. Select Specify settings and then select Specified addresses. Click Next. The Select
addresses page is displayed.

3. Click Edit Addresses. The Specified Addresses page is displayed.

4. Type the network address in Network address and click Add Address; the address is displayed
below in the box. Repeat this until you have entered all network addresses.

5. Check Show For Me next to each IP address you want to include on the Select IP ranges page
(the previous page).

6. If desired, remove any ranges by highlighting it and clicking Remove Address.
7. If desired, import a range list by clicking Import Addresses and then browse for the range list.

8. Ifdesired, export a range list by clicking Export Addresses and then browse for location you want
to store the range list.

9. Click OK and then click Next. The Confirm page is displayed.
10. Click Start. The Results page is displayed. Click Done.

Active Directory Discovery

e Active Directory Discoveries for Network Devices

e Active Directory Discoveries for PC-Connected Devices

° Details About Running an Active Directory Discovery

Active Directory Discovery requires your knowledge about the Active Directory domain. HP Web
Jetadmin 10.0 provides a new discovery feature that queries Microsoft Active Directory using an Active
Directory starting point such as domain, organization unit (OU), or other Active Directory containers. In
the case of network devices, HP Web Jetadmin 10.0 scans the Active Directory for published shared
printers. In the case of PC-Connected device discovery, HP Web Jetadmin 10.0 scans the active
directory for Windows hosts. From these initially discovered lists of nodes, HP Web Jetadmin 10.0 finds
and qualifies devices and then adds them to the All Devices list.

Active Directory Discoveries for Network Devices

Active Directory (AD) discovery requires your knowledge about the AD domain. Once the AD discovery
is started, the LDAP protocol is used to query AD for published print shares. From print shares
discovered, the Port Name field is checked for the default name forms which are: IP < ipaddr »>
orIP < ipaddrA >< port >.Ifthese defaults are detected, IP addresses are queried through SNMP
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to detect network connected printers. When network connected devices are discovered, they are added
to the HP Web Jetadmin 10.0 All Devices list. No special user credentials are needed other than device
based SNMP Get Community strings (normally not used). In fact, HP Web Jetadmin 10.0, running under
the low privilege account, Network Service, takes the credentials of the user logged in through the

HP Web Jetadmin 10.0 client and uses these to query the Active Directory.

You can choose to perform recursive queries meaning any sub-units below the specified path will be
searched. The administrator can also perform discovery on multiple Active Directory locations. And, the
discovery can also be filtered on both location and description strings if these are published to the Active
Directory.

Characteristics of Active Directory discoveries for network devices include:
e You can activate Active Directory discovery by specifying AD location(s).
e You can optionally set location and/or description filtering to narrow Active Directory discovery.

e  You can optionally specify Active Directory recursion searching to one or all levels below the
specified AD location or locations.

e Active Directory discovery scans the directory for printer shares.

e |P addresses that are resolved from printer shares are queried using SNMP.

e Printers that are qualified are populated into HP Web Jetadmin 10.0’s All Devices list.

e Discovery is fast.

e Discovery does not require any special privileges and relies on public Active Directory search.

e Discovery is accurate to the extent that network printers are shared and published through Active
Directory.

e Discovery relies on the fact that a default port name in the Active Directory share actually contains
the printer’s IP address.

Active Directory Discovery discovers published print queues in a network’s Active Directory. To
find the IP address of the network device to which the print queue is attached, AD discovery parses
the print queue’s port. An IP address can only be detected from those print queues with ports with
the default format of IP_www.xxx.yyy.zzz.

Active Directory Discoveries for PC-Connected Devices
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Active Directory discoveries for PC-Connected devices use the LDAP protocol to identify Windows hosts
on the network. Each host identified is queried using the WMI protocol. Administrative credentials are
required for this discovery. Once a connection is established through WMI, the host is queried for a
locally connected printer.

Characteristics of Active Directory discoveries for PC-Connected devices include:

e  Settings are identical to discoveries for network devices.

e Discoveries for PC-Connected devices scan Active Directory for Windows hosts.

e  SNMP queries are attempted on discovered nodes.

e If no SNMP Proxy Agent response, WMI queries are performed when credentials exist in settings.

e Local administrator credentials are required to perform this discovery.
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Details About Running an Active Directory Discovery

Start here if one of the discovery methods you choose is Active Directory (while creating templates
(Create a Discovery Template on page 126), editing templates (Edit a Discovery Template

on page 128), or scheduling (Schedule a Discovery on page 123)), then the Specify Active Directory
options page is displayed. On this page, you can define options for Active Directory discoveries:

1. Type the path for the Active Directory location or browse to it. Then click Add; it will be displayed
in the list below.

2. Check next to any location you want included in the discovery.
3. Ifdesired, remove any ranges by highlighting it and clicking Remove.
4. Select the recursion level:

e Current level: discoveries check the container specified by the path and the contents of any
containers in the path.

e All levels: discoveries check the container specified by the path plus the contents of all
containers and sub-containers in the path.

5. Specify the print queue filter to use in Filter.

6. Click Next.

Passive SLP Discovery
(For network device discoveries only.)

When HP Jetdirect-connected devices are power-cycled, they propagate SLP (service location protocol)
multicast packets. When HP Web Jetadmin 10.0 detects an HP Jetdirect SLP multicast (recognized by
the source 124.0.1.60), it performs follow-up SNMP queries and adds the device to the All Devices list.

Characteristics of Passive SLP discoveries for network devices include:

e Passive SLP discovery is quiet; HP Web Jetadmin 10.0 does not propagate traffic unless a
previously undetected device announces itself.

e HP Web Jetadmin 10.0 listens for UDP traffic on port 427.

e Devices, including new devices, are discovered as they are powered on.
e Router filtering may inhibit multicast packets.

e Can be disabled on HP Jetdirect print servers.

e  Will only discover HP Jetdirect-connected print servers.

Domain Discovery

° Details About Running a Discovery Using Domains

(For PC-Connected device discoveries only.)

For Domain discoveries for PC-Connected devices, the domain is browsed to identify Windows hosts
on the network. Each host identified is queried using the SNMP or WMI protocol. Administrative
credentials are required for WMI. For WMI, once a connection is established the host is queried for a
locally connected printer.
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Characteristics of domain discoveries for PC-Connected devices include:

e  SNMP queries are attempted on discovered nodes.

e If no SNMP Proxy Agent response, WMI queries are performed when credentials exist in settings.
e  Might be slow on large domains.

e Local administrator credentials are needed to perform this discovery.

Details About Running a Discovery Using Domains

Start here if one of the discovery methods you choose is Domain (while creating templates (Create a
Discovery Template on page 126), editing templates (Edit a Discovery Template on page 128), or

scheduling (Schedule a Discovery on page 123)), then the Select domains page is displayed. On this
page, you can select the domains to include in the discoveries:

1. Type the domain in Domain or browse for the domain. Then click Add. The domain is displayed
in the Domain box below.

To remove any domains from the Domain box, highlight the domain and click Remove.

2. Click Next.

Task Modules for Discovery

° Discovery - Current Tasks and Common Tasks Task Modules

° Discovery - Summary Task Module

° Discovery - Active Discoveries Task Module

° Discovery - Scheduled Discoveries Task Module

° Discovery - Templates Task Module

° Discovery - Quick Monitor Task Module

The following task modules can be displayed or hidden in Discovery.

Discovery - Current Tasks and Common Tasks Task Modules
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The Discovery - Current Tasks task module can be displayed on the Discovery page and includes
the following tasks:

° Discover Devices (the Device Discovery Wizard) on page 121

e Schedule a Discovery on page 123

e Create a Discovery Template on page 126

e Apply (or Run) a Discovery Template on page 127

° Edit a Discovery Template on page 128

° Delete a Discovery Template on page 128

The Discovery - Current Tasks task module can be displayed in other areas of HP Web Jetadmin 10.0;
in the other areas it is called Discovery - Common Tasks.
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Discovery - Summary Task Module
The Discovery - Summary task module gives you the date and time of the last discovery. You can:

e View Configuration History on page 138.

° Discover Devices (the Device Discovery Wizard) on page 121.

Discovery - Active Discoveries Task Module

The Discovery - Active Discoveries task module shows you any discoveries currently running. You
can:

e  Stop a discovery by highlighting it and clicking Stop.

e View the progress of the discovery by highlighting it and clicking View.

Discovery - Scheduled Discoveries Task Module

The Discovery - Scheduled Discoveries task module shows you any discoveries that are scheduled
to run but that have not run yet. You can:

° Delete a Discovery Template on page 128

° Edit a Discovery Template on page 128

Discovery - Templates Task Module
The Discovery - Templates task module enables you to perform any action on a discovery template:

e Apply (or Run) a Discovery Template on page 127

e Create a Discovery Template on page 126

° Delete a Discovery Template on page 128

° Edit a Discovery Template on page 128

e View. The following is displayed:
0 Discovery type: network device discovery or PC-Connected device discovery.
o Credentials specified: whether or not credentials were requested for devices.

o Use global credentials: uses credentials established in Tools > Options > Credentials
(does not require you to provide credentials).

o Discovery methods: a summary of the different methods used.
From this summary template page, you can:

° Edit (Edit a Discovery Template on page 128).

° Apply (Apply (or Run) a Discovery Template on page 127).

° Delete (Delete a Discovery Template on page 128).
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Discovery - Quick Monitor Task Module

The Discovery - Quick Monitor task module enables you to discover a specific device and monitor its
status all in one step. Enter the device’s IP address in Device and then click Go; or drag a device from
any device list into the quick monitor task module.

e Go: type an IP address or hostname in Device and click Go; the device status and information is
displayed.

e Clear: removes all information from the Quick Monitor task module.

e Open: when activated in the Device Management view, brings the user to the All Devices list with
the device specified in Quick Monitor task module selected within the All Devices list.

Related Application Options for Discovery

e SNMPv3 Enabled Devices

e General
° Network

Discovery settings refine the way HP Web Jetadmin 10.0 performs a discovery in your own environment.

SNMPv3 Enabled Devices

ENWW

Devices that have SNMPv3 fully enabled can be discovered by HP Web Jetadmin 10.0. To discover
these devices, enable Discover SNMPv3 devices in Tools > Options > Device Management >
Discovery.

HP Web Jetadmin 10.0 requires SNMPv3 credentials for these devices in order for them to be
discovered. There are two ways HP Web Jetadmin 10.0 can become aware of device SNMPv3
credentials:

e HP Web Jetadmin 10.0 is used to enable SNMPv3 and also configure the SNMPv3 credentials
onto the devices. In this case, HP Web Jetadmin 10.0 stores the credentials into its credential store
and uses them whenever device communication is required. HP Web Jetadmin 10.0 also marks
these devices as SNMPv3-enabled and remembers to use the credentials and SNMPv3 whenever
communication is required.

e HP Web Jetadmin 10.0 has had SNMPv3 credentials added to the Global credentials store and
these credentials match those credential values on the devices. In this case, HP Web Jetadmin
10.0 is being made aware of credential values that work for devices that are SNMPv3-enabled.
When one of these devices is encountered, HP Web Jetadmin 10.0 will try the credential values
that are configured using the option SNMPv3 Credentials in Tools > Options > Application
Management > Credentials. If the credential values work and HP Web Jetadmin 10.0 is able to
communicate with the devices, the credential values will be stored individually for each device.

Devices that were discovered through SNMPv1 and have had SNMPv3 enabled through some other
means such as Embedded Web Server or another instance of HP Web Jetadmin 10.0 will indicate a
communication failure when HP Web Jetadmin 10.0 attempts to re-establish communication. The
Refresh Selection (Full) command can be used on these devices to cause HP Web Jetadmin to reset
them to SNMPv3-enabled devices.
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B NOTE:
setting for Discover SNMPv3 Devices must be configured in Tools > Options > Device
Management > Discovery > General. No new SNMPv3 devices will be added to the database unless
this option is enabled.

If SNMPv3 communication was established outside of HP Web Jetadmin, the global discovery

General

General Discovery settings include settings for SLP Listen, SNMPv3, and discovery history (or

statistics).

149,

B NOTE: HP Jetdirect firmware version x.06.00 or greater is required to support the Multicast and SLP

discovery method.

Follow these steps:

1.

On the top menu bar, access Tools > Options and expand Device Management.

Expand Discovery and then select General.

Configure the desired settings:

Listen for new devices (passive discovery): Select this to use passive discovery (on port
427 for SLP signals propagated at HP Jetdirect power-on). (The default for this field is off or
unchecked.)

Discover SNMPv3 devices: Select this to enable SNMPv3 credential entry fields in HP Web
Jetadmin 10.0 discovery settings. When these credentials are added (at discovery settings or
global credentials), HP Web Jetadmin 10.0 attempts SNMPv3 queries on devices. (The
default for this field is off or unchecked.)

NOTE: SNMPv3 discoveries can be slow if not properly set. These should be targeted at
only parts of the network that are known to have SNMPv3-enabled devices. Also, SNMPv3
devices require that SNMPv3 Credentials are entered.

Retention: Select the number of days to retain statistics from discoveries (the default is 90)
(Discovery History on page 125).

To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.
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Network

Related options that can be set in HP Web Jetadmin 10.0 through Tools > Options > Application
Management > Network include:

SNMP on page 244:

° SNMPv1 timeout value: specify how long HP Web Jetadmin 10.0 should wait for a reply from
a network query from SNMPv1 devices (the default is 500ms).

° SNMPv3 timeout value: specify how long HP Web Jetadmin 10.0 should wait for a reply from
a network query from SNMPv3 devices (the default is 1,000ms).

0 SNMP retries: specify how many times HP Web Jetadmin 10.0 should retry an SNMP
communication with devices before giving up once a timeout has occurred (the default is 3
total attempts).

DNS on page 245 (Enable DNS lookups): forces HP Web Jetadmin 10.0 to query name services
for each device discovered. This setting is sometimes disabled in environments where DNS
responses are slow or are not functioning. (The default is on.)

IP Ranges on page 248: global store for IP Range settings used by network device discovery, PC-
Connected device discovery and HP Web Jetadmin 10.0 application discovery.

Credentials on page 252: in some cases, credentials like SNMP Get Community Name

on page 255 or SNMPv3 Credentials on page 257 are being used. Use Credentials to set well
known device credentials. These will be tried during discovery when devices don’t respond to
queries that use default credentials.

Discover Devices (the Device Discovery Wizard)

Discover Devices

Steps to Discover Devices

Other Ways to Discover Devices

Discover Devices launches the HP Web Jetadmin 10.0 Device Discovery wizard. This wizard is used
to launch or schedule any type of active discovery method. The wizard ends with a Results page that
can be monitored or hidden.

Discover Devices
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Node-discovery and node-resolve progress are both reported through a Results page, which is the last
page displayed as part of the Discovery wizard.

The Results page displays progress for the different portions of a discovery. This can make it easy to
determine which method is currently executing or whether node-discovery or node-resolve portions have
begun execution. Here is a list of items displayed on the Results page:

Progress: shows a throbber graphic and percentage complete, or it shows that the discovery is
complete.

Started by: shows the user that initiated the discovery.
Progress (estimated): shows an overall estimated percentage.

Current method: states the current method executing (IP Range, and so forth).
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Nodes found: shows a count of nodes responding so far.
Nodes resolved: shows the number of nodes being resolved.

Devices found (this discovery): shows a count of nodes that are qualified devices (network or
PC-Connected).

New devices (this discovery): shows a count of devices that are new since last discovery.

Steps to Discover Devices

1.

10.

In the left navigation pane, click Discovery and then click Discover devices on my network (in
the Discovery - Current Tasks task module). The Device Discovery wizard is started with the
Specify discovery options page displayed.

To use a discovery template that has already been created, select it from the drop-down list.

Select the type of discovery you want to perform (Network devices or PC-Connected devices).

NOTE: For more information about any of the types of discoveries, see Discovery Types and
Methods on page 100.

Select the discovery method you want to use (at least one must be selected) (Discovery Types and
Methods on page 100).

If you want to specify credentials for this discovery, check Specify credentials for this
discovery. This is used if devices have been configured for SNMPv3, or if non-standard SNMP
Get Community Names are being used.

To run this discovery later, check Schedule discovery. To run this discovery now, leave this box
unchecked.

NOTE: If you schedule a task (for example, a discovery or a configuration or others) using a
corresponding template, the task uses the settings defined in the template at the time the task
starts. This makes it easy to redefine settings used in a regularly scheduled task without having to
delete and create a scheduled task.

NOTE: All HP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin
install host. The client system being used to access HP Web Jetadmin may or may not be in the
same time zone as the HP Web Jetadmin install host. You should be aware of the time and possible
date differences when configuring HP Web Jetadmin 10.0 scheduling.

Click Next.

Depending on the discovery options selected, you will be asked to specify configurations. In most
cases you can edit the criteria listed by clicking Edit.

If you chose to schedule this discovery, the Specify schedule options page is displayed:
a. Select the start date and time from the drop-down lists.
b. Select the recurrence for this schedule.

c. Enter the name of this schedule in Name and click Next.

NOTE: For more information about scheduling discoveries, see Schedule a Discovery
on page 123.

The Confirm page is displayed. If all of the settings are correct, click Start.
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11. The Progress page is displayed showing you the Discovery’s progress. To hide the discovery
click Hide; to stop the discovery click Stop.

12. When the discovery has completed (or if you click Stop during the discovery), the Results page
is displayed:

° To view the discovered devices, check View all devices.

° To exit, click Done.

Other Ways to Discover Devices

1. In the left navigation pane, right-click on All Devices and select Discover devices.

2. Within any device list, right-click and select Discover.

Schedule a Discovery

ENWW

° Example for Scheduling Discoveries

° Steps to Schedule a Discovery

e Other Ways to Schedule a Discovery

HP Web Jetadmin 10.0 has a flexible discovery scheduler that allows the administrator to launch specific
discoveries at the desired date and time. Multiple schedules can be created and maintained which
enables the administrator the flexibly of launching different discoveries in different time zones and with
different settings. Both PC-Connected device discovery and network connected device discovery can
be scheduled. Many discovery schedules can exist and be run as a one-time event or as recurring
events.

NOTE: If you schedule a task (for example, a discovery or a configuration or others) using a
corresponding template, the task uses the settings defined in the template at the time the task starts.
This makes it easy to redefine settings used in a regularly scheduled task without having to delete and
create a scheduled task.

NOTE: All HP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin install
host. The client system being used to access HP Web Jetadmin may or may not be in the same time
zone as the HP Web Jetadmin install host. You should be aware of the time and possible date differences
when configuring HP Web Jetadmin 10.0 scheduling.

Characteristics of scheduling discoveries include:

e  Scheduled discoveries can contain different types of Discovery settings including different settings
values such as IP range, broadcast addresses, and so forth.

e Recurring schedules can be set up to be daily, weekly, monthly, and so forth.
e  Specific weekdays can be chosen for recurring schedules.

e  Settings within preexisting schedules can be altered without having to create new scheduled
events.

e A Discovery - Scheduled Discoveries Task Module on page 118 exists to easily view, edit and
delete existing schedules.
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Example for Scheduling Discoveries

You are tasked with scanning subnets in Europe and Asia once per week in order to keep the HP Web
Jetadmin 10.0 All Devices lists up to date. Each of these locations has 5 subnets. Most of the employees
in these locations turn off the devices at night in order to save energy. You want to launch two discoveries
every Wednesday at 11:00AM in the area where the devices exist. You and the HP Web Jetadmin 10.0
host are in the central time zone.

You create two discovery schedules:

Table 4-8 Examples of Discovery Schedules

Schedule Name Time Weekly IP Ranges Included
Asia 9:00PM central time Every week on Tuesdays 15.62.40.1-15.62.47.254
Europe 4:00AM central time Every week on Wednesdays 15.5.188.2-15.5.188.254

Steps to Schedule a Discovery

Follow these steps:

1.

In the left navigation pane, click Discovery and then click Schedule discovery (in the Discovery
- Current Tasks task module). The Device Discovery wizard is started with the Specify
discovery options page displayed.

Select the type of discovery you want to perform (Network devices or PC-Connected devices).

NOTE: For more information about any of the types of discoveries, see Discovery Types and
Methods on page 100.

Select the discovery method you want to use (at least one must be selected) (Discovery Types and
Methods on page 100).

If you want to specify credentials by checking Specify credentials for this discovery. This is used
in cases if devices have been configured for SNMPV3, or if non-standard SNMP Get Community
Names are being used.

Click Next. The Specify schedule options page is displayed.

Select the date and time for the discovery to run.

NOTE: If you schedule a task (for example, a discovery or a configuration or others) using a
corresponding template, the task uses the settings defined in the template at the time the task
starts. This makes it easy to redefine settings used in a regularly scheduled task without having to
delete and create a scheduled task.

NOTE: All HP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin
install host. The client system being used to access HP Web Jetadmin may or may not be in the
same time zone as the HP Web Jetadmin install host. You should be aware of the time and possible
date differences when configuring HP Web Jetadmin 10.0 scheduling.

You can further define an appropriate time range for the discovery to start by checking Allow start
time to occur between the specified hours of and then selecting the From and To times.

Select the recurrence for this schedule.

Type a name for this schedule and click Next. The Confirm page is displayed.
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10. If all of the settings are correct, click Start. The Results page is displayed.

11. Click Done.

Other Ways to Schedule a Discovery

1. In the left navigation pane, right-click on Discovery and select Schedule discovery.

2. InDiscover Devices (the Device Discovery Wizard) on page 121, you can schedule a discovery to
run at any time.

Discovery History

e Steps for Discovery History

° Other Ways to View Discovery History

After discoveries have been run, you can consider the effectiveness of the discoveries so that you can
tailor any future discoveries based on these statistics. Three types of data are gathered:

1. Discovery summary data: allows comparing effectiveness of different discoveries, on a per-
discovery method level and includes original discovery settings.

2. Detailed discovery data: shows data about what discovery methods discovered which devices;
this also displays a Unique field that shows how many devices were discovered only by that
method.

3. PC-Connected device discovery data: allows gauging reliability of PC-connected device
discoveries.

After discoveries have been run, you can;

e View statistics associated with the discoveries:

o

list of discoveries (History).

for each discovery: start time, stop time, methods run, total devices found, and PC-Connected
devices found (servers queried and so forth).

for each discovery: how many “New” devices were found with each discovery.

Steps for Discovery History

ENWW

1. In the left navigation pane, expand Discovery and then click History.

2. The first row lists summary information for each discovery:

Date: the date and time the discovery ran.

User: the user who requested the discovery.

Duration: how long it took for the discovery to complete.

Type: type of discovery ran (PC-Connected devices or network devices).

Total Devices Found: the number of network and PC-Connected devices found.

New Devices Found: the number of “New” devices found (network and PC-Connected).
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3. You can expand or collapse the second row by clicking + or - next to each first row. The second
row shows more detailed information for each discovery:

e Method: the type of discovery that was run.
4. To clear the statistics for all of the discoveries, click Clear.

5. To close the Discovery History page, click on another option in the left navigation pane or in a
task module.

Other Ways to View Discovery History

e Inthe left navigation pane, right-click on Discovery and select View discovery history.

Discovery Templates

Discovery templates can be accessed through the left navigation menu or through the Discovery -
Current Tasks task module. For more information, see View a Discovery Template on page 129.

Create a Discovery Template

e Steps for Creating a Discovery Template

e Other Ways to Create a Discovery Template

Discovery templates are like other templates in HP Web Jetadmin 10.0: they store predefined settings
that can be retrieved at a later time. Both PC-Connected printer discovery and network-connected printer
discovery settings can be stored in templates. Once a discovery template has been created it can be
accessed through a normal discovery launch via Discover Devices (the Device Discovery Wizard)

on page 121 or can be added into a discovery schedule Schedule a Discovery on page 123.

Characteristics of discovery templates include:
e Any number of predefined Discovery settings can be stored as a Discovery Template.

e The Discovery - Templates Task Module on page 118 is used to:

o Create a Discovery Template on page 126 (or Add).

0 Edit a Discovery Template on page 128.

0 Delete a Discovery Template on page 128.

° Apply (or Run) a Discovery Template on page 127.

0 View a Discovery Template on page 129.

e Discovery templates can be used when creating Discovery Schedules (Schedule a Discovery
on page 123).
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Steps for Creating a Discovery Template

1. In the left navigation pane, click Discovery and then click Create discovery template (in the
Discovery - Current Tasks task module). The Create Discovery Template wizard is started with
the Select methods page displayed.

2. Select the type of discovery you want to perform (Network devices or PC-Connected devices).

B NOTE: For more information about any of the types of discoveries, see Discovery Types and
Methods on page 100.

3. Select the discovery method you want to use (at least one must be selected) (Discovery Types and
Methods on page 100).

4. If you want to specify credentials, check Specify credentials for this discovery. This is used in
cases if devices have been configured for SNMPv3, or if non-standard SNMP Get Community
Names are being used.

5. Click Next. Depending on the discovery method selected, pages are displayed to further define
those settings. Click Next.

The Specify template name page is displayed.
Enter the name for this template and then click Next. The Confirm page is displayed.

If all of the settings are correct, click Create Template. The Results page is displayed.

© o N o

Click Done.

Other Ways to Create a Discovery Template

e Inthe left navigation pane, right-click on Discovery and select Create discovery template.

Apply (or Run) a Discovery Template

° Steps for Running a Discovery Template

° Other Ways to Run a Discovery Template

After a discovery template has been created, you can select it at any time to run a discovery. (See
Create a Discovery Template on page 126.)

Steps for Running a Discovery Template

1. In the left navigation pane, click Discovery and then click Run discovery template (in the
Discovery - Current Tasks task module). The Device Discovery wizard is started with the
Specify discovery options page displayed.

2. Select the template to use and click Next. The Confirm page is displayed.

3. The template summary information is displayed. Review your selection and if it is correct click
Start. The Progress page is displayed. (You can hide the Progress page to do other functions in
HP Web Jetadmin 10.0 while the discovery is in progress, or you can stop the discovery from this

page.)
4. When the discovery is complete, the Results page is displayed.

To view the discovered devices on the All Devices list, check View all devices.
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To return to the Discovery page, click Done.

Other Ways to Run a Discovery Template
1. In the left navigation pane, right-click on Discovery and select Run discovery template.
2. Inthe Discovery - Templates task module, select Apply.

3. Through Schedule a Discovery on page 123, you can plan to run any discovery template.

Edit a Discovery Template

e Steps for Editing a Discovery Template

° Other Ways to Edit a Discovery Template

You can change anything in a discovery template. The steps are the same as for Create a Discovery
Template on page 126.

Steps for Editing a Discovery Template

1. In the left navigation pane, click Discovery and expand Templates. Select the template to edit
and the template is displayed.

2. Click Edit. The Edit Discovery Template wizard is started with the Select methods page
displayed.

3. Make any changes to the methods (at least one must be selected).

Bf NOTE: For more information about any of the types of discoveries, see Discovery Types and
Methods on page 100.

4. If you want to specify credentials, check Specify credentials for this discovery. The
Credentials page is displayed if this box is checked, which enables you to enter Get Community
Names within the Discovery wizard.

5. Click Next. Depending on the discovery method selected, pages are displayed to further define
those settings. Click Next.

The Specify template name page is displayed.
If desired, edit the name for this template and then click Next. The Confirm page is displayed.

If all of the settings are correct, click Edit Template. The Results page is displayed.

© ® N o

Click Done.

Other Ways to Edit a Discovery Template

e In the left navigation pane, right-click on Discovery and select Edit discovery template.

Delete a Discovery Template

e Steps for Deleting a Discovery Template

° Other Ways to Delete a Discovery Template

You can delete any discovery template you have created in HP Web Jetadmin 10.0.
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Steps for Deleting a Discovery Template

1. In the left navigation pane, click Discovery and then click Delete discovery template (in the
Discovery - Current Tasks task module). The Delete Discovery Templates wizard is started with
the Select template page displayed.

2. Highlight the template you want to delete and click Next. The Confirm page is displayed.

3. If this is the correct template to delete, click Next. The template will be deleted and the Results
page is displayed.

4. Click Done.
Other Ways to Delete a Discovery Template
1. In the left navigation pane, right-click on Discovery and select Delete discovery template.

2. Inthe Discovery - Templates task module, select the template and click Delete.

View a Discovery Template

° Steps for Viewing a Discovery Template

° Other Ways to View a Discovery Template

You can view templates that you have created for discoveries and also perform other actions on those
templates.

Steps for Viewing a Discovery Template

1. In the left navigation pane, click Discovery and then do the following to display the Discovery
Templates page:

e Click Templates (in the left navigation pane under Discovery).
2. Highlight the template you want to view and then click:

e Apply (or Run) a Discovery Template on page 127; you can choose to run the discovery now
with the selected template, or you can schedule the discovery to run later (Schedule a
Discovery on page 123).

° Create a Discovery Template on page 126.

° Delete a Discovery Template on page 128.

° Edit a Discovery Template on page 128.

e View a Discovery Template on page 129.

3. Toclose the Discovery Templates page, click on another option in the left navigation pane or in
a task module.

Other Ways to View a Discovery Template
1. In the left navigation pane, right-click on Discovery and select View discovery templates.

2. Inthe left navigation pane, expand Discovery and Templates. Select the template to delete and
click Delete.
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Configuration

All About Device Configuration

Task Modules for Configuration

Related Application Options for Configuration Management

Configure Devices

View Configuration History

Schedule a Device Configuration

Configuration Templates

Create a Configuration Template

Edit a Configuration Template

Delete a Configuration Template

View a Configuration Template to Devices

Apply a Configuration Template to Devices

All About Device Configuration

Many device settings can be viewed and configured through HP Web Jetadmin 10.0. Device

Device Credentials

Importing a Configuration from a File

configuration works differently depending on whether a single device or multiple devices are selected.

If a single device is selected, the configuration items in the tab are shown with the current device settings.
If multiple devices are selected, configuration items in the tab are shown with unspecified or blank
settings. The list of configurable options varies by the devices selected. With multiple devices selected,
all configurable items will probably not apply to all devices. Only settings that apply to a device will be
set on that device. Some options may be repeated multiple times because different settings are
supported on different devices. If it is not clear which device or device model a particular setting applies
to, holding the mouse over the name in the configuration settings displays a tooltip with additional
information.

Configuration option availability depends on device model, network card and firmware revision. One
model of device may support a configuration option for digital send functionality where another model,

probably a single-function one, does not support that same configuration option. Again, in fleet

scenarios, any configuration option that is set in HP Web Jetadmin 10.0 will only be applied to device
models for which it is supported.

To ensure this feature works properly, see Minimum System Requirements for HP Web

Jetadmin 10.0 on page 2 for HP Web Jetadmin 10.0.

Device Credentials

Whenever HP Web Jetadmin 10.0 encounters a device configuration that requires credentials, it looks
to the device-specific Credentials Store first (The Credentials Store on page 252). If credentials exist
in the store for that device, they will be used in the configuration. If successful, the device is configured
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and the store is left as is. If the credentials in the store do not exist or do not enable configuration success,
then global credentials are used. If global credentials enable configuration success, the value or values
used are stored for that device. Any time a device credential failure occurs, the device is flagged as
“credential required”. Whenever you are attempting a “live” configuration and a “credentials-required”
condition is encountered, a “Needed Credentials” dialog box is displayed providing a way for you to add
credentials to the HP Web Jetadmin 10.0. Once the required credentials are added, the configuration
should succeed.

This state can also be detected in post-configuration in either Configuration History or in the
Credentials Required column. After the required credential values exist in the Credentials Store,
prompting from HP Web Jetadmin 10.0 should not occur unless the values on the device change.

For more information about credentials, see Credentials for Devices on page 84.

Importing a Configuration from a File

ENWW

A CSV (comma separated value) file can be created and then imported into HP Web Jetadmin 10.0 for
the purpose of device configuration. This provides a way to configure a fleet of devices with unique
parameters that would otherwise have to be configured one device at a time. CSV files can easily be
created by exporting data from a spreadsheet or word processing program.

Here is an example of a device configuration scenario:

e 30 devices exist: 16.24.1.26-16.24.1.56

e Asset number assignments are required: Abc10040-Abc10070
e Assignments are made respective to IP address sequence

A file can be created to represent the configuration desired. Here is a quick look at an example file:

Table 4-9 Example of a Configuration File

IP Addr Port Asset Number
16.24.1.26 1 Abc10040
16.24.1.27 1 Abc10041
16.24.1.28 1 Abc10042
16.24.1.29 1 Abc10043
16.24.1.30 1 Abc10044

NOTE: The first column for device identification can be an IP Address or Mac Address. The second
column is always “Port,” and is usually 1 unless a device is attached to a multi-port print server.

Once the file is created and stored to disk on the client desktop; the user can import the file contents
into HP Web Jetadmin 10.0 using Configure Devices.

The CSYV file contains header text for each device property to be configured. Once the user has browsed
and uploaded the file a Map Headers control appears. The customer specific header text can be matched
with the corresponding device property.

The first two columns are used to identify the devices to be configured. These devices must have already
been discovered in HP Web Jetadmin 10.0 prior to importing the file, or they will not be configured:
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Table 4-10 Column Headers for Columns 1 through 3 for a CSV File

Column 1: Device Identifier (either IP address, hardware address (MAC address), or IP hostname)

Column 2: Port (always just “Port”)

Column 3+: selected by the user

Table 4-11 Importable Device Settings for Columns 3+ for a CSV File

Access Control List

Asset Number

Company Name

Default Copier Copies

Default Printer Copies

Device Location

Device Name

Get Community Name

Job Timeout

Set Community Name

System Contact

System Location

System Name

TCP Idle Timeout

Any User defined settings (added through Tools > Options > Device Management > Configuration > User Defined; User
Defined Configuration Settings on page 135). (In previous versions of HP Web Jetadmin 10.0, this used to be called custom
fields or custom settings.)

Once the mapping is configured, HP Web Jetadmin 10.0 displays the data headers and device status.
Devices which were previously discovered and successfully matched are shown in the list; any devices
in the file which were not successfully matched are counted as “Unresolved devices”.

Only the settings listed above can be imported from a file. If a setting contains a comma, quotations
must be used around that particular setting. For example, the following line can be used to set values
of “Chicago, IL, USA” and “Building 5, Floor 3:

16.24.1.26,1,"“Chicago, IL, USA”,“Building 5, Floor 3"

Task Modules for Configuration

e Configuration - Common Tasks Task Module

e Configuration - Recent Configurations Task Module

e Configuration - Active Configurations Task Module

e Configuration - Scheduled Configurations Task Module
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° Configuration - Templates Task Module

The following task modules can be displayed or hidden in Configuration.

Configuration - Common Tasks Task Module

The Configuration - Current Tasks task module can be displayed on the Configuration page and
includes the following tasks:

e Configure devices: configure single devices or a fleet of devices (Configure Devices
on page 136).

e Schedule device configuration: schedule configuration for a device for a later time (Schedule a
Device Configuration on page 139).

e Create configuration template: create a configuration template (Create a Configuration
Template on page 143).

e Apply configuration template to devices: apply an existing configuration template to devices
(Apply a Configuration Template to Devices on page 146).

e Edit configuration template: make changes to an existing configuration template (Edit a
Configuration Template on page 144).

o Delete configuration template: delete a configuration template (Delete a Configuration
Template on page 145).

e View configuration history: view all of the configuration tasks which have occurred on all devices
within the retention period (View Configuration History on page 138).

The Configuration - Current Tasks task module can be displayed in other areas of HP Web Jetadmin
10.0; in the other areas it is Configuration - Common Tasks.

Configuration - Recent Configurations Task Module

The Configuration - Recent Configurations task module shows the recent configurations. You can
select a configuration task and choose one of the following:

° Details: view details of the selected task.

e View History: view all of the configuration tasks which have occurred on all devices within the
retention period (View Configuration History on page 138).

Configuration - Active Configurations Task Module

The Configuration - Active Configurations task module shows the active, or currently running,
configurations. You can select a configuration task and choose one of the following:

e  Stop: stops the current configuration task in progress, preventing any devices which have not yet
been configured from being configured.

e View: view the selected configuration task in progress, including detailed results.
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Configuration - Scheduled Configurations Task Module

The Configuration - Scheduled Configurations task module shows the configurations that are
scheduled. You can select a configuration task and choose one of the following:

e Delete: delete the selected configuration.

e Edit: make changes to the selected configuration.

Configuration - Templates Task Module

The Configuration - Templates task module shows the configuration templates that have been created.
You can select a configuration template and choose one of the following:

e Apply: apply the selected configuration template to devices (Apply a Configuration Template to
Devices on page 146).

e Create: create a configuration template (Create a Configuration Template on page 143).

e Delete: delete a configuration template (Delete a Configuration Template on page 145).

e Edit: make changes to a configuration template (Edit a Configuration Template on page 144).

e View: view a configuration template (View a Configuration Template to Devices on page 145).

Related Application Options for Configuration Management

e General Configuration Settings

° User Defined Configuration Settings

Global settings can be set here for fleet configurations.

General Configuration Settings

If a device is turned off or is disconnected from the network, it will not respond to a configuration attempt.
You can schedule how many times and how often HP Web Jetadmin 10.0 tries to configure devices
before the configuration attempt is considered a failure. If a device does not respond to HP Web
Jetadmin 10.0 during a configuration operation, it is added to a list of failed configuration operations.
HP Web Jetadmin 10.0 tries to configure each device on the list until either the number of specified
retries has occurred or all devices have been configured.

Bf NOTE: The settings on this page apply to all configuration options including scheduled configurations,
configurations initiated by a user, and multiple device configurations. If the device cannot be configured,
an entry noting the failed operation is logged in the Application Log (Application Logging on page 34)
and in Configuration History (View Configuration History on page 138).

Follow these steps:

1. On the top menu bar, access Tools > Options and expand Device Management.
Expand Configuration and then select General.

2. Configure the desired settings:

o Number of configuration retries: Select the number of times a configuration task will attempt
to configure a device before giving up.

e Hours between configuration retries: Select the hours between each retry.
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e Retention time: Select the number of days to retain configuration history (the default is 90).
e Restore default templates: Restores all templates shipped with HP Web Jetadmin 10.0.
To clear all previous configuration history, click Clear History.

To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

User Defined Configuration Settings

ENWW

Any number of custom device settings can be created and then configured on devices. These User
defined settings exist within the application only and not on the devices. These settings can provide
additional information about the device that cannot be represented using the available configuration
options. These settings can be any text value, and can be displayed in the device lists (Device Lists
on page 67), reports (Reports on page 173), and Config tab (Config Tab on page 57). (In previous
versions of HP Web Jetadmin 10.0, this used to be called custom fields or custom settings.)

Warranty expiration dates: you would know when to expect to pay for service calls or start a new
contract.

Lease start and stop dates: you would know when units need to be returned or lease needs to
be renewed.

Service maintenance dates: you would know when to schedule service personnel visits.

Locale details: you would know the city, state, and country/region to easily locate a device.

After the User defined settings are configured, they will be displayed in any configuration interface
within HP Web Jetadmin 10.0. It is important to remember that these objects only appear in the HP Web
Jetadmin 10.0 installation in which they are configured.

Follow these steps:

1.

On the top menu bar, access Tools > Options and expand Device Management.
Expand Configuration and then select User Defined.
Any user-defined settings already added are listed:

e New: create new user-defined settings. The Create User Defined Setting dialog appears.
Name the setting and choose whether or not to hide the setting when configuring multiple
devices. This option should be checked if the setting is unique for each device and should not
be used with multiple devices or templates (such as an identification number). Click OK.

e Edit: make changes to an existing user-defined setting. Select the setting and click Edit.
The Edit User Defined Setting dialog appears. Make any changes and click OK.

Bf NOTE: Changing a setting name does not affect any current or historical data saved for that
setting, so the new name should still match the setting purpose. Also, changes may not take
effect completely until the HP Web Jetadmin 10.0 client is closed and restarted.

e Delete: remove any user-defined setting. Select the setting and click Delete. The Delete User
Defined Setting dialog appears. Confirm your selection and click OK.
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3.

B NOTE: After a setting is deleted, all current and historical data is lost for that setting and the
setting will be removed from any templates or scheduled tasks. Also, changes may not take
effect completely until the HP Web Jetadmin 10.0 client is closed and restarted.

Settings on this page are effective immediately without clicking Apply, and cannot be canceled.

Configure Devices

Steps to Configure Devices

Other Ways to Configure Devices

You can configure devices without using a configuration template.

Steps to Configure Devices

1.

In the left navigation pane, click on Configuration.

In the Configuration - Common Tasks task module, select Configure devices. The Configure
Devices wizard is started with the Specify configuration options page displayed.

Select one of the options:

e Use template: devices will be configured by applying settings from a template. Select a
configuration template from the drop-down box and go to Step 3.

e Specify settings: devices will be configured by specifying settings in the wizard. Go to Step
3.

o Import from file: devices will be configured by importing settings from a CSV file. (See
Importing a Configuration from a File on page 131.)

o Click Next. The Select CSV file page is displayed.

° Type the path and name of the CSV file to import, or browse for the file. Click Next. If
successful, it shows you the headers from the CSV file.

= NOTE: If any errors are found in the CSV file, you will need to correct them and then
try this import procedure again.

° Select the comparable device setting for each header. Click Next. The Confirm page is
displayed.

o Click Configure devices. The Results page is displayed. Click Done to display the
Configuration page.

To schedule the configuration for a later time, click Schedule configuration.

NOTE: If you schedule a task (for example, a discovery or a configuration or others) using a
corresponding template, the task uses the settings defined in the template at the time the task
starts. This makes it easy to redefine settings used in a regularly scheduled task without having to
delete and create a scheduled task.

NOTE: All HP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin
install host. The client system being used to access HP Web Jetadmin may or may not be in the
same time zone as the HP Web Jetadmin install host. You should be aware of the time and possible
date differences when configuring HP Web Jetadmin 10.0 scheduling.

Click Next. The Select devices page is displayed.
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Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.

You can also select an entire group instead of individual devices, by changing the selection method
to Groups. Tasks (for example configurations and more) can be performed on a single group or a
group and all of its subgroups.

NOTE: Including all subgroups can potentially take much longer and cause much more network
traffic, so should be used only when appropriate.

If you schedule a task using a group, the task will apply to the devices in the group at the time the
task starts. This makes it easy to redefine the devices used in regularly scheduled tasks without
having to delete and create a scheduled task.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device Identification.

Click Next. If you chose to specify settings, the Specify device settings page is displayed.

The settings displayed are the ones supported by the devices selected in Step 5. Settings are
organized alphabetically within each category. You can also use the personalized My Settings
category to easily find your favorite settings. If My Settings is not visible, then right-click and
select Show ‘My Settings’. Select the configuration options and then click Next.

NOTE: Forinformation about specific configuration options that might not work properly in a batch
mode, see Captured Configurable Options and Configuration Templates on page 142.

If you chose to schedule this configuration, the Specify schedule options page is displayed.
If you did not choose to schedule this configuration, go to Step 8.

Select the start date and time for your configuration, specify how often it should run, and give it a
name. Configuration schedules can have the following flexible settings applied:

e Task name: enter a name for this scheduled task, for easier identification in the task modules
and the configuration history.

e Allow start time to occur between the specified hours of: limits the start time to a specified
window of time. The configuration will only run if able to do so during the time specified here.
This is useful for configurations that should only occur in low traffic times such as late at night.

e Recurrence, Once: launches only once in the specified schedule.

e Recurrence, Daily: task will recur daily once per day or once per weekday depending on the
selected setting.

e Recurrence, Weekly: task will recur once every X weeks on the day specified depending on
the setting.

e Recurrence, Monthly: task will recur once every X months on XX day depending on setting;
or, task will recur on specified day pattern depending on setting.

Click Next. The Confirm page is displayed.
Review the settings selected. If you did not choose to schedule this configuration, go to step 10.

Click Create Schedule. The Results page is displayed.
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10.

At this point, the schedule has been created but the devices have not yet been configured. You
may want to run the configuration once to make sure there are no problems, such as devices
needing credentials in order to be configured. This will increase the chances of the scheduled
configuration completing successfully. If you do not want to run the configuration now, uncheck the
option Run configuration now (recommended) and click Done to display the Configuration
page. Otherwise, you will be taken to a second Configuration page.

Click Configure Devices. The Results page is displayed. To see details of the configuration,
click Details. Then click Close.

Click Done to display the Configuration page.

Other Ways to Configure Devices

In the left navigation pane, right-click on Configuration and select Configure devices.

In any device list, select one or more devices; right-click, select Configuration, and then select
Configure devices.

In the Configuration - Recent Configurations task module, select a recent configuration, right-
click and select Configure devices.

To configure devices using a template, in any device list, select one or more devices. Then select
the Config tab and click Apply Template.

In any device list, select one or more devices; select the Config tab at the bottom of the page.
Make changes to configuration settings on the tab and click Apply.

View Configuration History

Steps to View Configuration History

Other Ways to View Configuration History

Any device configuration result is added to configuration history.

Steps to View Configuration History

1.

In the left navigation pane, expand Configuration and then click History. The Configuration
History page is displayed.

Select the way you want to group the history results:
e None: shows all the history as a flat list, which can be sorted by column.

e Task: shows configurations according to task name, which can only be changed on scheduled
tasks.

e Device: shows configurations by device.
e Initiator: shows configurations according to the user who initiated them.

e  Start time: shows configurations according to start time.
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e Device result: shows configurations according to the device results, to easily find device
failures.

e Task result: shows configurations according to the overall task result.

3. To view details click + (Expand All) in the header to expand all details or at a line item to expand
just that line.

Other Ways to View Configuration History

e Inthe left navigation pane, click Configuration. In the Configuration - Common Tasks task
module, select View configuration history.

e Inthe Configuration - Recent Configurations task module, select View History.
e Inthe left navigation pane, right-click on Configuration and select View configuration history.

e Inthe left navigation pane, right-click on Overview. Select Configuration > View configuration
history.

e Inany device list, select one or more devices. Then right-click and select Configuration > View
configuration history to view the history for just those devices.

e Inany device list, select one or more devices. Select the Config tab at the bottom of the page.
Then select View History to view the history for just those devices.

e In any device list, select one or more devices and select the Troubleshoot tab. In the
Troubleshooting tools drop-down select Recent Configurations and click View History to view
the history for just those devices.

Schedule a Device Configuration

B
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e Steps for Scheduling a Device Configuration

° Other Ways to Schedule a Device Configuration

Configurations can be scheduled to occur at the time and day you specify. Like other scheduling within
HP Web Jetadmin 10.0, configuration schedules can have the following flexible settings applied:

NOTE: If you schedule a task (for example, a discovery or a configuration or others) using a
corresponding template, the task uses the settings defined in the template at the time the task starts.
This makes it easy to redefine settings used in a regularly scheduled task without having to delete and
create a scheduled task.

NOTE: All HP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin install
host. The client system being used to access HP Web Jetadmin may or may not be in the same time
zone as the HP Web Jetadmin install host. You should be aware of the time and possible date differences
when configuring HP Web Jetadmin 10.0 scheduling.

e Task name: allows flexible naming of scheduled tasks.
e Start Date and Time: specifies when the configuration will launch.

e Allow start time to occur between the specified hours of: limits the starting of task to a specified
window of time. Task will only run if able to do so during the specified time period. This is useful
for tasks that should only occur in low traffic times such as late at night.

e Recurrence, Once: launches only once in the specified schedule.
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Recurrence, Daily: will recur daily once per day or once per weekday depending on setting.
Recurrence, Weekly: will recur every X weeks depending on setting.

Recurrence, Monthly: will recur once every X months on XX day depending on setting; or, task
will recur on specified day pattern depending on setting.

Once a configuration task is scheduled it can be viewed in the Configuration - Scheduled
Configurations task module. Running tasks can be viewed in Configuration - Active
Configurations task module.

Steps for Scheduling a Device Configuration

EY NOTE: Al HP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin install
host. The client system being used to access HP Web Jetadmin may or may not be in the same time
zone as the HP Web Jetadmin install host. You should be aware of the time and possible date differences
when configuring HP Web Jetadmin 10.0 scheduling.

1.

In the left navigation pane, click on Configuration.

In the Configuration - Common Tasks task module, select Schedule device configuration.
The Schedule Device Configuration wizard is started with the Specify configuration options
page displayed.

Select one of the options:

e Use template: devices will be configured by applying settings from a template. Select a
configuration template from the drop-down box and go to Step 3.

e Specify settings: devices will be configured by specifying settings in the wizard. Go to Step
3.

e Import from file: devices will be configured by importing settings from a CSV file. (See
Importing a Configuration from a File on page 131.)

° Click Next. The Select CSV file page is displayed.

° Type the path and name of the CSYV file to import, or browse for the file. Click Next. If
successful, it shows you the headers from the CSV file.

B NOTE: If any errors are found in the CSV file, you will need to correct them and then
try this import procedure again.

o Select the comparable device setting for each header. Click Next. The Confirm page is
displayed.

° Click Configure devices. The Results page is displayed. Click Done to display the
Configuration page.

Click Next. The Select devices page is displayed.

Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.

You can also select an entire group instead of individual devices, by changing the selection method
to Groups. Tasks (for example configurations and more) can be performed on a single group or a
group and all of its subgroups.
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NOTE: Including all subgroups can potentially take much longer and cause much more network
traffic, so should be used only when appropriate.

If you schedule a task using a group, the task will apply to the devices in the group at the time the
task starts. This makes it easy to redefine the devices used in regularly scheduled tasks without
having to delete and create a scheduled task.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device Identification.

Click Next. If you chose to specify settings, the Specify device settings page is displayed.

The settings displayed are the ones supported by the devices selected in Step 4. Settings are
organized alphabetically within each category. You can also use the personalized My Settings
category to easily find your favorite settings. If My Settings is not visible, then right-click and
select Show ‘My Settings’. Select the configuration options and then click Next.

NOTE: Forinformation about specific configuration options that might not work properly in a batch
mode, see Captured Configurable Options and Configuration Templates on page 142.

Select the start date and time for your configuration, specify how often it should run, and give it a
name. Configuration schedules can have the following flexible settings applied:

e Task name: enter a name for this scheduled task, for easier identification in the task modules
and the configuration history.

e Allow start time to occur between the specified hours of: limits the start time to a specified
window of time. The configuration will only run if able to do so during the time specified here.
This is useful for configurations that should only occur in low traffic times such as late at night.

e Recurrence, Once: launches only once in the specified schedule.

e Recurrence, Daily: task will recur daily once per day or once per weekday depending on the
selected setting

e Recurrence, Weekly: task will recur once every X weeks on the day specified depending on
the setting.

e Recurrence, Monthly: task will recur once every X months on XX day depending on setting;
or, task will recur on specified day pattern depending on setting.

Click Next. The Confirm page is displayed.
Review the settings selected.
Click Create Schedule. The Results page is displayed.

At this point, the schedule has been created but the devices have not yet been configured. You
may want to run the configuration once to make sure there are no problems, such as devices
needing credentials in order to be configured. This will increase the chances of the scheduled
configuration completing successfully. If you do not want to run the configuration now, uncheck the
option Run configuration now (recommended) and click Done to display the Configuration
page. Otherwise, you will be taken to a second Configuration page.

Click Configure Devices. The Results page is displayed. To see details of the configuration,
click Details. Then click Close.

Click Done to display the Configuration page.
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Other Ways to Schedule a Device Configuration

e In any device list, select one or more devices; right-click and select Configuration > Schedule
configuration.

e In the left navigation pane, right-click on Configuration and select Schedule configuration.

e In the left navigation pane, right-click on Overview and select Configuration > Schedule
configuration.

e In many of the methods for Configuring a device or Applying a template, you also have the
option of scheduling that task by checking Schedule configuration on the first page of the wizard.

Configuration Templates

e Adding Configuration Templates to a Group Policy

° Captured Configurable Options and Configuration Templates

Configuration templates are used to store device settings and apply those settings to one or more
devices. This can be done to keep device configurations consistent and to make it easy to apply a
common set of settings on a regular basis. Templates are an easy way to change the settings for
regularly scheduled configurations, without having to recreate the entire schedule. Templates can also
be used to save many settings from a device, either for backup purposes or to apply to similar devices.

You can create and manage configuration templates:

e Create configuration template: create a configuration template (Create a Configuration
Template on page 143).

e Apply configuration template to devices: apply the selected configuration template to devices
(Apply a Configuration Template to Devices on page 146).

o Edit configuration template: make changes to an existing configuration template (Edit a
Configuration Template on page 144).

e Delete configuration template: delete a configuration template (Delete a Configuration
Template on page 145).

e View configuration template: view an existing configuration template (View a Configuration
Template to Devices on page 145).

Adding Configuration Templates to a Group Policy

Configuration templates can be added to Group policies. Group policies are a powerful new automation
tool that can save you a great deal of time configuring devices and HP Web Jetadmin 10.0 settings. Any
device group can have a property known as Group Policy. One type of group policy is Configure Devices,
which uses a selected configuration template from the list of existing templates. The configuration
template can be applied either as the device is added into the group or as the device is removed from
the group. Multiple Configure Devices Group Policies using different templates can exist on a single
device group.

Captured Configurable Options and Configuration Templates

Some configuration options behave differently for single-device configuration than they do for multiple-
device configuration. When capturing device settings into a configuration template via the Save As
Template feature, some configuration options will fail when the template is used to configure multiple
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devices. The configuration options that will fail when used to configure multiple devices via a stored
configuration template are:

e  Tray Administration

e Authentication Manager

e  Control Panel Language

e  Default Media Type

e  SNMP Trap Destination Table
e Access Control List

e |Pv6 Options

e  Asset Number

e  System Name

e [P Address

e LAA Address Configuration

When capturing device settings via the Save As Template feature, these items should remain
unchecked. If it is desired to have these configuration options as part of the template, an edit can be
performed on the template after it has been saved and the desired configuration option can be selected
and configured appropriately. Once the modified template is saved, a version of the configuration option
that supports multiple configuration will be used and the operation should succeed. This situation will
not occur during normal use of multiple device configuration or when a configuration template is created
independently from a device.

Create a Configuration Template

e Steps to Create a Configuration Template

e Other Ways to Create a Configuration Template

Configuration templates are used to store device settings and apply those settings to one or more
devices. This can be done to keep device configurations consistent and to make it easy to apply a
common set of settings on a regular basis. Templates are an easy way to change the settings for
regularly scheduled configurations, without having to recreate the entire schedule. Templates can also
be used to save many settings from a device, either for backup purposes or to apply to similar devices.

Steps to Create a Configuration Template

1. In the left navigation pane, click on Configuration. In the Configuration - Common Tasks task
module, select Create configuration template. The Create Device Configuration Template
wizard is started with the Specify template options page displayed.

2. Enter the name of the template (up to 48 characters).

3. Select the configuration options to include with the template and then click Next. The Confirm
page is displayed.

Bf NOTE: Forinformation about specific configuration options that might not work properly in a batch
mode, see Captured Configurable Options and Configuration Templates on page 142.
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4,

5.

NOTE: The configuration options selected for this template will only be applied to those devices
that support the options.

Review the settings selected and click Create Template. The Results page is displayed.

Click Done to display the Configuration page.

Other Ways to Create a Configuration Template

In the left navigation pane, right-click on Configuration and select Create configuration
template.

In the left navigation pane, expand Configuration and right-click Templates. Then select Create
configuration template.

In the Configuration - Templates task module, select Create.

In the left navigation pane, right-click on Overview and select Configuration > Create
configuration template.

In the left navigation pane, expand Configuration and select Templates. Click Create next to the
list of templates displayed.

In any device list, select one or more devices and click the Config tab at the bottom of the page.
Select the configuration options and then click Save as Template.

Edit a Configuration Template

Steps to Edit a Configuration Template

Other Ways to Edit a Configuration Template

You can make changes to any configuration template after is has been created.

Steps to Edit a Configuration Template

1.

In the left navigation pane, click on Configuration. In the Configuration - Common Tasks task
module, select Edit configuration template. The Edit Device Configure Template wizard is
started with the Select template page displayed.

Select the template to edit and click Next. The Specify template options page is displayed. You
can change the name of the template if desired (up to 48 characters).

Select the configuration options to include with the template and then click Next. The Confirm
page is displayed.

NOTE: Forinformation about specific configuration options that might not work properly in a batch
mode, see Captured Configurable Options and Configuration Templates on page 142.

NOTE: The configuration options selected for this template will only be applied to those devices
that support the options.

Review the settings selected and click Save Template. The Results page is displayed.

Click Done to display the Configuration page.
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Other Ways to Edit a Configuration Template
e Inthe left navigation pane, right-click on Configuration and select Edit configuration template.

e In the left navigation pane, expand Configuration and then expand Templates. Right-click on the
template to edit and select Edit configuration template.

e In the left navigation pane, expand Configuration and then expand Templates. Select the
template to edit and click Edit on the page displaying the template settings.

e Inthe Configuration - Templates task module, select the template to edit and click Edit.
e Inthe left navigation pane, expand Configuration and then select Templates. Select the template
to edit from the list displayed and click Edit.
Delete a Configuration Template

e Steps to Delete a Configuration Template

e Other Ways to Delete a Configuration Template

Configuration templates can be deleted.

Steps to Delete a Configuration Template

1. In the left navigation pane, click on Configuration. In the Configuration - Common Tasks task
module, select Delete configuration template. The Delete Device Configuration Template
wizard is started with the Select template page displayed.

2. Select the template to delete and click Next. The Confirm page is displayed.
3. Click Delete Template. The Results page is displayed.

Click Done to display the Configuration page.

Other Ways to Delete a Configuration Template

e Inthe left navigation pane, right-click on Configuration and select Delete configuration
template.

e Inthe left navigation pane, expand Configuration and then expand Templates. Select the
template to delete and click Delete on your keyboard.

e Inthe left navigation pane, expand Configuration and then expand Templates. Right-click on the
template to delete and select Delete configuration template.

e Inthe Configuration - Templates task module, select the template to delete and click Delete.

e Inthe left navigation pane, expand Configuration and then select Templates. Select the template
to delete from the list displayed and click Delete.

View a Configuration Template to Devices

e Steps to View a Configuration Template

° Other Ways to View a Configuration Template to Devices

You can view existing configuration templates.
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Steps to View a Configuration Template

1. In the left navigation pane, expand Configuration and then expand Templates. Click on the
template you want to view. The template page is displayed.

2. You can view all of the settings for the template. You can also:

e Apply: apply the selected configuration template to devices (Apply a Configuration Template
to Devices on page 146).

e Edit: make changes to an existing configuration template (Edit a Configuration Template
on page 144).

e New: create a configuration template (Create a Configuration Template on page 143).

e Remove: delete a configuration template (Delete a Configuration Template on page 145).

Other Ways to View a Configuration Template to Devices

e Inthe Configuration - Templates task module, select the template to view and click View.

Apply a Configuration Template to Devices

e Steps to Apply a Configuration Template to Devices

° Other Ways to Apply a Configuration Template to Devices

When you apply a configuration template, you are actually configuring devices with the settings that
were stored in the template.

Steps to Apply a Configuration Template to Devices

1. In the left navigation pane, click Configuration. In the Configuration - Common Tasks task
module, select Apply configuration template to devices. The Apply Device Configuration
Template wizard is started with the Specify configuration options page displayed.

2. Select the configuration template from the drop-down box.

3. If you want to schedule this configuration to run at a later time, select Schedule configuration.
Click Next; the Select devices page is displayed.

Bf NOTE: If you schedule a task (for example, a discovery or a configuration or others) using a
corresponding template, the task uses the settings defined in the template at the time the task
starts. This makes it easy to redefine settings used in a regularly scheduled task without having to
delete and create a scheduled task.

NOTE: All HP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin
install host. The client system being used to access HP Web Jetadmin may or may not be in the
same time zone as the HP Web Jetadmin install host. You should be aware of the time and possible
date differences when configuring HP Web Jetadmin 10.0 scheduling.

4. Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.
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You can also select an entire group instead of individual devices, by changing the selection method
to Groups. Tasks (for example configurations and more) can be performed on a single group or a
group and all of its subgroups.

NOTE: Including all subgroups can potentially take much longer and cause much more network
traffic, so should be used only when appropriate.

If you schedule a task using a group, the task will apply to the devices in the group at the time the
task starts. This makes it easy to redefine the devices used in regularly scheduled tasks without
having to delete and create a scheduled task.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device ldentification.

Click Next. The Confirm page is displayed.
Review the settings selected. Click Apply Template. The Results page is displayed.
To see details of the configuration, click Details. Then click Close.

Click Done to display the Configuration page.

Other Ways to Apply a Configuration Template to Devices

ENWW

In the left navigation pane, expand Configuration and then expand Templates to list all of the
configuration templates. You can drag-and-drop one or more devices onto one of the configuration
templates listed under Templates.

In the left navigation pane, right-click on Configuration and select Apply configuration
template.

In any device list, select one or more devices. Then right-click and select Configuration > Apply
configure template.

In the Configuration - Templates task module, select the template to apply and click Apply.

In the left navigation pane, expand Configuration and then select Templates. Select the template
you wish to apply from the displayed list and click Apply.

In the left navigation pane, expand Configuration and then expand Templates. Right-click on the
template you wish to apply in the navigation tree and select Apply configuration template.
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Alerts
e All About Alerts

e Alerts Traps Listener Port

e Task Modules for Alerts

° Related Application Options for Alerts

e Subscribe for Device Alerts

° Edit an Alert Subscription

e  Alert History

e Alert Subscription Templates

e Create a Subscription Template

e Apply an Alert Subscription Template

° Edit an Alert Subscription Template

° Delete an Alert Subscription Template

e All Subscriptions

All About Alerts
e Alerts and HP Web Jetadmin 10.0

e What You Can Do With Alerts

e Types of Alerts

° Examples of Alerts

HP Web Jetadmin 10.0 can detect different events occurring on devices and then relay detailed
messages about those events, device states, and other important specifics. These messages can be
sent to email addresses or to Alerts History within HP Web Jetadmin 10.0. For example, error or
warning conditions on printers, such as paper out or toner low, can trigger email messages to be sent
by HP Web Jetadmin 10.0 that contain detailed information pertaining to the condition, allowing the
recipient to act upon that condition immediately

The advantage of alerts is that you can receive proactive, real-time warnings via email for events that
occur on networked printers. Receiving early notification of printer events allows administrators to
correct the problems before they impact end user productivity, saving time for both the administrator
and the end user. Helpdesks might use alerts to proactively troubleshoot issues with printers before end
users detect them. Individuals responsible for ordering consumables, such as toner cartridges, might
enable toner low alerts so they can be warned of toner low conditions in order to proactively order toner
before it runs out.

To ensure this feature works properly, see Minimum System Requirements for HP Web
Jetadmin 10.0 on page 2 for HP Web Jetadmin 10.0.
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Alerts and HP Web Jetadmin 10.0

As in earlier releases of HP Web Jetadmin, proactive alerting is accomplished through detection of an
event based on a device, processing to determine the appropriate action to take, and then notification
through some method (usually email). The initial detection of device based events is done in one of two
ways:

e Polling devices: always used for Supplies and for Critical Alerts types.

e Traps: packets sent to HP Web Jetadmin 10.0 to signal an event. When the device is first
established in HP Web Jetadmin 10.0 Alerts, the trap destination (the application’s IP address) is
configured onto the device.

The following Alerts features have been added to HP Web Jetadmin 10.0:
e Intuitive, easy to use Alerts settings interface

e  Multiple subscription control

e Alerts subscription templates

e  Supplies alerting

e  Backup polling

e Adaptive polling (supplies)

e Alerts history interface

What You Can Do With Alerts

You can use Alerts to have immediate or real-time notification that an event has occurred. A common
scenario is a print maintenance or support team. These people would like to know when a problem
happens rather than to wait for a customer complaint. In this way, they can proactively handle trouble
perhaps even prior to the customer experiencing downtime.

In HP Web Jetadmin 10.0, you actually subscribe to Alerts to get information about devices. When you
subscribe to an Alert, you are requesting information from a device (or devices) about specific settings
on that device (or devices) including events, email address notification, and more. (See Subscribe for
Device Alerts on page 152.)

Types of Alerts

ENWW

There are three types of Alerts:

e General alerts (detailed): include most non-supply device events and rely on traps. Polling is
established when traps destinations cannot be configured.

e Supplies alerts: monitor device supply status and levels through polling. The polling mechanism
uses a combination of slow-polling and sliding time interval depending on the level of the supply
being monitored.

e Critical alerts: events are monitored by polling every five minutes. The polling interval is
configurable within the range of 5 to 360 minutes. Because of the frequent polling nature of this
solution, it is important to use it sparingly and only for devices that need immediate attention. All
General Alerts are available.
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Examples of Alerts
Following are some examples of alerts you might want to configure:

e An alert set to add specific printer error code events to Alerts History as these events occur (Alert
History on page 156).

Bf NOTE: Alerts now support more detailed printer errors such as “Subsystem 72 -- Service Error”
and more.

e An alert set to notify a recipient through email about a Toner Low condition.
e An alert set to notify a recipient through email about a specific supply threshold.
e An alert set to propagate an SNMP trap directed at a listener process on another application such
as HP OpenView.
Alerts Traps Listener Port

Earlier releases of HP Web Jetadmin used a different traps listener port for Reports than the traps
listener used for Alerts events. In HP Web Jetadmin 10.0, this has changed. Shown here are the
differences between previous versions of HP Web Jetadmin and HP Web Jetadmin 10.0:

e HP Web Jetadmin 10.0 traps listener port: is UDP port=27892 for Alerts and Reports by-user
collections.

e  Prior versions of HP Web Jetadmin 10.0 traps listener port was UDP port=27892 for Alerts and
UDP port=27894 for Report Generation Plug-in by-user collections.

Task Modules for Alerts

e Alerts - Current Tasks and Alerts - Common Tasks Task Modules

e Alerts - Active Tasks Task Module

e Alerts - Recent Alerts Task Module

e Alerts - Alert Subscriptions Task Module

e Alerts - Subscription Templates Task Module

The following task modules can be displayed or hidden in Alerts on the Alerts Management page.

Alerts - Current Tasks and Alerts - Common Tasks Task Modules

The Alerts - Current Tasks task module can be displayed on the Alerts Management page and
includes the following tasks:

e Subscribe for Device Alerts on page 152

e Create a Subscription Template on page 157

e Apply an Alert Subscription Template on page 159

° Edit an Alert Subscription Template on page 160

° Delete an Alert Subscription Template on page 161
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Alerts -

Alerts -

Alerts -

Alerts -

The Alerts - Current Tasks task module can be displayed in other areas of HP Web Jetadmin 10.0; in

the other areas it is Alerts - Common Tasks.

Active Tasks Task Module
The Alerts - Active Tasks task module shows you any alerts currently scheduled. You can:
e Stop an alert by highlighting it and clicking Stop.
e View an alert template. The following is displayed:
o Task Name: the name of the alert.
° State: whether or not credentials were requested for devices.
o Initiator: the name of the user who started the alert.

° Start Time: the time the alert should start.

Recent Alerts Task Module

View summary information or complete information about alerts history (Alert History on page 156).
Click View History to see the entire Alert History page.

Alert Subscriptions Task Module

e Subscribed devices (Subscribe for Device Alerts on page 152): how many devices had alert

subscriptions. Also displayed is the percentage of all devices that devices with alert subscriptions

represents.

e Unsubscribed devices: how many devices have no alert subscriptions. Also displayed is the
percentage of all devices that devices with no alert subscriptions represents.

Subscription Templates Task Module

e Apply an Alert Subscription Template on page 159

e Create a Subscription Template on page 157

° Delete an Alert Subscription Template on page 161

° Edit an Alert Subscription Template on page 160

e View (Alert Subscription Templates on page 157)

Related Application Options for Alerts

General

ENWW

e General

e Template Settings

Global settings can be stored here for managing alerts.

You can define how often devices should be checked to see if they warrant alerts or not. Frequent polling

can increase network traffic; infrequent polling might cause some device alerts to go unnoticed and
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therefore unattended. You can also specify how long an alert event stays in the alert history log or clear
the alerts log at any time.

Follow these steps:

1.

On the top menu bar, access Tools > Options and expand Device Management.
Expand Alerts and then select General.
Configure the desired settings:

¢ Maximum communication interval: used when no device communications have existed for
the specified number of hours (the default is 24 hours).

e Critical alert interval: used for devices with Critical Alerts settings; the devices are polled
every X minutes (the default is 5 minutes).

e Retention time: the number of days to save alerts log entries (default is 30 days). To clear
the log, select Clear Log.

To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Template Settings

You can reset the default alert subscription template back to its original state. This is convenient if
changes have been made to the template that you do not want applied anymore.

Follow these steps:

1.

On the top menu bar, access Tools > Options and expand Device Management.
Expand Alerts and then select Template Settings.

To reset the alert subscription template to factory settings (its state when first installed), click
Restore.

To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Subscribe for Device Alerts

Steps for Subscribing to Device Alerts

Other Ways to Create an Alert Subscription

You can define alerts for one or more devices.
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Steps for Subscribing to Device Alerts

1.

ENWW

Expand the Alerts tree in the left navigation pane. In the Alerts - Common Tasks task module,
select Subscribe for device alerts. The Create Alert Subscription wizard is started with the
Specify alerts subscription type page displayed.

Choose one of the following:
e  Select a template from the drop-down box, or
e  Specify the alert settings:

° General alerts (detailed): include most non-supply device events and rely on traps.
Polling is established when traps destinations cannot be configured.

° Supplies alerts: monitor device supply status and levels through polling. The polling
mechanism uses a combination of slow-polling and sliding time interval depending on
the level of the supply being monitored.

° Critical alerts: events are monitored by polling every five minutes. The polling interval
is configurable within the range of 5 to 360 minutes. Because of the frequent polling
nature of this solution, it is important to use it sparingly and only for devices that need
immediate attention. All General Alerts are available. This and other polling rates are
adjustable.

Click Next. The Select devices page is displayed.

Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.

You can also select an entire group instead of individual devices, by changing the selection method
to Groups. Tasks (for example configurations and more) can be performed on a single group or a
group and all of its subgroups.

NOTE: Including all subgroups can potentially take much longer and cause much more network
traffic, so should be used only when appropriate.

If you schedule a task using a group, the task will apply to the devices in the group at the time the
task starts. This makes it easy to redefine the devices used in regularly scheduled tasks without
having to delete and create a scheduled task.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device ldentification.

Click Next. The Specify notification type page is displayed.

Select the way you want to be notified about alerts:
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B NOTE: Alerts will always be included in the Alert History display. Also, plug-in solutions such
as the SNMP Traps Generator will add the choices to this page.

e Alert logging only: enter any alerts into the Alert History Log and do not send any email
messages about the alerts. Click Next. The Select alerts page is displayed.

¢ Email Notifier: enter any alerts into the Alert History Log and send an email message about
the alerts. Click Next. The Specify notification settings page is displayed:

° Enter the email address or browse for the email address. Multiple email addresses can
be separated by a semi-colon.

° Select the email format:
Concise (default): short description of the received alert.
Verbose: longer description of the alert.

Custom: message format that you can create and name for reuse later. If you do not
find a template in the drop-down list of custom messages, you can create one by
clicking Custom Email Templates.

° Click Next. The Select alerts page is displayed.

Proper SMTP settings must be made in Tools > Options > Application Management >
Email > SMTP (SMTP on page 246) and Email Addresses Management on page 246).

5. Select the alerts you want to be notified about and then click Next. The Specify advanced
settings page is displayed; select the advanced settings (the ones displayed are dependent on
the alerts selected on the previous page):

e No advanced settings: select this option if you do not want to configure any advanced
settings.

e Time to ignore duplicate alerts: when enabled, this value keeps HP Web Jetadmin 10.0
from sending duplicate Alerts within the time specified. This setting is specific to the
Subscription being edited or created.

o Ignore duplicates for: specify the amount of time that should elapse before HP Web
Jetadmin 10.0 should post an alert to email or to Alerts History.

0 Ignore first time period: if you want HP Web Jetadmin 10.0 to ignore the first time period
(as indicated in Ignore duplicates for above), then select this option.

Click Next; the Specify subscription name page is displayed.
6. Type the name for this set of alerts. Click Next; the Confirm page is displayed.
7. Click Subscribe; the Progress page is displayed.

8. To see details about the alerts, click Details; to see details about the alerts for each device,
click Expand All. When done, click Close; the Progress page is displayed again.

Bf NOTE: The Device Trap Table Settings page might be displayed. If so, complete this page and
click Finish.

9. Click Done.
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Other Ways to Create an Alert Subscription

e Right-click on Alerts in the left navigation pane and then select Subscribe.
e Inthe All Devices list, highlight a device and right-click. Select Alerts > Subscribe.

e Inthe All Devices list, highlight a device. Click the Alerts tab in the lower portion of the page and
then select Subscribe.

Edit an Alert Subscription

° Steps for Editing an Alert Subscription

e Other Ways to Edit an Alert Subscription

After an alerts subscription has been made for a device, changes in existing Notification Settings, email
recipients and formats, Available Alerts selections, Advanced Settings, and the Subscription Name can
be changed.

Steps for Editing an Alert Subscription
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1. Expand the Alerts tree in the left navigation pane and select All Subscriptions. Select the
subscription or device and then click Edit Subscription (at the bottom of the page). The Edit
Subscription wizard is started with the Specify notification type page displayed (if the
subscription is a supplies solution, this page will not be displayed).

2. Select the way you want to be notified about alerts:

e Alert logging only: enter any alerts into the Alert History Log and do not send any email
messages about the alerts. Click Next. The Select alerts page is displayed.

e Email Notifier: enter any alerts into the Alert History Log and send an email message about
the alerts. Click Next. The Specify notification settings page is displayed:

° Enter the email address or browse for the email address. Multiple email address can be
separated by a semi-colon.

° Select the email format:
Concise (default): short description of the received alert.
Verbose: longer description of the alert.

Custom: message format that you can create and name for reuse later. If you do not
find a template in the drop-down list of custom messages, you can create one by
clicking Custom Email Templates.

° Click Next. The Select alerts page is displayed.

3. Select the alerts you want to be notified about. Click Next. The Specify advanced settings page
is displayed; select the advanced settings.

Click Next; the Specify subscription name page is displayed.
4. Type the name for this set of alerts. Click Next; the Confirm page is displayed.

5. Click Edit Subscription; the Progress page is displayed.
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6.

7.

To see details about the alerts, click Details; to see details about the alerts for each device,
click Expand All. When done, click Close; the Results page is displayed again.

Click Done; the All Subscriptions page is displayed.

Other Ways to Edit an Alert Subscription

In the Alerts - Alert Subscriptions task module, click Subscribed devices. The All
Subsciptions page is displayed. Select the subscription or device and then click Edit
Subscription.

Alert History

Steps for Viewing Alert History

Other Ways to View Alert History

On the Alert History page, you can view the following information about alerts:

Time Received: the time the alert was received.

Alert: the name of the alert.

Device Model: the model of the device that received the alert.

IP Hostname: the IP Hostname of the device that received the alert.

IP Address: the IP Address of the device that received the alert.

You can sort the details by any of the columns listed by dragging that column to the top left of the page.

Steps for Viewing Alert History

1.

2,

Expand the Alerts tree in the left navigation pane. In the Alerts - Recent Alerts task module,
click View History. The Alert History page is displayed

After you have viewed the history, click Close. The Alerts Management page is displayed.

Other Ways to View Alert History

Right-click on Alerts in the left navigation pane and select View alerts history.

Click and expand Alerts in the left navigation pane. Then right-click on History and select View
alerts history.

In the Alerts - Recent Alerts task module, view summary information, or highlight an alert and
click View History.

In the All Devices list, highlight the device and then click the Alerts tab in the lower portion of the
page. Then select Alert History.

In the All Devices list, highlight the device and then right-click. Select Alerts > View alerts
history.

Select a device from the device list and select the Troubleshoot tab. Then Recent Alerts from
the right drop-down list. Click on View History to display the complete log for that device.
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Alert Subscription Templates

e Steps for Viewing Alert Subscription Templates

e Other Ways to View an Alert Subscription Template

You can view Alert templates (including the default template) and also do any of the following actions:

e Apply an Alert Subscription Template on page 159

e Create a Subscription Template on page 157

° Delete an Alert Subscription Template on page 161

° Edit an Alert Subscription Template on page 160

Steps for Viewing Alert Subscription Templates

1. Expand the Alerts tree in the left navigation pane and then expand Templates to list all Alert
templates. Click on the template you want to view. The specific template detail is displayed.

2.  You can do any of the following:

e Apply: apply the template to devices (Apply an Alert Subscription Template on page 159).

e Edit: make changes to the template (Edit an Alert Subscription Template on page 160).

Other Ways to View an Alert Subscription Template

e Expand the Alerts tree in the left navigation pane and then click on Templates. The Alerts -
Subscription Templates page is displayed listing all of the Alert templates. Highlight a template
and then click View.

Create a Subscription Template

e  Steps for Creating a Subscription Template

e Other Ways to Create an Alert Subscription Template

Alert templates are used to store settings to be reused again. When an Alert Subscription Template is
applied to a device as a ‘Linked Subscription’, the subscription will be altered if the associated template
is changed. A default Alerts Subscription Template is pre-configured when HP Web Jetadmin 10.0 is
installed and contains a combination of Supplies, Service and Media Path Alerts.
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Steps for Creating a Subscription Template

1.

Expand the Alerts tree in the left navigation pane. In the Alerts - Common Tasks task module,
select Create subscription template. The Create Alert Subscription Template wizard is started
with the Specify alerts subscription type page displayed.

Specify the alert settings:

e General alerts (detailed): include most non-supply device events and rely on traps. Polling
is established when traps destinations cannot be configured.

e Supplies alerts: monitor device supply status and levels through polling. The polling
mechanism uses a combination of slow-polling and sliding time interval depending on the level
of the supply being monitored.

e Critical alerts: events are monitored by polling every five minutes. The polling interval is
configurable within the range of 5 to 360 minutes. Because of the frequent polling nature of
this solution, it is important to use it sparingly and only for devices that need immediate
attention. All General Alerts are available. This and other polling rates are adjustable.

Click Next. The Specify notification type page is displayed.
Select the way you want to be notified about alerts:

e Alert logging only: enter any alerts into the Alert History Log and do not send any email
messages about the alerts. Click Next. The Select alerts page is displayed.

¢ Email Notifier: enter any alerts into the Alert History Log and send an email message about
the alerts. Click Next. The Specify notification settings page is displayed:

0 Enter the email address or browse for the email address. Multiple email address can be
separated by a semi-colon.

0 Select the email format:
Concise (default): short description of the received alert.
Verbose: longer description of the alert.

Custom: message format that you can create and name for reuse later. If you do not
find a template in the drop-down list of custom messages, you can create one by
clicking Custom Email Templates.

o Click Next. The Select alerts page is displayed.

Select the alerts you want to be notified about. Click Next. The Specify advanced settings page
is displayed; select the advanced settings.

Click Next; the Alerts template name page is displayed.
Type the name for this set of alerts. Click Next; the Confirm page is displayed.
Click Create Template; the Results page is displayed.

To apply the template to devices now, click Apply template and complete the pages displayed
(Subscribe for Device Alerts on page 152). To apply the template to devices later, click Done;
the Alerts Management page is displayed.
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Other Ways to Create an Alert Subscription Template

e Right-click on Alerts in the left navigation pane and then select Create subscription template.

e Inthe Alerts - Subscription Templates task module, click Create.

Apply an Alert Subscription Template

° Alert templates in Group Policies

° Steps for Applying an Alert Subscription Template

e Other Ways to Apply an Alert Subscription Template

After an alert template has been created, you can specify devices to use it with (Create a Subscription
Template on page 157). When applying a template to devices, you can choose to have the devices:

e Link template to subscription: any changes made to the template will automatically affect any
devices associated with this template.

e Do NOT link template to subscription: changes made to this template will not affect the devices
associated with it. This is used to apply the template settings as a new subscription without linking
that subscription in any way to the original template.

Alert templates create an alerts subscription on the devices to which they were applied. Any time a new
template is applied, a new alerts subscription is created on those devices.

Alert templates in Group Policies

The Groups Policy features is a powerful new automation tool that saves users a great deal of time
configuring devices and HP Web Jetadmin 10.0 settings. Both Automatic and Manual type groups can
have the Group Policy property. One policy that can be added to any device group’s properties is Alerts.
Both Subscribe and Unsubscribe using Alert templates can be applied to devices in the group either as
they are populated into group membership or as they are removed from group membership. In this way,
devices can have specific Alerts applied or de-applied without impact to other Alerts settings. (See
Group Policies on page 87.)

Steps for Applying an Alert Subscription Template
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1. Expand the Alerts tree in the left navigation pane. In the Alerts - Common Tasks task module,
select Apply subscription template. The Select template page is displayed with all alert
subscription templates in alphabetical order.

2. Highlight the template and click Next. The Select devices page displayed.

3. Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.

You can also select an entire group instead of individual devices, by changing the selection method
to Groups. Tasks (for example configurations and more) can be performed on a single group or a
group and all of its subgroups.
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7.

B NOTE: Including all subgroups can potentially take much longer and cause much more network

traffic, so should be used only when appropriate.

If you schedule a task using a group, the task will apply to the devices in the group at the time the
task starts. This makes it easy to redefine the devices used in regularly scheduled tasks without
having to delete and create a scheduled task.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device Identification.

Click Next. The Specify link options page is displayed.
Select the way you want to be notified about alerts:

e Link template to subscription: any changes made to the template will automatically affect
any devices associated with this template.

e Do NOT link template to subscription: changes made to this template will not affect the
devices associated with it. In effect, you are just using the settings from the template and then
saving them under a different name for the device just added. You must enter that different
name for the subscription.

Click Next.
The Confirm page is displayed. Click Apply Template.

To see details about the alerts, click Details; to see details about the alerts for each device,
click Expand All. When done, click Close; the Results page is displayed.

Click Done.

Other Ways to Apply an Alert Subscription Template

In the Alerts - Subscription Templates task module, highlight a template and click Apply.
In the left navigation pane, right-click on Alerts and select Apply subscription template.

In the All Devices list, highlight the device and then click the Alerts tab in the lower portion of the
page. Then select Apply Subscription Template.

In the All Devices list, highlight the device and then right-click. Select Alerts > Apply subscription
template.

In the All Devices list, select one or more devices and drag them to the Templates node in the
left navigation pane.

Edit an Alert Subscription Template

Steps for Editing an Alert Subscription Template

Other Ways to Edit an Alert Subscription Template

After an alert subscription template has been created, it can be changed. (See Create a Subscription
Template on page 157.)

If devices have been associated with the template, and if you chose to have them unlinked from the
templates, then any changes made will not affect those devices. (See Apply an Alert Subscription
Template on page 159.)
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Steps for Editing an Alert Subscription Template

1. Expand the Alerts tree in the left navigation pane. In the Alerts - Common Tasks task module,
select Edit subscription template. The Edit Subscription Template wizard is started with the
Select template page displayed.

2. Highlight the template and click Next. The Select alerts page is displayed.

3. Select the alerts you want to be notified about and then click Next. The Specify advanced
settings page is displayed; select the advanced settings and click Next.

4. The Specify notification type page is displayed. Select the way you want to be notified about
alerts:

e Alert logging only: enter any alerts into the Alert History Log and do not send any email
messages about the alerts. Click Next.

e Email Notifier: enter any alerts into the Alert History Log and send an email message about
the alerts. Click Next. The Specify notification settings page is displayed:

° Enter the email address or browse for the email address. Multiple email address can be
separated by a semi-colon.

° Select the email format:
Concise (default): short description of the received alert.
Verbose: longer description of the alert.

Custom: message format that you can create and name for reuse later. If you do not
find a template in the drop-down list of custom messages, you can create one by
clicking Custom Email Templates.

5. Click Next. The Specify name page is displayed. Type the name for this set of alerts. Click
Next; the Confirm page is displayed.

6. Click Save Template; the Results page is displayed.
7. Click Done.

Other Ways to Edit an Alert Subscription Template
e Inthe Alerts - Subscription Templates task module, highlight a template and click Edit.

Delete an Alert Subscription Template

e Steps for Deleting an Alert Subscription Template

° Other Ways to Delete an Alert Subscription Template

You can delete Alert subscription templates.
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Steps for Deleting an Alert Subscription Template

1.

3.
4,

Expand the Alerts tree in the left navigation pane. In the Alerts - Common Tasks task module,
select Delete subscription template. The Delete Alert Template wizard is started with the Select
template page displayed.

Highlight the template you want to delete and click Next. If the template is linked to devices, specify
the options to remove:

e Remove template but save linked subscriptions: delete the template but do not delete any
occurrences of this template that have been saved by other names with devices associated
with it (unlinked, see Apply an Alert Subscription Template on page 159).

e Remove subscriptions for all linked devices (listed below): delete the template and any
subscriptions to the template for all of the devices listed on this page.

Click Next. The Confirm page is displayed.
Click Delete Template; the Results page is displayed.
Click Done.

Other Ways to Delete an Alert Subscription Template

In the Alerts - Subscription Templates task module, highlight a template and click Delete.

All Subscriptions

Steps for Viewing Alert Subscriptions

Other Ways to View Alert Subscriptions

On the All Subscriptions page, you can view the following information about alerts:

Device Model: the model of the device that received the alert.

IP Hosthame: the IP Hostname of the device that received the alert.

IP Address: the IP Address of the device that received the alert.

Advanced Settings: any advanced settings for the device.

Notification Type: how you are notified about the alert (logging or email and logging).

Subscription Type: General alerts (detailed), Supplies solution, and Mission critical
solution.

Linked to Template: If the device is linked to a template (any future changes to that template will
affect the alert settings for the device).

Steps for Viewing Alert Subscriptions

1.

Expand the Alerts tree in the left navigation pane and select All Subscriptions. The All
Subscriptions page is displayed.

A summary is displayed with all alert subscription templates in alphabetical order. To view details,
click + next to the device. To show details for all subscriptions click + (Expand All) at the top of the
page, or click - (Collapse All) to minimize all subscriptions.
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3. To group Alerts, select Group By at the top of the page. You can group alerts by:

Device: displays devices that can be individually expanded to show each applied subscription
and corresponding Alerts detail.

Subscription: displays subscriptions by name that can be individually expanded to show
devices to which the subscription has been applied.

Solution Type: displays one or any of the three types of Alerts that have been configured.
These can be expanded to show individual subscriptions and devices to which the subscription
has been applied.

4. With All Subscriptions, you can do any of the following:

Save as Template: starts the Create Alert Subscription Template wizard, with the
subscription settings that were selected; see Create a Subscription Template on page 157.

Unsubscribe: stop subscribing to the alerts currently set for this device.

Edit Subscription: make changes to the alerts for this subscription; see Edit an Alert
Subscription on page 155.

Other Ways to View Alert Subscriptions
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e From any device list or a group list, select the Alerts tab. The subscriptions for the selected devices
are displayed.

e Right-click on Alerts in the left navigation pane and select View alerts subscriptions.
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Firmware

e All About Firmware

° Task Modules for Firmware

° Related Application Options for Firmware

° Upgrade Firmware

° Firmware Repository

All About Firmware

e Qualifying Firmware

Both printer and HP Jetdirect device firmware can be updated from HP Web Jetadmin 10.0. A firmware
image file can be downloaded onto the HP Web Jetadmin 10.0 application and if the version of this
image is greater than the version on the device, an upgrade is possible. HP Web Jetadmin 10.0 cannot
be used to downgrade firmware to an older revision level. Firmware updates can be scheduled to occur
at any time. Firmware update retry is also available in cases where an update failed or a device was not
on the network.

To ensure this feature works properly, see Minimum System Requirements for HP Web
Jetadmin 10.0 on page 2 for HP Web Jetadmin 10.0.

Qualifying Firmware

° Firmware Repository and Qualifying Firmware

° Refresh Feature

° Download Feature

° Upload Feature
e  Qualify Feature
° Finding Images

Qualifying firmware images ensures that firmware images are tested by individuals with permissions to
qualify images before installing and implementing them in your workplace. When firmware images are
required to be Qualified, they are listed with the column Qualified in the Firmware Repository. You
can require firmware images to be qualified by checking Use qualified firmware images in Tools >
Options > Device Management > Firmware > Firmware Repository Options. If you have appropriate
permission, you can actually qualify firmware images and also download and install qualified or non-
qualified firmware images. If you do not have permission, you can only download and install firmware
images that have been Qualified. Permissions are set in Application Management > User

Security > Roles; for permissions settings, select Device Firmware > Manage Firmware Images.
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Firmware Repository and Qualifying Firmware

The Firmware Repository can be accessed from the navigation pane under Firmware (Firmware
Repository on page 170). HP Jetdirect and printer firmware images exist on http://www.hp.com and
can be accessed in two ways:

e HP Web Jetadmin 10.0 can contact http://www.hp.com and display available images to users.

e Image files can be manually obtained and uploaded to HP Web Jetadmin 10.0 by the user through
the Upload button on the Firmware Repository page.

In both cases, the goal is to get the desired image(s) onto the HP Web Jetadmin 10.0 host so that they
can be used for updating. Firmware that is available on the local HP Web Jetadmin 10.0 host is marked
as Available in the WJA Server column. Images that are listed and marked as Not Available reside
on http://www.hp.com but have not yet been downloaded to HP Web Jetadmin 10.0.

Refresh Feature

Firmware images on http://www.hp.com that are ready for download can also be displayed through
the Firmware Repository by using the Refresh feature. When activated, this feature checks the image
listing at http://www.hp.com and displays new updates as Available in the HP.com column. Contact
with http://www.hp.com from the system hosting HP Web Jetadmin 10.0 is required for the Refresh
feature to work. This feature can be used at any time to update the listing.

Download Feature

The Download feature is used to download selected images from http://www.hp.com onto the HP Web
Jetadmin 10.0 host. Once a download action is complete, the image is marked as Available in the WJA
Server column.

Upload Feature

Contact with http://www.hp.com from the system hosting HP Web Jetadmin 10.0 may not be possible.
In this case, files can be obtained through a browser and then uploaded onto HP Web Jetadmin 10.0

manually. Once the Upload action is complete, images are marked as Available in the WJA Server

column.

Qualify Feature

ENWW

Images that are downloaded can be marked as Qualified. This allows administrative control over
firmware images as they are downloaded from the Web. This feature must first be enabled within
Tools > Options > Device Management > Firmware > Firmware Repository Options, Use qualified
firmware images. Once this feature item is enabled, the Qualified column in the Firmware
Repository will become visible.

Users assigned to Roles having Upgrade Device permission enabled, but who do not have Manage
Firmware Images enabled are able to upgrade only with firmware images that are qualified (those
marked as Yes in the Qualified column. Images that are not qualified, will not appear in the list.

Administrators assigned to Roles having Manage Firmware Images enabled, have the ability to see
non-qualified images (those marked as No) and qualified images (those marked as Yes). These
administrators can use upgrade devices with this firmware for test and qualification purposes. Once the
firmware is qualified, these same administrators can use the Qualify feature in the Firmware
Repository to mark the firmware as qualified. This action allows other users to begin performing
upgrades with tested/qualified firmware.
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Finding Images

HP Jetdirect firmware can be obtained through http://www.hp.com/go/wja_firmware. HP Printer firmware
images can be obtained by visiting the device specific Software and Drivers Downloads pages at
http://www.hp.com/go/webjetadmin_software. Devices that have firmware update capability will offer a
self extracting executable. The file required for HP Jetdirect printer firmware updates has an rfu
extension. This file can be extracted from the download and then uploaded into HP Jetdirect by using
Upload.

Task Modules for Firmware

° Firmware - Current Tasks and Common Tasks Task Modules

° Firmware - Active Tasks Task Module

° Firmware - Scheduled Tasks Task Module

The following task modules can be displayed or hidden in Firmware.

Firmware - Current Tasks and Common Tasks Task Modules

The Firmware - Current Tasks task module can be displayed on the Firmware page and includes the
following tasks:

° Upgrade Firmware on page 168

e View the Firmware Repository on page 170

The Firmware - Current Tasks task module can be displayed in other areas of HP Web Jetadmin 10.0;
in the other areas it is Firmware - Common Tasks.

Firmware - Active Tasks Task Module

The Firmware - Active Tasks task module can be displayed on the Firmware page and includes the
following tasks:

e Stop any active task.

e View active tasks (View the Firmware Repository on page 170).

Firmware - Scheduled Tasks Task Module

The Firmware - Scheduled Tasks task module can be displayed on the Firmware page and includes
the following tasks:

e Delete any scheduled task (Delete on page 172).

° Edit scheduled tasks (Edit on page 171).

Related Application Options for Firmware

e Firmware Upgrade Options

e Firmware Repository Options

° HTTP Settings

Global settings can be stored here for managing firmware images and how devices are updated.
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Firmware Upgrade Options

You can change the way firmware upgrades are performed, including how retries are done if a device
cannot be contacted or the number of devices that can be upgraded at once.

Follow these steps:
1. On the top menu bar, access Tools > Options and expand Device Management.
Expand Firmware and then select Firmware Upgrade Options.
2. Configure the desired settings:
e Maximum concurrent upgrades: Select the maximum number of upgrades at a given time.

e Retries: Select the number of retries for an upgrade and also how many times you want to
wait before trying to upgrade the device’s firmware again.

e Time between retries: Select the hours between each retry.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Firmware Repository Options

You can change the way that HP Web Jetadmin 10.0 manages its local copies of firmware images.
Images can be retrieved in the background on a regular schedule (for example, late at night or on a
weekend). You can also tell HP Web Jetadmin 10.0 to only use firmware images that have been tested
and “qualified” for use by your organization.

Follow these steps:

1. On the top menu bar, access Tools > Options and expand Device Management.
Expand Firmware and then select Firmware Repository Options.

2. Configure the desired settings:

e Enable background checking: Select this to have HP Web Jetadmin 10.0 check for new
firmware updates on http://www.hp.com in the background. To change the schedule click
Change:

° Select the date and time. You can also specify the start time to be within a range of hours.
° Select the recurrence.

° Click OK.

B NOTE: If you schedule a task (for example, a discovery or a configuration or others)
using a corresponding template, the task uses the settings defined in the template at the
time the task starts. This makes it easy to redefine settings used in a regularly scheduled
task without having to delete and create a scheduled task.
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NOTE: All HP Web Jetadmin 10.0 schedules are the date and time at the HP Web
Jetadmin install host. The client system being used to access HP Web Jetadmin may or
may not be in the same time zone as the HP Web Jetadmin install host. You should be
aware of the time and possible date differences when configuring HP Web Jetadmin 10.0
scheduling.

e Use qualified firmware images: You can choose to only use qualified firmware images. This
means someone in your organization has to certify an image before it can be installed. If you
check this, then in the Firmware Repository, firmware images will have to be certified as
qualified before they can be installed by a user who has non-administrative permissions.
See Qualifying Firmware on page 164.

B NOTE: Whomever is actually qualifying firmware images in the Firmware Repository must
have Manage Firmware Images permissions set through Device Management > Device
Firmware in User Security on page 260.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

HTTP Settings

The ability for HP Web Jetadmin 10.0 to display and get firmware images from http://www.hp.com
directly requires that HP Web Jetadmin 10.0 can contact http://www.hp.com. This requires that the
Allow download feature in Tools > Options > Application Management > Network > HTTP be
enabled and maybe also proxy settings (HTTP on page 245).

Upgrade Firmware

° Upgrading Firmware for HP Jetdirect Devices versus Printer Devices

e Steps for Upgrading Firmware

Once the firmware images exist on HP Web Jetadmin 10.0 host, they can be applied as upgrades to
devices.

If you chose to only use qualified firmware images, then you must certify firmware images before
upgrading the firmware. (To require firmware images be qualified, access Tools > Options > Device
Management > Firmware > Firmware Repository Options and check Use qualified firmware
images; whomever is actually qualifying firmware images in the Firmware Repository must have
Manage Firmware Images permissions set through Device Management > Device Firmware in User
Security on page 260.)

Upgrading Firmware for HP Jetdirect Devices versus Printer Devices

Upgrading firmware on HP Jetdirect devices versus printing devices is similar but not identical.

HP Jetdirect firmware updates are done by contacting the device through SNMP and directing it to
perform an update by obtaining the updated firmware from a TFTP service that is started on the HP Web
Jetadmin 10.0 server. HP Web Jetadmin 10.0 uses the standard port number for the TFTP server (port
69) that may get blocked by firewall software on the system hosting HP Web Jetadmin 10.0 software.
Once the update action is started, the device performs get actions against the image file on the TFTP
server until the whole image file is obtained. The actual update action is performed by the HP Jetdirect
device itself.

Printer firmware updates are done by HP Web Jetadmin 10.0 sending the RFU image file to the printer
in the same way a print job would be sent. This print-file action is done via port 9100 on the printer. Once
the printer receives the job, it recognizes it as an update and then launches internal processes that
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perform the actual update. HP Web Jetadmin 10.0 is used strictly as a file send agent in the case of
printer firmware updates.

Steps for Upgrading Firmware

ENWW

1.

In the left navigation pane, expand Firmware. In the Firmware - Common Tasks task module,
select Upgrade firmware. The Upgrade Firmware wizard is started with the Select upgrade
type page displayed.

Select the type of firmware to upgrade (device or HP Jetdirect).

To schedule the firmware upgrade for later, select Schedule firmware upgrade. Click Next.
The Select devices page is displayed.

NOTE: If you schedule a task (for example, a discovery or a configuration or others) using a
corresponding template, the task uses the settings defined in the template at the time the task
starts. This makes it easy to redefine settings used in a regularly scheduled task without having to
delete and create a scheduled task.

NOTE: All HP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin
install host. The client system being used to access HP Web Jetadmin may or may not be in the
same time zone as the HP Web Jetadmin install host. You should be aware of the time and possible
date differences when configuring HP Web Jetadmin 10.0 scheduling.

Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.

You can also select an entire group instead of individual devices, by changing the selection method
to Groups. Tasks (for example configurations and more) can be performed on a single group or a
group and all of its subgroups.

NOTE: Including all subgroups can potentially take much longer and cause much more network
traffic, so should be used only when appropriate.

If you schedule a task using a group, the task will apply to the devices in the group at the time the
task starts. This makes it easy to redefine the devices used in regularly scheduled tasks without
having to delete and create a scheduled task.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device ldentification.

Click Next. The Select firmware version page is displayed.

To search http://www.hp.com for the latest firmware, click Download images now (if
necessary).

You can choose to select the recommended version (Automatic) or you can select a version
(Custom).

If you chose to only use qualified firmware images (in Tools > Options > Device

Management > Firmware > Firmware Upgrade Options), a column is displayed showing whether
or not each image listed is qualified. You can select any of the qualified images to upgrade. If you
need to qualify an image and you have the appropriate permissions (Manage Firmware Images
set through User Security on page 260), select the image and click Qualify. The Qualify
Images wizard is started and you can complete qualifying images.
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5. Ifyou are scheduling this upgrade for a later time, the Specify schedule options page is displayed.
Select the start date and time. Then click Next.

6. The Confirm page is displayed. Click Next.
7. The Results page is displayed. Click Done.

Firmware Repository

e View the Firmware Repository

° Download

° Upload

Refresh the Latest Firmware Images

e Edit
° Delete

The first step in firmware updates is to find available images. Images exist on http://www.hp.com and
can be accessed in two ways:

e HP Web Jetadmin 10.0 can contact http://www.hp.com and display available images for you.

e  You can manually obtain and upload image files to HP Web Jetadmin 10.0.

In both cases, the goal is to get the desired image onto the HP Web Jetadmin 10.0 host so that it can
be used for updating. This image will be marked as Available on the Firmware Repository page.

Ef NOTE: For more information about qualifying firmware and the Firmware Repository, see Qualifying
Firmware on page 164.

View the Firmware Repository

You can view the firmware images for use by HP Web Jetadmin 10.0 on the Firmware Repository
page. This page displays the version of the firmware, the date of the version, whether the image is local
or not, and the device models the firmware upgrade supports. From here you can choose to:

° Download on page 171

° Upload on page 171

° Refresh the Latest Firmware Images on page 171

° Delete on page 172

Steps for Viewing the Firmware Repository
1. In the left navigation pane, expand Firmware and click Firmware Repository.

2. The available firmware upgrades are listed on the Firmware Repository page.

Other Ways to View the Firmware Repository

e Inthe left navigation pane, click Firmware. In the Firmware - Common Tasks task module,
select View firmware repository.
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Download

Download is used to download selected images from http://www.hp.com onto the HP Web Jetadmin
10.0 host. Once a download action is complete, the image is marked as Available in the WJA Server
column on the Firmware Repository page.

Steps for Downloading Firmware

1. In the left navigation pane, expand Firmware and click Firmware Repository.

The firmware upgrades are displayed on the Firmware Repository page. Click Download. The
Download Firmware wizard is started with the Confirm page displayed.

2. Click Next. The image is downloaded to HP Web Jetadmin 10.0 and the Results page is displayed.
Click Done.

Other Ways to Download Firmware

e Inthe left navigation pane, click Firmware. In the Firmware - Common Tasks task module,
select View firmware repository.

Upload

Contact with http://www.hp.com from the system hosting HP Web Jetadmin 10.0 may not be possible.
In these cases, files can be obtained through a browser and then uploaded onto HP Web Jetadmin 10.0
manually. Once the Upload action is complete, images are marked as Available in the WJA Server
column on the Firmware Repository page.

Steps for Uploading Firmware

1. In the left navigation pane, expand Firmware and click Firmware Repository.

The firmware upgrades are displayed on the Firmware Repository page. Click Upload. The
Upload Firmware Image wizard is started with the Select firmware file page displayed.

2. Enterorbrowse to the file with the firmware image and click Next. The image is uploaded to HP Web
Jetadmin 10.0 and the Results page is displayed. Click Done.

Refresh the Latest Firmware Images

HP Web Jetadmin 10.0 images on http://www.hp.com that are ready for download can also be displayed
through the Firmware Repository by using the Refresh feature. This checks the image listing at
http://www.hp.com and displays new updates as Available in the HP.com column on the Firmware
Repository page. Contact with http://www.hp.com from the system hosting HP Web Jetadmin 10.0 is
required for the Refresh feature to work.

Steps for Refreshing Firmware Images

1. Inthe left navigation pane, click Firmware and then click Firmware Repository.
On the Firmware Repository page, select Refresh.
2. The available firmware updates are found and listed on the Firmware Repository page.
Edit

You can edit any scheduled upgrade task listed in the Firmware - Scheduled Tasks task module.
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Steps for Editing a Firmware Upgrade Task

1.  In the Firmware - Scheduled Tasks task module, select the task and click Edit.
2. Make any changes to the scheduled upgrade task and click Next. The Confirm page is displayed.

3. Click Next. The schedule for upgrading the firmware will be changed.

Delete

You can delete any firmware image listed on the Firmware Repository page.

Steps for Deleting Firmware Images

1. In the left navigation pane, click Firmware and then click Firmware Repository.

On the Firmware Repository page, select the firmware image you want to delete and click
Delete.

2. A confirmation message is displayed. Click Yes.

3. The firmware will be deleted from HP Web Jetadmin 10.0.
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Reports

e All About Reports

e Task Modules for Reports

° Related Application Options for Reports

e Available Reports

e  Getting Started

° Data Collection

° Report Generation

e Archived Reports

All About Reports

e Types of Data Collection and Available Reports

° Examples

HP Web Jetadmin 10.0 provides a rich set of data collection and reporting features. These features
enable data collections that are stored in a database and that are used in generating reports at a later
time. After data is collected about a device or group of devices, you can display the data in a report,
save the data for future use, or save the report.

There are two steps to producing a report:

1. Collecting the data: request which devices to collect information about for the report. Since this
process causes network traffic and database space, you must turn on data collection when you
want a report.

Bf NOTE: If the data collection is not turned on, then the data will not be included in the report when
it is run.

2. Generating the report: specify the report type, the device or group or devices to include in the
report (which could be all or a subset of the devices you specified in Step 1), and the time frame
for the data to be included in the report. This must be done each time you want the report to run.

Reporting in HP Web Jetadmin 10.0 shows data change over time. A very simple report could be simple
device page count on a single device (Media Page Count, see Media Page Count on page 183). After
data collection has been established and multiple page counts exist in the database, a report can be
displayed that shows the page count change (if any) in a selected time interval.

For more information about producing a report for the first time, see Getting Started on page 185.

To ensure this feature works properly, see Minimum System Requirements for HP Web
Jetadmin 10.0 on page 2 for HP Web Jetadmin 10.0.

Types of Data Collection and Available Reports

The following reports can be generated and produced if you select the corresponding type of data
collection:
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Table 4-12 Available Types of Data Collection and Reports

Select this type of To gather this

Data Collection

type of data

To generate this
report

To determine

Available report
formats are

Notes

Accessories

Lists accessories

Device Detail

Tracks device

Table sorted by

Accessory data is

Inventory installed on the accessory device (no charts  collected once
devices. For inventory. available). every 24 hours.
example, a printer
might have an
accessory
duplexer or paper
tray.

By User Tracking Pages printed by User Page Count  Which jobs are Table sorted by Data is collected
user including bring printed and device or by user  whenever job-
application details. by whom. (no charts traps are sent from
Traps-based available). a device to the
triggering. HP Web Jetadmin

NOTE: Many host; collects
printers do not device job-table
support the data. For devices
automatic that do not support

notification when a

job is printed, so

data collection will
revert back to once

every 24 hours.

job-traps, HP Web
Jetadmin collects
the device job table
once every 24
hours.

Device Inventory

Reports on device

status and attribute
changes. Includes

device first and last
communication.

Device Changes

Reports “new”,
“found” and “lost”
device status.
Includes the
number of various
models installed on
the network. This
enables you to
monitor which
devices are
actually on the
network.

Last known status
or time interval (no

charts available).

Data is collected
once every 24
hours; collects
device status and
other device
details.

Device Utilization

Page-counts for
color, mono (black
and white),
simplex, duplex,
and total pages.
Also, page counts
for copy pages,
scan pages, digital
send pages, and
fax pages.

Media Page
Count

Time interval or
reporting period
counts for media/
page types
processed.

Reporting period or

time interval

(charts available).

Data is collected
once every 24
hours; collects
device page/media
detail.

Error History

Shows error type
counts stored on a
device.

Error History

Tracking error
frequency by error

type.

Table by period, by
type, or by device

(no charts
available).

Collects error log
detail.

Peak Usage

Page-counts for
color, mono (black
and white),
simplex, duplex,
and total pages.
Also, page counts
for copy pages,
scan pages, digital

Daily Peak Usage

Device media/
page counts on an
hourly basis
presented via
charts or summary
reports.

Hourly interval or

multiple bar chart.

Data is collected
once every 1 hour;
collects device
page/media detail.
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Table 4-12 Available Types of Data Collection and Reports (continued)

Select this type of To gather this

To generate this

To determine Available report

Notes

Data Collection type of data report formats are
send pages, and
fax pages.

Supply Utilization Forecasting and Supply Ordering  Reports supplies Table or chart. Data is collected
reporting for (HP SureSupply)  order requirements once every 24
supplies about to based on hours.
run out or percentages,
consumption rates, threshold; allows
based on current you to
usage. Includes automatically
toner cartridges, place your order
ink cartridges, and via
drum kits. HP SureSupply.

Supply Predicts supply Table or chart.
Replacement replacement dates
Forecast using supply usage

histories. Includes
percentage of
confidence, part
number details,
current supply
levels, and more.

Supply Usage

Improves Table or chart.
understanding of
supply
consumption rates
in particular
environments.
Shows individual
supply
consumption to-
date, supplies’ last
install date, supply
serial number, and
more.

NOTE: This
report only
includes
information about
devices with serial
numbers on their
toner cartridges.

Examples

ENWW

Reporting in HP Web Jetadmin 10.0 shows data change over time. A very simple report could be simple
device page count on a single device. After data collection has been established and multiple page

counts exist in the database, a report can be displayed that shows the page count change (if any) in a
selected time interval. (See Media Page Count on page 183).

Following is an example of data collection for page counts for a device for seven days:

Table 4-13 Example for Weekly Page Counts for the Media Page Count Report

Day 1: 20 pages

Day 8: 35 pages

Day 2: 25 pages

Day 9: 40 pages
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Table 4-13 Example for Weekly Page Counts for the Media Page Count Report (continued)

Day 3: 26 pages

Day 10: 44 pages

Day 4: 26 pages

Day 11: 44 pages

Day 5: 26 pages

Day 12: 44 pages

Day 6: 26 pages

Day 13: 44 pages

Day 7: 31 pages

Day 14: 47 pages

On days where page counts remain the same (in the example above, Days 3, 4, 5, and 6), HP Web
Jetadmin 10.0 stores the unchanged value.

Based on the above example, a simple report totaling pages printed in one week intervals might look
like this:

Table 4-14 Example for Media Page Count Report for Weekly Count

Device 1.1.0.1

Week 1: 11 pages

(31 pages - 20 pages = 11 pages)

Week 2: 16 pages

(47 pages - 35 pages = 16 pages)

Total: 27 pages

(11 pages + 16 pages = 27 pages)

Another report totaling pages printed in daily intervals might look like this:

Table 4-15 Example of Daily Page Counts for the Media Page Count Report

Day 1: 0 pages

Day 8: 4 pages

Day 2: 5 pages

Day 9: 5 pages

Day 3: 1 pages

Day 10: 4 pages

Day 4: 0 pages

Day 11: 0 pages

Day 5: 0 pages

Day 12: 0 pages

Day 6: 0 pages

Day 13: 0 pages

Day 7: 5 pages

Day 14: 3 pages

Device 1.1.0.1

Total Pages = 27

Complex reporting features exist and facilitate much more than simple page counts. Data collected over
time and reported in some interval is the general basis for most reporting features.

Task Modules for Reports

° Reports - Current Tasks and Report Management - Common Tasks Task Modules
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Reports - Report Templates Task Module

Reports - Archived Reports Task Module

Reports - Data Collection - Management Task Module

Reports - Data Collection - Templates Task Module

Reports - Scheduled Reports Task Module

Reports - Report Generation Task Module

The following task modules can be displayed or hidden in Reports on the Reports page, on the Data
Collection page, and on the Report Generation page.

Reports - Current Tasks and Report Management - Common Tasks Task Modules

The Reports - Current Tasks task module can be displayed on the Reports page and includes the
following tasks:

Getting Started on page 185: provides introductory information and links that explain the two main
steps required to produce reports and enables you to actually request and run a report.

Add Devices to Data Collection on page 188: also listed on the Data Collection on page 185 menu
and on the Reports - Data Collection - Management Task Module on page 178; this is the first
required step in producing a report. It enables you to select the type of data to collect from devices
and also specify which devices to collect the data from. (After you enable reporting, you must
select Generate a Report on page 197.)

Remove Devices from Data Collection on page 192: also listed on the Data Collection
on page 185 menu and on the Reports - Data Collection - Management Task Module
on page 178; enables you to exclude previously selected devices from data collection.

Generate a Report on page 197: also listed on the Report Generation on page 196 menu and on
the Report Generation - Common Tasks Task Module on page 196; the second required step in
producing a report; after you have started collecting data for reports, you are ready to generate the
report.

Schedule a Report on page 201: also listed on the Report Generation on page 196 menu and on
the Reports - Current Tasks and Report Management - Common Tasks Task Modules
on page 177; request the report to be produced at a specific time.

View Archived Reports on page 210: also listed on the Report Generation on page 196 menu and
on the Reports - Archived Reports Task Module on page 178; review reports that have been
produced and archived.

Delete Archived Reports on page 211: also listed on the Report Generation on page 196 menu
and on the Reports - Archived Reports Task Module on page 178; delete reports that have been
produced and archived.

The Reports - Current Tasks task module can be displayed in other areas of HP Web Jetadmin 10.0;
in the other areas it is Report Management - Common Tasks.
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Reports - Report Templates Task Module

The Reports - Report Templates task module can be displayed on the Reports page and on the
Report Generation page (Report Generation on page 196) and provides you access to the following
tasks:

Apply (Apply a Report Template on page 200): apply a report template that has already been
created to a device or group of devices.

Create (Create a Report Template on page 205): customize and store reports settings that can
be applied to one device or a group of devices while generating a report.

Delete (Delete a Report Template on page 209): delete a report template that has previously been
created.

Edit (Edit a Report Template on page 207): make changes to a report template that has previously
been created.

View (View a Report Template on page 209): view a report template that has been previously
created.

Reports - Archived Reports Task Module

The Reports - Archived Reports task module can be displayed on the Reports page and on the Report
Generation page (Report Generation on page 196) and provides you with access to the following tasks:

View (View Archived Reports on page 210): also listed on the Report Generation on page 196
menu; review reports that have been produced and archived.

Email (Email Reports on page 205): also listed on the Report Generation on page 196 menu;
email archived reports.

Save (Save Archived Reports on page 205): also listed on the Report Generation on page 196
menu; save reports that have been produced and archived.

Delete (Delete Archived Reports on page 211): also listed on the Report Generation
on page 196 menu; delete reports that have been produced and archived.

Reports - Data Collection - Management Task Module

The Reports - Data Collection - Management task module can be displayed on the Reports page
and the Data Collection page (Data Collection on page 185) and provides you with access to the
following tasks:

Add Devices (Add Devices to Data Collection on page 188): also listed on the Data Collection
on page 185 menu; add devices to a specific type of data collection.

Remove Devices (Remove Devices from Data Collection on page 192): also listed on the Data
Collection on page 185 menu; remove devices from a specific type of data collection.

View (Data Collection Summaries on page 194): also available from the left navigation pane as
specific Data Collection types; view the criteria selected for any specific type of data collection.

Anomalies (Data Collection Anomalies on page 196): review data collection anomalies and
choose to reconcile or resolve them. Anomalies are inconsistent information returned by the printer.
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Reports - Data Collection - Templates Task Module

The Reports - Data Collection - Templates task module can be displayed on the Reports page and
the Data Collection page (Data Collection on page 185) and provides you with access to the following
tasks:

New (Create a Data Collection Template on page 189): also listed on the Data Collection
on page 185 menu; lets you create a template for data collection.

Edit (Edit a Data Collection Template on page 191): also listed on the Data Collection
on page 185 menu; lets you edit a data collection template that has already been created.

Apply (Apply a Data Collection Template on page 190): also listed on the Data Collection
on page 185 menu; lets you apply a data collection template that has already been created to
devices.

View (Data Collection Templates on page 193): also listed on the Data Collection on page 185
menu; lets you view a data collection template that has already been created.

Delete (Delete a Data Collection Template on page 192) also listed on the Data Collection
on page 185 menu; lets you delete a data collection template that has already been created.

Reports - Scheduled Reports Task Module

The Reports - Scheduled Reports task module can be displayed on the Reports page and on the
Report Generation page (Report Generation on page 196) and provides you with access to the
following tasks:

Delete (Deleting Scheduled Reports on page 204): also listed on the Report Generation
on page 196 menu; lets you delete a report that has been scheduled (Schedule a Report

on page 201).

Edit (Editing the Schedule for a Report on page 204): also listed on the Report Generation
on page 196 menu; lets you edit a schedule for a report (Schedule a Report on page 201).

Reports - Report Generation Task Module

The Reports - Report Generation task module can be displayed on the Reports page and on the
Report Generation page (Report Generation on page 196) and provides you with access to the
following tasks:

Generate: also listed on the Report Generation on page 196 menu and on the Report Generation
- Common Tasks Task Module on page 196; the second required step in producing a report; after
you have started collecting data for reports, you are ready to generate the report (Generate a
Report on page 197).

Schedule: also listed on the Report Generation on page 196 menu and on the Reports - Current
Tasks and Report Management - Common Tasks Task Modules on page 177; request the report
to be produced at a specific time (Schedule a Report on page 201).

Sample: select a report and click Sample to display a sample of the report.

Related Application Options for Reports
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Global settings can be stored here for managing report data.

General

You can define your calendar quarters for your company. Your settings will be reflected in some of the
reports generated if the data is separated into quarters. You can also restore report templates that came
with HP Web Jetadmin 10.0. Templates are useful when generating the same report periodically. After
you change settings to the templates, you can restore them back to the factory defaults if desired. For
more information about factory defaults, see Default Settings on page 18.

Follow these steps:

1.

o & 0 BN

On the top menu bar, access Tools > Options and expand Device Management. Then select
Reports.

Select the date for the first day of the first quarter of the year (for your company).
To restore all of the Report templates that came with HP Web Jetadmin 10.0, click Restore.
You will be asked to confirm your request. Click OK in the dialog box.

To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Data Retention

As data is collected for reports, it is stored in tables within the HP Web Jetadmin 10.0 database. You
can specify how long to retain data for reporting purposes, and delete data that has been retained by
HP Web Jetadmin 10.0 for reporting purposes. Data retention is set to one year beyond the initial
collection date. You can change this value to a maximum of five years through this option.

Follow these steps:

1.

On the top menu bar, access Tools > Options and expand Device Management.
Expand Reports and then select Data Retention.
Select the type of data to delete:

e All data: delete all data that has been collected to-date, as though no data collections had
ever been done.

e User data: you will be asked to identify the user and then confirm your request.

e Device data: delete device data that has been collected to-date, as though no data collections
had ever been done.

Click Delete Data. Confirm the delete request by clicking Yes.

Specify how long you want to keep data for reporting purposes (from 1 to 5 years). (The default is
one year.)

To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Available Reports

Daily Peak Usage
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° Device Changes

° Device Details

° Error History
° Media Page Count

e Supply Ordering

° Supply Replacement Forecast

° Supplies Usage

° User Page Count

Reports are generated through a combination of user-defined settings and collected data that is stored
in the database. There are many report types that correspond directly to data collection types.
Completed reports can be displayed through the HP Web Jetadmin 10.0 client host. Reports can also
be stored in an archive or sent to email through SMTP.

Reports can be generated in a summary format, a reporting period format, and through any number of
graphical formats. Reports can be scheduled to occur at a specified time automatically or immediately.

NOTE: If you schedule a task (for example, a discovery or a configuration or others) using a
corresponding template, the task uses the settings defined in the template at the time the task starts.
This makes it easy to redefine settings used in a regularly scheduled task without having to delete and
create a scheduled task.

NOTE: All HP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin install
host. The client system being used to access HP Web Jetadmin may or may not be in the same time
zone as the HP Web Jetadmin install host. You should be aware of the time and possible date differences
when configuring HP Web Jetadmin 10.0 scheduling.

NOTE: The message No Data Collected is displayed on the report if you have selected a date range
that spans time when no report device data exists.

Daily Peak Usage
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The Daily Peak Usage report tracks hourly page and media counts.
Chart types include only the multiple bar.

Available columns for this report include but are not limited to:

e  Hour (default)

e Color (default)

e Black and White Pages (default)

e Total Page Count (default)

e Total Duplex Pages (default)

e Total Simplex Pages (default)

e Copy Pages

Click here for a table showing the Types of Data Collection and Available Reports on page 173.
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Device Changes

The Device Changes report captures device status and device communication states. This report can
be used to track devices that are missing or have been known to be missing in some timeframe.

The Report Type is used to separate devices by status changes or by some interval within the reporting
period. These include Last Known Status and Time Interval Summary.

Available columns for this report include but are not limited to:
e First seen

e Lastseen

e  Status (default)

e Device Model (default)

Click here for a table showing the Types of Data Collection and Available Reports on page 173.

Device Details
The Device Detail report can be used to inventory and track changes in device accessories.
Available columns for this report include but are not limited to:
e Accessory (default)
e Collection Date (default)
e  Status (default)

Click here for a table showing the Types of Data Collection and Available Reports on page 173.

Error History

The Error History report shows device errors and error categories on either a time interval or by-incident
basis.

The Report Type enables you to control how error data is tabulated within the report: By Period, By
Error Type or By Device.

The reporting frequency can be daily, weekly, monthly, or yearly.
Chart types include only the multiple line and multiple bar.
Available columns for this report include but are not limited to:

e Time Period (default)

e Paper Jam Count (default)

e ErroriD

e Page Count

Click here for a table showing the Types of Data Collection and Available Reports on page 173.
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Media Page Count

This report is used to track media and/or page counts over time. There are two possible formats:

Time Interval Summary: specify start and end dates. Each device table is conveyed with the
values from the reporting period selected.

By Reporting Period: specify the reporting frequency (monthly, weekly or daily). This breaks each
device table into interval periods spanning the reporting period.

The Reporting frequency (Monthly, Weekly or Daily) is active only when the report type By Reporting
Period is selected.

Chart types include pie, multiple bar, and multiple line.

Available columns for this report include but are not limited to:

Color (default)

Black and White Pages (default)
Total Page Count (default)

Total Duplex Pages

Copy Pages

Scan Pages

Executive

Letter

Click here for a table showing the Types of Data Collection and Available Reports on page 173.

Supply Ordering

The Supply Ordering report provides a list of needed supplies based on your specified percentage and
threshold. Also included is an HP SureSupply order option.

Chart types include the bar, multiple line, and multiple bar.

Available columns for this report include but are not limited to:

Part No. (default)
Date Collected (default)
Installation Date

Serial Number

Click here for a table showing the Types of Data Collection and Available Reports on page 173.

Supply Replacement Forecast

The Supply Replacement Forecast report is a predictive report showing replacement needs for specific
supplies. The device supplies metrics that exist in your database will be analyzed, a prediction about
needed supplies will be made, and the Supply Replacement Forecast will be generated. This
prediction is based on details that include supplies levels, percentage coverage, and other historic data
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relegated to supplies and printing. The report will include a percentage confidence rating to give you an
indication of how much data existed and was used in the analysis. If very little data existed, the
percentage confidence should indicate a low value. If you have been tracking supplies on devices for a
long period of time, the report would show a higher percentage of confidence.

Chart types include the bar, pie, and multiple bar.

Available columns for this report include but are not limited to:
e  Supply (default)

e Part No. (default)

e % Remaining (default)

e Pages Remaining (default)

Click here for a table showing the Types of Data Collection and Available Reports on page 173.

Supplies Usage

The Supply Usage report shows usage based on page count over supply lifetime, including many supply
details including install dates and serial numbers. This report only includes information about devices
with serial numbers on their toner cartridges.

Chart types include the bar and multiple bar.

Available columns for this report include but are not limited to:
e  Supply Part Number (default)

e  Supply Description (default)

e Supply Consumption (%) (default)

e Pages Printed (default)

e Average Supply Coverage (%) (default)

Click here for a table showing the Types of Data Collection and Available Reports on page 173.

User Page Count

The User Page Count reports by-user or by-application page counts based on job tables captured at
the device.

The Report Type is used to convey the information either By Device or By User.
Chart types include only the pie and multiple bar.

Available columns for this report include but are not limited to:

e Domain\User (default)

e Total Pages (default)

e MS Word Pages (default)

e  Other Applications (default)
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e Color Pages (default)
e Black and White Pages (default)

Click here for a table showing the Types of Data Collection and Available Reports on page 173.

Getting Started

There are two steps to generating a report:

1. Collecting the data (Data Collection on page 185): request which devices to collect information
about for the report. Since this process causes network traffic and database space, you must turn
on data collection when you want a report. If the data collection is not turned on, then the data will
not be included in the report when it is run. Based on the type of data collection selected, you can
then request certain reports to be generated.

2. Generating the report (Report Generation on page 196): specify the following:

e report type: the type of data collection selected in Step 1 dictates the reports available to be
generated.

e group or individual devices to include in the report, which could be all or a subset of the
devices you specified in Step 1.

e time frame for the data to be included in the report.

This must be done each time you want the report to run.

Bf NOTE: You can only select devices for which data has been collected.

Click here for a table showing the Types of Data Collection and Available Reports on page 173.

Data Collection

e Data Collection Cycle

° Initial Data Collection

° By User Tracking

° Using Group Policies to Set Data Collection

° Data Collection - Common Tasks Task Module

e Add Devices to Data Collection

e Create a Data Collection Template

e Apply a Data Collection Template

° Edit a Data Collection Template

° Delete a Data Collection Template

° Remove Devices from Data Collection

° Data Collection Templates

° Data Collection Summaries
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° Data Collection Anomalies

Data collections are groups of devices that have specific collection types enabled. You can apply a data
collection type such as Device Utilization to a single device, to multiple devices, or to a device group.
When a data collection is first applied to a device or devices, HP Web Jetadmin 10.0 launches a data
collection immediately establishing a data baseline. Once the device is populated under a specific data
collection type, data collections occur at some interval or by way of some trigger.

NOTE: Applying data collection to a device group is done through Group Policies on page 87.

As data is collected, it is stored in tables within the HP Web Jetadmin 10.0 database. Data retention is
set to one year beyond the initial collection date. This value can be changed in Tools > Options >
Device Management > Reports > Data Retention (Data Retention on page 180). Data collections for
Reports can be retained for up to 5 years.

Data Collection Cycle

Data collection types all have a specific collection cycle that may or may not be dependent on a schedule.
The By User Tracking data collections are triggered when printers send job-trap packets into the

HP Web Jetadmin 10.0 host. All other types are schedule-triggered. All data collections collect data
every 24 hours except for the Peak Usage data collection which is collected once every hour to provide
greater reporting resolution.

The start time for the data collection 24 hour cycle is set at 12:00AM at the HP Web Jetadmin 10.0 host.
When subscribing a device to a data collection, you can choose the time of collection if you prefer a
different time. The 24 hour cycle is designed to ensure reporting accuracy. Data within reports will be
marked if the data collected did not represent a full 24 hour cycle.

The message No Data Collected is displayed on the report if you have selected a date range that spans
time when no report device data exists.

Initial Data Collection

Activating data collection always launches the specific data collection type on selected devices. This is
done to gather initial or baseline data that is then stored in the database. This is not a user-selectable
action. The result of this initial data collection can be observed in the Results display for any completed
data collection configuration.

By User Tracking

The By User Tracking data collection type uses SNMP traps to trigger the HP Web Jetadmin 10.0 host
data collection. Every time a print job is completed by the device, a trap is sent and HP Web Jetadmin
10.0 runs a complete query of the device’s job table. Any new entries in the job table are stored in the
HP Web Jetadmin 10.0 database; all old entries that were previously stored are discarded.

By User Tracking accuracy may be limited by two things:
e the device’s ability to store only a limited number of jobs in the job table.
e the device’s ability to trap when multiple print jobs are queued.

Both of these are dependant on device printer model and firmware. By User Tracking and Reporting
should never be used as a substitute for job accounting. HP Web Jetadmin 10.0 Reports features are
designed for trending and analysis purposes.

NOTE: For devices that don’t support job-traps, HP Web Jetadmin 10.0 will collect the device’s job
table once every 24 hours.
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Reports and Alerts Traps Listener Port

Earlier releases of HP Web Jetadmin used a different traps listener port for Reports than the traps
listener used for Alerts events. In HP Web Jetadmin 10.0, this has changed. Shown here are the
differences between previous versions of HP Web Jetadmin and HP Web Jetadmin 10.0:

e HP Web Jetadmin 10.0 traps listener port: is UDP port=27892 for Alerts and Reports by-user
collections.

e  Prior versions of HP Web Jetadmin traps listener port was UDP port=27892 for Alerts and UDP
port=27894 for Report Generation Plug-in by-user collections.

Device and Printer Driver Support for By User Tracking

Job logging features are not available on all HP printers. Check your printer documentation to be sure
these device-based features exist.

End of job trapping is not supported on all HP printers. In the case where end of job trapping is not
supported, HP Web Jetadmin 10.0 will query the job tables once per collection period (24 hours). This
may impact the accuracy of by-user reporting due to the limited size of the device job log.

Windows print drivers supplied by HP are known to support device job log entries. Windows print drivers
available through Microsoft Windows operating systems may not support job log entries. Be sure to use
HP model-specific drivers or the HP Universal Print Driver (UPD) when by-user tracking is required.

Using Group Policies to Set Data Collection

The Group Policies feature is a powerful new automation tool that can save you a lot of time configuring
devices and HP Web Jetadmin 10.0 settings. Any device group has a property known as a Group
Policies. One policy that can be added to any device group’s properties is Enable Data Collection.
When activating the Enable Data Collection to a device group, you must define a data collection
template from the list of existing templates. Also, a trigger is specified that enables the configuration to
take place either as the device is populated into the group or as the device is de-populated from the
group. Multiple Enable Data Collection settings can exist on a single device group. See Group
Policies on page 87.

Data Collection - Common Tasks Task Module
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Tasks available within Data Collection are listed in the Data Collection - Common Tasks task module:

e Create a Data Collection Template on page 189: also listed on the Reports - Data Collection -
Templates Task Module on page 179 menu; lets you create a template for data collection.

e Apply a Data Collection Template on page 190: also listed on the Reports - Data Collection -
Templates Task Module on page 179 menu; lets you apply a data collection template that has
already been created to devices.

e Edit a Data Collection Template on page 191: also listed on the Reports - Data Collection -
Templates Task Module on page 179 menu; lets you edit a data collection template that has already
been created.

e Delete a Data Collection Template on page 192: also listed on the Reports - Data Collection -
Templates Task Module on page 179 menu; lets you delete a data collection template that has
already been created.
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e Add Devices to Data Collection on page 188: also listed on the Reports - Data Collection -
Management Task Module on page 178; lets you add devices to a specific type of data collection.

e Remove Devices from Data Collection on page 192: also listed on the Reports - Data Collection
- Management Task Module on page 178; lets you remove devices from a specific type of data
collection.

Add Devices to Data Collection
° Data Collection Offset

e Steps for Adding Devices to Data Collection

e Other Ways to Add Devices to Data Collection

Devices can be added to any type of data collection.

Data Collection Offset

HP Web Jetadmin 10.0 has a Collection offset feature that allows you to specify a positive offset value
to the fixed data collection start time. The fixed data collection start time is 12:00AM local server time.
The offset value causes HP Web Jetadmin 10.0 to delay the data collection start time by the number of
hours entered (up to 23 hours are possible). Here are two examples:

Joy wants to start data collections at 8:00AM for her devices which are in the same area as the HP Web
Jetadmin 10.0 server host. Joy enters a data collection offset of 8. Pat wants to start data collections at
12:00PM for his devices which are in an area that has a 14 hour time differential from the area in which
the HP Web Jetadmin 10.0 server is hosted. Pat uses an offset of 10 to push the data collection start
time to 12:00PM in his area.

Calculations are needed to determine the offset needed. These offsets should not be changed once
they are set. HP Web Jetadmin 10.0 will continue to use a 24 hour data collection cycle for all devices.
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Steps for Adding Devices to Data Collection

Bf NOTE: If you access this feature through the Reports - Data Collection - Management Task Module
on page 178, then you will skip the first page of the Add Devices to Data Collection Wizard.

1.

5.

6.

Expand the Reports tree in the left navigation pane and then click Data Collection.

In the Data Collection - Common Tasks task module, select Add devices to data collection.
The Add Devices to Data Collection wizard is started with the Select data collection page
displayed.

Select the type of data collection for this template and specify the number of offset hours (if any)
and then click Next. The Select devices page is displayed.

NOTE: For more information about Data Collection offset hours, see Data Collection Offset
on page 188.

Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.

You can also select an entire group instead of individual devices, by changing the selection method
to Groups. Tasks (for example configurations and more) can be performed on a single group or a
group and all of its subgroups.

NOTE: Including all subgroups can potentially take much longer and cause much more network
traffic, so should be used only when appropriate.

If you schedule a task using a group, the task will apply to the devices in the group at the time the
task starts. This makes it easy to redefine the devices used in regularly scheduled tasks without
having to delete and create a scheduled task.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device Identification.

Click Next. The Confirm page is displayed.
Click Next. The Results page is displayed.

Click Details to view the types of data collection for that device. When done, click Close; the
Results page is displayed again.

Click Done to display the Data Collection page.

Now you are ready to generate a report.

Other Ways to Add Devices to Data Collection

In the left navigation pane, right-click on Reports and select Add devices to data collection.
In the All Devices list, right-click Reports and select Add devices to data collection.

In the All Devices list, highlight the device and then in the lower portion of the page click the
Reports tab. Then click Add devices to data collection.

Create a Data Collection Template
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Steps for Creating a Data Collection Template
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e Other Ways to Create a Data Collection Template

Click here for a table showing the Types of Data Collection and Available Reports on page 173.

Data Collection Templates are designed to help you enable more than one data collection type. In
summary, you can create a data collection template by opening the Create Data Collection
Template wizard, select one or more data collection types, name the template, and then confirm the
settings.

After the template has been created, it can be applied to devices in the same ways as individual data
collection types. By applying data collection templates, you are actually configuring the individual data
collection types without having to activate controls multiple times.

For scheduling information, see Data Collection Offset on page 188.

Steps for Creating a Data Collection Template
1. Expand the Reports tree in the left navigation pane and then click Data Collection.

In the Data Collection - Common Tasks task module, select Create data collection template.
The Create Data Collection Template wizard is started with the Choose data collection type
page displayed.

2. Select the type of data collection for this template and specify the number of offset hours (if any)
and then click Next. The Specify template name page is displayed.

B NOTE: For more information about Data Collection offset hours, see Data Collection Offset
on page 188.

Type the name for the template and then click Next. The Confirm page is displayed.

3

4. Click Next. The Results page is displayed.

5. Click Done to display the Data Collection page.
6

Now you are ready to apply the template to devices and to generate a report.

Other Ways to Create a Data Collection Template

e In the left navigation pane, right-click on Reports and select Create data collection template.

Apply a Data Collection Template

° Steps for Applying a Data Collection Template

e Other Ways to Apply a Data Collection Template

You can apply a Data Collection template that has already been created to a device or group of devices.
You can also turn data collection on and off; this is useful if you need to control the network traffic
generated to communicate with the devices and also because the data is stored in database tables
which, over time, can become quite large. By selecting the data to include, you have great flexibility as
to what you want to include in your reports.
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Steps for Applying a Data Collection Template

1.

6.
7.

Expand the Reports tree in the left navigation pane and then click Data Collection.

In the Data Collection - Common Tasks task module, select Apply data collection template.
The Apply Data Collection Template wizard is started with the Select data collection page
displayed.

Select a template and click Next. The Select devices page is displayed.

Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.

You can also select an entire group instead of individual devices, by changing the selection method
to Groups. Tasks (for example configurations and more) can be performed on a single group or a
group and all of its subgroups.

NOTE: Including all subgroups can potentially take much longer and cause much more network
traffic, so should be used only when appropriate.

If you schedule a task using a group, the task will apply to the devices in the group at the time the
task starts. This makes it easy to redefine the devices used in regularly scheduled tasks without
having to delete and create a scheduled task.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device Identification.

Click Next. The Confirm page is displayed.
Click Next. The Results page is displayed.

Click Details to view the types of data collection for that device. To expand the details for all
devices, click Expand All. When done, click Close; the Results page is displayed again.

Click Done to display the Data Collection page.

Now you are ready to generate a report.

Other Ways to Apply a Data Collection Template

In the left navigation pane, right-click on Reports and select Apply data collection template.
In the All Devices list, right-click Reports and select Apply data collection template.

In the All Devices list, highlight the device and then in the lower portion of the page click the
Reports tab. Then click Apply data collection template.

Edit a Data Collection Template

Steps for Editing a Data Collection Template

Other Ways to Edit a Data Collection Template

You can change the type of data collection for a specified template and you can change the template’s
name.
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Steps for Editing a Data Collection Template
1. Expand the Reports tree in the left navigation pane and then click Data Collection.

In the Data Collection - Common Tasks task module, select Edit data collection template.
The Edit Data Collection Template wizard is started with the Data Collection Template
Selection page displayed.

2. Select a template and click Next. The Choose data collection type page is displayed.

3. To change the type of data collection for this template, check the type or types to include and
uncheck those that should not be included. Then click Next. The Specify template name page is
displayed.

4. To change the name for this template, type the new name in Template name (or you can leave
the name as it was). Then click Next. The Confirm page is displayed showing you the old settings
and the new settings for this template.

5. Click Next. The Results page is displayed.
6. Click Done to display the Data Collection page.

7. Now you are ready to generate a report.

Other Ways to Edit a Data Collection Template

e Inthe left navigation pane, right-click on Reports and select Edit data collection template.

Delete a Data Collection Template

e Steps for Deleting a Data Collection Template

° Other Ways to Delete a Data Collection Template

You can delete a data collection template.

Steps for Deleting a Data Collection Template
1. Expand the Reports tree in the left navigation pane and then click Data Collection.

In the Data Collection - Common Tasks task module, select Delete data collection template.
The Delete Data Collection Templates wizard is started with the Select templates page
displayed.

2. Select the data collection template or templates to delete and click Next. The Confirm page is
displayed.

3. Click Next. The Results page is displayed.
4. Click Done to display the Data Collection page.

Other Ways to Delete a Data Collection Template

e In the left navigation pane, right-click on Reports and select Delete data collection template.

Remove Devices from Data Collection

° Steps for Removing Devices from Data Collection
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Other Ways to Remove Devices from Data Collection

You can remove devices from any type of data collection at any time.

Steps for Removing Devices from Data Collection

1.

5.
6.

Expand the Reports tree in the left navigation pane and then click Data Collection.

In the Data Collection - Common Tasks task module, select Remove devices from data
collection. The Remove Devices from Data Collection wizard is started with the Select data
collection type page displayed showing the devices currently selected for that type of data
collection.

Select the type of data collection that you want to remove devices from and click Next.

Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.

Click Next. The Confirm page is displayed showing you the devices to be deleted from this type
of data collection.

Click Next. The Results page is displayed.

Click Done to display the Data Collection page.

Other Ways to Remove Devices from Data Collection

In the left navigation pane, right-click on Reports and select Remove devices from data
collection.

Data Collection Templates

Steps for Accessing and Working with Data Collection Templates

Other Ways to Access a Data Collection Template

In Data Collection Templates, you can:

Create new templates (Create a Data Collection Template on page 189).

View existing templates (Data Collection Templates on page 193).

Edit existing templates (Edit a Data Collection Template on page 191).

Apply existing templates (Apply a Data Collection Template on page 190).

Delete existing templates (Delete a Data Collection Template on page 192).

You can also add devices to or remove devices from this type of data collection.

ENWW

Reports 193



Steps for Accessing and Working with Data Collection Templates

1.

Expand the Reports tree in the left navigation pane; then expand the Data Collection tree and
click Templates.

Do one of the following:

e To create a data collection template, click New (Create a Data Collection Template
on page 189).

e To view an existing data collection template, highlight the template and click View. Then you
can edit, apply, or delete the template (see below).

e To edit an existing data collection template, highlight the template and click Edit (Edit a Data
Collection Template on page 191).

e To apply an existing data collection template, click Apply (Apply a Data Collection
Template on page 190).

e To delete an existing data collection template, click Delete (Delete a Data Collection
Template on page 192).

Other Ways to Access a Data Collection Template

In the left navigation pane, expand Reports and then expand Data Collection. All of the existing
templates are listed in the Data Collection - Templates task module.

Data Collection Summaries

Steps for Data Collection Summaries

Other Ways for Data Collection Summaries

You can view which devices have been added to any type of data collection. The following information
is displayed:

Reports Supported: shows all of the reports you could generate with this particular type of data
collection.

Summary: shows the type (or name) of data collection, the impact the collection itself will have on
your network, the time of day the data is collected, and the number of devices you are collecting
data about.

Devices: lists all of the devices you have included for this type of data collection.

Add/Remove Devices (button at the bottom of the page): add devices to or remove devices from
this type of data collection.

Steps for Data Collection Summaries

1.

Expand the Reports tree in the left navigation pane and then expand Data Collection. Below Data
Collection, click on any type of data collection. The summary page for that type of data collection
is displayed.

View the summary data displayed.
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3. To add devices from this type of data collection:

a. Click Add Devices (at the bottom of the page). The Add Devices to Data Collection wizard
is started with the Select data collection page displayed. Click Next.

b. Select the device by highlighting it and clicking the arrow buttons between the two lists. To
select multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list
to the other, use the double arrow buttons. You can sort the list of available devices by clicking
the column headers, or view more columns by right-clicking the column headers.

You can also select an entire group instead of individual devices, by changing the selection
method to Groups. Tasks (for example configurations and more) can be performed on a single
group or a group and all of its subgroups.

Ef NOTE: Including all subgroups can potentially take much longer and cause much more
network traffic, so should be used only when appropriate.

If you schedule a task using a group, the task will apply to the devices in the group at the time
the task starts. This makes it easy to redefine the devices used in regularly scheduled tasks
without having to delete and create a scheduled task.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device Identification.

c. Click Next. The Confirm page is displayed showing you the devices to be added to this type
of data collection.

d. Click Next. The Results page is displayed.
e. Click Done to display the summary data page.
4. To remove devices from this type of data collection:

a. Selectthe devices you want to remove and click Remove Devices (at the bottom of the page).
The Remove Devices from Data Collection wizard is started with the Confirm page
displayed.

b. Click Next. The Results page is displayed.
c. Click Done to display the summary data page.

5. Now you are ready to generate a report.

Other Ways for Data Collection Summaries

e Inthe Reports - Data Collection - Management task module, highlight the type of data collection
to view and click View.
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Data Collection Anomalies

Anomalies can be invoked through the Data Collection - Management task module. There are three
anomaly conditions:

e Collected page count has decreased: old data (prior to the decrease) will be removed.

e Page counts do not reconcile (example: page count total is different than the sum of color and
mono page counts): causes the irreconcilable data to be ignored.

e Invalid device serial number: these are not reconcilable within the application, serial number issues
must be corrected at the device.

Steps for Data Collection Anomalies

1. Inthe Reports - Data Collection - Management task module, highlight the type of data collection
to review and click Anomalies. The Data Collection Anomalies page is displayed.

2. Select the anomaly to view and click Reconcile.
3. You can choose to Ignore the anomaly.

4. When done, click Close.

Report Generation

° Report Generation - Common Tasks Task Module

e Generate a Report

e Apply a Report Template

e Schedule a Report

° Email Reports

e Save Archived Reports

e Create a Report Template

° Edit a Report Template

° Delete a Report Template

e View a Report Template

e View Reports

After data collection has been performed, you can generate reports. The type of reports that can be
generated is dependent upon the type of data collection that you ran.

Report Generation - Common Tasks Task Module

Tasks available within Report Generation are listed in the Report Generation - Common Tasks task
module:

e Generate a Report on page 197

e Apply a Report Template on page 200
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° Schedule a Report on page 201

° View Archived Reports on page 210

° Email Reports on page 205

° Save Archived Reports on page 205

° Delete Archived Reports on page 211

° Create a Report Template on page 205

° Edit a Report Template on page 207

° Delete a Report Template on page 209

Generate a Report

ENWW

e Steps for Generating a Report

e Other Ways to Generate a Report

Generating the report requires you to specify the report type, the group or individual devices to include
in the report (which could be all or a subset of the devices you specified during data collection) (Data
Collection on page 185), and the time frame for the data to be included in the report. You will also specify
whether the output should be directed to the page or to a file (or both).

A generated, or completed, report can contain a lot of data! A report that is displayed through HTML or
CSV may contain notes that provide important notices about stored data. Here are a few of those items:

e No Data Collected: no data was collected for the corresponding time period.

e Partial: the data represented in the corresponding time period was collected somewhere in that
time period and may not represent an actual count.

For example, if you launch a report with Collect data for today enabled, this data collection will

be out of the normal data collection cycle which begins at 12:00AM (data between 12:00AM and

the time you request this would be the data that is out of the normal data collection). Data reported
using this data will be marked as Partial. This is normally displayed at the beginning or end of a

report.

e Estimate: data that was averaged over several days. This could be due to a lapse in data collection
where perhaps several days went by with no collections.
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Steps for Generating a Report

1.

B

Select Reports from the left navigation pane. The Reports page is displayed.

In the Report Management - Common Tasks task module click Generate Report. The Generate
Report wizard is started with the Choose report options page displayed.

If templates have been created, you can select an existing template from the Use template drop-
down box.

If there are no existing templates or if you want to request a custom report, select the type of data
collection under Specify settings and then select the supported reports for that type of data
collection from the drop-down box.

NOTE: Be sure and select a report that matches the type of data collection you specified in Data
Collection on page 185. If you find you need a different report, you might have to go back to Data

Collection on page 185 and select a different type of data collection.

To schedule the report to run at a later time, click Schedule report.

To run the report now, click Next. The Specify date range for report page is displayed.

NOTE: If you schedule a task (for example, a discovery or a configuration or others) using a
corresponding template, the task uses the settings defined in the template at the time the task
starts. This makes it easy to redefine settings used in a regularly scheduled task without having to
delete and create a scheduled task.

NOTE: All HP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin
install host. The client system being used to access HP Web Jetadmin may or may not be in the
same time zone as the HP Web Jetadmin install host. You should be aware of the time and possible
date differences when configuring HP Web Jetadmin 10.0 scheduling.

Specify the date range for the data to be included on the report.

The message Warning: No Data Collected is displayed when you select a data range that spans
time when no report device data exists. This check is done again for selected devices.

If you selected Schedule report on the previous page, you have the option to select a previous
time period.

NOTE: Even though data can be collected for a period of time, not all of that data has to be
included on the report. You can determine a smaller time frame for the data that is actually included
in the report.

To ensure your report contains recent data, you can select Collect data for today. This option
enables data collection one more time prior to generating the report so that page counts and other
data are up to date as of the minute the report is run, as opposed to the previous night.

NOTE: This option is not available if you are scheduling this report for a later time.

Click Next. The Select devices page is displayed.

Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.
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You can also select an entire group instead of individual devices, by changing the selection method
to Groups. Tasks (for example configurations and more) can be performed on a single group or a
group and all of its subgroups.

Bf NOTE: Including all subgroups can potentially take much longer and cause much more network
traffic, so should be used only when appropriate.

If you schedule a task using a group, the task will apply to the devices in the group at the time the
task starts. This makes it easy to redefine the devices used in regularly scheduled tasks without
having to delete and create a scheduled task.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device ldentification.

NOTE: If data collection has not been enabled for a selected device, you are given the option to
start data collection now.

Click Next.
7. Now you can actually define what will be included on your report:

e Report Format: If applicable for the report being generated, select the chart type for your
report from the drop-down box. This criteria varies depending on the report being generated.

e Report Columns:

0 Device ID Columns: select the columns to include on the report that identify the devices
from the drop-down box.

o Available columns and Columns to show: select the columns to include on the report.
If you want totals for any specific column, check the box under Show Totals.

The selections vary by report type but are representative of the data stored for the
corresponding data collection type. These can be enabled and disabled and can also be
re-ordered in the report.

B NOTE: To select multiple columns, use either Ctrl+Click or Shift+Click.

You can move the type of column up or down in the list (Up and Down); this determines
its order on the report.

° Group by: specify how you want the data grouped by selecting an option from the Group
by drop-down box. An example of this is Device Model. If chosen, HP Web Jetadmin
10.0 groups all of the same device models next to each other in the report.

° Sort by: specify how you want the data sorted by selecting an option from the Sort by
drop-down box. An example is IP address: when chosen, HP Web Jetadmin 10.0 orders
the devices within the report by their IP addresses. Of course, the ordering occurs within
the Group by subsets.

e (If applicable) Display cartridges with percentage below: select the percentage for ink
levels remaining in cartridges.

e (Ifapplicable) Order from HP SureSupply?: check this box if you want to order supplies from
HP SureSupply.

8. After you have defined the report format, click Next. The Specify destination options page is
displayed.
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10.

1.

12.

13.

14.

15.
16.

Select how you want the report displayed (either on the page or directly to email). If sending the
report to email addresses, you can either browse for those addresses or you can enter them
manually. Separate each address with a semi-colon.

Specify the report destination:
e Display: displays the report on your page.

e  Email: send the report (in HTML or CSYV file format) to an email address (Email Reports
on page 205). Type the email address on this page or browse for the correct email address.

Specify the file format:

° HTML.: save the file as an HTML document (Save Archived Reports on page 205).

e CSV: export the report as a CSV document (Email Reports on page 205).

Click Next; the Specify report name page is displayed.

Enter the name for this report and specify how long you want to keep this report. Then click
Next.

If you are scheduling this report for a later time, the Specify schedule options page is displayed.
Select the start date and time for your report and also how often it should run. Then click Next.

The Confirm page is displayed, summarizing all of the report format options you have selected for
this report. Click Next.

The Report Generation Complete page is displayed showing the actual report generation.

Click Done to display the Reports page.

Other Ways to Generate a Report

In the navigation pane, right-click on Reports and select Generate report.

On the All Devices page, highlight the device to collect data for a report; and then, in the lower
portion of the All Devices page, click on the Reports tab and then click Generate report.

Apply a Report Template

Steps for Applying a Report Template

Other Ways to Apply a Report Template

A report template contains a set of criteria including the report type, devices, and the report format. After
a report template is created, you can apply it to generate a report easily.

Steps for Applying a Report Template

1.

Expand the Reports menu in the left navigation pane and select Report Generation.

In the Reports - Common Tasks task module, click Apply report template. The Generate
Report wizard is started with the Choose report options page displayed.

In the Use template drop-down box, highlight the template you want to use and click Next. The
Specify date range for report page is displayed.

Specify the date range for the data to be included on the report and click Next. The Select
devices page is displayed.
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7.

8.

Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.

You can also select an entire group instead of individual devices, by changing the selection method
to Groups. Tasks (for example configurations and more) can be performed on a single group or a
group and all of its subgroups.

NOTE: Including all subgroups can potentially take much longer and cause much more network
traffic, so should be used only when appropriate.

If you schedule a task using a group, the task will apply to the devices in the group at the time the
task starts. This makes it easy to redefine the devices used in regularly scheduled tasks without
having to delete and create a scheduled task.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device Identification.

Click Next; the Specify report name page is displayed. Type the name for this report template
and then click Next.

The Confirm page is displayed, summarizing all of the report format options you have selected for
this report. Click Next.

The Report Generation Complete page is displayed showing the actual report generation.

Click Done to display the Reports page.

Other Ways to Apply a Report Template

1.

2,

Expand the Reports menu in the left navigation pane and then right-click on Report
Generation. Then select Apply report template.

In the All Devices list, highlight a device and right-click. Then select Reports > Apply report
template.

Schedule a Report

Steps for Scheduling a Report

Other Ways to Schedule a Report

Deleting Scheduled Reports

Editing the Schedule for a Report

Reports can be generated as you request them (if data collection has been enabled) or they can be
scheduled to be generated at a future time. This might reduce network traffic at particular heavy times,
or it might give the data collection process time to collect the data necessary to make the report
meaningful.

Bf NOTE: If you schedule a task (for example, a discovery or a configuration or others) using a
corresponding template, the task uses the settings defined in the template at the time the task starts.
This makes it easy to redefine settings used in a regularly scheduled task without having to delete and
create a scheduled task.
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NOTE: All HP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin install
host. The client system being used to access HP Web Jetadmin may or may not be in the same time
zone as the HP Web Jetadmin install host. You should be aware of the time and possible date differences
when configuring HP Web Jetadmin 10.0 scheduling.

Steps for Scheduling a Report
1.

B

Select Reports from the left navigation pane. The Reports page is displayed.

In the Report Management - Common Tasks task module click Generate report. The Generate
Report wizard is started with the Choose report options page displayed.

If templates have been created, you can select an existing template from the Use template drop-
down box.

If there are no existing templates or if you want to request a custom report, select the type of data
collection under Specify settings and then select the supported reports for that type of data
collection from the drop-down box.

NOTE: Be sure and select a report that matches the type of data collection you specified in Data
Collection on page 185. If you find you need a different report, you might have to go back to Data
Collection on page 185 and select a different type of data collection.

Click Next. The Specify data range for report page is displayed.
Date range: specify the date range for the data to be included on the report.

Previous time period: specify the time period covered by the report when it is generated. (For
example, if the report is generated on July 1st, you might want to specify the time period for the
previous month to include the month of June).

Then click Next. The Select devices page is displayed.

Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.

You can also select an entire group instead of individual devices, by changing the selection method
to Groups. Tasks (for example configurations and more) can be performed on a single group or a
group and all of its subgroups.

NOTE: Including all subgroups can potentially take much longer and cause much more network
traffic, so should be used only when appropriate.

If you schedule a task using a group, the task will apply to the devices in the group at the time the
task starts. This makes it easy to redefine the devices used in regularly scheduled tasks without
having to delete and create a scheduled task.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device Identification.

Click Next.
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5.

Now you can actually define what will be included on your report:

e Report Format: If applicable for the report being generated, select the chart type for your
report from the drop-down box. This criteria varies depending on the report being generated.

e Report Columns:

0 Device ID Columns: select the columns to include on the report that identify the devices
from the drop-down box.

o Available columns and Columns to show: select the columns to include on the report.
If you want totals for any specific column, check the box under Show Totals.

B NOTE: To select multiple columns, use either Ctrl+Click or Shift+Click.

You can move the type of column up or down in the list (Up and Down); this determines
its order on the report.

° Group by: specify how you want the data grouped by selecting an option from the Group
by drop-down box.

° Sort by: specify how you want the data sorted by selecting an option from the Sort by
drop-down box.

e (If applicable) Display cartridges with percentage below: select the percentage for ink
levels remaining in cartridges.

e (Ifapplicable) Order from HP SureSupply?: check this box if you want to order supplies from
HP SureSupply.

After you have defined the report format, click Next. The Specify destination options page is
displayed.

Select how you want the report displayed (either on the page or directly to email). If sending the
report to email addresses, you can either browse for those addresses or you can enter them
manually. Separate each address with a semi-colon.

Specify the report destination:
e Display: displays the report on your page.

e Email: send the report to an email address (Email Reports on page 205). Type the email
address on this page or browse for the correct email address.

Specify the file format:

e HTML: save the file as an HTML document (Save Archived Reports on page 205).

e CSV: export the report as a CSV document (Email Reports on page 205).

Click Next; the Specify report name page is displayed.

Enter the name for this report and specify how long you want to keep this report.

NOTE: If you schedule a task (for example, a discovery or a configuration or others) using a
corresponding template, the task uses the settings defined in the template at the time the task
starts. This makes it easy to redefine settings used in a regularly scheduled task without having to
delete and create a scheduled task.
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11.

12.

13.

14.

NOTE: All HP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin
install host. The client system being used to access HP Web Jetadmin may or may not be in the
same time zone as the HP Web Jetadmin install host. You should be aware of the time and possible
date differences when configuring HP Web Jetadmin 10.0 scheduling.

If you are scheduling this report for a later time, the Specify schedule options page is displayed.
Select the start date and time for your report and also how often it should run:

e Allow start time to occur between the specified hours of: limits the start time for the report
to a specified window of time. The report will only run if able to do so during the time specified
here. This is useful for reports that should only occur in low traffic times such as late at night.

e Recurrence, Once: launches only once in the specified schedule.

e Recurrence, Daily: task will recur daily once per day or once per weekday depending on the
selected setting.

e Recurrence, Weekly: task will recur once every X weeks on the day specified depending on
the setting.

e Recurrence, Monthly: task will recur once every X months on XX day depending on setting;
or, task will recur on specified day pattern depending on setting.

Click Next. The Confirm page is displayed, summarizing all of the report format options you have
selected for this report.

Click Next. The Report Generation Complete page is displayed showing the actual report
generation.

Click Done to display the Reports page.

Other Ways to Schedule a Report

1.
2,
3.

4,

Right-click on Reports and then select Schedule report.
Expand the Reports menu. Right-click on Report Generation and then select Schedule report.

In the All Devices list, highlight a device and right-click. Then select Reports > Schedule
report.

In the Reports - Report Generation task module, select the report and click Schedule.

Deleting Scheduled Reports

You can delete a report after it has been scheduled, if it has not been generated, through the Reports
- Scheduled Reports task module.

1.
2,
3.

In Reports, display the Reports - Scheduled Reports task module.
Highlight the report to delete and click Delete. The Confirm Delete message is displayed.

Click Yes. The previous page is displayed again.

Editing the Schedule for a Report

You can edit the schedule for a report, if the report has not been generated yet, through the Reports -
Scheduled Reports task module.
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B NOTE: If you schedule a task (for example, a discovery or a configuration or others) using a
corresponding template, the task uses the settings defined in the template at the time the task starts.
This makes it easy to redefine settings used in a regularly scheduled task without having to delete and
create a scheduled task.

NOTE: All HP Web Jetadmin 10.0 schedules are the date and time at the HP Web Jetadmin install
host. The client system being used to access HP Web Jetadmin may or may not be in the same time
zone as the HP Web Jetadmin install host. You should be aware of the time and possible date differences
when configuring HP Web Jetadmin 10.0 scheduling.

1. Select Reports from the left navigation pane. The Reports page is displayed.

Display the Reports - Scheduled Reports task module. The reports that have been scheduled
are listed.

2. Highlight the report click Edit. The Edit Schedule (Report Generation Task) wizard is displayed.

3. Make changes to the schedule that had been created for the report. When done, click Next. The
Confirm page is displayed.

4. Review your selections and then click Next. The Progress page is displayed. When done, click
Done.

Email Reports

You can request that a report be emailed in HTML format if desired. The SMTP on page 246 server
must be configured before a report can be emailed.

Save Archived Reports

You can request that a report be saved as an HTML document anywhere on your network. When you
select Save As, you can type the filename and location or browse for the location. The report will
automatically be saved in HTML format.

You can request that a report be exported in comma-separated value (CSV) file format. CSV is a file
type that stores tabular data (like in an Excel sheet) and is common on all computer platforms. CSV is
one implementation of a delimited text file, which uses a comma to separate values. However, CSV
differs from other delimiter separated file formats in using a " (double quote) character around fields that
contain reserved characters (such as commas or newlines). Most other delimiter formats either use an
escape character such as a backslash, or have no support for reserved characters. In computer science
terms, this type of format is called a flat file because only one table can be stored in a CSV file. Most
systems use a series of tables to store their information, which must be flattened into a single table often
with information repeated over several rows to create a delimited text file.

Create a Report Template

e Steps for Creating a Report Template

° Other Ways to Create a Report Template

A report template contains a set of criteria including the report type, devices, and the report format. After
a report template is created, you can apply it to generate a report easily.
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Any number of templates can be added to the four pre-existing templates that come with HP Web
Jetadmin 10.0:

e Supply Replacement Forecast Template

e By User Template: Color verses Black and White

e Pages Printed Template: Color verses Black and White
e Pages Printed Template: Job Type Template

Create Report Template is the wizard used to customize and store reports settings. Once the wizard
is launched, you can select any one of the available Report types and then select settings for this
template, including Report Format, Report Columns, Destination Settings, and more.

Steps for Creating a Report Template
1. Expand the Reports menu in the left navigation pane and then select Report Generation.

In the Reports - Common Tasks task module, select Create report template. The Create Report
Template wizard is started with the Select report type page displayed.

2. Highlight the report type and click Next. (Only one report type may be selected at a time.) The
Specify report settings page is displayed.

3.  Now you can actually define what will be included on your report:

e Report Format: If applicable for the report being generated, select the chart type for your
report from the drop-down box. This criteria varies depending on the report being generated.

e Report Columns:

0 Device ID Columns: select the columns to include on the report that identify the devices
from the drop-down box.

° Available columns and Columns to show: select the columns to include on the report.
If you want totals for any specific column, check the box under Show Totals.

B NOTE: To select multiple columns, use either Ctrl+Click or Shift+Click.

You can move the type of column up or down in the list (Up and Down); this determines
its order on the report.

o Group by: specify how you want the data grouped by selecting an option from the Group
by drop-down box.

° Sort by: specify how you want the data sorted by selecting an option from the Sort by
drop-down box.

e (If applicable) Display cartridges with percentage below: select the percentage for ink
levels remaining in cartridges.

e (Ifapplicable) Order from HP SureSupply?: check this box if you want to order supplies from
HP SureSupply.

4. After you have defined the report format, click Next. The Specify destination options page is
displayed.
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10.
1.

Select how you want the report displayed (either on the page or directly to email). If sending the
report to email addresses, you can either browse for those addresses or you can enter them
manually. Separate each address with a semi-colon.

Specify the report destination:
e Display: displays the report on your page.

e Email: send the report to an email address (Email Reports on page 205). Type the email
address on this page or browse for the correct email address.

Specify the file format:

e HTML: save the file as an HTML document (Save Archived Reports on page 205).

e CSV: export the report as a CSV document (Email Reports on page 205).

Click Next; the Specify name page is displayed.
Type the name for this report template and then click Next.

The Confirm page is displayed, summarizing all of the report format options you have selected for
this report. Click Next.

The Results page is displayed showing the actual report generation.

Click Done to display the Report Generation page.

Other Ways to Create a Report Template

1.
2,

Right-click on Reports in the left navigation pane and select Create report template.

Expand the Reports menu in the left navigation pane and right-click on Report Generation; then
select Create report template.

Edit a Report Template

Steps for Editing a Report Template

Other Ways to Edit a Report Template

After a report template has been created, it can be edited.

Steps for Editing a Report Template

1.

ENWW

Expand the Reports menu in the left navigation pane and then select Report Generation.

In the Reports - Common Tasks task module, select Edit report template. The Edit Report
Template wizard is started with the Select template page displayed.

Highlight the template to edit and click Next. (Only one template may be selected at a time.)
The Specify report settings page is displayed.
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3.  You can change what will be included on your report:

e Report Format: If applicable for the report being generated, select the chart type for your
report from the drop-down box. This criteria varies depending on the report being generated.

e Report Columns:

0 Device ID Columns: select the columns to include on the report that identify the devices
from the drop-down box.

o Available columns and Columns to show: select the columns to include on the report.
If you want totals for any specific column, check the box under Show Totals.

B NOTE: To select multiple columns, use either Ctrl+Click or Shift+Click.

You can move the type of column up or down in the list (Up and Down); this determines
its order on the report.

° Group by: specify how you want the data grouped by selecting an option from the Group
by drop-down box.

° Sort by: specify how you want the data sorted by selecting an option from the Sort by
drop-down box.

e (If applicable) Display cartridges with percentage below: select the percentage for ink
levels remaining in cartridges.

e (Ifapplicable) Order from HP SureSupply?: check this box if you want to order supplies from
HP SureSupply.

4. After you have defined the report format, click Next. The Specify destination options page is
displayed.

5. Select how you want the report displayed (either on the page or directly to email). If sending the
report to email addresses, you can either browse for those addresses or you can enter them
manually. Separate each address with a semi-colon.

6. Specify the report destination:
e Display: displays the report on your page.

e Email: send the report to an email address (Email Reports on page 205). Type the email
address on this page or browse for the correct email address.

7. Specify the file format:

° HTML.: save the file as an HTML document (Save Archived Reports on page 205).

e CSV: export the report as a CSV document (Email Reports on page 205).

Click Next; the Specify name page is displayed.
8. Type the name for this report template and then click Next.

9. The Confirm page is displayed, summarizing all of the report format options you have selected for
this report. Click Next.

10. The Results page is displayed showing the actual report generation.

11. Click Done to display the Report Generation page.
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Other Ways to Edit a Report Template
1. Right-click on Reports in the left navigation pane and select Edit report template.

2. Expand the Reports menu in the left navigation pane and right-click on Report Generation. Then
select Edit report template.

3. Inthe Reports - Report Templates task module, highlight the template to edit and click Edit.

4. Expand the Reports menu in the left navigation pane and expand Report Generation. Then
select Templates.

Delete a Report Template

° Steps for Deleting a Report Template

° Other Ways to Delete a Report Template

A report template can be deleted at any time.

Steps for Deleting a Report Template
1. Expand the Reports menu in the left navigation pane and then select Report Generation.

In the Reports - Common Tasks task module, select Delete report template. The Delete Report
Templates wizard is started with the Select template page displayed.

2. Highlight the template to delete and click Next. (Only one template may be selected at a time.)
The Confirm page is displayed.

3. Click Next. The Results page is displayed.

4. Click Done to display the Report Generation page.

Other Ways to Delete a Report Template
e Right-click on Reports in the left navigation pane and select Delete report template.

e Expand the Reports menu in the left navigation pane and right-click on Report Generation. Then
select Delete report template.

e Inthe Reports - Report Templates task module, highlight the template to delete and click
Delete.

e Expand the Reports menu in the left navigation pane and expand Report Generation. Then
select Templates.

View a Report Template

° Steps for Viewing a Report Template

You can view a report template.
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Steps for Viewing a Report Template

1. Expand the Reports menu in the left navigation pane and then expand Report Generation. Then
click Templates.

2. Click on the template to view.
3. Now you can:

e Apply (Apply a Report Template on page 200): apply a report template that has already been
created to a device or group of devices.

o Delete (Delete a Report Template on page 209): delete a report template that has previously
been created.

e Edit (Edit a Report Template on page 207): make changes to a report template that has
previously been created.

e View (View a Report Template on page 209): view a report template that has been previously
created.

View Reports

° Steps for Viewing Reports

You can view any report that has already been generated.

Steps for Viewing Reports

1. In the left navigation pane, expand Reports. The archived reports are listed on the Archived
Reports page

2. Select the report. Now you can:
e View the report; the report is then displayed. You can then email, save, or print the report.

e  Email the report (Email Reports on page 205).

e  Save the report; then you can specify the directory and filename for the report.

o Delete the report; a confirmation page is displayed.

Archived Reports

e View Archived Reports

° Delete Archived Reports

Archived Reports stores all previously-generated reports and gives you a way to display them. You
can view archived reports, export them to CSV format, or delete them. An adjustable 90 day time-to-
live (TTL) setting erases these reports as they age. Once the report has reached this value, HP Web
Jetadmin 10.0 automatically clears it from the archive.

View Archived Reports

° Steps for Viewing Archived Reports

° Other Ways to View Archived Reports
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You can view any report that has already been generated through View archived reports. All reports
that have been generated are stored in Archived Reports.

Steps for Viewing Archived Reports
1. In the left navigation pane, expand Reports.
Select Archived Reports. The Archived Reports page is displayed.
2. Highlight the report to view and click View.
3. Now you can:

° Email Reports on page 205.

° Save Archived Reports on page 205.

e Print: select Print and then select the printer to send the report to.

4. Click Close. The Archived Reports page is displayed.

Other Ways to View Archived Reports
e Inthe Reports - Archived Reports task module, highlight the report to view and click View.

Delete Archived Reports

e Steps for Deleting Archived Reports

e Other Ways to Delete Archived Reports

Reports that have been archived can be deleted.

Steps for Deleting Archived Reports

1. In the left navigation pane, expand Reports and then click Archived Reports. The Archived
Reports page is displayed.

2. Highlight the archived report you want to delete and click Delete. The Delete Archived Report
wizard is started with the Confirm page displayed.

3. If you need to make changes, click Back. If this is the correct report to delete, click Next. The
Results page is displayed.

4. The report you deleted is displayed. Click Done.

Other Ways to Delete Archived Reports
e Inthe Reports - Archived Reports task module, highlight the report to view and click Delete.
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Supplies

All About Supplies

Task Modules for Supplies

Related Application Options for Supplies

Creating a Supplies Group

Add Devices to a Supplies Group

Remove Devices from a Supplies Group

Deleting a Supplies Group

Shop for Supplies

Viewing a Supplies Group

All About Supplies

HP Web Jetadmin 10.0 has several device supply-related features that help you monitor, order, and
replenish supplies for your devices. The Supplies feature in HP Web Jetadmin 10.0 includes enhanced
reporting and alerting functionality.

You can use the Supplies feature to keep your devices up and running efficiently. Here are some key
feature items for Supplies:

Quickly display all supplies details for any device list selection using the Supplies device tab
(Supplies Tab on page 61).

Consolidated supplies ordering (available in both Reports and Alerts within Supplies) launches you
into HP SureSupply page on http://www.hp.com.

Supplies features enable a variety of monitoring and fulfillment models.

A key feature in HP Web Jetadmin 10.0 is Supplies Groups. These are special groups that only appear
in the left navigation pane under Supplies. Their purpose is to pull together supplies alerts and supplies
reports features for grouped devices.

To ensure this feature works properly, see Minimum System Requirements for HP Web
Jetadmin 10.0 on page 2 for HP Web Jetadmin 10.0.

Task Modules for Supplies

Supplies - Current Tasks and Supplies - Common Tasks Task Modules

Supplies - Group Tools Task Module

Supplies - Group Summary Task Module

Supplies - Device Status Summary Task Module

Supplies - Archived Reports Task Module

Supplies - Recent Alerts Task Module

Supplies - Scheduled Reports Task Module
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The task modules that can be displayed or hidden in Supplies are described in the following sections.

Supplies - Current Tasks and Supplies - Common Tasks Task Modules

The Supplies - Current Tasks task module can be displayed on the Supplies page and includes the
following tasks:

e Create supplies group (Creating a Supplies Group on page 215)

e Add devices to supplies group (Add Devices to a Supplies Group on page 216)

e Remove devices from supplies group (Remove Devices from a Supplies Group on page 217)

e Delete supplies group (Deleting a Supplies Group on page 218)

e Shop for supplies (Shop for Supplies on page 218)

The Supplies - Current Tasks task module can be displayed in other areas of HP Web Jetadmin 10.0;
in the other areas it is called Supplies - Common Tasks.

Supplies - Group Tools Task Module

The Supplies - Group Tools task module can be displayed on the Supplies page and includes the
following tasks:

e Create (Creating a Supplies Group on page 215)

e Add Devices (Add Devices to a Supplies Group on page 216)

° Remove Devices (Remove Devices from a Supplies Group on page 217)

° Delete (Deleting a Supplies Group on page 218)

e View (Viewing a Supplies Group on page 219)

Supplies - Group Summary Task Module

The Supplies - Group Summary task module can be displayed on the Supplies page and includes
the following information:

e Supplies group status: shows how many supplies groups have devices in an Error, Warning,
or OK status.

e Device grouping: shows how many devices belong to a group and how many do not belong to a
group.

Supplies - Device Status Summary Task Module

The Supplies - Device Status Summary task module can be displayed on the Supplies page and
includes the following information:

e Device supply status: shows how many devices in an Error, Warning, or OK status are in
supplies groups.
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Supplies - Archived Reports Task Module

The Supplies - Archived Reports task module can be displayed on the Supplies page and provides
you with access to the following tasks:

e View (View Archived Reports on page 210): review supplies reports that have been produced and
archived.

e Email (Email Reports on page 205): email archived supplies reports.

e Save (Save Archived Reports on page 205): save supplies reports that have been produced and
archived.

e Delete (Delete Archived Reports on page 211): delete supplies reports that have been produced
and archived.

Supplies - Recent Alerts Task Module

The Supplies - Recent Alerts task module can be displayed on the Supplies page. After selecting a
group, the corresponding supplies alerts are displayed.

Supplies - Scheduled Reports Task Module

The Supplies - Scheduled Reports task module can be displayed on the Supplies page and lists all
schedule supplies reports.

Related Application Options for Supplies
e General

e Supplies Reordering

The General options controls the supply threshold at which devices are placed in the “supply needed”
state.

The Supplies Reordering option lets you select whether or not to display a Shop for Supplies link on
the Supplies Ordering report; this is a direct link to the HP SureSupply web site.

General

The General option controls the supply threshold at which devices are placed in the “supply needed”
state.

Follow these steps:

1. On the top menu bar, access Tools > Options > Device Management > Supplies and then
select General.

You can also access this option from a supply group’s Devices tab; click Settings.
2. Select the percentage of supplies left in the device that you want to be notified.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.
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Supplies Reordering

The Supplies Reordering option lets you select whether or not to display a Shop for Supplies link on
the Supplies Ordering report; this is a direct link to the HP SureSupply web site.

Follow these steps:

1. On the top menu bar, access Tools > Options > Device Management > Supplies and then
select Supplies Reordering.

You can also access this option from a supply group’s Devices tab; click Settings.

2. Check the box Include shop for supplies link in reports to allow the administrator to enable or
disable ordering from SureSupply for the application.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Creating a Supplies Group

e Steps for Creating a Supplies Group

e Other Ways to Create a Supplies Group

Supplies groups pull together supplies alerts and supplies reports features for grouped devices.

An example is when someone in one department has responsibility for supplies for a set of devices.
This person has the devices grouped in supply group “A”. Another person has responsibility for
managing supplies for a different part of the company; for this person, supply group “B” is created. These
two individuals can manage supplies separately and can also choose specifics such as methods,
thresholds, and even unique email addresses.

When devices are added to a supplies group, Supplies polling begins. The polling method used to
monitor supplies is sometimes called slow-polling, the same polling as when you view a device list. The
default is 4 devices queried every 15 seconds. When supplies polling is enabled devices are polled at
all times, not just when you access a device list. Then, when you view the supply group, up-to-date
supply details are displayed.

Steps for Creating a Supplies Group

1. In the left navigation pane, click on Supplies. In the Supplies - Common Tasks task module,
select Create supplies group. The Create Supplies Group wizard is started with the Specify
group name page displayed.

2. Type the name for the supplies group (up to 48 characters).

3. If you are not adding devices to the group now, click Next and go to Step 4.
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To add devices to the group now, select Add devices now and click Next. The Select devices
page is displayed.

e Select the device by highlighting it and clicking the arrow buttons between the two lists. To
select multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list
to the other, use the double arrow buttons. You can sort the list of available devices by clicking
the column headers, or view more columns by right-clicking the column headers.

You can also select an entire group instead of individual devices, by changing the selection
method to Groups. Tasks (for example configurations and more) can be performed on a single
group or a group and all of its subgroups.

Bf NOTE: Including all subgroups can potentially take much longer and cause much more
network traffic, so should be used only when appropriate.

If you schedule a task using a group, the task will apply to the devices in the group at the time
the task starts. This makes it easy to redefine the devices used in regularly scheduled tasks
without having to delete and create a scheduled task.

e Click Next.
4. The Confirm page is displayed. Click Next.

5. The Results page is displayed. After the results are displayed, you can choose to open the group
when you click Done.

Other Ways to Create a Supplies Group
e In the left navigation pane, right-click on Supplies and select Create group.
e In the Supplies - Group Tools task module, click Create.

e In any device list, right-click on a device. Select Supply Groups and then select Add devices to
hew group.

Add Devices to a Supplies Group

° Steps for Adding Devices to a Supplies Group

e Other Ways to Add Devices to a Supplies Group

After a supplies group has been created, devices can be added to that group.

Steps for Adding Devices to a Supplies Group

1. In the left navigation pane, click on Supplies. In the Supplies - Common Tasks task module,
select Add devices to supplies group. The Add Devices to Supplies Group wizard is started
with the Select groups page displayed.

2. Select the group and click Next. The Select devices page is displayed.

3. Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.
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You can also select an entire group instead of individual devices, by changing the selection method
to Groups. Tasks (for example configurations and more) can be performed on a single group or a
group and all of its subgroups.

Bf NOTE: Including all subgroups can potentially take much longer and cause much more network
traffic, so should be used only when appropriate.

If you schedule a task using a group, the task will apply to the devices in the group at the time the
task starts. This makes it easy to redefine the devices used in regularly scheduled tasks without
having to delete and create a scheduled task.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device ldentification.

4. Click Next. The Confirm page is displayed.
5. Click Next. The Results page is displayed. Click Done.

Other Ways to Add Devices to a Supplies Group
e In the left navigation pane, right-click on Supplies and select Add devices to group.

e Inthe left navigation pane, expand Supplies and right-click on the specific group; then select Add
devices to group.

e Inthe Supplies - Group Tools task module, click Add Devices.
e In any device list, right-click on a device. Select Supply Groups and then select Add devices to
group.
Remove Devices from a Supplies Group

e Steps for Removing Devices from a Supplies Group

° Other Ways to Remove Devices from a Supplies Group

After a supplies group has been created and devices have been added, devices can be removed from
that group.

Steps for Removing Devices from a Supplies Group

1. In the left navigation pane, click on Supplies. In the Supplies - Common Tasks task module,
select Remove devices from supplies group. The Remove Devices from Supplies Group
wizard is started with the Select groups page displayed.

2. Select the group and click Next. The Select devices page is displayed.

3. Select the device by highlighting it and clicking the arrow buttons between the two lists. To select
multiple devices, use either Ctrl+Click or Shift+Click. To move all devices from one list to the other,
use the double arrow buttons. You can sort the list of available devices by clicking the column
headers, or view more columns by right-clicking the column headers.

You can also select an entire group instead of individual devices, by changing the selection method
to Groups. Tasks (for example configurations and more) can be performed on a single group or a
group and all of its subgroups.
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B NOTE: Including all subgroups can potentially take much longer and cause much more network
traffic, so should be used only when appropriate.

If you schedule a task using a group, the task will apply to the devices in the group at the time the
task starts. This makes it easy to redefine the devices used in regularly scheduled tasks without
having to delete and create a scheduled task.

NOTE: The columns displayed on the Select Devices page are defined in View >
Preferences > Device Identification.

4. Click Next. The Confirm page is displayed.
5. Click Next. The Results page is displayed. Click Done.

Other Ways to Remove Devices from a Supplies Group
e In the left navigation pane, right-click on Supplies and select Remove devices from group.

e In the left navigation pane, expand Supplies. Select the specific group to remove devices from.
Right-click and select Remove devices from group.

e Inthe Supplies - Group Tools task module, select the specific group to remove devices from and
click Remove Devices.

Deleting a Supplies Group

e Steps for Deleting a Supplies Group

° Other Ways to Delete a Supplies Group

Deleting a supplies group removes contained devices from the slow poller. It also removes proactive
alerts, predictive reports, and data collection.

Steps for Deleting a Supplies Group

1. In the left navigation pane, click on Supplies. In the Supplies - Common Tasks task module,
select Delete supplies group. The Delete Supplies Group wizard is started with the Select
groups page displayed.

2. Select the group and click Next. The Confirm page is displayed.
3. Click Next. The Results page is displayed. Click Done.

Other Ways to Delete a Supplies Group
e In the left navigation pane, right-click on Supplies and select Delete group.

e Inthe left navigation pane, expand Supplies. Select the specific group to delete. Right-click and
select Delete group.

e Inthe Supplies - Group Tools task module, select the specific group to delete and click Delete.

Shop for Supplies

In any device list, you can select a device or group and then select the Supplies device tab. (If the
device tabs are hidden, see Showing and Hiding Device Tabs on page 53.) Supplies you need to order
can be included on the Supply Ordering report if you chose predictive settings (Predictive Settings
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on page 221). Proactive supplies alerts sends an email with a supply ordering report when a supply
meets a threshold.

After you run this report, you can access the HP SureSupply web site to actually order your supplies.
(See Supply Ordering on page 183.)

Viewing a Supplies Group

ENWW

Proactive Settings

Predictive Settings

Steps for Viewing a Supplies Group

Other Ways to View a Supplies Group

You can view a supply group. The page displayed is identical to the one displayed when you click the
Supplies device tab in any device list with a selected device.

Options on the Supplies tab page include:

Group By: control how the supplies information is presented: by device, urgency, HP part number,
or none.

o Device: shows devices in a collapsed state. Expanding one or more devices reveals supply
detail.

o Urgency: groups the devices by Out, Warning, Unknown, and OK supply status categories.
Expanding these reveals device and supply detail.

0 Part number: groups the devices by collapsed supply part number categories. Expanding
these reveals device and supply detail.

o None: reveals supply detail in an expanded device list.

View: choose between two views of the supplies data: the default view or the details view, which
includes serial number of the supply, install date, and last used date.

+ (Expand All): view detail.
- (Collapse All): view summary information only and no detail.

Shop for supplies online: easy access to HP SureSupply to shop for all supplies or just needed
supplies (the default). After this selection is made, you are connected to the HP SureSupply web
site with either needed or all supplies categories pre-selected to order. You are notified that
information will be transferred to the HP SureSupply web site and can approve or disapprove of
the information being sent to that web site. Shop for supplies needs to have proxy setup in web
browser.

Show all and Show only needed: displays the list in a filtered or unfiltered state. In this way, only
devices that are in a “supply needed” state are displayed in the list.

NOTE: The Show only needed state is dictated by the setting in Tools > Options > Device
Management > Supplies (General on page 214).

Print shopping list: prepares a printout of the device list as it is currently displayed.
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In the left navigation pane, expand Supplies and then select the supplies group. In the bottom portion
of this page are the following:

Devices: control how the supplies information is presented: by device, urgency, HP part number,
or none. This shows the devices that are in the group (you can add or remove devices).

° Settings: lets you configure supplies in Tools > Options > Device Management >
Supplies. See General on page 214.

Proactive Settings: leverages HP Web Jetadmin 10.0 alerting features and includes:

Table 4-16 Proactive Settings

Setting Threshold
Supply refreshed Fixed 100%
Early warning Adjustable 0-99%
Supply low Adjustable 0-50%
Supply out Adjustable 0-2%

When a supply reaches its threshold, an email will be sent. See Proactive Settings on page 220.

Predictive Settings: starts Reports data collection on all devices contained in the supplies group.
See Predictive Settings on page 221.

Proactive Settings

Proactive Settings leverage HP Web Jetadmin 10.0 alerting features.

When supplies alerting is enabled, HP Web Jetadmin 10.0 uses an adaptive polling technique that
increases polling frequency as a supply gets closer to the user specified threshold. In this way, HP Web
Jetadmin 10.0 can propagate supplies alerts messages accurately and use less network bandwidth than
is used with traditional polling methods.

Steps for Configuring Proactive Settings

1.

In the left navigation pane, expand Supplies and then select the supplies group.
Click the Proactive Settings tab.
Check Enable to enable proactive settings.

To see recent supplies alerts for the devices in this specific group, click Recent alerts. (For more
information, see Alert History on page 156.)

To make changes to the settings displayed, click Edit. The Edit Proactive Settings page is
displayed.

Select the proactive settings and the threshold for each one selected.

Table 4-17 Proactive Settings

Setting Threshold
Supply replaced Fixed 100%
Early warning Adjustable 0-99%

220 Chapter 4 Device Management ENWW



Table 4-17 Proactive Settings (continued)

Setting Threshold
Supply low Adjustable 0-50%
Supply out Adjustable 0-2%

6. Enter email addresses (separated by a semi-colon). Click Browse to search for email addresses
already entered. Click Next. The Confirm page is displayed.

7. Click Next. The Results page is displayed. Click Done.

Predictive Settings

Predictive Settings starts Reports data collection on all devices contained in the supplies group. This
setting also leverages the Reports feature by enabling a predictive supplies report for the devices within
the supplies group. Here are the details behind the supply group report:

e  Fully schedulable report (default: 1st day of each month)

e Archived in Reports

e  Optional email recipients

e Report details include Supply, Part number, Estimated replacement date, others
e Report detail can be customized by using the Edit control

e Generated report contains HP SureSupply link

Steps for Configuring Predictive Settings
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1. In the left navigation pane, expand Supplies and then select the supplies group.
Click the Predictive Settings tab.
2. Check Enable to enable predictive settings.

3. To view archived report for this specific supply group, click Archived reports. (For more
information, see Supply Replacement Forecast on page 183.)

4. To make changes to the settings displayed, click Edit. The Edit Predictive Settings page is
displayed with the Select report settings page displayed.

5. Select the report settings.
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6. Now you can actually define what will be included on your report:

e Report Format: If applicable for the report being generated, select the chart type for your
report from the drop-down box. This criteria varies depending on the report being generated.

e Report Columns:

0 Device ID Columns: select the columns to include on the report that identify the devices
from the drop-down box.

o Available columns and Columns to show: select the columns to include on the report.
If you want totals for any specific column, check the box under Show Totals.

The selections vary by report type but are representative of the data stored for the
corresponding data collection type. These can be enabled and disabled and can also be
re-ordered in the report.

Ef NOTE: To select multiple columns, use either Ctrl+Click or Shift+Click.

You can move the type of column up or down in the list (Up and Down); this determines
its order on the report.

o Group by: specify how you want the data grouped by selecting an option from the Group
by drop-down box. An example of this is Device Model. If chosen, HP Web Jetadmin
10.0 groups all of the same device models next to each other in the report.

° Sort by: specify how you want the data sorted by selecting an option from the Sort by
drop-down box. An example is IP address: when chosen, HP Web Jetadmin 10.0 orders
the devices within the report by their IP addresses. Of course, the ordering occurs within
the Group by subsets.

e (If applicable) Display cartridges with percentage below: select the percentage for ink
levels remaining in cartridges.

e (Ifapplicable) Order from HP SureSupply?: check this box if you want to order supplies from
HP SureSupply.

7. After you have defined the report format, click Next. The Enter destinations page is displayed.

8. Complete Send to with the email address (or addresses separated by a semi-colon). Click
Browse to search for the email address.

The SMTP server must be configured before you can send email. Click SMTP server is not
configured; see Email on page 245.

9. Click Next. If you are scheduling this report for a later time, the Specify schedule options page
is displayed. Select the start date and time for your report and also how often it should run. Then
click Next.

10. The Confirm settings page is displayed, summarizing all of the report format options you have
selected for this report.

11. Click Next. The Results page is displayed showing the actual report generation.

12. Click Done to display the supplies group page.
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Steps for Viewing a Supplies Group

1. Inthe left navigation pane, expand Supplies and then click the supplies group to view. The Supply
Group page is displayed.

2. You can choose the following:

Proactive Settings (Proactive Settings on page 220).

Predictive Settings (Predictive Settings on page 221).

Settings (Related Application Options for Supplies on page 214).

Add Devices (Add Devices to a Supplies Group on page 216).

Remove Devices (Remove Devices from a Supplies Group on page 217).

Other Ways to View a Supplies Group

e Inthe Supplies - Group Tools task module, select the group and click View.

e Inany device list, click the Supplies tab at the bottom of the page.
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5 Print Management

e All About Print Management

° Print Management Task Modules

° Print Management Options

e Create Print Queue

° Edit Print Queue

e Delete Print Queue

° Pre-configure Driver

° Upload Driver to Available Drivers

° Delete a Driver

° Retrieve a Driver
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All About Print Management

° Print Queue Management

° Driver Management

The Print Management view gives you control over remote print queues and drivers. These features
can be used to create, edit, and delete existing queues as well as to install or update printer drivers.
HP Web Jetadmin 10.0 can act as a driver repository for deploying new HP drivers onto remote systems.
And, HP Web Jetadmin 10.0 Print Management features use HP’s Universal Print Drivers (UPDs).

For example, you can use HP Web Jetadmin 10.0 Print Management to locate a workstation or server
on the network. Once this host is found, you can add administrative credentials and begin to manage
the print queue and drivers on the remote host. Existing queues on the host can have a number of
settings and/or the driver changed. Queues can be added or removed. You must have local administrator
rights on these remote systems when performing this management activity.

Print Queue Management

° Fleet Management of Print Queues

Print queue management in HP Web Jetadmin 10.0 includes the following:

e Create print queue (Create Print Queue on page 230).

e  Edit print queue (Edit Print Queue on page 232).

e Delete print queue (Delete Print Queue on page 233).

File and printer sharing must be enabled at the remote host where the print queue is to be created.

Fleet Management of Print Queues

Within the Print Management view, HP Web Jetadmin 10.0 has the capability of installing queues and
drivers onto multiple remote hosts. This fleet queue creation can be done remotely from the HP Web
Jetadmin 10.0 client interface and in a configuration session.

Users of the Print Management feature could be IT personnel in school districts. These personnel may
have responsibility over desktop print functionality and print devices in remote and wide geographic
distribution. On top of the remote distribution problem, large numbers of workstations and different
restrictions apply. Consider this problem:

e Each school in the district has obtained a color MFP.

e A dozen to several hundred student workstations could exist in each school.
e  Staff are allowed to print color but students are not.

e IT has full administrative access to all of the workstations.

HP Web Jetadmin 10.0 could be used in attaining substantial savings in an environment like this one.
Pre-configuration could be used on drivers deployed to student workstations. All drivers and queues
could be deployed through the Create Print Queue tool (Create Print Queue on page 230) and in very
few configuration sessions. Travel to each of the schools could then be reduced to a bare minimum.

Driver Management
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HP Web Jetadmin 10.0 facilitates driver management. Drivers can be added to the HP Web Jetadmin
10.0 host which acts like a driver repository. These drivers are installed on remote hosts where queue
management is being performed. Some of these features can be locked.

Driver management in HP Web Jetadmin 10.0 includes the following:

e Pre-configure driver (Pre-configure Driver on page 234).

e Upload driver to available drivers (Upload Driver to Available Drivers on page 235).

e Delete driver from available drivers (Delete a Driver on page 236).

° Retrieve driver from available drivers (Retrieve a Driver on page 237).

Supported drivers include:
e HP device specific drivers
e INF install

e UPD packaged for HP Web Jetadmin 10.0 (installed through Product Update, Product Update Task
Modules on page 270).

HP’s Universal Print Driver

The HP Universal Print Driver Postscript (UPD-PS) is bundled with HP Web Jetadmin 10.0 software
and can be installed from any create or edit queue interface (Create Print Queue on page 230 or Edit
Print Queue on page 232). Universal Print Drivers PCL5 and PCL6 can be added to HP Web Jetadmin
through Product Update in Application Management.

The HP Universal Print Driver has pre-configure capability which enables you to specify print defaults
such as duplex or grayscale. Some of these defaults can be locked so that users must always use certain
features such as duplex.

When HP Web Jetadmin 10.0 creates a queue using the HP Universal Print Driver, the driver and printer
(specified in HP Web Jetadmin 10.0) are installed in traditional mode, which means that the printer and
driver have none of the special HP Universal Print Driver features that are available when this driver is
installed from install.exe when downloaded from http://www.hp.com.
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Print Management Task Modules

The following task modules can be displayed or hidden in the Print Management.

B NOTE: To display the Task Module docking area, click View > Task Module docking area. This is

a toggle selection; if you select it again it closes the Task Module docking area.

Table 5-1 Print Management Task Modules

° Print Management - Current Tasks and Print Management - Common Tasks Task Modules on page 227

° Print Management - Print Queues Task Module on page 228

° Print Management - Available Drivers Task Module on page 228

° Print Management - Active Tasks Task Module on page 228

Print Management and Credentials

A

HP Web Jetadmin 10.0 requests and utilizes Windows user credentials during print management
operations. These credentials are needed for viewing, adding or removing print queues or for modifying
print queue driver or queue settings on remote systems. The credentials used during print management
must provide local administrator access on the Windows system being managed by HP Web Jetadmin
10.0. These credentials are stored securely by HP Web Jetadmin 10.0 and are re-used when the same
Windows user requests further print management operations. These credentials are not reused for other
Windows users requesting print management operations; credentials for different Windows users are
stored separately and securely for each user requesting print management operations. These
credentials can be cleared from the HP Web Jetadmin 10.0 credential-store by using the Clear all stored
credentials feature within Tools > Options > Application Management > Credentials.

CAUTION: Clear all Credentials removes all stored credentials including all device credentials. Use
caution when performing this operation.

Print Management - Current Tasks and Print Management - Common Tasks
Task Modules
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The Print Management - Current Tasks and Print Management - Common Tasks task module can
be displayed on the Overview page and includes the following tasks:

e Create print queue (Create Print Queue on page 230)

e Edit print queue (Edit Print Queue on page 232)

o Delete print queue (Delete Print Queue on page 233)

e Pre-configure driver (Pre-configure Driver on page 234)

e Upload driver to available drivers (Upload Driver to Available Drivers on page 235)

° Delete driver from available drivers (Delete a Driver on page 236)

o Retrieve driver from available drivers (Retrieve a Driver on page 237)

The Print Management - Current Tasks task module can be displayed in other areas of HP Web
Jetadmin 10.0; in the other areas it is called Print Management - Common Tasks.
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Print Management - Print Queues Task Module

The Print Management - Print Queues task module can be displayed on the Overview page. This
task module first locates the remote host on the network and then adds the user credentials that will
provide administrative access.

This task module includes the following tasks:

° New (Create Print Queue on page 230).

e Delete (Delete Print Queue on page 233).

° Edit (Edit Print Queue on page 232).

e Test to print a test page.

Print Management - Available Drivers Task Module

The Print Management - Available Drivers task module can be displayed on the Overview page and
includes the following tasks:

e Upload (Upload Driver to Available Drivers on page 235).

e Delete (Delete a Driver on page 236).

e Pre-configure (Pre-configure Driver on page 234).

° Retrieve (Retrieve a Driver on page 237).

Print Management - Active Tasks Task Module

The Print Management - Active Tasks task module can be displayed on the Overview page and
includes the following tasks:

e  Stop: stop the currently running tasks which are listed in this task module.

e View: displays the progress and results page for the currently running tasks that are listed in this
task module (Add Devices to a Group on page 92).
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Print Management Options

There are no configuration options for Print Management at this time.
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Create Print Queue

° Steps for Creating a Print Queue

e Other Ways to Create a Print Queue

Local administrator credentials are required on hosts managed by HP Web Jetadmin 10.0 Print
Management features. You can have these rights in a number of ways.

e You are a domain administrator.

e  Your user domain account exists in the local Administrator group on the remote host.

e You belong to a domain group that exists in the local Administrator group on the remote host.
File and printer sharing must be enabled at the remote host where the print queue is to be created.

It is possible to create queues on many remote hosts in one working session (Fleet Management of
Print Queues on page 225).

Steps for Creating a Print Queue

EBf NOTE: When creating print queues on Windows Server 2003, you may be prompted for credentials
repeatedly if there are no shared printers already on that host. In this case, you may have to add a
shared printer locally. See Microsoft documentation about enabling the RPC endpoint for the print
spooler.

NOTE: Print Management features allow the use of HP drivers regardless of the specific printer model
selected. In many cases, a printer may only be supported with host-based print drivers or other types
of print drivers. In the case where a driver is used in creating a print queue for a device that does not
support that driver type, printing may or may not succeed when using that print queue. Always be sure
that a supported driver is being used and matches the device for which the print queue is being created.

1. Inthe left navigation pane, click Print Management at the bottom of the screen.

In the Print Management - Print Queues task module, click New. The Create Queue wizard is
started with the Select device page displayed.

2. Selectadevice from the list (only one device can be selected). Click Next. The Select server page
is displayed.

3. Select a computer name and a domain. Select Add (more than one computer name can be
selected). Click Next. The Select driver page is displayed.

4. The Credentials wizard is started if there is only one server selected, if the Show drivers on
server in Available Drivers is checked, and if you have not entered credentials for that server
already. Select the print server and then type your credentials and password. Click Set and then
click Finish. The Select driver page is displayed.

5. Select the driver:

Bf NOTE: The drivers on the print server are displayed in the Available Drivers list if Show drivers
on server in Available Drivers is selected on the Select server page. Plus, if this feature is
selected, all drivers are listed, some of which are not supported.
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10.
1.

12.

NOTE: If creating a print queue on multiple servers, only the drivers on the HP Web Jetadmin
10.0 server and the UPD drivers are available.

e Universal Print Driver: the Universal Print Driver PostScript is available (HP’s Universal Print
Driver on page 226); other Universal Print Drivers can be obtained and installed through
Product Update (Product Update on page 270).

e Known Drivers: drivers that are already installed on the remote host or drivers that exist on
the HP Web Jetadmin 10.0 server (INF driver install base). These drivers, when identified for
use with the print queue, are added to the queue as it is being installed (Create Print
Queue on page 230).

To display all drivers (not just the ones that are specific to the selected device), click Show all
drivers.

Click Next. The Specify print queue options page is displayed.

Type the printer name using Windows naming conventions for print queues. This name must be a
unique name on the server.

Type the port name. This defaults to the printer’s IP Address preceded by IP; it is recommended
to leave this as the default but you can change it if desired.

If you want to share this printer click Share this printer.

The share name defaults to the printer name but you can change it if desired.

You can add a location and any comments. Then click Next. The Confirm page is displayed.
Click Next. The Results page is displayed.

If the printer was shared, you can print a test page.

Click Done. The Print Management page is displayed.

Other Ways to Create a Print Queue
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In the left navigation pane, right-click on Overview and select Create print queue.

In the Print Management - Print Queue task module, type a computer name and domain and
click Find. Enter the credentials to display the queues on the specified server. Then you can
click Add and create a new print queue on that server.

In the Print Management - Common Tasks task module, select Create print queue.
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Edit Print Queue

Steps for Editing a Print Queue

Other Ways to Edit a Queue

Any existing print queue can be edited to change the driver associated with it, whether or not it is shared.

Steps for Editing a Print Queue

B NOTE: Print Management features allow the use of HP drivers regardless of the specific printer model
selected. In many cases, a printer may only be supported with host-based print drivers or other types
of print drivers. In the case where a driver is used in creating a print queue for a device that does not
support that driver type, printing may or may not succeed when using that print queue. Always be sure
that a supported driver is being used and matches the device for which the print queue is being created.

1.

In the left navigation pane, click Print Management at the bottom of the screen.

In the Print Management - Print Queues task module, select the print queue and click Edit.
The Edit Print Queue wizard is started with the Select driver page displayed.

Select the driver:

e Universal Print Driver: the Universal Print Driver PostScript is available (HP’s Universal Print
Driver on page 226); other Universal Print Drivers can be obtained and installed through
Product Update (Product Update on page 270).

e Known Drivers: drivers that are already installed on the remote host or drivers that exist on
the HP Web Jetadmin 10.0 server (INF driver install base). These drivers, when identified for
use with the print queue, are added to the queue as it is being installed (Create Print
Queue on page 230).

To display all drivers (not just the ones that are specific to the selected device), click Show all
drivers.

Click Next. The Specify print queue options page is displayed.
If you want to share this printer click Share this printer.

Click Next. The Results page is displayed.

Click Done. The Print Management page is displayed.

Other Ways to Edit a Queue

In the left navigation pane, right-click on Overview and select Edit print queue.
In the Print Management - Print Queues task module, select Edit.

In the Print Management - Print Queue task module, type a computer name and domain and
click Find. Enter the credentials to display the queues on the specified server. Then you can select
a queue and click Edit.
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Delete Print Queue

Steps for Deleting a Print Queue

Other Ways to Delete a Print Queue

You can delete print queues from HP Web Jetadmin 10.0.

Steps for Deleting a Print Queue

1.

3.
4,

In the left navigation pane, click Print Management at the bottom of the screen.

In the Print Management - Print Queues task module, click Delete. The Delete Print Queue
wizard is started.

Select one of the following to delete:

e Driver associated with the print queue: removes the driver that this queue utilized.

B NOTE: When selecting Driver associated with the print queue, the driver might not
actually be removed; this is due to known problems with Microsoft’'s Spooler system.

e Port associated with the print queue: removes the port that this queue utilized.

Bf NOTE: When selecting Port associated with the print queue, the port might not actually
be removed; this is due to known problems with Microsoft’s Spooler system.

e Purge jobs associated with the print queue: removes any queued jobs associated with the
queue.

Click Next. The Confirm page is displayed.
Click Next. The Results page is displayed. Click Done to display the Print Management page.

Other Ways to Delete a Print Queue
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In the left navigation pane, right-click on Overview and select Delete print queue.
In the Print Management - Print Queues task module, select Delete.

In the Print Management - Print Queue task module, type a computer name and domain and
click Find. Enter the credentials to display the queues on the specified server. Then you can select
a queue and click Delete.
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Pre-configure Driver

° Steps for Pre-configuring a Driver

e Other Ways to Pre-Configure a Driver

After drivers are listed in Available Drivers, they can be pre-configured to contain settings such as
duplex-on or grayscale. Many HP drivers can be pre-configured. Typically, PCL5 and PCL6 HP drivers
for newer HP devices can be pre-configured in a variety of ways. Some settings can be locked.

Table 5-2 Driver Settings

Setting Lockable or Not Lockable
Duplex/Simplex Lockable

Orientation: Portrait/Landscape Not Lockable

Print in grayscale Lockable

Print quality Not Lockable

After a pre-configuration has been added for a driver to HP Web Jetadmin 10.0, whenever that driver
is selected you will be asked to select the default or the pre-configured driver.

Steps for Pre-configuring a Driver

149,

B NOTE: Users who are not members of the local administrators group on the HP Web Jetadmin 10.0
server host are not able to create driver pre-configuration settings. The Printing Preferences tab and
the Device Settings tab are not displayed for those users not in the local administrators group.

1. In the left navigation pane, click Print Management at the bottom of the screen.

In the Print Management - Common Tasks task module, click Pre-configure driver. The Driver
Pre-configuration wizard is started with the Select driver page displayed.

2. Select the driver and click Next. The Specify Configuration Options page is displayed.

3. Configure the driver settings and name the pre-configuration for the driver; notice that some might
be locked in which cases you cannot adjust them. Click Next. The Confirm page is displayed.

4. Click Save Configuration. The Results page is displayed.
5. Click Done. The Print Management page is displayed.

The new pre-configuration and the default configuration now exist and can either be exported to
an INF driver install file set or used in managing print queues.

Other Ways to Pre-Configure a Driver
e Inthe left navigation pane, right-click on Overview and select Pre-configure driver.

e In the Print Management-Available Drivers task module, select Pre-configure.
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Upload Driver to Available Drivers

° Steps for Uploading a Driver to Available Drivers

e Other Ways to Upload a Driver to Available Drivers

INF install file sets for drivers can be uploaded into the HP Web Jetadmin 10.0 host. These drivers can
then be installed onto remote hosts (Edit Print Queue on page 232 or Create Print Queue

on page 230).
All of the files in the directory with the INF file and all files in subdirectories of that directory are copied

to the HP Web Jetadmin 10.0 server as part of the upload process. Extra files not related to that driver
should not be in that directory or its subdirectories.

Steps for Uploading a Driver to Available Drivers
1. In the left navigation pane, click Print Management at the bottom of the screen.

In the Print Management - Available Drivers task module, click Upload. The Upload Driver
wizard is started with the Select INF File page displayed.

2. Select an INF file and click Next. The Confirm page is displayed.
3. Click Start. The selected driver is copied to the destination specified in the preceding step.

4. Click Done. The Print Management page is displayed.

Other Ways to Upload a Driver to Available Drivers
e Inthe left navigation pane, right-click on Overview and select Upload driver.

e Inthe Print Management - Common Tasks task module, select Upload driver to available
drivers.
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Delete a Driver

° Steps for Deleting a Driver

e Other Ways to Delete a Driver

Drivers can be removed from HP Web Jetadmin 10.0 if there is a more current version available or if
they are no longer needed.

Steps for Deleting a Driver

1. In the left navigation pane, click Print Management at the bottom of the screen.

In the Print Management - Available Drivers task module, click Delete. The Delete Driver wizard
is started with the Confirm page displayed.

2. Click Next. The Results page is displayed. Click Done to display the Print Management page.

Other Ways to Delete a Driver

In the left navigation pane, right-click on Overview and select Delete driver from available
drivers.

In the Print Management - Common Tasks task module, select Delete driver from available
drivers.
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Retrieve a Driver

Steps for Retrieving a Driver

Other Ways to Retrieve a Driver

You can copy a driver to any destination.

Steps for Retrieving a Driver

1.

In the left navigation pane, click Print Management at the bottom of the screen.

In the Print Management - Available Drivers task module, click Retrieve. The Get Driver wizard
is started with the Select driver page displayed.

Select the driver:

e Universal Print Driver: the Universal Print Driver PostScript is available (HP’s Universal Print
Driver on page 226); other Universal Print Drivers can be obtained and installed through
Product Update (Product Update on page 270).

e Known Drivers: drivers that are already installed on the remote host or drivers that exist on
the HP Web Jetadmin 10.0 server (INF driver install base). These drivers, when identified for
use with the print queue, are added to the queue as it is being installed (Create Print
Queue on page 230).

To display all drivers (not just the ones that are specific to the selected device), click Show all
drivers.

Click Next.

Select the driver and the pre-configuration for the driver and click Next. The Specify destination
settings page is displayed.

Select a folder for the driver and click Next. The Confirm page is displayed.
Click Start. The selected driver is copied to the destination specified in the preceding step.

Click Done. The Print Management page is displayed.

Other Ways to Retrieve a Driver
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In the left navigation pane, right-click on Overview and select Retrieve driver from available
drivers.

In the Print Management - Common Tasks task module, select Retrieve driver from available
drivers.
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6 Application Management

e All About Application Management

e Application Management Task Modules

e Application Management Options

° User Security

° Product Update

e Web Jetadmin Management
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All About Application Management
e  Network Ports

The Application Management view provides many features that help you configure and manage
devices on your network. The Overview page can provide you access to all of these features through
the various task modules. (See Application Management Task Modules on page 241.)

Following are some important things to note about HP Web Jetadmin 10.0:

e Low Privilege User Service: HP Web Jetadmin 10.0 runs under the low privilege user service
Network Service. Many environments require that applications like HP Web Jetadmin 10.0 not have
administrative access to the operating system.

e Database Access and Authentication: the SQL Server 2005 Express database instance that was
created at install time is accessed by the application, HP Web Jetadmin using Windows
credentials.

e File Permissions and NTFS: the SQL Server 2005 Express database instance that was created
at install time is accessed by HP Web Jetadmin using Windows credentials.

Network Ports

HP Web Jetadmin 10.0 opens a number of ports for various reasons. The following table shows the
ports.

Bf NOTE: A port number of “0” indicates a random port selected by the operating system or by HP Web
Jetadmin 10.0.

Table 6-1 Server-required Ports Opened by HP Web Jetadmin 10.0

Port Number Type 110 Details

0 UDP 1/0 TFTP send/receive request
handling

0 UDP (e} SNMP

0 TCP O WMI Communication

0 TCP (0] Firmware upgrade

69 UDP | TFTP incoming port

427 UDP I SLP Listen

3702 UDP | WS Discovery Listen”

4088 TCP 1/0 Client Remoting

8000 UDP | Web Jetadmin Discovery
Listen

8000 TCP | WebServer (http)

8443 TCP | WebServer (https)

27892 UDP | Traps Listener

for the discovery of other HP Web Jetadmin servers
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Table 6-2 Client-required Ports Opened by HP Web Jetadmin 10.0

Port Number Type 110 Details

161 UDP I SNMP

445 ubP | WMI communication
9100 TCP | Firmware
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Application Management Task Modules

e Application Management - Current Tasks and Common Tasks Task Module

e Application Management - Active Tasks Task Module

e Application Management - All Active Tasks Task Module

e Application Management - Scheduled Tasks Task Module

e Application Management - All Scheduled Tasks Task Module

The following task modules can be displayed or hidden in the Overview section of Application -
Management and also in the corresponding functional area within HP Web Jetadmin 10.0 by right-
clicking within the page and selecting the specific task module.

Bf NOTE: To display the Task Module docking area, click View > Task Module docking area. This is
a toggle selection; if you select it again it closes the Task Module docking area.

Table 6-3 Application Management Task Modules

Overview

e  Application Management - Current Tasks and Common Tasks Task Module on page 242

e  Application Management - Active Tasks Task Module on page 242

e  Application Management - All Active Tasks Task Module on page 242

e Application Management - Scheduled Tasks Task Module on page 242

° Application Management - All Scheduled Tasks Task Module on page 242

User Security on page 260

° User Security - Current Tasks and User Security - Common Tasks Task Modules on page 262

° User Security - Roles Task Module on page 263

° User Security - Users Task Module on page 263

° User Security - Active Clients Task Module on page 263

Product Update on page 270

° Product Update - Current Tasks and Product Update - Common Tasks Task Modules on page 271

° Product Update - Available Packages Task Module on page 271

° Product Update - Recommended Packages Task Module on page 271

° Product Update - Solutions on page 271

Web Jetadmin Management on page 275

e  Web Jetadmin Installations - Current Tasks and Web Jetadmin Installations - Common Tasks Task Module
on page 276

e Web Jetadmin - Management Task Module on page 276

e Web Jetadmin Installations - Summary Task Module on page 276
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Application Management - Current Tasks and Common Tasks Task Module

The Application Management - Current Tasks task module can be displayed on the Application
Management - Overview page and includes the following tasks:

° Create a Role on page 264

e Assign Roles to Users on page 267

° Install Packages on page 271

° Find Web Jetadmin Installations on page 277

The Application Management - Current Tasks task module can be displayed in other areas of HP Web
Jetadmin 10.0; in the other areas it is called Application Management - Common Tasks.

Application Management - Active Tasks Task Module

The Application Management - Active Tasks task module can be displayed on the Application
Management - Overview page and lists active tasks related to Application Management. From this
task module you can:

e Stop a task related to Application Management.

e View a active task related to Application Management.

Application Management - All Active Tasks Task Module

The Application Management - Active Tasks task module can be displayed on the Application
Management - Overview and lists all active tasks within HP Web Jetadmin 10.0. From this task module
you can:

e  Stop an active task in HP Web Jetadmin 10.0.

e View an active task in HP Web Jetadmin 10.0.

Application Management - Scheduled Tasks Task Module

The Application Management - Scheduled Tasks task module can be displayed on the Application
Management - Overview page and lists scheduled tasks related to Application Management. From
this task module you can:

e Delete a scheduled task related to Application Management.

e View a scheduled task related to Application Management.

Application Management - All Scheduled Tasks Task Module

The Application Management - All Scheduled Tasks task module can be displayed on the
Application Management - Overview page and lists all scheduled tasks within HP Web Jetadmin 10.0.
From this task module you can:

e Delete any scheduled task in HP Web Jetadmin 10.0.
e View any scheduled task in HP Web Jetadmin 10.0.
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° Network
° Email

° Time Preference

° IP Ranges

° Domain Browsing

e  Support

e Application Log
e Server Certificates (or SSL)

° User Management

e Credentials

° Product Update

Application Management Options

The following options can be set for Application Management in Tools > Options > Application

Management

Table 6-4 Application Management Options

Functional Area

Available Options

Network on page 244

° SNMP on page 244
° HTTP on page 245

° DNS on page 245

Email on page 245

e SMTP on page 246

° Email Addresses Management on page 246

° Custom Email Templates on page 247

Time Preference on page 247

° Domain Browsing on page 249

IP Ranges on page 247

° IP_Ranges - General (Large Subnets) on page 247

° IP_Ranges on page 248

Domain Browsing on page 249

° Domain Browsing on page 249

Support on page 249

e  Support on page 249

Application Log on page 250

e  Application Log on page 250

Server Certificates (or SSL) on page 250

e  Server Certificates (or SSL) on page 250

User Management on page 251

° User Management on page 251

Credentials on page 252

° Global Credentials on page 255

e SNMP Get Community Name on page 255

e SNMP Set Community Name on page 256
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Table 6-4 Application Management Options (continued)

Functional Area Available Options

° SNMPv3 Credentials on page 257

° EWS Password on page 258

Product Update on page 258 ° Product Update on page 258
Network
e SNMP
e HTTP
° DNS

SNMP

Network settings impact how HP Web Jetadmin 10.0 behaves on your network and how it performs for
functions like discovery.

e Steps for Setting SNMP_Configuration Options

HP Web Jetadmin 10.0 uses the SNMP protocol to gather information from the devices. You can
configure the SNMP timeout value and SNMP retries. On some networks, SNMP timeouts and retries
should be increased due to low bandwidth or slow links. Also, some networks might experience improved
discovery performance by decreasing SNMP timeouts and retries.

Your network topology might cause slow response times; in this case you would want the timeout
configured for a longer time. Or, you might want to set the number of retries to a higher number to protect
against packet loss.

Bf NOTE: Increasing SNMP values can increase the amount of time it takes to perform a discovery.

Steps for Setting SNMP Configuration Options

1. On the top menu bar, access Tools > Options > Application Management.
Expand Network and then select SNMP.
2. Configure the desired settings:

e  SNMPv1 timeout value: specify how long HP Web Jetadmin 10.0 should wait for a reply from
a network query from SNMPv1 devices (the default is 500ms).

e  SNMPv3 timeout value: specify how long HP Web Jetadmin 10.0 should wait for a reply from
a network query from SNMPv3 devices (the default is 1,000ms).

e  SNMP retries: specify how many times HP Web Jetadmin 10.0 should retry an SNMP
communication with devices before giving up once a timeout has occurred (the default is 3
total attempts).

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.
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HTTP

Steps for Configuring HTTP _Configuration Options

HTTP options enable you to specify a web proxy server and port number from which a client can access
the proxy server. A security barrier is enabled on your internal network while accessing external websites
that are required by HP Web Jetadmin 10.0.

Steps for Configuring HTTP Configuration Options

DNS

1.

On the top menu bar, access Tools > Options > Application Management.
Expand Network and then select HTTP.
Configure the desired settings:

e HTTP proxy user settings: If your environment includes a proxy server, enter the HTTP
proxy address settings. |dentify the address and the port number HP Web Jetadmin 10.0
should use to communicate through the proxy server.

e Use HTTP proxy credentials: check the box to use HTTP proxy user settings and then
specify the user and password.

e Allow download: check this box to allow downloads.

To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Steps for Configuring DNS Options

By default, HP Web Jetadmin 10.0 enables DNS lookups. You can turn them off here if desired.

Steps for Configuring DNS Options

Email
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1.

On the top menu bar, access Tools > Options > Application Management.
Expand Network and then select DNS.
Configure the desired settings:

e Enable DNS lookups: check this box to enable HP Web Jetadmin 10.0 to perform DNS
lookups.

To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

SMTP

Email Addresses Management

Custom Email Templates

Options in Email provide a way to configure settings to enable email communications from HP Web
Jetadmin 10.0 and also to manage email addresses.
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SMTP

Steps for Configuring SMTP Options for Email

SMTP options sets the SMTP gateway for relaying messages to email user accounts. These types of
messages are used to convey Alerts event details to recipients, reports and reports data export details
to recipients, and device list export details to recipients.

Steps for Configuring SMTP Options for Email

1.

On the top menu bar, access Tools > Options > Application Management.

Expand Email and then select SMTP. (You might have to expand Email twice to see the SMTP
option.)

Configure the desired settings:

e  SMTP server settings: enter the IP address or hostname and the port number for the mail
server gateway.

e  SMTP user settings: enter the user name and password; these are optional user credentials
when SMTP authentication exists.

e Default ‘from’ address: enter the email address. This address exists in each email message
sent by the application (the default is wja@hp.com). Enter the username and password; these
are optional user credentials when SMTP authentication exists.

To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Email Addresses Management

Steps for Managing Email Addresses

This option allows email addresses to be added and maintained for use in Reports on page 173,
Alerts on page 148, and Device Lists on page 67.

Steps for Managing Email Addresses

1.

On the top menu bar, access Tools > Options > Application Management.

Expand Email and then select Email Addresses. (You might have to expand Email twice to see
the Email Addresses option.)

Configure the desired settings:
e New: type the new email address and select the preferred language. Then click OK.

e Remove: select an existing email address and click Remove. You will be asked to confirm
the action.

o Edit: select an existing email address and click Edit. Make changes to the email address and
click OK.

To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.
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Custom Email Templates

° Steps for Configuring Custom Email Templates

This option allows custom email templates to be created for use in Reports on page 173, Alerts
on page 148, and Device Lists on page 67.

Steps for Configuring Custom Email Templates
1. On the top menu bar, access Tools > Options > Application Management.
Expand Email and then select Custom Email Templates.
2. To create a new template, click Create and complete the displayed pages.
3. To delete or edit an existing template, select the template and then select the action to perform:
e Delete: delete an existing template.
e Edit: make changes to an existing template.

4. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Time Preference

° Steps for Configuring Time Preference

This option allows you to configure whether the HP Web Jetadmin 10.0 server uses a 24 hour or 12
hour clock when creating email messages and reports. Client-side time display is controlled by the
operating system setting on the client running HP Web Jetadmin 10.0.

Steps for Configuring Time Preference

1.  On the top menu bar, access Tools > Options > Application Management and select Time
Preference.

2. Select 12 hours or 24 hours.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

IP Ranges

You can search for devices located within a range of IP addresses (multiple IP ranges can be
designated).

IP Ranges - General (Large Subnets)

e Steps for Configuring Large |IP_Ranges

You can choose to specify a large subnet range using the larger subnet address feature (Tools >
Options > Application Management > IP Ranges > General). Large networks are considered any
network bigger than a Class B network, which has up to 65,000 nodes.
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Steps for Configuring Large IP Ranges
1. On the top menu bar, access Tools > Options > Application Management.
Expand IP Ranges and then select General.

2. To search for subnets larger than Class B (65,000 nodes), click Allow large subnet
discoveries.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

To define the IP ranges, see IP Ranges on page 248.

IP Ranges

e Steps for Configuring IP Ranges

HP Web Jetadmin 10.0 can search for devices located within a range of IP addresses (multiple IP ranges
can be designated) (IP_Range Discovery on page 107).

Steps for Configuring IP Ranges

On the top menu bar, access Tools > Options > Application Management. Expand IP Ranges and
then select IP Ranges.

1. Choose the action to take:
e Selectan IP range.

e Add: add an IP range. Type the range in First address and Last address; then type a
description (if desired) in Description. Click Add.

Calculate range: to calculate a range, click Calculate range. The Calculate IP Range page
is displayed:

o Subnet from my computer: automatically use IP address ranges currently found on the
local subnet of your computer. You can add a description in Description if desired.

0 Subnet from WJA server: automatically use IP address ranges currently found on the
subnet of the HP Web Jetadmin 10.0 server. You can add a description in Description
if desired.

0 Subnet from network address: type a known IP address and subnet mask. You can
add a description in Description if desired.

e Edit: make changes to IP ranges. Follow the steps in the bullet above for adding an IP range.
o Delete: remove addresses from the list by highlighting the address and clicking Delete.
e Import: If desired, import a range list by clicking Import and then browse for the range list.

e Export: if desired, export a range list by clicking Export and then browse for location you want
to store the range list.

2. Click OK. The Select IP Ranges page is displayed.
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Domain Browsing

Steps for Configuring Domain Browsing

This option allows you to enter domain credentials when needed.

Steps for Configuring Domain Browsing

Support

1.

On the top menu bar, access Tools > Options > Application Management and select Domain
Browsing.

Configure the desired settings:

e AddDomain: add adomain. The Add Domain dialog is displayed. Type the domain or browse
for it. If you browse, you might be asked for credentials.

e Set Credential: enter the username and password. In the Stored column, set credentials for
any domain with Yes.

° Remove: delete a domain; select a domain listed and click Remove.
e Test: test the domain. Credentials might be required.

To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Steps for Configuring Support

You can choose to send information to HP about the use of HP Web Jetadmin.

If you choose to allow HP Web Jetadmin to contact http://www.hp.com, each time the application
communicates with HP it sends 4 pieces of information:

an identification number unique to the HP Web Jetadmin installation.
the operating system of the client or host.
the version of HP Web Jetadmin.

the current configured language of HP Web Jetadmin.

This information is sent on service start-up and whenever a new client connects to the service.

Steps for Configuring Support
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1.

On the top menu bar, access Tools > Options > Application Management.
Select Support.
Configure the desired settings:

° Provide Web Jetadmin installation information to Hewlett-Packard: check this box to
send information about the HP Web Jetadmin installation back to HP.

To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.
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Application Log

° Steps for Configuring Application Log Options

This option lets you set the time for application log data to be saved.

Steps for Configuring Application Log Options
1. On the top menu bar, access Tools > Options > Application Management.
Select Application Log.
2. Configure the desired settings:

e Save log entries for: select the length of time to save log entries from the drop-down box
(the default is 30 days).

e Clear Log: clear the Application Log. You must then confirm or cancel your request.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Server Certificates (or SSL)

e SSL (Secure Sockets Layer)

° Important Points to Remember When Implementing SSL

HP Web Jetadmin 10.0’s HTTP service runs without certificates until you add one. After a certificate is
added, the HTTP server is running in HTTPS mode which means that SSL (secure sockets layer)
communication is enforced. This is a mode in which the user and the HTTP server are authenticated to
one another and in which the traffic between the two is encrypted. This adds an extra layer of security
to the Smart Client download and other HTTP transactions (Smart Client Deployment on page 16).

HP Web Jetadmin 10.0 does not self generate certificates as in previous versions of HP Web Jetadmin.
Now you have to get one from a CA (certificate authority). You can use the Signing Request to do this.
After you generate a signing request, send it to your CA, and then when the CA sends you back your
certificate, use the Install Certificate to enable HTTPS. CAs can exist inside or outside of your
organization. Many companies have their own CAs.

SSL (Secure Sockets Layer)

HP Web Jetadmin administrators can enable the SSL (secure sockets layer) which forces browser
communication to the more secure HTTPS protocol. SSL is enabled by the administrator from the
console or host running the application. A notice will occur when users try to enable this feature from a
remote client.

In some environments, SSL is required anytime an HTTP interface or service is being used for
communication. In these cases, SSL can be enabled and enforced by HP Web Jetadmin 10.0. SSL
provides a good deal of assurance in both authentication and encryption aspects of HTTP
communication. That is, the user requesting access to the HP Web Jetadmin 10.0 Smart Client download
can be reasonably assured that the system hosting HP Web Jetadmin 10.0 is authentic and the
communication between the two systems is encrypted so that it cannot be easily read by eavesdroppers
(Smart Client Deployment on page 16).

Certificates are used by the SSL protocol in order to accommodate both authentication and encryption.
HP Web Jetadmin 10.0 is capable of generating a signing request that can be used by a CA (certificate
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authority) for the purpose of generating a certificate. Using Tools > Options > Application
Management > Server Certificates area, the user can generate a Signing Request.

Once the request has been fulfilled by the CA, the certificate is ready to be installed on HP Web Jetadmin
10.0. Remember, it is not possible to use Tools > Options > Application Management > Server
Certificates without being at the application console. Install Certificate is used to browse and upload
the certificate file.

Once the certificate is installed, the HTTP service enforces SSL. Any browser contact with HP Web
Jetadmin 10.0 should indicate HTTPS on the URL when a certificate is installed. Using Remove
uninstalls the certificate and SSL is no longer enforced.

Important Points to Remember When Implementing SSL
Client communication with SSL enforced requires one or more of the following considerations.

e When SSL has been implemented on HP Web Jetadmin 10.0 with an internal CA (certificate
authority), the CA’s authorizing certificate is required to be installed in the client browser. If this
certificate is not installed in the client browser the HP Web Jetadmin 10.0 Smart Client page will
fail to load up in SSL mode.

e  Proxy servers tend to use the standard SSL port which is 443. If HP Web Jetadmin 10.0’'s Smart
Client page is being called through a proxy server, a redirect error may occur. This is due to the
URL being redirected to 443 rather than 8443 which is the port used by HP Web Jetadmin 10.0’s
SSL. The workaround for this is to place the HP Web Jetadmin 10.0 FQDN into the browsers
exceptions list under Tools > Internet Options > Connections > LAN Settings > Advanced.
This causes the browser to pull http and https content from the HP Web Jetadmin 10.0 server
directly.

B NOTE: HP Web Jetadmin 10.0 http and https port numbers can be customized to something
other than 8000 and 8443.

e  When you have implemented SSL on HP Web Jetadmin 10.0, a redirect occurs when the browser
URL uses port 8000. Here is an example:

The known URL prior to SSL implementation is http://servername.domain.xxx:8000.

After SSL implementation, HP Web Jetadmin 10.0 will redirect this to a new URL: https://
servername.domain.xxx:8443.

The URLs shown here use FQDN (fully qualified domain name). In most cases the certificate issued
and installed in the HP Web Jetadmin 10.0 SSL implementation will contain an FQDN for the host
on which HP Web Jetadmin 10.0 is installed. If a non FQDN is used in the browser, certificate
failure will occur. As a general rule, form the HP Web Jetadmin 10.0 URL with FQDN when HP Web
Jetadmin 10.0 is implemented with SSL.

To configure Server Certifications, access Tools > Options > Application Management > Server
Certificates.

User Management

e Steps for Configuring User Management

You can restore default user roles if desired (Roles on page 263).
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Steps for Configuring User Management
1. On the top menu bar, access Tools > Options > Application Management.
Select User Management.
2. To restore all values for the role Default Device Admin Role Template, select Restore.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

Credentials
e All About Credentials

e Global Credentials

e SNMP Get Community Name

e SNMP Set Community Name

e SNMPv3 Credentials

° EWS Password

° File System Password

All About Credentials

HP Web Jetadmin 10.0 can configure many devices at once. This saves device administrators from
having to contact every device separately for the purpose of assigning configuration items like
passwords and other credentials. In many environments, password policies exist which make the device
administrator have to reconfigure security credentials periodically. The power of HP Web Jetadmin 10.0
fleet management lends itself to configuration of many devices at once.

The Credentials Store

The concept of a Credential Store is not new to HP Web Jetadmin. Older versions of HP Web Jetadmin
stored credentials as they were used and configured onto the devices. This feature keeps HP Web
Jetadmin 10.0 users from having to provide a credential every time a device is configured that requires
one.

The Credentials Store is a portion of the HP Web Jetadmin 10.0 database that securely encrypts and
stores device credentials when ever a correct credential value is authenticated at the device. These
values are stored on a per credential and per device basis.

Here is a list of HP device credentials used by HP Web Jetadmin 10.0:

e EWS Password: blocks unauthorized access to the device-embedded http interface. It is also
synchronized with the HP Jetdirect telnet password.

e File System Password: protects the printer disk and other storage facilities from unauthorized
access.

e SNMPv3 Credentials: consists of user name, passphrase1, and passphrase2 which are all used
when SNMPv3 is enabled. This version of SNMP (Simple Network Management Protocol) secures
and authenticates communication between management applications like HP Web Jetadmin 10.0
and the device. This protocol is used when strong security is required.
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e SNMP Set Community Name: a grouping mechanism for SNMPv1/v2 that has been adopted as
a security mechanism by many customers. Device configuration is not possible without knowledge
of the Set name value. The Set name value traverses the network in clear text and can be “sniffed”
by eavesdroppers.

e SNMP Get Community Name: sometimes used to prevent device discovery from other HP Web
Jetadmin 10.0 installations. Devices only respond to Get packets that have the correct value. The
Get name value traverses the network in clear text and can be “sniffed” by eavesdroppers.

Two actions cause the value of any credential to be stored:
e configuration: the credential becomes stored once it has been configured onto the device.
e use: the credential value, when used successfully, becomes stored.

Stored credentials are reused by HP Web Jetadmin 10.0 any time the requirement for them is
encountered. A user configuring a device that has had a credential stored is not required to re-enter the
credential into HP Web Jetadmin 10.0. The application uses the credential in the background. In fact,
the user is not even required to know the credential since HP Web Jetadmin 10.0 is using stored values.

Credentials Delegation

With credentials stored in the Credentials Store, HP Web Jetadmin 10.0 can apply them transparently
any time the need arises. While configuring devices, users do not have to remember or even know the
credential to perform the configuration. Users just need access to HP Web Jetadmin 10.0 and device
configuration features. This is called credentials delegation; some characteristics of credentials
delegation are:

e  Only one or a few device administrators know the device credentials.

e Some HP Web Jetadmin 10.0 users are allowed configuration access to the devices via Roles and
User Security.

e Users can be added or removed from this delegation via Roles and User Security (User
Security on page 260).

e  Other HP Web Jetadmin 10.0 users can be restricted from device configuration.
e Knowledge about device passwords is required before you can change any password value.

Credentials delegation is used to allow configuration of devices without having to share the credential
“secrets” across a large distribution. Staffs can control and configure devices while administrators control
and configure passwords. Any user with access to devices and configuration features has delegated
access to the Credential Store.

Credentials Needed

ENWW

When HP Web Jetadmin 10.0, during an action such as device configuration, encounters a device with
a credential such as SNMP Set Community Name, it follows a specific sequence. Here is an over
simplification of how HP Web Jetadmin 10.0 attempts to resolve a credential:

° HP Web Jetadmin 10.0 checks the Credential Store for a credential.
e Ifit exists, HP Web Jetadmin 10.0 attempts the configuration using the credential value.
If it does not exist, HP Web Jetadmin 10.0 checks Global Credentials.

e If the configuration is successful, the credential check is resolved and complete.
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If it fails, HP Web Jetadmin 10.0 checks Global Credentials.

During a user-attended configuration session, HP Web Jetadmin 10.0 prompts for credentials. In the
case where the user did not supply the credential or the session was not live, the device is flagged
as Credentials Required and listed in the Credentials Required column that can be enabled in any
device list (Columns for Device Lists on page 68). You can right-click the device and add the needed
credential to the system in order to resolve this state.

What happened to the HP Jetdirect Device Password?

HP Web Jetadmin 10.0 enables device security by providing management over appropriate, device-
based security settings. The HP Jetdirect password that was used by HP Web Jetadmin in the past is
a software security solution and not a device-based security solution. That is, the password itself had
to be recognized and authenticated by earlier revisions of HP Web Jetadmin software. Other applications
did not recognize this password and did not force users to prove knowledge of the password.

As security features have become more sophisticated and device based security has improved, HP Web
Jetadmin 10.0 developers have opted out of using the HP Jetdirect device password as a protective
mechanism for device authentication. There are two recommendations for providing device security in
place of the HP Jetdirect device password:

e SNMP Set Community Name: devices will not allow an SNMP Set from any application without
the Set Community Name correctly embedded in the SNMP packet. If the Set name in the packet
is “public” and the Set name on the device is “George”, the device won’t accept or acknowledge
the packet. Set Community Names traverse the network in clear text and can therefore be “sniffed”
or viewed by eavesdroppers. In most environments, security provided by Set Community Names
may provide adequate security.

e SNMPv3: devices configured via SNMPV3 offer significant security benefits. First, SNMPv3
configures a user account and two pass-phrases onto the device which requires the user (or
application) to authenticate. This blocks unauthorized management of devices and the account/
pass-phrase details do not traverse the network in clear text which makes it difficult for
eavesdroppers to learn the “secrets”. Second, the communication between the management
application and the device is encrypted using the SNMP credentials so information about the device
is protected. SNMPv3 is recommended in security sensitive environments.

Restricting Configuration by Device Group

Within the model of device credential delegation, restriction to specific device configuration can be
further defined in User Security using the Restriction type Groups (Roles and Restrictions
on page 263).

Consider the following layers of security:

e Access to device credential values: Credential Store/selected device administrators (The
Credentials Store on page 252).

e Access to HP Web Jetadmin 10.0: Users and Roles (User Security on page 260).

e Access to device credentials store: Roles/Feature Permissions (Roles on page 263).

e Access to specific devices: Roles/Device Group Membership/Device Feature Permissions
(Roles on page 263).
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Each layer uses HP Web Jetadmin 10.0 security to protect against unauthorized access:
1.  First, device passwords are protected by one or a few select administrators.
2. Second, Users and Roles allow only authorized users to log onto HP Web Jetadmin 10.0.

3. Third, Roles and Feature Permissions allow only authorized users configuration access to all
devices.

4. Finally, Roles, Device Group Membership, and Device Feature Permissions allow authorized
users to specific devices based on device group membership and specified device configuration
features.

All devices and configuration options outside of the Group Restriction Type are secured from
unauthorized access.

Global Credentials

° Steps for Configuring Global Credentials

Global credentials are credentials that HP Web Jetadmin 10.0 uses for any device; they are an easy
way for you to enter common credentials up front. Global credentials can be set for SNMPv1 Get
Community Name, SNMPv1 Set Community Name, SNMPv3 Credentials, and EWS Password. If these
credentials have been set, and device operations (for example, device configuration) require credentials
in order to succeed, the global credential will be tried. If the operation succeeds for the devices with the
global credential, that global credential will be stored with the device. It will still remain a global credential
for other devices, but now that specific device has a working credential stored with it.

For example: User “A” enters global credentials for SNMPv1 Get Community Name as “mine” and
“yours”. User “B” tries to interact with device “X”, which has a community name already set. HP Web

",

Jetadmin 10.0 first tries global credentials “yours” and “mine”; “yours” works. “Yours” will then be stored
as aregular credential for device “X”. The next time any user tries to interact with device “X”, the regular
credential for that device (which is now “yours”) will be used by HP Web Jetadmin 10.0 and any global
credentials will be ignored. However, if the regular credential “yours” becomes out of date, this process
starts all over again.

Steps for Configuring Global Credentials
1. On the top menu bar, access Tools > Options > Application Management.
Expand Credentials and then select Global Credentials.
2. Configure the desired settings:
e Clear global credentials: clears every temporary, global, device-specific credential.
e Clear all stored credentials: clears every temporary, global, device-specific credential.
You must then confirm or cancel your request.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

SNMP Get Community Name

e Steps for Configuring SNMP Get Community Name
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The SNMP Get Community Name object is configurable from within security settings. The problem with
Get names is they can cause a device to disappear. For example:

User A is running an instance of HP Web Jetadmin 10.0 known as Web Jetadmin A. This user is
managing a set of devices that are also being managed by User B. User B is running another copy of
HP Web Jetadmin 10.0 known as Web Jetadmin B. This B copy of HP Web Jetadmin 10.0 is being used
at the help desk.

User B decides to change the default Get Community Name on the set of devices from public to
private. He does this using HP Web Jetadmin 10.0. He does this because he has heard that it provides
a measure of security. User A opens HP Web Jetadmin 10.0. She notices that all the devices have
become non-responsive and show only a device communication error. Quick Device
Discovery does not help. When User A checks the printer itself, she finds it to be powered on. She can
also reach the printer web server interface via a browser.

/A WARNING! Changing the Get Community Name can cause devices to become unresponsive to
management applications like HP Web Jetadmin 10.0. The SNMP protocol will no longer respond to
public queries and other management applications on the network will not be able to communicate
with these devices.

Steps for Configuring SNMP Get Community Name
1. On the top menu bar, access Tools > Options > Application Management.
Expand Credentials and then select SNMPv1 Get Community Name.

2. To add a community name, click Add and type the community name. Enter an associated (or
easier) name in Remember credential as and click OK.

To remove a Get Community Name, click Remove.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

SNMP Set Community Name

e Steps for Configuring SNMP Set Community Name

The SNMP Set Community Name is a grouping mechanism for SNMPv1/v2 that has been adopted as
a security mechanism by many customers. Device configuration is not possible without knowledge of
the Set name value. The Set name value traverses the network in clear text and can be easily detected
by eavesdroppers.

Steps for Configuring SNMP Set Community Name
1. On the top menu bar, access Tools > Options > Application Management.
Expand Credentials and then select SNMP Set Community Name.

2. Toadd a community name, click Add and type the community name. Enter an associated (or
easier) name in Remember credential as and click OK.

To remove a Set Community Name, click Remove.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.
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SNMPv3 Credentials

° SNMPv3 Enabled Devices

e Steps for Configuring SNMPv3 Credentials

SNMPv3 Credentials consist of user name, passphrase1 and passphrase2 which are used when
SNMPvV3 is enabled. This version of the Simple Network Management Protocol (SNMP) secures and
authenticates communication between management applications like HP Web Jetadmin 10.0 and the
device. This protocol is used when strong security is a requirement.

SNMPv3 Enabled Devices

Devices that have SNMPv3 fully enabled can be discovered by HP Web Jetadmin 10.0. You must
configure HP Web Jetadmin 10.0 to discover these devices through Tools > Options > Device
Management > Discovery > General; check the box for Discover SNMPv3 devices (General

on page 120). HP Web Jetadmin 10.0 will not discover SNMPv3 devices without this option enabled.
However, HP Web Jetadmin 10.0 has this option disabled by default because enabling this option can
cause discoveries to take longer to complete.

HP Web Jetadmin requires SNMPvV3 credentials for these devices in order for them to be discovered.
There are two ways HP Web Jetadmin can become ‘aware’ of device SNMPv3 credentials:

e HP Web Jetadmin 10.0 is used to enable SNMPv3 and also configure the SNMPv3 credentials
onto the devices. In this case, HP Web Jetadmin 10.0 stores the credentials into its credential store
and uses them whenever device communication is required. HP Web Jetadmin 10.0 also marks
these devices as SNMPv3 enabled and remembers to use the credentials and SNMPv3 whenever
communication is required.

e HP Web Jetadmin 10.0 has had SNMPv3 credentials added to the Global credentials store and
these credentials match those credential values on the devices. In this case, HP Web Jetadmin
10.0 is being made aware of credential values that work for devices that are SNMPv3 enabled.
When one of these devices is encountered, HP Web Jetadmin 10.0 will try the credential values
that are configured in Tools > Options > Application Management > Credentials > SNMPv3
Credentials (SNMPv3 Credentials on page 257). If the credential values work and HP Web
Jetadmin 10.0 is able to communicate with the devices, the credential values will be stored
individually for each device.

Devices that were discovered through SNMPv1 and have had SNMPv3 enabled through some other
means such as Embedded Web Server or another instance of HP Web Jetadmin 10.0 will indicate a
communication failure when HP Web Jetadmin 10.0 attempts to re-establish communication. The
refresh command can be used on these devices to cause HP Web Jetadmin 10.0 to reset them to
SNMPv3 enabled devices.

Steps for Configuring SNMPv3 Credentials
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1.  On the top menu bar, access Tools > Options > Application Management > Credentials >
SNMPv3 Credentials.

2. Toaddan SNMPv3 credential, click Add and type the username, the authenticated password (must
be at least 8 characters), and the private password (must be at least 8 characters). Then enter an
associated (or easier) name in Remember credential as and click OK.

To remove a an SNMPv3 credential, click Remove.
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3. To save the SNMPv3 credential, click OK.

4. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

EWS Password

e Steps for Configuring the EWS Password

The EWS password blocks unauthorized access to the device-embedded http interface. Also, it is
synchronized with the HP Jetdirect telnet password.

Steps for Configuring the EWS Password
1. On the top menu bar, access Tools > Options > Application Management.
Expand Credentials and then select EWS Password.

2. Toadd an EWS password, click Add and type the username and password. Then enter an
associated (or easier) name in Remember credential as and click OK.

To remove an EWS password, click Remove.

3. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.

File System Password

e Steps for Configuring the File System Password

The File system password protects the printer disk and other storage facilities from unauthorized
access.

Steps for Configuring the File System Password
1. On the top menu bar, access Tools > Options > Application Management.
Expand Credentials and then select File System.

2. Toadd afile system password, Add and type the password. Then enter an associated (or easier)
name in Remember password as and click OK.

To remove a file system password, click Remove.

3. Click OK.

Product Update

e Steps for Configuring Product Update

You can configure the Product Update to have HP Web Jetadmin 10.0 check the product update index
on http://www.hp.com on a scheduled basis. This way, you can go to Product Update and see a current
listing without having to ask for the list to be updated from http://www.hp.com (Product Update

on page 270).
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Steps for Configuring Product Update

1.  On the top menu bar, access Tools > Options > Application Management and select Product
Update.

2. Select Enable background checking.

3. To setor change the schedule click Change and then select the time you want HP Web Jetadmin
10.0 to check http://www.hp.com for product updates. When new updates are detected, they will
be listed on the Product Update page (Product Update on page 270).

4. To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.
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User Security

e All About User Security

° User Security Task Modules

° Roles
° Users

° User Security Diagnostics

All About User Security

° Initial User Security

° The HP Web Jetadmin 10.0 Administrator Role

° Domains and Workgroups

Within the Application Management view, HP Web Jetadmin 10.0 administrators can assign local or
domain users to user-roles. A role is a set of permissions to HP Web Jetadmin 10.0 features. Once a
user is assigned to a role, that user will have access to the permissions designated by the role

(Roles on page 263).

HP Web Jetadmin 10.0’s security features include:

e Advanced security technologies of the MS .NET platform which provides authentication and
encryption of client/server communications.

e Windows Active Directory integrated role-based user authentication secures the application
against unauthorized usage.

e  Optional SSL (Secure Sockets Layer) communication between client browser and application
server ensure data security for application file download.

e  Optional Simple Network Management Protocol v3 (SNMPv3) used on devices provides
authentication and encryption.

e IPsec plug-in; using HP Web Jetadmin 10.0, you can configure an IPsec policy and then apply it
to one or more selected HP Jetdirect devices.

e Running under a low-privilege service account reducing risk of privilege escalation attacks.

e  Secure online update features allow a safe easy way to get online patches updates and new
features.

You can manage access to HP Web Jetadmin 10.0 in User Security. You can control who has access
and what they have access to. In User Security, you can manage:

e role templates: two exist to allow you to create one set of access levels and then apply that
template when adding users. You can create, view, edit, and delete role templates.

e users: allows you to assign users to a role template. You can create, view, edit, and delete users.

The Application Management view provides many features that help you configure and manage
devices on your network. The Overview page can provide you access to all of these features through
the various task modules. (See Application Management Task Modules on page 241.)
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Initial User Security

HP Web Jetadmin 10.0 is a multi-user application that can be accessed from remote client-workstations.
Users and user-permissions can be administered to control access to the application and specific
features within the application. An example of this would be a helpdesk scenario where many users may
not require or should not have access to features like, discovery, user permissions or, global application
settings.

HP Web Jetadmin 10.0 uses Windows domain identities to authenticate users and grant access to the
application or to specified features. HP Web Jetadmin 10.0 provides single-sign-on which means the
user is authenticated by virtue of being logged into their client host. They do not have to provide their
credentials again when logging into HP Web Jetadmin 10.0.

The HP Web Jetadmin 10.0 Administrator Role

The HP Web Jetadmin 10.0 administrator has full rights to all application settings and features. The
person installing HP Web Jetadmin 10.0 software must have local administrative privileges on the install-
host and therefore will have initial administrative access to the software. Any identity that is a member
of the local administrators group on the local host also has administrative access to the software. The
identity must have local administrative privileges on the install-host and therefore will have initial
administrative access to the software.

Domains and Workgroups
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Normally, HP Web Jetadmin 10.0 will be hosted by a system that is joined to a Windows user-domain.
The computer will exist in the list of domain member computers. Also, the user installing HP Web
Jetadmin 10.0 must be a member of the local Administrators. This user is also a member of the Windows
domain. In some cases, the computer or the user may not be joined to the domain. In these cases, local
users can be created and provided access to the application.

In the following example, any user linked to the local administrator group via an account or group has
administrative access to the application. In fact, HP Web Jetadmin 10.0 will operate on a Windows
workgroup where neither computers or users are controlled by a domain:

e Local Administrators Group Membership: Domain user account, Domain user group, Local user
account, Local user group.

Workgroups are where either or both computers and users are not domain members. In these cases,
HP Web Jetadmin 10.0 client access is possible. Remote client access can be established if the following
is true.

In the table below the local user account “Joe” exists on both hosts and the password for that account
is the same. On the HP Web Jetadmin 10.0 host, “Joe” is a member of the local administrators group
which gives “Joe” rights to all HP Web Jetadmin 10.0 features and settings. “Joe” is an application
administrator.

Table 6-5 User Account Example

Iltem Web Jetadmin host Client host
Local user account “Joe” “Joe”
Password “XYZ’ “XYzZ’
Local Administrator Membership Yes No
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In some cases, the workgroups systems hosting both HP Web Jetadmin 10.0 server and client will
require some special security settings. Local Security Policy may have to be adjusted on both the
HP Web Jetadmin 10.0 and client hosts:

1. Access the Control Panel on the HP Web Jetadmin 10.0 host computer and go to Administrative
Tools > Local Security Policy MMC.

2. Go to Local Policies-Security Options.
3. Locate the item Network access: Sharing and security model for local accounts.

4. Change the setting to Classic - local users authenticate as themselves.

149,

B NOTE: See the Microsoft documentation to learn more about security policy settings.

User Security Task Modules

° User Security - Current Tasks and User Security - Common Tasks Task Modules

° User Security - Roles Task Module

° User Security - Users Task Module

° User Security - Active Clients Task Module

The following task modules can be displayed or hidden in the User Security section of Application
Management and also in the corresponding functional area within HP Web Jetadmin 10.0 by right-
clicking within the page and selecting the specific task module.

Bf NOTE: To display the Task Module docking area, click View > Task Module docking area. This is
a toggle selection; if you select it again it closes the Task Module docking area.

Table 6-6 User Security Task Modules

User Security on page 260

e  User Security - Current Tasks and User Security - Common Tasks Task Modules on page 262

° User Security - Roles Task Module on page 263

e  User Security - Users Task Module on page 263

e  User Security - Active Clients Task Module on page 263

User Security - Current Tasks and User Security - Common Tasks Task Modules

The User Security - Current Tasks task module can be displayed on the User Security page and
includes the following tasks:

e Create a Role on page 264

e Assign Roles to Users on page 267

The User Security - Current Tasks task module can be displayed in other areas of HP Web Jetadmin
10.0; in the other areas it is called User Security - Common Tasks.
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User Security - Roles Task Module

The User Security - Roles task module can be displayed on the User Security page and includes the
following tasks:

° New (Create a Role on page 264)

° Edit (Edit a Role on page 264)

° Delete (Delete a Role on page 265)

e View (Role Templates on page 265)

User Security - Users Task Module

The User Security - Users task module can be displayed on the User Security page and includes the
following tasks:

e Assign Role (Assign Roles to Users on page 267)

o Edit (Edit Users on page 268)

° Remove Role (Remove Roles on page 268)

e Diagnose (User Security Diagnostics on page 269)

User Security - Active Clients Task Module

Roles

The User Security - Active Clients task module can be displayed on the User Security page.

° Roles and Restrictions

e Create a Role
° Edit a Role
° Delete a Role

° Role Templates

Arole is a set of permissions to HP Web Jetadmin 10.0 features. Once a user is assigned to a role, that
user will have access to the permissions designated by the role.

Roles and Restrictions
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Roles can be created with the Device Group Restriction type. These roles have permissions settings
that apply only to device management settings. After a role has been established with the Device
Group Restriction type, it can be assigned to a user and a specific device group. One or more of these
can exist to provide different access to users. When you are creating a role you can specify a restriction
type (None or Device Group) (Create a Role on page 264).

After creating a role with the Device Group Restriction Type, users can be assigned along with a device
group assignment. When a role is selected that has the Device Group Restriction Type, one or more
groups can be added to the Restrict Permissions by Groups list. This will apply device management
permissions to the user based on device group membership.
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When users have roles assigned that allow device management permissions on a group or groups, they
have access to device management features for devices that are members of the associated groups.
They don’t have access to device management features for devices that are not members of these
groups.

HP Web Jetadmin 10.0 Users and Roles features are designed to be least-restrictive in nature. This
means that if a user is assigned to two roles and one allows a feature permission and the other does
not allow the same feature permission, the user will have access to the feature. Diagnostics is a great
way to determine a user’s access to features (User Security Diagnostics on page 269).

Create a Role

e Steps for Creating a Role

If you have permission to manage users, you can create a role using the Create Role wizard. You can
also view, edit, and delete roles in the system.

199,

B NOTE: Even though you can create, edit, and view role templates, you cannot edit or delete the
HP Web Jetadmin Administrator (Read-Only) role template.

Steps for Creating a Role
1. In the left navigation pane, click on User Security.

Click Create role. The Create Role wizard is started with the Specify permissions settings page
displayed.

2. Select the restrictions for the role you are creating:

e None: provides permission choices that are global in nature and apply to all parts of the
application.

e  Groups: provides permission choices that are specific to Device Groups (Device Groups
on page 85).

3. Select or deselect each permission for this role. Click Next; the Specify role name page is
displayed.

4. Type the name for this role and click Next; the Confirm page is displayed.

B NOTE: Each role template must have a unique name.

5. Review the selections you have made. If you need to modify any, click Back. If they are correct,
click Next; the Results page is displayed.

6. The Role Template is complete.

To assign this template to users, check Assign to users now (Assign Roles to Users
on page 267).

Edit a Role

e Steps for Editing a Role

After a role has been created, you can edit it if necessary to change its permissions. The only role you
cannot edit is the Administrator role.

Ef NOTE: You cannot change the type of restriction for a role after the role has been created.
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Steps for Editing a Role

1.

In the left navigation pane, click on User Security.

In the User Security - Roles task module, select the role to change and click Edit. The Edit
Role wizard is started with the Specify permissions settings page displayed.

Select or deselect each permission for this role by checking or unchecking each box. Click Next;
the Specify role name page is displayed.

Type the name for this role and click Next; the Confirm page is displayed.

NOTE: Each role template must have a unique name.

Review the selections you have made. If you need to modify any, click Back. If they are correct,
click Next; the Results page is displayed.

The Role Template is complete.

To assign this template to users, check Assign to users now (Assign Roles to Users
on page 267).

Delete a Role

Steps for Deleting a Role

You can delete any role in HP Web Jetadmin 10.0 except for the Administrator role.

Steps for Deleting a Role

1.

2,

3.

In the left navigation pane, click on User Security.

In the User Security - Roles task module, select the role to change and click Delete. The Delete
Role wizard is started with the Confirm page displayed.

If this is the correct role to delete, click Next. The Results page is displayed.

Click Done. The User Security page is displayed

Role Templates

Steps for Viewing a Role

Two role templates come with HP Web Jetadmin 10.0:

Default Device Admin Role: has limited device management permissions and no application
management permissions. You can open this template, rename it, and then change permissions
as necessary.

HP Web Jetadmin Administrator Role: a read-only role. Users assigned to this role have full
rights to HP Web Jetadmin 10.0. Both users and user-groups can be added to this role. User groups
that are added can be either local or domain groups.

For information about assigning a role template or a role to users, see Assign Roles to Users
on page 267.

Bf NOTE: Even though you can create, edit, and view role templates, you cannot edit or delete the
HP Web Jetadmin Administrator (Read-Only) role template.
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Steps for Viewing a Role

1.

Users

In the left navigation pane, click on User Security.

In the User Security - Roles task module, select the role to change and click View. The role is
displayed showing the type of restriction and any permissions set.

From this page, you can:

e Edit a Role on page 264 (if it is not the Administrator role).

e Delete a Role on page 265 (if it is not the Administrator role).

e Add User (Assign Roles to Users on page 267).

° Remove User (Remove Roles on page 268).

Managing Users within User Groups

Assign Roles to Users

Edit Users

Remove Roles

If you have permission to manage users in HP Web Jetadmin 10.0 you can add users to a role. A user
can be added to a role with all of its permissions, or that user can be added to a role with only a subset
of its permissions.

Managing Users within User Groups

Either domain or local user groups can be assigned to an HP Web Jetadmin 10.0 Role. Once the
assignment is made, the users contained within the user group have privileges that are defined within
by the role. Here are some examples of user groups and Role assignment.

Example 1: a domain user group contains users who belong to the Support team. The company
adds and removes users as needed when staff changes occur. The Support team’s user-group is
associated with an HP Web Jetadmin 10.0 Role named HELPDESK.

Domain User Group-Support:
AMERICAS \ralphj
EMEA\rjiminez
ASIAPACIFIC\chansen

Table 6-7 Assignments for Example 1

User Role

AMERICA\Support HELPDESK

Example 2: a local group on the system that hosts HP Web Jetadmin 10.0 includes a group named
WJAUsers. This group is managed by the HP Web Jetadmin 10.0 administrator who’s name is
Chester. Chester keeps a few people in the group who help him administer the application. The
group is associated with the built-in Role named HP Web Jetadmin 10.0 Administrator (read only).
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Local User Group-WJAUsers:
EMEA\Wendt

EMEA\Pac;j

ASIAPACIFIC\Hae

Table 6-8 Assignments for Example 2

User Role

WJA-SYSTEM\WJAUsers HP Web Jetadmin Administrator (read only)

Assign Roles to Users

Steps for Adding Users and Assigning Roles

After role templates are created, you can assign users to them. This lets you manage their set of
permissions for HP Web Jetadmin 10.0 easily and quickly. A user can have more than one role
assignment.

Steps for Adding Users and Assigning Roles
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1.

Select Application Management from the bottom of the left navigation pane.

Expand User Security and click on Users. The User Security - Users page is displayed.
Click Assign roles to users.

Click Add and type the user name and the domain. Click Add.

If you need to search for the user, click Browse. You can find users on either the HP Web Jetadmin
10.0 host or on the Windows domain. The Select User page is displayed. Type the Object Type
and Location and click OK. If necessary, you can browse for locations.

The information will be validated. If the user is found, it will be listed in the Selected Users box at
the bottom of this page. If the user is not found, verify the user name and domain and re-enter that
information.

Review the users assigned to this role shown in Selected Users.
If any should be removed, click Remove.

If the users assigned to this role template are correct, click Next. The User Security - Users page
is displayed.

Select the role from the Role drop-down box. One role can be selected for assignment.

If any groups have permissions associated with them, they are listed in the Restrict Permissions
by Group box at the bottom of this page.

If any of the sets of permissions should apply to this user, click Add. This means the user will only
be allowed to perform actions on the group listed.

If any of the sets of permissions listed should be removed so that the user has access to more
groups, click Remove.
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8.

Edit Users

Click Next The Confirm page is displayed.

Review the selections. If they are correct, click Next. The Results page is displayed. Click Done.

Steps for Edit Users

You can change the user and role for an existing assignment.

Steps for Edit Users

1.

8.

Select Application Management from the bottom of the left navigation pane.
Expand User Security and click on Users. The User Security - Users page is displayed.

Select the user or group and click Edit. The Edit User Roles wizard is started with the Users page
displayed.

To change the user for the role check Change User and then type the User name and domain.

If you click Browse, the Select User page is displayed. Type the Object Type and Location and
click Next. If necessary, you can browse for locations.

The information will be validated. If the user is found, it will be listed in the Selected Users box at
the bottom of this page. If the user is not found, verify the user name and domain and re-enter that
information.

Review the users assigned to this role shown in Selected Users.
If any should be removed, click Remove.

If the users assigned to this role template are correct, click Next. The User Security - Users page
is displayed again.

Select the role from the Role drop-down box.

If any groups have permissions associated with them, they are listed in the Restrict Permissions
by Group box at the bottom of this page.

If any of the sets of permissions should apply to this user, click Add. This means the user will only
be allowed to perform actions on the group listed.

If any of the sets of permissions listed should be removed so that the user has access to more
groups, click Remove.

Click Next. The Confirm page is displayed.

Review the selections. If they are correct, click Next. The Results page is displayed. Click Done.

Remove Roles

Steps for Removing Roles

Following are steps for removing roles.
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Steps for Removing Roles

1.

3.
4,

Select Application Management from the bottom of the left navigation pane.
Expand User Security and click on Users. The User Security - Users page is displayed.

Select the user or group and click Remove Role. The Remove User Role wizard is started with
the Confirm page displayed.

If this is the correct user to delete, click Next. The Results page is displayed.

Click Done. The User Security - Users page is displayed.

User Security Diagnostics

Steps for Diagnostics

User Security - Diagnostics provides analysis of permissions as they exist for an individual user or
group. Any domain or local user or group can be chosen and then examined for existing permissions
on HP Web Jetadmin 10.0.

Steps for Diagnostics

1.
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Select Application Management from the bottom of the left navigation pane.

Expand User Security and click on Diagnostics. The User Security - Diagnostics page is
displayed.

Browse for or enter the user name and domain and then click View Roles.
If desired, select a restriction to filter the list displayed.

The role or roles and permissions for the user are displayed.
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Product Update

e All About Product Update

° Product Update Task Modules

° Install Packages

° Upload Packages

° Remove Packages

View Installed Packages

Available Packages

° Installed Packages

All About Product Update
e HP Web Jetadmin 10.0 and Digital Signatures

HP Web Jetadmin 10.0 Product Update features allow the installation of update packages. These
updates can include additional functionality, device support, service patches, language support, and
more. When HP Web Jetadmin 10.0 has http access to the Internet, it can display available update
packages directly in Product Update.

These updates can be installed without having to actually visit http://www.hp.com/go/
webjetadmin_software. Sometimes connection to the Internet from HP Web Jetadmin 10.0 is not
possible. All HP Web Jetadmin 10.0 software is available on http://www.hp.com/go/
webjetadmin_software. Once packages are downloaded to a desktop, they can be uploaded through
the HP Web Jetadmin 10.0 client and then installed through Product Update.

B NOTE: To get directed to your local site, access http://www.hp.com.

HP Web Jetadmin 10.0 and Digital Signatures

All HP Web Jetadmin 10.0 packages and plug-in descriptor files are signed with digital certificates to
ensure the integrity and authenticity of these files on the HP Web Jetadmin server. HP Web Jetadmin
10.0 will not load a file or package if authentication fails.

Product Update Task Modules

° Product Update - Current Tasks and Product Update - Common Tasks Task Modules

° Product Update - Available Packages Task Module

° Product Update - Recommended Packages Task Module

° Product Update - Solutions

The following task modules can be displayed or hidden in the Product Update section of Application
Management and also in the corresponding functional area within HP Web Jetadmin 10.0 by right-
clicking within the page and selecting the specific task module.

B NOTE: To display the Task Module docking area, click View > Task Module docking area. This is
a toggle selection; if you select it again it closes the Task Module docking area.
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Table 6-9 Product Update Task Modules

Product Update on page 270

° Product Update - Current Tasks and Product Update - Common Tasks Task Modules on page 271

° Product Update - Available Packages Task Module on page 271

° Product Update - Recommended Packages Task Module on page 271

° Product Update - Solutions on page 271

Product Update - Current Tasks and Product Update - Common Tasks Task Modules
The Product Update - Current Tasks task module can be displayed on the Product Update page.

When you first select Product Update from the left navigation pane, the Product Update page is
displayed. There are three areas that can be displayed or hidden (by clicking the arrows in the title bar
for each area):

e Install packages (Install Packages on page 271).

e Remove packages (Remove Packages on page 273).

e View installed packages View Installed Packages on page 274).

The Product Update - Current Tasks task module can be displayed in other areas of HP Web Jetadmin
10.0; in the other areas it is called Product Update - Common Tasks.

Product Update - Available Packages Task Module

The Product Update - Available Packages task module can be displayed on the Product Update
page and includes the following tasks:

e Install packages (Install Packages on page 271).

e Remove packages (Remove Packages on page 273).

Product Update - Recommended Packages Task Module

The Product Update - Recommended Packages task module can be displayed on the Product
Update page and includes the following tasks:

e Install packages (Install Packages on page 271).

Product Update - Solutions

The Product Update - Solutions task module can be displayed on the Product Update page and
provides you access to important and useful information such as training, additional software, and
services.

Install Packages

e Steps to Install New Packages

e Other Ways to Install New Packages
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You can install plug-ins and new versions of HP Web Jetadmin 10.0 when they are available. You may
want to delay the start of an update so that other users have time to log off. For example, you could
send a broadcast message to other users who are logged on saying that an update will run in 5 minutes
and to please log off; then configure the update with a five minute timer.

Steps to perform a Product Update are:

Web-connected:

° Enable HTTP, Allow download (Network on page 244).

0 View Available Packages in Application Management (Available Packages
on page 274).

o Select desired update.

o Select Install.

° Supply user credentials (required for Product Updates).
Manual download:

° Obtain desired update package file from HP Software and Driver Downloads Web page
(http://www.hp.com/go/webjetadmin_software).

° Upload the package file within Available Packages (Available Packages on page 274).

o Select the package listed in Available Packages.
o Select Install.

o Supply user credentials (required for Product Updates).

In both cases, a separate Update client will start while the update is in process. Once the update is
complete, the HP Web Jetadmin 10.0 client can be started again. The updated package can be viewed
in Installed Packages within Application Management (Installed Packages on page 274).

Steps to Install New Packages

Before you start installing a new package, it is recommended to access the Users - Active Clients task
module to confirm that everyone is off the system.

1.

In the left navigation pane, click on Product Update and select Available Packages. If HP Web
Jetadmin 10.0 has contact with http://www.hp.com, summaries of installed and available packages
are displayed. You can install listed packages or remove them.

To search http://www.hp.com for the latest packages, click Check for Latest Index.

Select a package and click Install. The Install Packages wizard is started with the Update
Settings page displayed.

NOTE: Ifthere are any dependency issues (for example, the selected package depended on one
that was not installed), a page is displayed that allows you to install the dependent packages.

Enter the server credentials (domain, name, and password). If you want to delay the installation,
select the time for delay (up to 5 minutes) in Start update delay. Click Next.

The HP WJA Update Client dialog is displayed. When the installation is complete, the HP WJA
Update Client displays a “successful” message. When available, click Launch. The HP Web
Jetadmin 10.0 service is started in the background and a new client is started.
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Other Ways to Install New Packages

e In the left navigation pane, expand Product Update and click Available Packages.

e In the left navigation pane, right-click Product Update and select Install packages.

Upload Packages

e Steps for Uploading Packages

If HP Web Jetadmin 10.0 does not have access to http://www.hp.com/go/webjetadmin_software, you
can browse for the package to install. After you upload the package, you need to actually install it from
the list of Available Packages.

Steps for Uploading Packages

Before you start uploading a new package, it is recommended to access the Users - Active Clients
task module to confirm that everyone is off the system.

1. Inthe left navigation pane, click on Product Update and select Available Packages. The Upload
Package File Manager wizard is started with the Select package file page displayed.

2. Browse to the package file or type the filename (if known) and then click OK. The file will be
uploaded to HP Web Jetadmin 10.0.

3.  Now you can install the package (Install Packages on page 271).

Remove Packages

e Steps for Removing Packages

e Other Ways to Remove Packages

You can remove packages at any time.

Steps for Removing Packages

Before you start removing a package, it is recommended to access the Users - Active Clients task
module to confirm that everyone is off the system.

1. In the left navigation pane, click on Product Update and select Installed Packages.

2. Select a package to remove and click Remove (or click Remove all to remove all installed
packages). The Remove Packages wizard is started with the Update Settings page displayed.

3. Enterthe server credentials (domain, name, and password). If you want to delay the removal, select
the time for delay (up to 5 minutes) in Start update delay. Click Next.

4. The HP WJA Update Client dialog is displayed. When the removal is complete, the HP WJA
Update Client displays a “successful” message. When available, click Launch. The HP Web
Jetadmin 10.0 service is started in the background and a new client is started.
Other Ways to Remove Packages

e Inthe left navigation pane, expand Product Update and select Installed Packages. On that page
is an option to Remove or Remove All.

e Inthe Product Update - Common Tasks task module, click Remove packages.
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View Installed Packages

You can view the packages installed at any time (Installed Packages on page 274).

Available Packages

e Steps for Available Packages

You can view available packages at any time. Packages that have already been installed will not be
listed (see View Installed Packages on page 274).

Steps for Available Packages

1. Inthe left navigation pane, expand Product Update and select Available Packages. The
Available Packages page is displayed.

2.  You can view the available packages and: install selected packages, install all packages, upload
packages, or refresh list.

e Install: installs the selected package (Install Packages on page 271).

o Install All: installs all packages listed in the Available Packages list (Install Packages
on page 271).

e Upload: if HP Web Jetadmin 10.0 does not have access to http://www.hp.com/go/
webjetadmin_software, you can browse for the package to install (Upload Packages

on page 273).

e Refresh List: scan hp.com for the latest online listing of available packages.

Installed Packages

e Steps for Installed Packages

e Other Ways to See Installed Packages

You can view all installed packages.

Steps for Installed Packages

1. In the left navigation pane, expand Product Update and select Installed Packages.

2.  From here you can choose to remove selected packages or all packages (Remove Packages
on page 273).

Other Ways to See Installed Packages

e Inthe Product Update - Available Packages task module, click Installed Packages.

e Inthe Product Update - Common Tasks task module, click View installed packages.
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Web Jetadmin Management

All About HP Web Jetadmin Management

Web Jetadmin Management Task Modules

Web Jetadmin Installations

Data Synchronization

All About HP Web Jetadmin Management

HP Web Jetadmin 10.0 provides the ability to discover most versions of other HP Web Jetadmin 10.0
installations. HP Web Jetadmin 10.0 can perform a unidirectional synchronization with another HP Web
Jetadmin 10.0 All Devices List (Device Lists on page 67). This makes it easy to discover devices that
have already been discovered by other installations of HP Web Jetadmin 10.0. Both of these features,
synchronization and application discovery are valuable for a variety of reasons:

An administrator detects others using HP Web Jetadmin 10.0 software to attain understanding of
printer management on the network.

An administrator detects other HP Web Jetadmin 10.0 installations as a matter of security or
management policy.

An administrator is responsible for finding all devices in a distributed environment where others are
responsible for managing them in multiple areas.

Web Jetadmin Management Task Modules

Web Jetadmin Installations - Current Tasks and Web Jetadmin Installations - Common Tasks Task
Module

Web Jetadmin - Management Task Module

Web Jetadmin Installations - Summary Task Module

The following task modules can be displayed or hidden in the Web Jetadmin Installations section
of Application Management and also in the corresponding functional area within HP Web Jetadmin
10.0 by right-clicking within the page and selecting the specific task module.

Bf NOTE: To display the Task Module docking area, click View > Task Module docking area. This is
a toggle selection; if you select it again it closes the Task Module docking area.

Table 6-10 Web Jetadmin Management Task Modules

Web Jetadmin Management on page 275

Web Jetadmin Installations - Current Tasks and Web Jetadmin Installations - Common Tasks Task Module
on page 276

Web Jetadmin - Management Task Module on page 276

Web Jetadmin Installations - Summary Task Module on page 276
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Web Jetadmin Installations - Current Tasks and Web Jetadmin Installations - Common
Tasks Task Module

The Web Jetadmin Installations - Current Tasks task module can be displayed on the Web Jetadmin
Installations page.

When you first select Product Update from the left navigation pane, the Product Update page is
displayed. There are two areas that can be displayed or hidden (by clicking the arrows in the title bar
for each area):

e Find Web Jetadmin Installations (Find Web Jetadmin Installations on page 277).

e View Web Jetadmin Installations (Remove Packages on page 273).

The Web Jetadmin Installations - Current Tasks task module can be displayed in other areas of
HP Web Jetadmin 10.0; in the other areas it is called Web Jetadmin - Common Tasks.

Web Jetadmin - Management Task Module

The Web Jetadmin - Management task module can be displayed on the Web Jetadmin
Installations page and includes the following tasks:

e Discover (Find Web Jetadmin Installations on page 277).

e Quick Discovery: enter the IP address or hostname of the Web Jetadmin server and click OK.

° Launch (Launching HP Web Jetadmin 10.0 on page 285).

Web Jetadmin Installations - Summary Task Module

The Web Jetadmin Installations - Summary task module can be displayed on the Product Update
page and includes summary information about how many applications were found and which versions
were found.

Web Jetadmin Installations

° Find Web Jetadmin Installations

° Synchronizing HP Web Jetadmin 10.0 Installations

° Launching HP Web Jetadmin 10.0

° Steps for Discovering Web Jetadmin on the Same Network

° Steps for Removing Web Jetadmin

Sometimes it is advantageous to find other HP Web Jetadmin 10.0 application installations on the
network. HP Web Jetadmin 10.0 provides the ability to discover most revisions of HP Web Jetadmin
10.0 software and then synchronize with those other installations. HP Web Jetadmin 8.x can also be
found and launched.

Using synchronization and application discovery enables you to:

e detectothers using HP Web Jetadmin 10.0 software to attain understanding of printer management
on the network.

e detect other HP Web Jetadmin 10.0 installations as a matter of security or management policy.
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e schedule the discovery of other HP Web Jetadmin 10.0 installations.

e find all devices in a distributed environment (others might manage them in multiple areas).

Find Web Jetadmin Installations

e Web Service (WS) Discoveries

° IP Broadcast Discovery

° IP Range Discovery

HP Web Jetadmin 10.0 instances can be listed for discovery, user viewing, removing, and even
launching.

HP Web Jetadmin 10.0 instances can be found on both local and remote networks. The settings for IP
Range and IP Broadcast are identical to HP Web Jetadmin 10.0 Discovery settings. In fact, these
settings are shared between the two features.

e HP Web Jetadmin 10.0 can discover other instances of HP Web Jetadmin 10.0.

e Discovery is possible with versions as early as 6.5.x.

e |IP Range and IP Broadcast discoveries share stored setting with other discovery features.
e HP Web Jetadmin 10.0 instances can be launched directly from the discovery listing.

e The listing can be modified by performing further discoveries or by manually removing the
instances.

e Address, URL, hostname, and version information are included in the listing.
Three different discovery features exist for finding HP Web Jetadmin 10.0 instances:

e Web Service (WS) Discoveries on page 277

° IP Broadcast Discovery on page 277

° IP_Range Discovery on page 279

You can schedule application discovery. If an application discovery is currently running and you try and
start another application discovery, you will receive a dialog asking if you want to view the current
discovery or schedule a new one.

Web Service (WS) Discoveries

Web Service (WS) discoveries actually find other instances of HP Web Jetadmin 10.0 (not previous
versions of HP Web Jetadmin).

B NOTE: To discover HP Web Jetadmin 10.0 and previous versions of HP Web Jetadmin, use IP
Broadcast Discovery on page 277 or |P Range Discovery on page 279.

IP Broadcast Discovery

° IP Broadcast Discoveries for Network Devices

° IP Broadcast Discoveries for PC-Connected Devices

° Details About Running an |P Broadcast Discovery
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IP Broadcast discoveries send SNMP query packets (in the form of IP broadcasts) to one or more IP
network(s). These are used in both PC-Connected and network device discoveries.

IP Broadcast Discoveries for Network Devices

An IP Broadcast discovery enables you to find devices or HP Web Jetadmin installations when IP
broadcast addressees are known. IP broadcast discoveries send SNMP query packets (in the form of
IP broadcasts) to one or more IP network(s). One network-specific broadcast address exists for each
IP subnet on an IP intranet. IP subnets are determined by the IP network number and the IP subnet
mask. IP calculators, available free on the Internet, are a great way to determine IP broadcast addresses.
An all 1s IP broadcast can also be used to query the entire intranet. Broadcasting is typically blocked
by routers due to traffic spike concerns.

Characteristics of IP broadcast discoveries for network devices include:

e Sends SNMP queries over one or more |P broadcasts.

e Listens for replies and then qualifies network connected devices.

e Default broadcast is the Global Broadcast Address (255.255.255.255).

e Can use one or more known IP broadcast addresses with optional address descriptions.
e Limited checking is performed to determine if the broadcast address is valid.

e Fast and thorough, especially on a local segment.

° Most modern networks block broadcast traffic.

IP Broadcast Discoveries for PC-Connected Devices

IP broadcast discoveries for PC-Connected devices send an SNMP query to the IP broadcast address
specified. An all 1s broadcast is the default. Systems with the SNMP Proxy Agent first answer with the
operating system. HP Web Jetadmin 10.0 follows up with queries to both host and to printer specific
objects. IP Broadcast discovery does not attempt WMI queries when no SNMP proxy agent exists.

Characteristics of IP broadcast discoveries for PC-Connected devices include:
e  Settings are the same as network device.
e SNMP queries are attempted on discovered nodes.

e Ifno SNMP Proxy Agent response, WMI queries are performed when credentials exist in settings.

Details About Running an IP Broadcast Discovery
1. Click Edit Addresses. The Select IP broadcast addresses page is displayed.
2. Youcan:
e  Select a broadcast address.

e Add: add a broadcast. Type the address in Address and type a description (if desired) in
Description. Then click Add.

e Show favorites only: view only the broadcast addresses you have added by clicking Show
favorites only (at the bottom of the page).
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e Delete: remove addresses from the list by highlighting the address and clicking Delete.

e Customize: show or hide addresses by clicking Customize. Then select an address and
click Show or Hide. When done, click OK (Customizing IP Range Discoveries

on page 282).
3. Click Next.

IP Range Discovery

° Setting Realistic Ranges

° Import and Export Features of IP Range Files

° IP_ Range Discoveries for Network Devices

° Customizing |IP_Range Discoveries

° IP_ Range Discoveries for PC-Connected Devices

° Steps for Running an I[P Range Discovery

In contrast to running a broadcast discovery (where all devices or HP Web Jetadmin installations in the
subnet are queried), you can choose to discover a specified IP range or a number of IP ranges. This
reduces network traffic and eliminates the possibility of having unwanted devices. HP Web Jetadmin
installations show up in the database. IP Range discovery searches for devices or HP Web Jetadmin
installations within a range of IP addresses. This type of discovery is accurate and thorough but can be
slow for large ranges.

IP Range Discovery is effective when the administrator has knowledge of IP segments. Administrators
use IP Range Discovery settings to map IP segments or groups of IP segments into HP Web Jetadmin
10.0 discovery. This method efficiently sweeps selected portions of the network or WAN. IP Range
address pairs consist of beginning and ending IP addresses. IP Range discoveries first ping (send ICMP
echo requests) specific IP addresses as defined by range address pairs. If the device responds, HP Web
Jetadmin 10.0 follows with SNMP queries. Multiple ranges can be specified in IP Range discoveries.
HP Web Jetadmin 10.0 pings in bursts of 30 queries to the first set of addresses from the first range
and then waits one second before sending the next burst of 30 queries.

Setting Realistic Ranges

° Setting Ranges Based on Subnets or Contiguous Subnets

Most networks are divided up into subnets, which can be used to describe a network IP addressing
scheme and are sometimes referred to as IP maps. A subnet within a large network can be described
with a network number and a subnet mask. This is an example of one subnet with an IP range of
15.5.188.1 through 15.5.191.254:

e Network number example: 15.5.188.0
e  Subnet mask example: 255.255.252.0

There are 1,022 possible addresses on this subnet. It may take HP Web Jetadmin 10.0 only about
10 minutes to discover devices on this network depending on the network, the number of devices on
that network, and the host on which HP Web Jetadmin 10.0 is installed.

B NOTE: IP address calculators are an easy way to analyze IP networks. Many free versions of IP
calculators exist and can be obtained on the Internet.
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IP Range discovery can perform to expectations when the range data has been correctly developed. It
is easy to configure ranges that are larger than needed and actually cause the discovery to take a long
time and perhaps even yield little in the way of devices. For example, a class A range could easily be

developed for the HP intranet but would literally take weeks to complete. On most large networks, the
maijority of the IP addresses won’t answer the HP Web Jetadmin 10.0 query and will cause timeouts to
occur; these translate into very long discovery times.

If you specify an IP range that is very large, your network might crash if that IP range is for a class A or
class B network (when the first two octets of the IP range are not the same). HP Web Jetadmin 10.0 will
display a warning message stating that a large range might cause a large amount of network traffic; you
can choose to continue or change the range.

You can choose to specify a large subnet range using the larger subnet address feature (Tools >
Options > Application Management > IP Ranges > General). Large networks are considered any
network bigger than a Class B network, which has up to 65,000 nodes.

Setting Ranges Based on Subnets or Contiguous Subnets

Since large IP ranges can cause HP Web Jetadmin 10.0 discovery to take long periods of time to
complete, it can be useful to use subnet ranges rather than the entire network for a discovery. These
subnets, when put together into one list, represent an IP map. This type of a map can be obtained from
an IT or Network Infrastructure team. It is also a good idea to work with these teams to discuss plans
for implementing HP Web Jetadmin 10.0 discoveries.

B NOTE: Hewlett-Packard strongly recommends that you discuss HP Web Jetadmin 10.0 discoveries
with your information technology or network administration team.

Here is an example of IP range planning. Assume we have 20 subnets on our hypothetical network. All
of these subnets use the same subnet mask of 255.255.255.0. Here are the network numbers that
represent our 20 subnets:

15.0.1.0, 15.0.2.0, 15.0.3.0, 15.0.4.0, 15.0.5.0, 15.0.30.0, 15.0.31.0, 15.0.32.0, 15.0.33.0, 15.0.34.0,
15.0.35.0, 15.0.36.0, 15.0.37.0, 15.0.38.0, 15.0.39.0, 15.0.55.0, 15.0.64.0, 15.0.65.0, 15.0.66.0,
15.0.67.0, 15.0.68.0, 15.0.69.0, 15.0.70.0, 15.0.71.0, 15.0.72.0, 15.0.73.0, 15.0.74.0

From this information, we can formulate the following IP address ranges and import them into HP Web
Jetadmin 10.0:

e 15.0.1.1-15.0.1.254
e 15.0.2.1-15.0.2.254
e 15.0.3.1-15.0.3.254
e 15.0.4.1-15.0.4.254
e 15.0.5.1-15.0.5.254
e 15.0.30.1-15.0.30.254
e 15.0.31.1-15.0.31.254
e 15.0.32.1-15.0.32.254
e 15.0.33.1-15.0.33.254
e 15.0.34.1-15.0.34.254
e 15.0.35.1-15.0.35.254
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e 15.0.36.1-15.0.36.254
e 15.0.37.1-15.0.37.254
e 15.0.38.1-15.0.38.254
e 15.0.39.1-15.0.39.254

We can take the formulation one step further and simplify things. Some of the IP ranges are contiguous.
These contiguously-addressed subnets are one after the other, in order, making it easy to combine
them. The final result would look like this:

e 15.0.1.1-15.0.5.254
e 15.0.30.1-15.0.39.254

This has reduced the number of IP ranges from 15 to 2. We can build this into a form that is easily
imported into HP Web Jetadmin 10.0 and also reflects descriptions. Here is an example of data that can
be imported via a text file:

e 15.0.1.1-15.0.5.254 = subnet range for western area

e 15.0.30.1-15.0.39.254 = subnet range for central area
e 15.0.55.1-15.0.55.254 = subnet range for branch office
e 15.0.64.1-15.0. 74.254 = subnet range for eastern area

Consolidating ranges makes dealing with large quantities of data simpler but may not help when
descriptions are needed for the purpose of cataloging ranges.

Import and Export Features of IP Range Files

IP range data can be developed in other tools and imported through text files. In fact, HP Web Jetadmin
10.0 can export IP range data to text files. This makes it easier to deal with large numbers of IP ranges,
manipulate complex data and archive data for use in multiple instances. Tile format for IP Range import
and export file format can be broken down as follows:

e 1range perline
e Each IP address is separated by a hyphen character (-)
e Comment or description strings can be appended to the IP range by using an equal character (=)

Here is an example of 1 IP range with a comment: XXX.XXX.XXX.XXX-XXX.XXX.XXX.Xxx=descriptive text
string (where xxx represents an octet in the IP address).

There is no known limit to the number of IP ranges manageable within HP Web Jetadmin software. IP
ranges are also used by other features like PC-Connected printer discovery and HP Web Jetadmin
Installations discovery. All IP ranges entered into HP Web Jetadmin can also be managed globally from
within Tools > Options > Application Management > IP Ranges > IP Ranges.

IP Range Discoveries for Network Devices

IP Range discoveries for network devices or HP Web Jetadmin installations first send an SNMP query
to all addresses within the range. When nodes are discovered, HP Web Jetadmin 10.0 performs queries
to determine qualified devices. These qualified devices, when found, are added to the device lists.
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Characteristics of IP range discoveries for network devices or HP Web Jetadmin installations include:

IP ranges are simply two addresses that represent range begin and end points.

Multiple ranges can be specified in an IP Range discovery.

IP range data can be manually added through the user interface.

IP ranges can be imported to HP Web Jetadmin 10.0 from text files.

Multiple IP ranges can be added and with optional, descriptive tags.

HP Web Jetadmin 10.0 sends 1 query to each address represented by the range.

HP Web Jetadmin 10.0 pings the device ranges in bursts of 30.

HP Web Jetadmin 10.0 has features to calculate IP ranges based on:

° Local client host

° WUJA server host

o Device

HP Web Jetadmin 10.0 IP Range discoveries have proven to be effective, accurate and thorough.
HP Web Jetadmin 10.0 IP Range discoveries can be very slow if not configured properly.

HP Web Jetadmin 10.0 IP Range discoveries can draw security attention due to their scanning
action.

Customizing IP Range Discoveries

When you are setting up an IP Range discovery, you have the option to customize the IP Ranges. You
can customize IP Ranges in two places within HP Web Jetadmin 10.0. In Device Management >
Discovery, select IP Ranges as the type of discovery and then select Customize. In Application
Management > Web Jetadmin Management, in the Common Tasks task module click Find Web
Jetadmin installations and select IP ranges as the type of discovery; then select Customize. You can
choose to add or remove addresses to favorites by selecting an address and clicking Add Favorite
or Remove Favorite.

IP Range Discoveries for PC-Connected Devices

IP Range discoveries for PC-Connected devices first send an SNMP query to all addresses within the
range. If SNMP communication is possible on a device, the discovery attempts to find a locally connected
printer. If no SNMP communication is possible and if the user provided administrative credentials, the
discovery will attempt to find a locally connected printer on the device.

Characteristics of IP range discoveries for PC-Connected devices include:

IP Range scanning is same as network connected.
Nodes representing hosts are detected.
SNMP queries are attempted on discovered nodes.

If no SNMP Proxy Agent response, WMI queries are performed when credentials exist in settings.
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Steps for Running an IP Range Discovery
The Select IP Ranges page is displayed when you choose IP Range as the discovery method while:

e creating discovery templates (Create a Discovery Template on page 126).

e editing discovery templates (Edit a Discovery Template on page 128).

e scheduling a discovery (Schedule a Discovery on page 123).

e running a Web Jetadmin discovery (Find Web Jetadmin Installations on page 277).

On the Select IP Ranges page, you can select the IP address ranges displayed or you can edit the
ranges.

1. Choose the action to take:
e Select an IP range.

e Add: add an IP range by clicking Add. Type the range in First address and Last address;
then type a description (if desired) in Description. Click Add.

To calculate a range, click Calculate range. The Calculate IP Range page is displayed:

° Subnet from my computer: automatically use IP address ranges currently found on the
local subnet of your computer. You can add a description in Description if desired.

o Subnet from WJA server: automatically use IP address ranges currently found on the
subnet of the HP Web Jetadmin 10.0 server. You can add a description in Description
if desired.

o Subnet from network address: type a known IP address and subnet mask. You can
add a description in Description if desired.

e Edit: make changes to IP ranges by clicking Edit. Follow the steps in the bullet above for
“Add”.

e Delete: remove addresses from the list by highlighting the address and clicking Delete.

e Import Range List: if desired, import a range list by clicking Import Range List and then
browse for the range list.

e Export Range List: if desired, export a range list by clicking Export Range List and then
browse for location you want to store the range list.

e Show favorites only: view only the IP ranges you have added by clicking (at the bottom of
the page).

e Customize: show or hide addresses by clicking Customize. Then select an address and
click Show or Hide. When done, click OK.

2. Click OK.

Synchronizing HP Web Jetadmin 10.0 Installations

Once discovered, other HP Web Jetadmin 10.0 device details can be synchronized into the device
details of the HP Web Jetadmin 10.0 that performed the discovery. The devices themselves and user-
selected attributes will be added to the local All Devices list.
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The control for this synchronization feature can be found in Tools > Data Synchronization. From the
Data Synchronization interface you can quick-discover other HP Web Jetadmin 10.0 instances,
synchronize the local All Devices list (requires credentials), schedule synchronization and manage
existing synchronization schedules.

Bf NOTE: The term “synchronize” is used to show that device details from the remote HP Web Jetadmin
10.0 instance are populated into the device space within the local HP Web Jetadmin 10.0 database.
This is not a two-way synchronization; the local HP Web Jetadmin 10.0 Data Synchronization controls
facilitate a one-way data transfer (Data Synchronization on page 35).

Characteristics of this data synchronization between versions of HP Web Jetadmin 10.0 are:

e HP Web Jetadmin 10.0 Quick Discovery can have an IP address or IP Hosthame applied to it for
the purpose of locating other instances of HP Web Jetadmin 10.0 software.

e  Once discovery has occurred, instant synchronization can be performed with HP Web Jetadmin
10.0 instances.

e Synchronization requires domain user credentials that have been associated with a role on the
remote HP Web Jetadmin 10.0 instance or have administrative rights on the remote system hosting
HP Web Jetadmin 10.0.

e Users can select a variety of device details as part of the synchronization.
e A base set of details will always be transferred as part of the synchronization, these include:
o Serial number
° Port
° Model Number
o Last Discovered
o Last Communication
o HP Jetdirect Model
° IP Hostname
o IP Address
° Discovery Date/time
A local user must be in:

e the user group on the HP Web Jetadmin 10.0 host and also be associated to a data synchronization
role on that host.

e the user group on the HP Web Jetadmin 10.0 remote Smart Client.

e the admin group on the data synchronization host.
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Launching HP Web Jetadmin 10.0

To launch other instances of HP Web Jetadmin 10.0, follow these steps:

1.

From the left navigation pane, access Application Management.

Expand Web Jetadmin Management and click on Web Jetadmin Installations. The Web
Jetadmin Installations page is displayed.

To launch a specific instance of HP Web Jetadmin 10.0 in an external browser window, highlight
the instance of HP Web Jetadmin 10.0 in the Installations page and then click Launch.

If the version of HP Web Jetadmin is 8.x, then the user interface will be displayed in the browser.

If you are using HP Web Jetadmin 10.0, then the Smart Client page is displayed; you can run
another instance of the client application (Smart Client Deployment on page 16).

Steps for Discovering Web Jetadmin on the Same Network

To discover other instances of HP Web Jetadmin 10.0 running on the same network, follow these steps:

1.

From the left navigation pane, access Application Management.

Expand Web Jetadmin Management and click on Web Jetadmin Installations. The Web
Jetadmin Installations page is displayed.

To discover other instances of HP Web Jetadmin 10.0, click Discover. The Web Jetadmin
Discovery page is displayed.

Check one or more types of discovery to run: WS Discovery, IP Broadcast, and IP Range.

Click Next. The settings page is displayed for the type of discovery; if you selected more than one
the different pages will be displayed in order.

Complete the settings page:

e WS discovery settings (Web Services Discovery): select the number of routers or hops.
e |IP broadcast settings: highlight the addresses.

o [P range settings: select the IP ranges.

After you make your selections, click Next. A confirmation page is displayed.

Review your selections and click Start. A Progress page is displayed, which you can Hide. After
the discovery has been run, you can review the results and then click Done.

Steps for Removing Web Jetadmin

ENWW

To remove one or more instances of HP Web Jetadmin 10.0 running on the same network, follow these
steps:

1.

From the left navigation pane, access Application Management, expand Web Jetadmin
Management and click on Web Jetadmin Installations. The Web Jetadmin Installations page
is displayed.

To remove one or more instances of HP Web Jetadmin 10.0, click Remove. To delete all instances
of HP Web Jetadmin 10.0, click Remove All. The Confirm page is displayed.
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3.

4,

If you need to make changes to your selections, click Back. If your selections are correct, click
Next.

The Progress page is displayed. Click Done.

Data Synchronization

Steps for Data Synchronization

You can synchronize data between HP Web Jetadmin 10.0 servers on your network.

You can either enter the hostname or IP address of the HP Web Jetadmin 10.0 server you want to
synchronize with, or you can discover all HP Web Jetadmin 10.0 devices on your network (in
Application Management under Web Jetadmin Management on page 275).

A local user must be in:

the user group on the HP Web Jetadmin 10.0 host and also be associated to a data synchronization
role on that host.

the user group on the HP Web Jetadmin 10.0 remote Smart Client.

the admin group on the data synchronization host.

Steps for Data Synchronization

1.
2,

On the top menu bar, access Tools > Data Synchronization.
Select the HP Web Jetadmin 10.0 server you want to synchronize with:

e If you know the hostname or IP address for the HP Web Jetadmin 10.0 server you want to
synchronize with, enter it in WJA Quick Discovery.

e Ifyou do not know the hostname or IP address for the HP Web Jetadmin 10.0 server you want
to synchronize with, highlight the server or servers in the list.

You can:
e Synchronize: synchronize the HP Web Jetadmin 10.0 servers now. Click Synchronize.

e Schedule: set up a future time to synchronize the HP Web Jetadmin 10.0 servers. Click
Schedule.

B NOTE: If you schedule a task (for example, a discovery or a configuration or others) using
a corresponding template, the task uses the settings defined in the template at the time the
task starts. This makes it easy to redefine settings used in a regularly scheduled task without
having to delete and create a scheduled task.

e Clear Schedule: clear any synchronization schedules that have been set up already. Click
Clear Schedule.

The Synchronization Credentials page is displayed. Enter your password and click Verify
Link to verify the authentication. The link must be verified before you can proceed.

To save these settings and continue setting other options, click Apply. Then click the next option
to configure in the left menu bar. To save these settings and close this window, click OK.
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7 Device Configuration Options

e Configuration Options
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Configuration Options

Device Configuration Options for Device

Device Configuration Options for Copier

Device Configuration Options for Network

Device Configuration Options for Security

Device Configuration Options for Projector

Device Configuration Options for Wireless

Device Configuration Options for Fax

Device Configuration Options for Embedded Web Server

Device Configuration Options for File System

Device Configuration Options for Digital Sending

Following are the various configuration options for devices. Your device might or might not support all
of the options.

Device Configuration Options for Device

Asset Number

Auto Cleaning Page

Auto Continue

Auto Tray Select

Color/Black Mix

Color Supply Out

Company Name

Control Panel Display

Control Panel Language

Date and Time

Default Input Paper Tray

Default Media Size

Default Media Type

Default Print Density

Default Printer Copies

Device Location

Device Name
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Device Volumes

Duplex Bindin

Duplex Blank Pages

Economode

High Capacity Output Mode

Input Auto Continue

Input Auto Continue Timeout

1/O Timeout to End Print Jobs

Jam Recovery
Job Hold Timeout

Job Retention

Job Storage Limit

Media Administration

Optimum Speed/Cost

Original Orientation

Output Auto Continue Configuration

Power Save Timeout

Print Courier Font Type

Printer Wakeup

Replace Supplies

Resolution

Resolution Enhancement

Size/Type Prompt

Status Page Language

Supplies Status Message on Control Panel

Suppress Blank Pages

System Contact

System Location

Time Zone

Toner Low Action

Toner Out Action
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e Tray 1 Mode
° Tray Setup Media Type

° Tray Administration

° Tray Assign Media Size

e Tray Setup Media Size

° User Defined Mode

Configuration options for Devices define general administrative functions for the device including Power
Save, Tray Administration, and print defaults.

Asset Number

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

The Asset Number identifies the device based on the accounting system for your organization. You
can use the Asset Number to search for and display a list of all of the devices that have specific text
in their asset numbers (for example, MKTG).

HP Web Jetadmin 10.0 displays the Asset Number on the device lists if you configured this option to
be listed (Device Identification on page 34 and Columns for Device Lists on page 68). You can also
choose to have this column display in any custom view (Customizing Layouts for Device Lists

on page 70).

B NOTE: This configuration option will behave differently for single-device configuration than for
multiple-device configuration. When capturing device settings into a configuration template via the Save
As Template feature, this option will fail when the template is used to configure multiple devices. For
more information, see Captured Configurable Options and Configuration Templates on page 142.

Following are steps to configure this option:
1. Type or change the device asset number in the Asset Number text box.
2. Choose from the following:

o Refresh: gets the current settings from a single device, or the unspecified settings for multiple
devices. Any pending changes which have not been applied will be lost.

e Save as Template: used to capture the selected configuration into an HP Web Jetadmin 10.0
configuration template. This can be done for a variety of reasons:

o A backup of the device configuration is needed to manage maintenance and risk.

° A device configuration is deemed as “release accepted” and a template is needed to
configure other devices with like-settings.

e Schedule: schedule this configuration for later (Schedule a Device Configuration
on page 139).

e Apply: apply all of the settings to the device or devices now.
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Auto Cleaning Page

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option enables and disables the automatic cleaning page. You can specify how often you want to
print the automatic cleaning page. If the printer is in the middle of a print job when it reaches the page
count that you specify, the printer finishes printing that print job before it starts the cleaning process.
The cleaning process takes approximately 2.5 minutes to complete. You can either discard or recycle
the cleaning page after it is printed.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To enable Auto Cleaning Page, select Auto cleaning page enabled.
2. Select the cleaning frequency.

3. Select the page size (Letter or A4). You must use plain paper.

B NOTE: To ensure that the cleaning process runs automatically and without intervention, make
sure that the paper size you specify is always available in the printer.

Auto Continue

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Choose to have a non-critical error message appear for ten seconds before the device resumes
operation. Select Off for Auto Continue to require you to acknowledge non-critical error messages by
pressing Continue on the device before the device resumes operation.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To enable Auto Continue, select On.

2. Todisable Auto Continue, select Off. You will have to acknowledge non-critical error messages
by pressing Continue on the device before the device resumes operation.

Auto Tray Select

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
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the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you use the capacity of both paper trays before generating an out-of-paper alert.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Select Tray Select On or Tray Select Off.
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Color/Black Mix

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option optimizes the performance or cost per page depending on the expected color content of
typical print jobs. This feature allows you to set printer behavior for printing mostly color or mostly black
(monochrome) print jobs.

B NOTE: Selecting the Print In Grayscale feature from the printer driver overrides these settings for a
specific print job.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. Auto: (default) best choice for most conditions; it behaves the same as Mostly Color Pages.

2. Mostly Color Pages: provides the best performance for most conditions, especially when mostly
color pages are printed. Under normal usage, there is minimal or no cost per page impact from this
selection.

3. Mostly Black Pages: provides the best cost per page for users printing mostly monochrome pages
on color printers.

Color Supply Out

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify how the printer responds when one of the color toners is empty. You can
choose to set the printer to continue printing with black toner (for a certain number of pages) or set it to
stop printing altogether. In both cases, HP Web Jetadmin 10.0 displays a Toner Out message on the
device lists.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To stop the printer from printing until the toner is replaced, select Stop.

2. To let the printer continue printing with black toner, when one or more of the color toners is out,
select Auto Continue Black.

Company Name

149,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

The company contact is the name of the organization that owns or is responsible for the device. HP Web
Jetadmin 10.0 displays the company contact on the Status page for the device and on several of the
device lists. You can also search for and display a list of all of the devices for which a specific organization
is responsible.
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Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Control Panel Display

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you make specific items appear on the Control Panel Display on the device. The items
include IP Address, Hosthame, Serial Number, Asset Number, Device Name, System Location, System
Contact, Device Location and a short text string that you can define.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites. One option can be selected.

Select the desired option. If you select Other, enter the message to display on the control panel.

Control Panel Language

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the language that is displayed on the printer control panel. The drop-down
list contains all of the languages that the printer supports. If you have a multilingual workforce, set the
control panel language to the one language that your employees prefer.

NOTE: This configuration option will behave differently for single-device configuration than for
multiple-device configuration. When capturing device settings into a configuration template via the Save
As Template feature, this option will fail when the template is used to configure multiple devices. For
more information, see Captured Configurable Options and Configuration Templates on page 142.

Choose the desired language from the drop-down list.

Date and Time

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option allows you to remotely specify the time and date for a device or group of devices. When the
correct time and date is set on a device, the device can complete time or date dependant operations
and add time and date stamps on documents, such as a diagnostic report.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To specify the time and date on a device, type the current year, month, and day in the corresponding
fields. Use the 24-hour system. For example, 1 PM is 13:00 hours.

Default Input Paper Tray

ENWW

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).
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This option lets you specify which tray the device should first get paper from as a default (upper paper
tray or lower paper tray).

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Select the paper tray you want to use for a default.

Default Media Size

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the default media size. The drop-down list contains all of the media sizes
that the printer supports. This option is useful if the people who use the printer typically print on a specific
size of media. For example, if the printer is dedicated to the legal department and those users typically
print on Legal paper, set the default media size to Legal.

The media size setting that you might select when printing a job overrides the setting specified here.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To specify the default media size, select the media size from the drop-down list labeled Default Media
Size.

Default Media Type

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option specifies the default media type. The drop-down list contains all of the media types that the
printer supports. This option is useful if the people who use the printer typically print on specific media.
For example, if the printer is dedicated to the human resources department and they typically print on
three-hole punched paper, set the default media type to Prepunched.

B NOTE: For this option to work, you must specify the media type for each tray under the Tray
Administration category on the Device Configuration page.

The media type setting that a user selects when printing a job overrides the setting specified here.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

B NOTE: This configuration option will behave differently for single-device configuration than for
multiple-device configuration. When capturing device settings into a configuration template via the Save
As Template feature, this option will fail when the template is used to configure multiple devices. For
more information, see Captured Configurable Options and Configuration Templates on page 142.

To specify the default media type, select the media type from the drop-down list.

Default Print Density

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).
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This option lets you select the default density for print jobs, which affects all pages printed on the device
(host print jobs, received faxes, copies, and internal reports).

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To select this option, select a density from the drop-down box (5 is the darkest, or highest density). For
color, select the desired print density for each color. If applicable, you can also select the print density
for highlights, midtones, and shadows.

Default Printer Copies

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the default number of copies that are printed for each print job. This option
is useful if the people who use the printer typically print a specific number of copies. For example, if the
printer is dedicated to the legal department and those users always print three copies of their documents,
set the default number of copies to three.

NOTE: The copies setting that you select when printing a job overrides the setting specified here.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To specify the default number of printer copies, type the number of copies into Default Printer
Copies.

Device Location

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option identifies the device based on its location. You can use the Device Location to search for
and display a list of all of the devices that have specific text in their device locations (for example, North
Building, 3rd Floor).

HP Web Jetadmin 10.0 displays the Device Location on the device lists if you configured this option
to be listed (Device Identification on page 34 and Columns for Device Lists on page 68). You can also
choose to have this column display in any custom view (Customizing Layouts for Device Lists

on page 70).

Type or change the device location in Device Location.

Device Name

B
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NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option identifies the device based on its name. You can use the Device Name to search for and
display a list of all of the devices that have specific text in their device names (for example,
Color LaserJet Marketing).
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HP Web Jetadmin 10.0 displays the Device Name on the device lists if you configured this option to be
listed (Device Identification on page 34 and Columns for Device Lists on page 68). You can also choose
to have this column display in any custom view (Customizing Layouts for Device Lists on page 70).

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To set the device name, type or change the device name in Device Name.

Device Volumes

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This group of options selects the volumes of certain sounds emitted by the device:

B NOTE: Some of the volume options may not be displayed depending on available features of the
device being configured.

e Line monitor: allows you to set the volume level used during the fax machine to fax machine
negotiation for each sent and received fax.

e Alarm: allows you to set the volume level used by the device for the beep to indicate an error
condition.

e Ring: allows you to set the volume level used to indicate an incoming call on the connected phone
line.

e Key press: allows you to set the volume level used when control panel keys are pressed.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To select the volume options, select Off, Soft, Medium, or Loud.

Duplex Binding

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option allows you to specify default action about whether to print on both sides of paper when the
print job does not specify a preference. Ability to specify the default duplex behavior of the printer can
be useful for implementing policy by system administrators where the print job is not particular about
this aspect of the job.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To select the default duplex action of the printer, select one of the options from the drop-down box:
None, Long Edge (recommended for portrait print jobs), or Short Edge (recommended for landscape
print jobs).
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Duplex Blank Pages

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you optimize the duplex printing performance.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Select Auto to enable enhanced print speed in some circumstances by often not taking the time to print
blank sides. For paper types that need to print the blank side (like letterhead), Auto is smart enough to
do so.

Select Yes to always print blank sides in duplex jobs. The image will always be on the correct side.

Economode

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option allows you to select the Economode (toner saving) default for jobs that do not specify an
Economode value. This allows the printer to behave in a consistent manner for print jobs which do not
specify the Economode setting.

To specify the default Economode value, select the radio button for the desired Economode (On or
Off).

High Capacity Output Mode

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify which high-capacity output accessory the printer directs output to. Directing
output to various high-capacity output accessories can help reduce how much time you spend going to
the printer and removing output from full bins. This is particularly useful for very large print jobs or busy
printers.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To set the high-capacity output mode, select one of the output accessory options.

Input Auto Continue

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
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the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the default action that the printer takes when the specified media size or
type is not available. It also lets you specify how long the printer waits before performing the default
action. Specifying a default action for the printer to take when the specified media size or type is not
available allows the printer to finish printing the current job without user intervention.
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Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To specify the action for the printer if the specified media size or type is not available, select the desired
action from the Input Auto Continue drop-down list.

Input Auto Continue Timeout

199,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify how long the printer waits before performing the default action when the
specified media size or type is not available. Specifying how long the printer should wait before taking
the default action when the specified media size or type is not available allows you time to manually
correct the issue.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To specify the action for the printer if the specified media size or type is not available, select how long
the printer waits from the drop-down box.

I/0 Timeout to End Print Jobs

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you select the amount of time the device should wait between packets of data on a print
job before canceling that job. You can select any time between 15 seconds and 5 minutes.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select how long the printer waits from the drop-down list.

Jam Recovery

Ef NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option allows you to select the default device reprint behavior after a paper jam is cleared on a fax
receive, copy, or print job. The settings include:

e Disabled: the device will never reprint a page after clearing a paper jam.
e Enabled: the device will always reprint a page after clearing a paper jam.

e Auto: the device will reprint a page after clearing a paper jam, if the installed memory is greater
than 7 MB.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To select the jam recovery behavior, select the desired setting (Disabled, Enabled, or Auto).
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Job Hold Timeout

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify how long the printer holds a print job that has not printed before automatically
deleting the print job.

CAUTION: Selecting Never Delete could cause the printer’s hard disk to fill up with print jobs that
were held but never released for printing.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Select the timeout value from the Job Hold Timeout drop-down list.

Job Retention

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you enable and disable the job retention feature. The job retention feature is available
on some printers that have mass storage capability. This allows you to store print jobs in the flash
memory on a printer. The job retention feature allows you to complete the following tasks:

e  Store a print job on the printer. You can then call the print job from the printer control panel as
needed. This feature is useful for storing forms and other commonly shared documents.

e  Store secure private copies to hold a print job until a user releases it by entering a personal
identification number. Print one copy of a multiple-copy print job for proofing. The user can then
release the remaining copies for printing or cancel them.

CAUTION: Ifthe job retention feature is disabled, the option appears on the printer driver user interface
but does not store the print job on the printer.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To enable the job retention feature, click Enable.

2. Todisable the job retention feature, click Disable. If the job retention feature is disabled, the option
appears on the printer driver user interface but does not store the print job on the printer.

Job Storage Limit

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
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the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify how many jobs can be stored on the printer hard disk at the same time.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.
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Media Administration

149,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option allows you to enable or disable the media types that the printer uses. You can also define
your own media types.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To enable a media type, select the check box next to the media type.
2. To disable a media type, clear the check box next to the media type.

3. To define a new media type, type the media name in Media Types. Select the check box next to
the media type to activate it.

Optimum Speed/Cost

149,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option optimizes the performance or cost per page depending on the expected color content of
typical print jobs. You can choose whether print quality is more important or whether speed of the print
job is more important.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To specify the optimum speed or cost per page, select one of the options (Auto, Speed, or Cost Per
Page).

Original Orientation

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the default orientation of the information on the printed page. This is useful
if the people who use the printer typically print with a specific orientation. For example, if the printer is
dedicated to the accounting department and those users typically print spreadsheets with many

columns, set the default orientation to Landscape to show as many columns as possible on one page.

B NOTE: The orientation setting that you select when printing a job overrides the setting specified here.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To print across the narrow side of the media, select Portrait.

2. To print across the wide side of the media, select Landscape.
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Output Auto Continue Configuration

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option allows you to control the behavior of the device if a print job is submitted which lets you
specify a paper tray and/or paper size which does not match the current device configuration. This allows
the printer to behave in a consistent manner in case of a conflict between the print job specification and
the printer configuration.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

Bf NOTE: The options available are dependent upon the device.

1. Output overflow command: specifies the default action to take when the output bin is full or when
the stapler is empty.

2. Output auto continue timeout: specifies how long before the device should wait before taking
the action specified in the output overflow command.

3. Output overflow bin: specifies what bin should be used if the primary bin is full.

Power Save Timeout

B

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify how long the printer can be idle before automatically powering off. Sleep
Delay mode reduces the printer average power consumption after it has been idle for a specific length
of time. This is useful if the printer is not used often.

NOTE: If the printer has an MFP (scanner unit) installed, such as the HP Color LaserJet 8500 or the
HP Color LaserJet 8550, the Power Save Timeout setting specified on the printer control panel
overrides the setting specified on this page.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To set the Sleep Delay, select the timeout value from the drop-down list.

Print Courier Font Type

ENWW

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option allows you to choose whether the regular courier font or a dark font is used. This setting
does not affect fax or copy jobs, but does apply to the internal reports which contain a Courier font. The
regular TrueType Courier font prints somewhat lighter than the bitmap fonts for the same.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.
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To specify the courier font type, select Regular or Dark.

Printer Wakeup

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the time of day that you want the printer to automatically start warming up.
This option is useful if you always print a job at a specific time of day and you do not want to wait for the
printer to warm up. For example, if you always print a job at 9:00 AM, use this option to have the printer
start warming up at 8:30 AM.

Ef NOTE: Make sure that you coordinate the time that you want the printer to start warming up with
the Power Save Timeout option (Power Save Timeout on page 301.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To set the automatic warm-up time, select Wake up printer.

Replace Supplies

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the behavior of the device when a supply reaches low or out. Configure the
device to stop when a supply reaches low or out. The option to Override at Out can only be chosen
through the device’s control panel. HP Web Jetadmin 10.0 will only show this option if it is the current
setting.

Ef NOTE: When device is set to Override at Out, the device will continue to print when the supply
reaches out.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To stop the device when a supply reaches low, select Stop at Low.

2. To stop the device when a supply is out, select Stop at Out.

Resolution

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you select the default resolution for print jobs that do not specify a resolution. This allows
the printer to behave in a consistent manner for print jobs which do not specify a resolution.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select the desired default resolution.
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Resolution Enhancement

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

REt (Resolution Enhancement Technology) is a process that you can turn on and off. Turning on REt
will sharpen the resolution but slow down printing. If the resolution selected is 1200 dpi, then REt will
not be used regardless of this setting. This setting is not in effect when the resolution used is 1200 dpi.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Select whether to turn REt on or off.

Size/Type Prompt

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify what the control panel displays when a paper tray is opened and closed.
Configure it to display or not display the message To change size or type press check on the control
panel. In either case, HP Web Jetadmin 10.0 displays a Tray empty message on the device’s Status
page.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. Toturn on the display message, select Display.

2. To turn off the display message, select Do Not Display.

Status Page Language

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the device personality (PCL, PostScript, Text, or HP-GL2) that the

HP Jetdirect print server uses when it sends a status page to the device. You might need to change the
status page language to accommodate a particular printing device. For example, a PostScript printer
might not be able to understand the default PCL print page that an HP Jetdirect print server sends.

Bf NOTE: This option only affects the test page output language, not the spooled print job language.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To set the status page language, select one of the status page language options.

Supplies Status Message on Control Panel

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).
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This option lets you control whether or not supplies-related status messages will be displayed on the
control panel.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To display status messages on the device’s control panel, select Show. To suppress status messages,
select Do Not Show.

Suppress Blank Pages

System
By

System

L)

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify how the printer responds when a job with blank pages is printed. Allowing
the printer to suppress printing blank pages can save you time, toner, and paper.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To allow printing blank pages in a print job, select No.

2. To suppress printing blank pages in a print job, select Yes.

Contact

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

The system contact is the name of the person who owns or is responsible for the device. HP Web
Jetadmin 10.0 displays the system contact on the device Status page and on several of the device lists.
The system contact is useful when you need to dispatch repair personnel, have questions about device
settings or usage, or need to report a problem with a device. You can also search for and display a list
of all of the devices that a particular person is responsible for.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To assign or change the system contact, type the name of the person to contact in System Contact.

Location

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option identifies the system based on its location.

Type or change the device location in System Location.
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Time Zone

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This options lets you specify what time zone the device is in based on hours ahead or behind Greenwich
Mean Time.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Select the number of hours ahead of or behind Greenwich Mean Time for the device.

Toner Low Action

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify how the printer responds when a toner-low condition exists. Set the printer
to continue normal operations or set it to stop printing. In either case, HP Web Jetadmin 10.0 displays
a Toner Low message on the Device Status page. Allowing the printer to continue printing when the
toner is low lets the current print job finish printing and gives the user who is responsible for the printer
time to change the toner cartridge. However, this might result in poor print quality.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To let the printer continue printing when the toner is low, select Continue.

2. To stop the printer from printing until the toner is replaced, select Stop.

Toner Out Action

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
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the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify how the printer responds when a toner-out condition exists. Set the printer
to continue normal operations or set it to stop printing. In either case, HP Web Jetadmin 10.0 displays
a Toner Out message on the Device Status page. Allowing the printer to continue printing when the
toner is out lets the current print job finish printing and gives the user who is responsible for the printer
time to change the toner cartridge. However, this might result in poor print quality.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To let the printer continue printing when the toner is out, select Continue.

2. To stop the printer from printing until the toner is replaced, select Stop.
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Tray 1 Mode

149,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify:
e Cassette: let the device prioritize by paper size first.

e First: means that the device will always try to use paper from that tray regardless of the media type
or size specified.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Select the desired option: Cassette or First.

Tray Setup Media Type

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you select the default paper type to be selected for each tray. The device is capable of
using various fuser temperatures for the printing process that are suitable for different types of paper.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, choose the desired paper type for each tray from the drop-down list box for
that tray. The available options are:

e Lightweight (Less than 60 g/m?), for Transparencies and Thin Paper.
e  Midweight (60 - 128 g/m?), for Plain Paper, Plain Envelope, and Postcard.
e Heavyweight (128 - 225 g/m?), for Bond Paper, Labels, Rough Paper, and Cardstock.

e ExtraHeavy (more than 225 g/m?).

Tray Administration

149,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you assign media sizes and types to input trays.

Bf NOTE: The drop-down list of media types contains all of the media types that are enabled on the
Media Administration page.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

NOTE: This configuration option will behave differently for single-device configuration than for
multiple-device configuration. When capturing device settings into a configuration template via the Save
As Template feature, this option will fail when the template is used to configure multiple devices. For
more information, see Captured Configurable Options and Configuration Templates on page 142.
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Following are steps to configure this option:
1. To set the media size and type, select the media size from the Size drop-down list next to the tray.

2. Select the media type from the Type drop-down list next to the tray.

Tray Assign Media Size

This option lets you assign media sizes and types to input trays. You can also see how much media is
in each tray.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

1. To set the media size for Tray 1, select the desired option from the drop-down list. Select Lock to
prevent this option for Tray 1 from being changed.

2. To set the media size for Tray 2, select the desired option from the drop-down list. Select Lock to
prevent this option for Tray 2 from being changed.

Tray Setup Media Size

The device is capable of using various fuser temperatures for the printing process that are suitable for
different types of paper. This option lets you choose the right fuser temperature for the paper to be used.
The available options are:

e Lightweight (Less than 68 g/m?) (Transparencies and Thin Paper)
e  Midweight (68 - 90 g/m?) (Plain Paper, Plain Envelope and Postcard)
e Heavyweight (Greater than 90 g/m?) (Bond Paper, Labels, Rough Paper, and Cardstock)

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select the desired paper type for each tray from the drop-down list box for that
tray.

User Defined Mode

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option is actually the User Configuration Settings which are created in the Options window and
then are displayed in the User Settings category after they are defined.

Device Configuration Options for Copier

ENWW

e Color Copy Option

e Copier Reduce/Enlarge

° Copy Job Auto Interrupt

e Copy Job Scan Ahead
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e  Copy Output Bin

° Default Copier Copies

e Default Copy Collation

e Default Copy Output Media Size

° Default Edge-to-Edge Setting

° Default Image Quality

e Default Number of Copies

° Default Number of Sides

° Default Original Content

° Default Original Density

e Hold Off Print Jobs During Copy

e Hold Off Time

° Interrupt Copy Jobs

e Reset Copy Send Timeout

e Reset Copy Timeout

Configuration options for Copiers define functions for the copiers including default copy settings.

Color Copy Option

199,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

The Color Copy Option provides an effective way to limit color copying which can serve as a cost
control option for you. To provide an option to disable color copies and limit the color copy costs.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To allow color copies, select Enable.

2. To disable color copies, select Disable.

Copier Reduce/Enlarge

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option enables you to specify reduction/enlargement for copies. The number is represented as a
percentage of the original. A value of 100 will make copies with no reduction or enlargement; higher
values will make enlargements, while lower values cause a reduction. It is often useful to be able to

308 Chapter 7 Device Configuration Options ENWW



make reductions or enlargements if the paper size being copied to is different from the size of the source
document. Some useful values for copying from one size to another would be:

e Legalto Letter (78%)
e Letterto A4 (97%)
e Adto Letter (94%)
e Legalto Ad (83%)

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To set this option, enter a number (between 25 and 200) for the percentage of the reduction or
enlargement.

Copy Job Auto Interrupt

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

The auto job interrupt feature allows the product to automatically interrupt an active network print job
between complete sets to print a new copy job. This option lets you specify if the auto job interrupt
feature is enabled or disabled. If you enable the auto job interrupt feature, users do not have to wait for
large, multi-copy network print jobs to finish printing before they can print a new copy job.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To enable the auto job interrupt feature, select On.

2. Todisable the auto job interrupt feature, select Off.

Copy Job Scan Ahead

ENWW

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

The walk-up copying feature allows you to walk up to the product and start making a copy while the
product is busy printing a network print job. If the walk-up copying feature is enabled and a user initiates
a copy job while the product is printing a network print job, the product scans and holds the copy job
until it finishes printing the network print job. If the walk-up copying feature is disabled and a user initiates
a copy job while the product is printing a network print job, the product waits until it finishes printing the
network print job to start scanning the copy job. The product displays a message on the control panel
saying that the copy job is blocked and will be processed as soon as the current job finishes printing.
The user can choose to cancel the copy job or leave the originals in the automatic document feeder
(ADF) or on the scanner glass.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.
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Following are steps to configure this option:
1. To enable this feature, select On.

2. To disable this feature, select Off.

Copy Output Bin

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify the default output bin where the printed copies are delivered. The output
bins that you can select depend on the output device that is configured with the product. If you want to
take advantage of the one-touch copying feature, you should change the default to the output bin where
the users typically send printed copies. This eliminates the need for the users to specify the output bin
at the control panel each time they make copies.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To specify the default output bin for copies, select the output bin from the drop-down list.

Default Copier Copies

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option allows you to select the default number of copies that will be generated on each copy job
initiated from the control panel.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To select the default number of copies, type the number of copies (between 1 and 99) in the edit box.

Default Copy Collation

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify collation behavior. Since collation does consume additional resources on
the device, turning this feature off can sometimes allow the device to complete jobs which otherwise
may have failed to complete.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To enable this feature, select On or Enabled.

2. To disable this feature, select Off or Disabled.
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Default Copy Output Media Size

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify the default output media size of copied documents. The paper sensors
override the default. If the paper sensors cannot detect the size of the original, the product uses the
default. If you want to take advantage of the one-touch copying feature, change the default copy media
size to the size of the originals that the users typically copy. This eliminates the need for the users to
specify the media size at the control panel each time they make copies.

B NOTE: This configuration item is not included in the control panel. The device must have firmware
version 03.779.0 or greater in order for the Auto selection to be successfully set.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To specify the media size of the originals, select the media size from the drop-down list.

Default Edge-to-Edge Setting

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

Use this option to specify whether copies are printed as close to the edge of the page as possible or
printed with the normal unprinted border.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. For a1 mm (0.04 inch) unprintable border, select the None.

2. Fora6.35 mm (0.25 inch) unprintable border, select the Clip.

Default Image Quality

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you select the default copy quality either for maximum performance, or for more
economic operation when the best performance is not needed.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select the desired quality level.

Default Number of Copies

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).
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This option lets you specify the default number of copies that are printed for each copy job. If you want
to take advantage of the one-touch copying feature, change the default to the number of copies that the
users typically print. This eliminates the need for the users to specify the number of copies at the control
panel each time they make copies.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To specify the default number of copies, type the quantity in the text box.

Default Number of Sides

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify if one side or both sides of the original or the copy document are copied.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select the desired default number of sides from the drop-down box.

Default Original Content

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify the default type of information that is on the original document (Text,
Graphics, or Mixed). If you want to take advantage of the one-touch copying feature and the users
typically copy originals that have only graphics or only text, change the default to the appropriate type
of information. This eliminates the need for the users to specify the page content at the control panel
each time they make copies.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select the information type (Text, Graphics, or Mixed) from the drop-down
box.

Default Original Density

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify the default density and brightness of the copies, making all copies lighter
or darker than the original. If you want to take advantage of the one-touch copying feature and the users
typically make copies lighter or darker than the original, change the default to the appropriate density
setting. This eliminates the need for the users to specify the density at the control panel each time they
make copies.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To specify the density of the copies, select the value from the drop-down box. For minimum brightness
(darkest), select 0 or —125; for maximum brightness (lightest), select 8 or 125.
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Hold Off Print Jobs During Copy

B

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

The hold off print job feature prevents network print jobs from starting within a specified time after the
product finishes printing a copy job. This option lets you specify if the hold off print job feature is enabled
or disabled. If you want to give walk-up copying users priority over network print jobs, you should
configure the Hold Off Time on page 313 option. HP Web Jetadmin 10.0 will not start printing any
network print jobs as long as a user is interacting with the control panel. In addition, the product will wait
for the amount of time that you specify for the Hold Off Time option after a copy job finishes printing
before starting to print any network print jobs.

NOTE: If you enable the hold off print job feature, you must also specify a value for the Hold Off
Time on page 313 option.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To enabile this feature, select On.

2. Todisable the hold off print job feature, select Off.

Hold Off Time

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify the default amount of time that network print jobs must wait before starting
to print if the Hold Off Print Jobs During Copy on page 313 option is enabled. If you want to give walk-
up copying users priority over network print jobs, you should configure the Hold Off Print Jobs During
Copy on page 313 option. HP Web Jetadmin 10.0 will not start printing any network print jobs as long
as a user is interacting with the control panel. In addition, the product will wait for the amount of time
that you specify for the Hold Off Time option after a copy job finishes printing before starting to print
any network print jobs.

NOTE: If the Hold Off Print Jobs During Copy on page 313 option is not enabled, HP Web Jetadmin
10.0 ignores the Hold Off Time value entered for this feature.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To specify how long HP Web Jetadmin 10.0 waits before starting network print jobs, type the number
of seconds in the text box.

Interrupt Copy Jobs

ENWW

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This feature lets you interrupt an active copy job between complete sets to print a new copy job. This
option lets you specify if the copy job interrupt feature is enabled or disabled. If you enable the copy job
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interrupt feature, users do not have to wait for large, multi-copy copy jobs to finish printing before they
can print a new copy job.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To enable this feature, select On.

2. Todisable the interrupt copy job feature, select Off.

Reset Copy Send Timeout

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify the default amount of time that HP Web Jetadmin 10.0 waits after any control
panel activity completes before it resets the send settings to their defaults. You should set the value to
provide users with enough time to set up and complete their digital sending tasks before the product
resets their send settings.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, type the number of seconds in the text box.

Reset Copy Timeout

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify the default amount of time that HP Web Jetadmin 10.0 waits after any control
panel activity completes before it resets the copy settings to their defaults. You should set the value to
provide users with enough time to set up and complete their copying tasks before the product resets
their copy settings.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, type the number of seconds in the text box.

Device Configuration Options for Network
e Desired USB Mode

° DNS Server Configuration

° Enable Features

° Encrypt All Web Communications

° Encryption Strength

° IP Address

° IPP _Printer Install Wizard
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° IPv6 - Configuration Precedence

e |Pv6 - DHCPV6 Policy

° IPv6 - Enable

° IPv6 - Options

e |PX Ethernet Frame Type

° IPX - Frame Type Token Ring

° IPX - Queue Server Job Polling Interval

° IPX - RCFG Support Enabled

° IPX - SAP Broadcast Interval

° IPX - Source Routing

e Jetdirect DHCP Config

° Jetdirect External Print Server

° Job Timeout

° LAA Address Configuration

e Link Setting
° Privacy Setting

° Protocol Stacks

e Scan Ildle Timeout

e SNMP Trap Destination Table

e System Log Server

e System Name
e TCP Idle Timeout

e TCP/IP Configuration Method

e WINS Server Configuration

Configuration options for Network define network communication functions for the device including TCP/
IP setup, and protocols.

Desired USB Mode

ENWW

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify the protocol that the USB uses to interface with this device. HP Jetdirect
normally uses the best protocol that the device supports. If a more complex interface does not work with
the HP Jetdirect print server, change this option to a simpler interface. If you select Automatic, the
HP Jetdirect print server uses the best protocol available. If you select Unidirectional, the HP Jetdirect
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print server uses the forward-data only protocol (USB class 7.1.1). If you select Bidirectional, the

HP Jetdirect print server uses the simple forward and reverse data protocol (USB class 7.1.2). If you
select Multiple Logical Channels (MLC), the HP Jetdirect print server uses the HP-MLC protocol (USB
class 7.1.2+).

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To change the protocol, select the option for the protocol that you want this HP Jetdirect print server to
use.

DNS Server Configuration

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

If your network uses Domain Name System (DNS) services, use this option to specify the IP address
of a primary DNS server for specified devices. If a secondary DNS server is available on your network
and can be configured on the device, you may also specify the IP address of the secondary DNS server.
A secondary DNS server is used when the primary DNS server is not available. Use Domain name to
specify a Domain Name for this device. A domain is a set of one or more IP addresses, and the Domain
Name identifies the domain in which the device resides (for example, support.hp.com). A Domain Name
typically consists of a series of labels separated by the dot (. ) character, ending with a predefined suffix
to identify its top-level domain. For example, top-level domain .com is used for commercial
businesses, .edu for educational institutions, and .org for nonprofit organizations.

Devices on an IP network actually use IP addresses for communications. However, device IP addresses
may dynamically change or be difficult to remember, use or manage. Domain Name System (DNS)
services are used to automatically translate user-friendly Domain Names to corresponding device IP
addresses. A server on the network that provides this service is a DNS server.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. Enter the IP address of the primary DNS server in Primary DNS server IP.

2. Enter the IP address of the secondary DNS server in the Secondary DNS server IP.

Bf NOTE: Some devices may not support configuration of a secondary DNS server.

3. Tospecify a Domain Name for a device, enter the Domain Name assigned to this device in Domain
name. (The entry is limited to 254 alphanumeric ASCII characters, including the dash (-) character
and dot (.) label separator.)

Bf NOTE: When specifying the Domain Name, do not include the device host name. The entry in
Domain name is not the fully-qualified host name (for example, printer1.support.hp.com is a fully-
qualified host name for a device with host name “printer1” in the domain “support.hp.com”).

Enable Features

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).
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You can enable or disable various network configuration tools, printing methods, and other features that
are supported by the device. Because each device supports different features, the items listed will vary.
For example, some devices may allow you to enable or disable network configuration tools such as
Telnet or the embedded Web server (EWS). Both Telnet and the embedded Web server provide
additional access to print server configuration and management web pages. Or, you may be able to
enable or disable printing services through File Transfer Protocol (FTP), Line Printer Daemon (LPD)
which provides line printer spooling services for TCP/IP systems, Internet Printing Protocol (IPP), or port
9100 (direct-mode printing). Other features, such as the Service Location Protocol (SLP), used by select
client applications to discover and identify the device, may be configurable. Finally, mDNS and IPv4
Multicast can be enabled or disabled. mDNS is typically used on small networks for IP address and
name resolution (through UDP port 5353) where a conventional DNS server is not used. IPv4 Multicast,
if enabled, allows the print server to send and receive IP version 4 multicast packets.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select the feature to enable (or deselect a feature to disable it).

Encrypt All Web Communications

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you to enable or disable the HP Jetdirect card to encrypt any information coming from
the device.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Select Enabled to encrypt information or Disabled to not encrypt information.

Encryption Strength

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option indicates the SSL encryption strength. For the encryption strength selected, ciphers are
displayed that identify the weakest cipher allowed. This only applies if encryption is enabled.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select one of the encryption strengths from the drop-down menu.

IP Address
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To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

Network devices use an IP address to communicate with another network device and the subnet mask
to determine the network and host portions of the IP address. The default gateway is the address of a
gateway system or a router, which are the nodes that let a network device communicate on other

networks or subnets. These options define the IP address, subnet mask, and default gateway address
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that the HP Jetdirect print server uses. The IP address, subnet mask, and gateway address are required
to communicate with a device that uses the TCP/IP protocol.

/\ CAUTION: These options are fundamental to TCP/IP-based networks. Before you change these
options, make sure that you clearly understand how the network is designed.

Ef NOTE: The IP address specified here overrides BOOTP, DHCP, or any previously configured IP
address on the HP Jetdirect print server. This is similar to configuring static addresses through Telnet
or the device control panel in the case of an internal HP Jetdirect print server. Use the static configuration
method if you do not have any automatic or server methods, such as BOOTP or DHCP.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Bf NOTE: This configuration option will behave differently for single-device configuration than for
multiple-device configuration. When capturing device settings into a configuration template via the Save
As Template feature, this option will fail when the template is used to configure multiple devices. For
more information, see Captured Configurable Options and Configuration Templates on page 142.

To change the IP address, type the new IP address in IP Address. To change the subnet mask, type
the new subnet IP address in Subnet Mask. To change the gateway address, type the new gateway IP
address in Gateway.

IPP Printer Install Wizard

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify the URL for the Internet Printing Protocol (IPP) Printer Install Wizard link for
this printer. When you access this link, an Install Wizard runs that lets you create a print path between
your computer and this printer.

/A CAUTION: If you change this URL, the availability of the Install Wizard may change. Make sure that
the Install Wizard has been properly set up before changing this.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, type the URL for the IPP Printer Install Wizard in the text box.

IPv6 - Configuration Precedence

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

You can set the priority of how a device obtains IP addresses on the network, based on the best method
for the network. The priority is determined by the order listed in this list. For example, if DHCP/BOOTP
has precedence over DHCPvVG6, an IP address provided through DHCPv4 will have precedence over an
IP address provided by DHCPvV6.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To specify the configuration precedence, highlight the method and then click Move Up or Move
Down. To restore the default configuration scheme, click Reset.
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IPv6 - DHCPv6 Policy

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

You can specify how the Dynamic Host Configuration Protocol version 6 (DHCPv6) functions on the
network. DHCPV6 is a protocol for assigning dynamic IP addresses to devices on a network. If you use
dynamic addressing, a different IP address is assigned to the device when it connects to the network.
A device’s IP address can even change while it is still connected. DHCP also supports static IP
addresses. Dynamic addressing monitors IP addresses on the network rather than requiring an
administrator to manage the task. This means that a new device can be added to a network without
manually assigning a unique IP address to the device.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this feature, select one of the options:
e Always perform DHCPv6 at startup
e Perform DHCPv6 when stateless configuration is unsuccessful

e Perform DHCPv6 only when requested by the router

IPv6 - Enable

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

You can enable or disable an IPv6-capable device to use the IPv6 protocol. IPv6 must be enabled to
access other |IPv6-capable devices through an IPv6 network.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To enable support for IPv6-capable devices, select Enable IPv6. To disable support, deselect this
option.

IPv6 - Options
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To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

You can enable or disable an IPv6-capable device to use the IPv6 protocol. IPv6 must be enabled to
access other IPv6-capable devices through an IPv6 network. You can set the priority of how a device
obtains IP addresses on the network, based on the best method for the network. The priority is
determined by the order listed in this list. For example, if DHCP/BOOTP has precedence over DHCPv6,
an IP address provided through DHCPV4 will have precedence over an IP address provided by DHCPv6.
You can specify how the Dynamic Host Configuration Protocol version 6 (DHCPv6) functions on the
network. DHCPV6 is a protocol for assigning dynamic IP addresses to devices on a network. If you use
dynamic addressing, a different IP address is assigned to the device when it connects to the network.
A device’s IP address can even change while it is still connected. DHCP also supports static IP
addresses. Dynamic addressing monitors IP addresses on the network rather than requiring an
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administrator to manage the task. This means that a new device can be added to a network without
manually assigning a unique IP address to the device.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

B NOTE: This configuration option will behave differently for single-device configuration than for
multiple-device configuration. When capturing device settings into a configuration template via the Save
As Template feature, this option will fail when the template is used to configure multiple devices. For
more information, see Captured Configurable Options and Configuration Templates on page 142.

Following are steps to configure this option:

1. Select one of the options:
e Always perform DHCPv6 at startup
e Perform DHCPv6 when stateless configuration is unsuccessful
e Perform DHCPv6 only when requested by the router

2.  You can specify a fully qualified domain name (FQDN) for a device. The FQDN corresponds to the
TCP/IP address for a networked device. FQDN contains a host name and a domain name. The
host name is always first, followed by the domain name, and then the top-level domain name.

3. You can specify the Primary and Secondary DNS servers for the device to be used in IPv6. If the
network uses Domain Name System (DNS) services, use this option to specify the IP address of
a primary DNS server for this device. If a secondary DNS server is available on the network and
can be configured on the device, specify the IP address of the secondary DNS server. A secondary
DNS server is used when the primary DNS server is not available.

IPX Ethernet Frame Type

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify the Ethernet frame types that the HP Jetdirect print server uses on the
network. If you select Auto, the HP Jetdirect print server tries all of the frame types until it finds the one
that works. If you know that you are only going to use one frame type, selecting that frame type reduces
network traffic.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this feature, select one of the Ethernet frame type options:
e Auto

e Ethernet 802.3

e Ethernetll

e Ethernet 802.2

e Ethernet SNAP

320 Chapter 7 Device Configuration Options ENWW



IPX - Frame Type Token Ring

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

IPX protocol is supported by Novell NetWare network OS. This option lets you specify which
encapsulation type for IPX to use for a token ring LAN or it can be set to let the device automatically
decide which is best to use.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

IPX - Queue Server Job Polling Interval

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

IPX protocol is supported by Novell's NetWare network operating system. This option lets you specify
the number of seconds between polling the queue server for jobs.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

IPX - RCFG Support Enabled

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

RCFG (remote configuration protocol) was developed by HP for remote configuration and management
of devices on an IPX/SPX network, typically a Novell NetWare network. By factory default, RCFG is
enabled. RCFG does not support encrypted communications or authentication, and is not secure. If
RCFG is not required for device configuration and management, it should be disabled. Disabling RCFG
does not affect the use of IPX/SPX Direct-Mode (peer-to-peer) printing. Use this feature to enable or
disable RCFG. If enabled, RCFG (sometimes called RCONFIG) allows the device to be remotely
configured on an IPX/SPX network. HP Web Jetadmin 10.0 may use RCFG to configure Novell NetWare
queue-server linkages on older HP Jetdirect print servers.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To enable RCFG, select Enable RCFG support. To disable RCFG, deselect this field.

IPX - SAP Broadcast Interval
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To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

By default, the HP Jetdirect print server sends out a Service Advertising Protocol (SAP) broadcast every
60 seconds to advertise itself on the network and make Novell print servers aware of its presence. SAP
broadcasts are necessary for the print server services to be located in some Novell NetWare
environments. This option lets you specify how often the HP Jetdirect print server sends out a SAP
broadcast. If you have many HP Jetdirect print servers on your network, SAP broadcasts can cause
network traffic. To reduce the impact that SAP broadcasts have on network traffic, increase the IPX SAP
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broadcast interval. You might want to disable HP Jetdirect SAP broadcasts on Novell networks that use
Novell Distributed Print Services (NDPS) or on other networks that do not require them.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To assign or change the IPX SAP broadcast interval , type the broadcast interval in minutes in the text
box. To disable the IPX SAP broadcast interval, type 0 (zero) in the text box.

IPX - Source Routing

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

IPX protocol is supported by Novell’'s NetWare network OS. This option lets you set how source routing
is handled by the device or allow it to automatically choose.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Jetdirect DHCP Config

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you enable or disable the DHCP configuration feature on the HP Jetdirect print server.
If you want to manually control the IP address on the print server, disable the DHCP configuration
feature. If you want to have DHCP automatically assign an IP address to the print server, enable the
DHCP configuration feature.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To enable DHCP configuration, select Enabled. To disable this option, select Disabled.

Jetdirect External Print Server

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

The HP Jetdirect External Print Server setting allows you to restart the print server remotely. The external
print server may not be close or be conveniently positioned for access.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To restart the external print server, select Restart.

Job Timeout

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).
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This value represents (in seconds) the maximum time of inactivity which must elapse before the print
server card switches from the current network protocol to another when a normal end of job is not
detected. For external HP Jetdirect print servers, allowable values are zero, and also within the range
30 to 3600 seconds. For internal HP Jetdirect print servers, allowable values are zero, and also within
the range 30 to 127 seconds.

NOTE: If the timeout value is set at zero, the print server will never time out (it will always stay in the
current network protocol being used).

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To specify a new job timeout, enter the timeout in seconds in the text field.

LAA Address Configuration

B

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Locally administered addresses are only supported in Token Ring HP Jetdirect print servers. The
network device manufacturer originally sets the media access control (MAC) address in the device read-
only memory. You can change the MAC address for most Token Ring network devices. This option lets
you specify the MAC address on the Token Ring HP Jetdirect print server. Some Token Ring
environments use the Locally Administered Address feature. While it is not a requirement that you
change the MAC address, the Locally Administered Address feature might be implemented in some
Token Ring environments. Some administrators find it easier to manage devices if the MAC address for
all of the devices of the same type start with specific characters. For example, starting all HP devices
with 003.

CAUTION: To prevent potential problems, make sure that the address you assign is not already in
use.

NOTE: While the Novell protocol environment on the HP Jetdirect print server can restart and begin
printing again after you assign locally administered addresses, you must reconfigure the other protocol
environments to acknowledge the new address. This includes the Linux and Microsoft host software.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

NOTE: This configuration option will behave differently for single-device configuration than for
multiple-device configuration. When capturing device settings into a configuration template via the Save
As Template feature, this option will fail when the template is used to configure multiple devices. For
more information, see Captured Configurable Options and Configuration Templates on page 142.

To assign or change the locally administered address, type the address in the text box.

Link Setting
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To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

Use this option to specify the link speed (10 or 100 Mbps) and the communication mode (full- or half-
duplex) that the device should use when connecting to your 10/100Base-TX network each time it is
powered on. To communicate on your network, the device link speed and communication mode must
match the operation of your network. If the device setting is AUTO, the device will attempt to
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autonegotiate its link settings with the network each time it is powered on. If the device successfully
links to the network, you can then use this feature to explicitly configure the required link setting on the
device. When the device is powered on again, the configured setting will be used directly. However, if
the device fails to link using AUTO, then the link settings on the device will default to 100 Mbps and half-
duplex mode. Communications with the device over the network may, or may not, be possible. The link
setting options:

e AUTO: link settings are automatically negotiated.

e 10TXFULL: the link is set to 10 Mbps, full-duplex operation.

e 10TXHALF: the link is set to 10 Mbps, half-duplex operation.

e 100TXFULL: the link is set to 100 Mbps, full-duplex operation.
e 100TXHALF: the link is set to 100 Mbps, half-duplex operation.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select one of the Link Setting options from the drop-down box.

Privacy Setting

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This feature allows you to control whether HP may collect statistical data on product use. By allowing
HP to collect this information, improved product features and services can be provided in the future.
HP will not collect network-specific or personal data. For information on HP privacy policies, read the
Hewlett-Packard Online Privacy Statement available by clicking privacy statement at
http://www.hp.com in your language. For HP to collect any information, Internet access must be
available. If you enable this feature, information collected by HP will be limited to the following items:

e HP Jetdirect product number.

e firmware version and manufacturing date.

e model number of the attached printer or device.
e Web browser and operating system detected.

e local language selections used for viewing.

e web pages Network communications protocols enabled.
e network management interfaces enabled.

e device discovery protocols enabled.

e printing protocols enabled.

e  TCP/IP configuration methods enabled.

e  SNMP control methods enabled.

e wireless configuration methods enabled.
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Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To allow HP to collect data on the use of this product, select the check box. To disable this feature, clear
the check box.

Protocol Stacks

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you enable or disable the various protocol stacks on the HP Jetdirect print server. Many
networks only use a few protocols. For example, the AppleTalk and DLC protocols are enabled by default
on HP Jetdirect print servers, but many networks do not use them. Although leaving unused protocols
active will not harm the network, you might gain the following benefits if you disable them:

e  Aslight improvement in network performance.

e An additional measure of security and control because each user must access the HP Jetdirect
print services centrally instead of establishing a direct connection. For example, a Macintosh user
cannot set up a direct AppleTalk connection with the printer, but the user can access centralized
print services through TCP/IP or IPX/SPX.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To enable a protocol stack, select the check box next to the protocol stack. To disable a protocol stack,
clear the check box next to the protocol stack.

Scan Idle Timeout

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify how long the printer waits before closing an idle connection and going to
the next print job. If your network is busy, there may be a delay in the packet transmissions. In this case,
you might want to specify a longer timeout value.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To assign or change the scan idle timeout, type the timeout value in seconds in the text field.

SNMP Trap Destination Table
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To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

HP Web Jetadmin 10.0 runs a background trap-server utility that is used to receive HP Jetdirect traps
and alerts, and can route alert notifications to email addresses. However, some networks may require
that specific network servers and management applications receive SNMP traps. This feature allows

you to specify different trap-management servers along with the use of special trap community names
and supported SNMP agents. Specified trap servers are stored in a Trap Destination Table on the print
server. The number of trap servers that can be configured (typically 3, 5, 10, or 12) depends on the print
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server model. A trap server is specified by its IP address and/or its Fully Qualified Domain Name
(FQDN), and a TCP/IP port number used by a management application on the server (a trap server port
number). If a port number is not specified, the default port 162 is used. The print server can be configured
to use a standard SNMPv1 or SNMPv2c agent, or an optional SNMPv2c Inform agent that requires an
acknowledgement from the trap server. The agent selected remains configured when the print server
is powered off/on. The default agentis SNMPv1. A trap community name can be specified for the SNMP
agent to use when sending traps. By default, the trap community name is “public”. If the Trap Destination
Table is empty, traps are not sent unless enabled through HP Web Jetadmin 10.0 running its background
trap-server utility. Because trap objects (or pre-defined events) are encoded in each device, the available
traps depend on the particular HP Jetdirect print server model and its current firmware version.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

B NOTE: This configuration option will behave differently for single-device configuration than for
multiple-device configuration. When capturing device settings into a configuration template via the Save
As Template feature, this option will fail when the template is used to configure multiple devices. For
more information, see Captured Configurable Options and Configuration Templates on page 142.

Following are steps to configure this option:
1. For single device configurations:

e To save an entry in the Trap Destination Table, select Add and complete the active fields on
this page.

e Toclear an entry from the Trap Destination Table, clear Add.
For multiple device configurations:

e To save an entry in the Trap Destination Table, select Save entry and complete the active
fields on this page.

e Toclear an entry from the Trap Destination Table, select Clear entry and complete the active
fields on this page.

e To clear all entries from the Trap Destination Table, select Clear all entries.

2. Enter the IP address of the desired trap server (to save or clear) in IP address, or enter the Fully
Qualified Domain Name (FQDN) in FQDN.

B NOTE: FQDN is shown only when FQDN is supported by the print server.

3. If required by the trap server:
e specify a TCP/IP port number for the management application in Port number.
e select an SNMP agent version from the Version drop-down list.

e  specify a trap community name in Community (up to 255 alphanumeric and special
characters).

System Log Server

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).
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This option lets you specify the IP address of the server where you want the HP Jetdirect print server
to send system log messages. System log messages identify, for example, when the HP Jetdirect print
server was turned on or when a printer problem occurred.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To assign the system log server, type the IP address of the system log server in the text box.

System Name

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify the system name, sometimes called the host name, for the HP Jetdirect
print server. You might want to specify the system name for the HP Jetdirect print server for a variety
of reasons, such as the following example:

e The system name is a static name that is saved on the HP Jetdirect print server. Use the system
name to identify and track devices on the network. You can also include the system name as a
column in device list views. Under some conditions, the system name is visible on the network or
the IP name can be resolved through network name services. This typically occurs in a DHCP
environment.

Bf NOTE: This option does not change the DNS server entries. If you want to view the system name on
the network, you must update network name services, such as DNS, with name and address data.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Bf NOTE: This configuration option will behave differently for single-device configuration than for
multiple-device configuration. When capturing device settings into a configuration template via the Save
As Template feature, this option will fail when the template is used to configure multiple devices. For
more information, see Captured Configurable Options and Configuration Templates on page 142.

To configure this option, type the host name in System Name.

TCP Idle Timeout

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify how long TCP/IP stays open when there is no traffic. If the network is busy,
there may be a delay in the packet transmissions. In this case, you might want to specify a longer timeout
value.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To assign or change the TCP idle timeout, type the timeout value in seconds in the text box.
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TCP/IP Configuration Method

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

This option lets you specify how the HP Jetdirect print server obtains its TCP/IP configuration. This is a
quick method for resetting the IP stack on the HP Jetdirect print server, forcing it to try and obtain an IP
configuration through BOOTP or DHCP.

Bf NOTE: The current HP Jetdirect print server TCP/IP configuration is erased.

e BOOTP Server: forces the HP Jetdirect print server to obtain its TCP/IP configuration on the
network through a BOOTP server, if one exists and if the print server configuration parameters
have been defined. When you save the configuration, the HP Jetdirect print server immediately
resets its IP address to 0.0.0.0. If a BOOTP configuration does not occur within a short period of
time, the IP address defaults to 192.0.0.192.

e DHCP Server: forces the HP Jetdirect print server to obtain its TCP/IP configuration on the network
through a DHCP server, if one exists and if the print server configuration parameters have been
defined. When you save the configuration, the print server immediately resets its IP address to
0.0.0.0. If a DHCP configuration does not occur within a short period of time, the IP address defaults
to 192.0.0.192.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To reconfigure the HP Jetdirect print server, select the configuration method option.

WINS Server Configuration

To see a list of devices that a specific configuration option can apply to, hold your cursor over the
configuration option name above where you define the settings (not in the left menu that lists all of the
configuration options).

Use this feature to specify the IP address of a primary Windows Internet Naming Service (WINS) server
for this device. A secondary WINS server may also be specified, if supported by the device, for use
when the primary WINS server is not available. Devices on IP networks actually use IP addresses for
communications. A WINS server provides name resolution services, that is, it translates between user-
friendly host names and IP addresses for each network computer or device. A WINS server employs a
distributed database of host names and associated IP addresses. The database is automatically
updated dynamically so that host name and IP address resolution is always current.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. Enter the IP address of the primary WINS server in Primary WINS server IP.
2. Enter the IP address of the secondary WINS server in Secondary WINS server IP.

Bf NOTE: Some devices may not support configuration for a secondary WINS server.

Device Configuration Options for Security

e Access Control List
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° Authentication Manager

° Bootloader Password

e Color Access Control

e Control Panel Access

° Disable Direct Ports

° Embedded Web Server Password

e Get Community Name

° Group 1 PIN
e Group 2 PIN

° Kerberos - Accessing the Authentication Server

° Kerberos - Accessing the LDAP Server

° Kerberos - Searching the LDAP Database

° LDAP - Accessing the Server

° LDAP - Searching the Database

° PJL Password

e Printer Firmware Update

e Set Community Name

e SNMP Version Access Control

e VULDAP

Configuration options for Security define functions for the device including authentication methods and
access.

Control List

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

An access control list (ACL) is used to specify the IP addresses on your network that are allowed access
to the device. The list supports up to 10 entries. If the list is empty, then any system is allowed access.
By default, host systems with HTTP connections (such as Web browser or Internet Printing Protocol
connections) are allowed access regardless of access control list entries. This allows hosts to access
the device when Proxy Servers or Network Address Translators are used. However, unfiltered access
by HTTP hosts may be disabled by clearing the Check ACL for HTTP checkbox.

CAUTION: You may lose your ability to communicate with the device if your system is not properly
specified in the list, or access through HTTP is disabled. If communication with the device is lost,
restoring network settings to factory-default values may be required.
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The access control list (ACL) is normally used for security purposes. Network administrators can
configure the device to limit which systems or management stations have access to the device. The
device will block communications from systems that are not configured for access.

Host systems to be allowed access are specified by their IP host or network address. If the network
contains subnets, an address mask may be used to specify whether the IP Address entry is for an
individual host system or a group of host systems. For an individual host system, the mask
255.255.255.255 is assumed and is not required.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

B NOTE: This configuration option will behave differently for single-device configuration than for
multiple-device configuration. When capturing device settings into a configuration template via the Save
As Template feature, this option will fail when the template is used to configure multiple devices. For
more information, see Captured Configurable Options and Configuration Templates on page 142.

To add an entry into the Access Control List:
1. Enter an IP address in IP Address.

2. To identify whether the IP address entry is an individual host or a group of hosts, enter a subnet
mask in Mask.

For single device configuration, to delete entries from the Access Control List, click Clear all ACL
Table entries.

Authentication Manager

149,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option enables you to set the authentication method to be used for accessing the device and various
functions on the device. The authentication methods are User PIN, Group 1 PIN, Group 2 PIN, LDAP,
Kerberos, and HP Digital Send Service. The device functions include walk-up, Copy, Send E-mail, Send
Fax, Send to Network folder, DSS Secondary E-mail, DSS Workflow. If another device function becomes
available through a 3rd party install, it would appear and be able to have an authentication method
enabled for it.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

B NOTE: This configuration option will behave differently for single-device configuration than for
multiple-device configuration. When capturing device settings into a configuration template via the Save
As Template feature, this option will fail when the template is used to configure multiple devices. For
more information, see Captured Configurable Options and Configuration Templates on page 142.

Bootloader Password

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you configure a password on the bootloader screens for a device. This keeps the user
from making any changes when the device first boots up. The Bootloader PIN keeps users from
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changing the Bootloader Password. You can enter a new 4 digit PIN (or enter the existing 4 digit PIN if
it had been set previously) and then enter the Bootloader Password itself.

Bf NOTE: Ifyou forgetthe Bootloader PIN, the Bootloader password can not be changed and could only

be cleared (along with the Bootloader PIN) via a service call.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Color Access Control

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify whether to allow jobs to print in color. The Enable Color setting will allow
all color jobs to print in color. The Color if Allowed setting will require the device to check the
permissions defined for the user and the application to determine whether each job will be printed in
color or not. If either the user or the application has “black-only” permission, then the job will be printed
without color. The Disable Color setting will result in all color jobs printing in black.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select one of the settings.

Control Panel Access

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option allows you to lock the device control panel, preventing unauthorized users from accessing
it and changing the device settings. Users can still read the settings on the device’s control panel. The
unlock options that are available depend on the device. For some devices, you can only lock and unlock
the control panel. For other devices, you can specify the level of access: minimum, moderate, or
maximum. The definitions for the different levels of access also depend on the device. If you install a
printer in a public area, you might require additional security. Locking the device control panel prevents
unauthorized users from accessing the device settings either at the device or though a software utility
that provides control panel access.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To prevent users from changing device settings, select the appropriate lock option. To let users change
device settings, select Unlock.

Disable Direct Ports

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
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the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Checking the disable direct ports makes the device more secure but it only allows printing through the
network connection. If this option is selected, the device must be rebooted afterwards.
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Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Embedded Web Server Password

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

If you are concerned about security, specify a password for the embedded Web server configuration.

Ef NOTE: When setting a password on the device, you must enter the current password, if any,
regardless of credentials stored in the application. If you don't, the setting will fail as “Invalid Data”.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To assign the password, type it in Password. Type the same password in Confirm password. To
change the password, type it in Current EWS password. Type the same password in Confirm
password.

Get Community Name

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

The Get Community Name password can be set to prevent unauthorized people from using SNMP
utilities to access a device and get the device settings.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To set a Get Community Name password, type the password and then repeat it for confirmation.

Group 1 PIN

Ef NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option enables you to force users to use a pin to access a device. You can then use the
Authentication Manager function to specify what features (such as walk-up, copy, send, fax) are
restricted by this. You can have two different groups, each with a unique pin.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To set this option, type the PIN and then type it again for confirmation.

Group 2 PIN

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).
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This option enables you to force users to use a pin to access a device. You can then use the
Authentication Manager function to specify what features (such as walk-up, copy, send, fax) are
restricted by this. You can have two different groups, each with a unique pin.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To set this option, type the PIN and then type it again for confirmation.

Kerberos - Accessing the Authentication Server

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Configuring the Kerberos Authentication for a device lets you specify which Kerberos server the device
should connect to when the user is trying to complete a task that requires Kerberos authentication.
Specifying this information allows the user to perform Kerberos authentication tasks on the device.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1.  Enter the name of the Kerberos realm in Kerberos default realm (domain).
2. Enter the hostname of the Kerberos server in Kerberos server hostname.

3. Enter the port number of the Kerberos server in Kerberos server port.

Kerberos - Accessing the LDAP Server

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Use this option to specify the attributes used to access the LDAP server.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Kerberos - Searching the LDAP Database

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

ENWW

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Use this option to specify how the device will access the LDAP server when using the Kerberos
authentication protocol. The user can specify the bind method — Anonymous resets the connection to
anonymous state, simple sends the users domain name and password in plain text, Simple over SSL
encrypts the domain name and password and Kerberos uses the Kerberos security protocol to secure
the communication with the LDAP server. You can also choose to use the device user’s credentials or
default credentials specified. You must specify the IP address of the LDAP server and the
communication port to use.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.
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LDAP - Accessing the Server

149,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify how the digital send device accesses the Lightweight Directory Access
Protocol (LDAP) server to look up email addresses. To send scanned documents from the digital send
device through email, the user must provide an email address. The process of entering email addresses
can be simplified by providing an address lookup list and by using an auto-complete feature. Access to
the LDAP server email address database provides a way for the digital send device to use the lookup
list and the auto-complete feature.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. Select one of the following server bind methods from LDAP server bind method:

e Simple: the digital send device will use credentials to access the LDAP server. You must
provide complete information in Username and Password text boxes when selecting this
option.

Bf NOTE: If you select Simple, the credentials are sent from the digital send device without
encryption. Contact the LDAP server’s administrator to determine the most appropriate server
bind method settings.

e Simple over SSL.: the digital send device will use credentials to access the LDAP server and
to enable the Secure Sockets Layer (SSL) protocol for communication between LDAP server
and the device. The SSL protocol encrypts the authentication credentials before sending the
credentials to the device.

2. Type the IP address or hostname for the LDAP server in LDAP server.

3. Type the number of the TCP/IP port on the server that receives LDAP requests in Port (usually
389).

4. If you select Simple, type the complete specified name of a user who has access to the LDAP
server in LDAP administrator’s credentials and the password for the user name in Password.

LDAP - Searching the Database

149,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Use this option to specify the root and attributes used to search the LDAP database for the user’'s email.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

PJL Password

149,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).
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Printer Job Language (PJL) is a command language that enables some features of a device. Setting
the PJL password restricts access to those PJL features.

NOTE: This option is only available for HP Jetdirect print servers on a NetWare machine.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Printer Firmware Update

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Use this option to enable or disable the ability of a device to have its firmware updated remotely. If
disabled, the device will not accept RFU firmware update files.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Set Community Name

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

The Set Community Name, which is different than the device password, prevents unauthorized users
from using SNMP utilities to access and change device setting. Once you assign a Set Community
Name, only users who know the Set Community Name can change the device settings from an SNMP
utility.

NOTE: When setting a password on the device, you must enter the current password, if any,
regardless of credentials stored in the application. If you don't, the setting will fail as “Invalid Data”.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, type the Set Community Name in Set community name and then confirm it
by retyping it in Repeat set community name. To change the Set Community Name password, type
the current one in Current set community name and then type the new one in Set community
name. Confirm it by retyping it in Repeat set community name.

SNMP Version Access Control

ENWW

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

SNMPvV3 protects network management information through user authentication and data encryption.

You can use SNMPV3 to prevent unauthorized users from viewing or changing device settings. You can
require SNMPv3 to view or change information on a device. Or, you can allow SNMPv1 read-only access
to the device, while requiring SNMPv3 to change information on a device. Enabling SNMPv3 protects

the information sent between HP Web Jetadmin 10.0 and a device by encrypting the data.

NOTE: SNMPv1 does not use data encryption when communicating with HP Web Jetadmin 10.0 and
a device.
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NOTE: When setting a password on the device, you must enter the current password, if any,
regardless of credentials stored in the application. If you don't, the setting will fail as “Invalid Data”.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. Select Enable SNMPv3 or Modify SNMPv3 and complete the fields in the corresponding area.
2. To disable SNMPv3, complete the fields in Disable SNMPv3.

VuLDAP

Ef NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Configuring the VULDAP information for a device lets you specify which LDAP server the device should
connect to when the user is trying to complete a task that requires LDAP. Specifying this information
allows the user to perform LDAP tasks on the device.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

1. Select the Configure LDAP Authentication check box. Select the LDAP Server bind method
from LDAP server bind method.

Enter the LDAP server name in LDAP Server.
Enter the port address in Port.
Enter the bind prefix in Bind Prefix.

Enter the root name for binding and searching in Bind and Search Root.

© o M~ w b

Enter the name of the LDAP attribute that you want to use for searching in Match the name entered
with the LDAP attribute.

7. Enterthe name of the LDAP attribute that matches the email address in Retrieve the device user’s
email address using attribute of.

8. Enter the name of the LDAP attribute that matches the device user’'s name in Retrieve the device
user’s name using attribute of.

Device Configuration Options for Projector
e Auto-search
e Auto-sync VGA
e Power

° Requested Source

Configuration options for Projector define functions specific to projectors.
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Auto-search

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

When Auto Search enabled is checked, the projector will automatically search for a device connected
to it.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Auto-sync VGA

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

When this option is selected, the device will automatically sync up its resolution with the incoming device.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Power

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you remotely change the power level of the device. Standby uses less power while
Lamp On will set the projector so it can be used.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Requested Source

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify what video standard source the projector will use for its source. You can
also specify the projector to scan for any attached source, and select the source from the drop-down
list.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Device Configuration Options for Wireless
e 802.3/802.11 Network Connections

Configuration options for Wireless define wireless communication for the device including setup and
encryption.
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802.3/802.11 Network Connections

149,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Selected HP Jetdirect print servers support a network connection using either a wired 802.3 port using
a network cable, or a wireless 802.11b/g port. However, only one port can be active at a time. For these
print servers, you should specify the active port behavior. Controlling the active wired or wireless port
is important to ensure availability for connected users. For example, when using the default setting Auto
(Cable Detect), an active wireless network will be disconnected if a network cable is inadvertently
connected to the print server.

e Auto (Cable Detect) (default setting): automatically detects whether an 802.3 network cable is
attached. If a network cable is not attached, only the 802.11 b/g wireless port will be active.
However, if a network cable is attached, then only the 802.3 wired port will be active.

e Disable Radio: disables the 802.11b/g wireless port. Only the 802.3 wired port will be active.

e Disable Wire: disables the 802.3 wired port, whether or not a network cable is attached. Only the
802.11 wireless port will be active.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select the appropriate port behavior.

Device Configuration Options for Fax

° Fax Answer Mode

e FaxBilling Code

e Fax General
° Fax Header

° Fax Modem Settings

° Fax Notification
° Fax Printing
° Fax Receive

° Fax Receive - Disposition

e Fax Receive - Other Options

° Fax Reporting and Error Corrections

° Fax Reports and Logs

° Fax Resolution Quality

° Fax Send

° Fax Send - Dialing Mode

e Fax Send - Other Options
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° Fax Send - Resolution

° Fax Time Format

Configuration options for Faxes define functions for fax devices including setup and default fax settings.

Fax Answer Mode

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you select the answer mode for this device. Manual mode requires user input and
Automatic does not.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Fax Billing Code

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the billing code information for the digital send device. Billing codes provide
a way to track faxes from different locations. When supported by the fax method, billing codes can be
used to track the fax source to a specific machine or sender.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

1. To allow the user to enter a billing code other than the default, select Yes from Editable by the
user.

2. Type the default billing code value in Default billing code.

3. Select the minimum number of characters that a user is allowed to enter as a valid billing code
from Minimum length. (The maximum number of characters allowed for a billing code is 16.)

Fax General

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
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the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify advanced fax settings for the digital send device. You can specify the modem
and ringer volumes, whether the header information is overlaid on top of the fax image, and whether
the fax device should use JBIG compression or Error Correction Mode (ECM). Printing the header over
the top of the fax image instead of above it reduces the chance that each faxed page is larger than the
selected paper size and prints as two pages on the receiving fax device.

JBIG compression is a protocol that allows for faster fax sending between two JBIG compliant fax
devices. Itis possible that older fax machines may fail to connect when JBIG is enabled. Error Correction
Mode (ECM) should normally be enabled, except in extreme circumstances where line conditions are
too poor to support ECM faxes.
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Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. Select the fax modem volume from Modem volume.
2. Select the fax ringer volume from the Ringer volume.

3. The phone number, time, and date are stamped at the top of all outgoing faxes. To print this
information over a small portion of the top of the fax image, select the Overlay header.

4. To disable JBIG compression, select the Disable JBIG compression.

5. To disable Error Correction Mode, select the Disable error correction.

Fax Header

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

You can specify the company name and fax number to be included at the top of your faxes.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. Type the company name in Company name.

2. Type the fax number in Fax number.

Fax Modem Settings

Ef NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Similar to a fax machine, the digital send device sends scanned documents to a fax phone number.
Specify the fax settings to ensure that the fax line associated with the digital send device is properly
configured.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

1. Select the country/region of origin from Country/region.

2. Optional: Type the name of the company of origin in Company name.

3. Type the phone number from which the device is dialing in Phone number.
4

If a prefix number is required by the local phone system, select Enable dialing prefix and then
type it in Dialing prefix.
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Fax Notification

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

The digital send device can generate notification reports to provide further details about the result of a
fax send or receive operation. Use this option to specify when the digital send device generates

notification reports and how those reports are delivered to the user. Depending on your needs, you can
configure the device to deliver notification reports regularly or only when specific types of errors occur.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. Select the condition when fax notifications should be sent from Condition upon which to notify.

2. Select the notification delivery method from the Method used to deliver notification:

Bf NOTE: The device must be correctly configured to use either option.

e  Print: print the fax notification report directly at the digital send device.
e Email Sender: send the fax notification report to the user’'s email address.

3. Toinclude a thumbnail image of each fax with the fax notification report, select Yes from Include
thumbnail.

Fax Printing

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
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the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the fax printing settings for the fax capable device. You can specify a PIN
to secure incoming fax documents and prevent unauthorized users from printing them. You can also
specify whether incoming faxes are printed or stored. For printed faxes, you can schedule when they
are printed. If incoming faxes contain sensitive information, securing the fax modem with a PIN prevents
unauthorized users from printing those faxes. If the fax device is not attended regularly, storing all
received faxes or specifying a printing schedule prevents the faxes from being printed when the device
is unattended.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.
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Following are steps to configure this option:

1. Type a numeric PIN in PIN number.
Confirm the numeric PIN by typing it again in Confirm PIN number.

2. To specify the Printing Mode settings for the fax, select an option from Enable mode:
e Print All Received Faxes: print all faxes when they are received.

e Store All Received Faxes: store all received faxes on the device. The faxes can only be
printed by entering the correct PIN on the device.

e Use Fax Printing Schedule: specify the times when incoming faxes can be printed. You can
specify the days and times when the device is unlocked.

Select a start time from Unlock time (print start time) and a stop time from Lock time (print
end time).

Specify the days that the digital send device is unlocked by selecting the appropriate check
boxes underneath Days as scheduled.

¥ NOTE: If you do not specify a schedule then the device stores all received faxes.

Fax Receive

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Use this option to specify the most efficient fax receive settings for the digital send device. You can
specify which bins on the digital send device the faxes are printed from and delivered to, how the faxes
are formatted for printing, the number of rings the fax device waits before answering an incoming call,
and whether the device should forward the fax document to another fax capable machine. These settings
will ensure that the majority of the incoming faxes are received successfully and delivered to the user
in the most effective manner.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

1.  Select the number of the input tray from which the digital send device prints faxes from Fax paper
tray.

2. Select the number of the output bin to which the digital send device prints faxes from Fax
destination bin.

3. Select the number of rings that the fax machine waits before answering an incoming call from
the Number of rings before answering.

4. To stamp received faxes with available information from the sender, select Stamp received
faxes.

5. To scale the incoming fax image to the size of the paper contained in the input tray, select Fit
image to page size.

6. To forward incoming faxes on the digital send device to another fax capable machine, type the
phone number of the target fax in Forwarding number.
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B NOTE: Even ifthe digital send device forwards a fax, it will still handle the fax normally by printing
it, emailing it, or storing it in memory.

Fax Receive - Disposition

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you define what a device should do when receiving a fax. Either print the fax or forward
it to a different fax number.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Fax Receive - Other Options

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you select additional options the device can do when receiving a fax. You can allow
users to get faxes even when attached to an extension phone, let the device detect if there is silence
after the incoming phone is answered, or even force each incoming fax to be time-stamped.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Fax Reporting and Error Corrections

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you set up options with errors and tracking reports. Enabling error correction lets the
device automatically attempt error correction with faxes. You can also select how often the fax log is
printed by selecting the frequency in the drop-down list. You can also choose to include the first page
or not.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Fax Reports and Logs

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
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the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify whether to print or clear the fax activity logs. The fax activity log contains a
record of all the incoming and outgoing fax calls that have occurred since the last time the fax log was
cleared. Periodically, the log should be printed for record-keeping purposes and then cleared. This
prevents the log from becoming too large.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.
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Following are steps to configure this option:

1. To print the fax activity log, select Print activity log. The log is printed when the settings for the
digital send device are applied.

2. To clear the fax activity log, select Clear activity log. The log is cleared when the settings for the
digital send device are applied.

Fax Resolution Quality

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the resolution quality of outbound faxes. Use the resolution setting to manage
the efficiency of the fax sending operation. Lower resolution typically results in faster fax send times,
but the quality of the fax document is reduced.

Ef NOTE: The resolution setting cannot be changed by the user.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select the quality of outbound faxes from the Resolution drop-down list.

Fax Send

Ef NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the most efficient settings for sending faxes from the digital send device.
These settings affect how the device dials outbound faxes and how it behaves when the receiving line
fails to answer the fax. These settings will ensure that the majority of the outbound faxes are received
successfully while minimizing time spent attempting to send faxes to unreachable recipients.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. Select the dialing mode from the Dialing mode drop-down list.

2. To have the fax wait for a dial tone before dialing for an outbound fax document, select Yes from
the Detect dial tone drop-down list.

3. Select the number of retry attempts when the receiving line is busy from the Redial on busy drop-
down list.

4. Select the number of retry attempts when the receiving line fails to answer from the Redial on no
answer drop-down list.

5. Select the number of minutes to wait between retry attempts from the Redial interval drop-down
list.
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Fax Send - Dialing Mode

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you sets the default dialing mode for dialing a number on a fax send (Tone or Pulse).
This lets you select the dialing mode that suits the characteristics of the available communication line.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select the radio button for the dialing mode.

Fax Send - Other Options

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you define what the device should do if the number dialed is busy or there is no answer.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Fax Send - Resolution

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you sets the default resolution that will be used when sending faxes. The available
selections are Standard, Fine, Superfine, and Photo. This lets you control the quality of the sent faxes
when the default setting is used.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select the desired resolution.

Fax Time Format

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you select the time format this device should use (12 hour or 24 hours).

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Device Configuration Options for Embedded Web Server

° Embedded Web Server Configuration Options

° Embedded Web Server Language Settings

° Embedded Web Server Mail Settings
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° Embedded Web Server Other Links

° Embedded Web Server URL

° Time Services

Configuration options for Embedded Web Server define functions for the device’s Embedded Web
Server.

Embedded Web Server Configuration Options

199,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you select various features for the embedded Web server. If you have a set of standard
configuration options for embedded Web servers, you can direct all of your embedded Web servers to
the URL of the printer that has the correct configuration options. This eliminates the need to manually
specify the configuration options for each embedded Web server, reducing errors.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To turn a feature on, select the feature check box. To turn a feature off, clear the feature check box.

Embedded Web Server Language Settings

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Use this option to specify what language the embedded Web server uses to display Web pages.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

B NOTE: If you want to receive HP Web Jetadmin 10.0 alerts, you must use English or the browser
language. To do this, set the Select a language to English and then specify the language in your
browser to the language you need to use. Then select the View pages in browser language option.

1. Todisplay the Web pages in a specific language, select Select a language and select a language
from the drop-down list.

2. Todisplay the Web pages in the language assigned in the user’s browser, select View pages in
browser language.

3. Todisplay the Web pages in the language assigned in the printer, select View pages in printer
language.

Embedded Web Server Mail Settings

Ef NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).
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Use this option to configure email settings for an individual printer or printers in a device group. You can
specify email settings for sending and receiving email messages from the printer.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. Select SMTP server and then type the SMTP server IP address in the text box.
2. Select Domain name and then type the SMTP server domain name in the text box.
3. To specify the incoming email options:
e Select POP3 server and then type the POP3 server IP address in the text box.
e Select Username and then type the printer name in the text box.

e Ifrequired, select Password and then type a password in the text box. Confirm the password
by typing it again in the Confirm password text box.

Embedded Web Server Other Links

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Use this option to create links to other Web sites. This is a convenient way to quickly browse to a Web
site. These links appear on the printer's embedded Web server page. You can create up to five links.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Bf NOTE: My Printer, Order Supplies, and Solve a Problem links are defaults and cannot be deleted

or changed.

Following are steps to configure this option:

Bf NOTE: The following characters are not allowed in a link name or link address: +, =, <, >, &, ", and ;.

1.  Type a name for the link in Link name.
2. Type the URL in Link URL and click Add Link.

If you typed a link that you do not want, highlight it in the User-defined links box and click
Remove. If you typed multiple links and you do not want any of them, click Clear all links at the
top of the page.

Embedded Web Server URL

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

ENWW

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Specify a URL where the embedded Web server can retrieve configuration information. If you have a
set of standard configuration options for embedded Web servers, you can set up a URL with those
configuration options and direct all of your embedded Web servers to that URL. This eliminates the need
to manually specify the configuration options for each embedded Web server, reducing errors.
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Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To assign or change the URL, type it in the text box.

Time Services

Ef NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Use this option to access another machine on the network to obtain the correct time for an individual
printer or printers in a device group. HP printers do not have an internal clock to keep track of the time;
therefore, they need to connect to another machine on the network to obtain the current time.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. To specify the default values, select Use default values.

2. Enable clock drift correction: the device will check with the server periodically and update its
time. This is beneficial because your device is always set to the correct time but it does cause some
network traffic.

3. To specify the network time server address select Network time server address and type the IP
address.

B NOTE: The printer receives the time from this machine on the network. For the default value,
HP Web Jetadmin 10.0 looks for another machine on the network. If another machine on the
network is not found, the value appears as 0.

4. Local port to receive time from server: specify the port to use for the device to get data from the
time server.

5. To specify an hour for the printer to synchronize with a machine on the network, select Synchronize
time with server every and type an integer value between 1 and 168 (default is 24 hours).

Ef NOTE: The time synchronizes with another machine on the network at the designated hourly
interval and not immediately after saving. For example, if you specify 2 hours, the printer waits 2
hours after you save this configuration.

Device Configuration Options for File System

° File System External Access

e Set File System Password

e Set Secure File Erase Mode

Configuration settings for File System are used to delete files on the device’s memory.

File System External Access

Ef NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).
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B

This option allows you to manage the access to file systems by various printer communication languages
on a device hard drive, which helps protect a device’s file system from unauthorized reading or writing
of data. If you disable a printer communication language, that printer communication language cannot
read or write any data to the file system on a device’s hard drive.

NOTE: All printer communication languages are enabled by default.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select the printer communication language or languages to enable.

Set File System Password

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option prevents unauthorized users from changing any file system configuration options and from
performing a secure storage erase operation. The file system password must be set to perform a secure
storage erase operation and to configure the secure file erase modes and the file system external
access.

NOTE: For easier password management, it is recommended to set the same file system password
for all devices.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To set the initial file system password for a device, type the password in File system password. Type
the password again in Confirm file system password.

Set Secure File Erase Mode

ENWW

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option determines the behavior of a secure storage erase operation and the erase operation that
a printer automatically performs to make space available on a hard disk drive for incoming print jobs.
The erase operations are designed to add available space to a device’s hard disk drive and to prevent
unauthorized users from accessing confidential information from a device’s hard disk drive or other
erasable storage device. The following are the supported secure file erase modes:

e Non-secure Fast Erase: erases the file system references to operations, such as completed print
jobs. By erasing the references, space on the hard disk drive is made available. This is the fastest
erase mode and the default mode.

e Secure Fast Erase: erases the file system references to operations and provides one layer of
masking to hide data stored on the hard disk drive or other erasable storage devices. This mode
is slower than the Non-secure Fast Erase but more secure.

e Secure Sanitizing Erase: erases the file system references to operations and provides multiple
layers of masking to hide data stored on the hard disk drive or other erasable storage devices. This
mode may introduce a significant performance impact to the device while the process is executing.
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Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

To configure this option, select a file erase mode from the drop-down list.

Device Configuration Options for Digital Sending

e Activity Log

e Address Book Management

e Administrator Information

e Advanced Search Options

° Default ‘From:’ Address

° Default Scanner Settings

° Digital Sending - Accessing the LDAP Server

e Digital Sending Service

° Email Attachment Settings

° Email Message Text

e Send to Network Folder

e SMTP Gateway Settings

° Time-outs

° Use MFP User Credentials

Configuration options for Digital Sending devices define functions for the device including setup and
default settings.

Activity Log

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you view the logs for the digital send device. The logs contain digital sending job
information and error events associated with the device. You can use this information to check the status
of digital send jobs for the device. If there are any errors associated with the jobs, you can also view the
specific error messages to begin troubleshooting any issues.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

1. To save the activity log, select Save log.

Bf NOTE: The log is saved when the settings for the digital send device are applied.

2. To clear the activity log, select Clear log.
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Address Book Management

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

B

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

Use this option to import a predefined list of email addresses (500 maximum) from a comma separated
value (CSV) file directly into the internal address book of the digital send device. The address book can
store up to 2,000 addresses. Once an address file is imported to the digital send device, the addresses
can be searched by alias. The alias can be a name or an email address. To ensure that searches are
consistent in the digital send device address book, use the same format for all aliases. For example,
type the first name and then the last name.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

NOTE: A digital send device can store up to 2000 entries, but only up to 500 entries can be loaded at
atime.

NOTE: The CSV file must have a pair of entries for each new address, where the first entry is the
name of the person and the second entry is a valid email address. The CSV file also must have a header
entry "name,emailaddress". Following is a sample of a CSV file:

name, emailaddress
taylor duggan, taylor.duggan@hp.com

kelly jacobson,kelly.jacobson@hp.com

1. Toimport an address file, select Import address book. Click File to browse to locate the CSV file
using a dialog window.

2. To clear the address book on the digital send device, select Clear device address book.

Administrator Information

B
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NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the contact information for the administrator of the digital send device. In
case of a problem with this device, this administrator should be contacted.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

1. Type the name of the person responsible for maintaining the digital sending features of this device
in Name.

2. Type the email address of the person responsible for maintaining the digital sending features of
this device in Email address.
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3. Type the phone number of the person responsible for maintaining the digital sending features of
this device in Phone number (optional).

4. Type the physical location of the person responsible for maintaining the digital sending features of
this device in Location (optional).

Advanced Search Options

199,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the settings the digital send device uses to search the LDAP database for
email addresses. LDAP servers with large email address databases can take a long time for the digital
send device to search. Specify the most efficient search method for the device to ensure the fastest
possible search results.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

1. Select the maximum number of addresses returned from an LDAP search from Maximum LDAP
addresses.

B NOTE: Smaller values typically result in faster search times, but may not provide the user with
all possible matching addresses.

2. Select the maximum amount of time that the digital send device waits for the LDAP search to
complete from Maximum search time.

B NOTE: Smaller values typically result in faster search times, but may not provide the user with
all possible matching addresses.

3. Optional: If the LDAP server supports additional search parameters, type a parameter into LDAP
filter condition. This parameter must be in the form of a valid LDAP filter.

4. Select how thoroughly the search is performed from the Find entries in the database.

e  Select fast mode to search for only entries that begin with the search string. This option is
faster, but may not return all matching entries.

e Select verbose mode to search for any entries that contain the search string. This option is
more thorough, but may take longer to complete.

5. If email entries in the LDAP database are alphabetized, select Enabled or Disabled from the
Entries in database are alphabetized drop-down list. The digital send device searches the LDAP
database more efficiently if this option is selected.

Default ‘From:’ Address

149,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the From address and subject information that initially appears in all email
messages sent from the digital send device. The digital send device uses these settings as the initial
From address and subject line for each email message it generates. You can also specify whether the
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digital send device user has permission to change the default From address at the device. For example,
you can specify the subject of the email: Please type in a subject for your message
here. For security reasons, you may not want to allow the user to change the From address provided
on the digital send device. You can specify a setting in this section that prevents the user from changing
the default From address.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

1. If desired, select Prevent user from changing the default ‘from:’ address.

2. To specify the default sender, type the email address in the Email address.

3. Optional: Type the name you want to appear in the From field of the email in the Display name.
4

Type the default subject for emails in Default subject. For example, type Please type in a
subject for your message here.

Default Scanner Settings

B
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NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

The default scanner settings determine the initial settings used when a user scans a document. These
settings apply to both copying and digital sending operations. Set the default scanner settings to the
preferences used most often for scanning on the digital send device. This increases user efficiency
because the user does not need to spend time manually configuring the scanner settings as often.

NOTE: The digital send device user can override each of the default scanner settings from the device
control panel.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

1. Select the default paper size the device scanner uses when scanning the document from
Document size.

2. Select the default document type the scanner’s image processor uses when scanning the
document from the Document type:

e Text: for documents consisting mostly of textual information.
e Graphics: for documents consisting mostly of graphical images.

e Mixed: for documents consisting of both text information and graphical images.

3. Ifthe device scanner supports two-sided scanning, select 2 Sided document to have the scanner

device scan both sides of the document.

Configuration Options 353



Digital Sending - Accessing the LDAP Server

149,

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify how the digital send device accesses the Lightweight Directory Access
Protocol (LDAP) server to look up email addresses. To send scanned documents from the digital send
device through email, the user must provide an email address. The process of entering email addresses
can be simplified by providing an address lookup list and by using an auto-complete feature. Access to
the LDAP server email address database provides a way for the digital send device to use the lookup
list and the auto-complete feature.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

1. Select one of the following server bind methods from the LDAP server bind method drop-down
list:

e Anonymous: tells the digital send device to access the LDAP server without using credentials
(no user name or password required).

e Simple: tells the digital send device to use credentials to access the LDAP server. You must
provide complete information in Username and Password when selecting this option.

B NOTE: If you select Simple, the credentials are sent from the digital send device without
encryption. Contact the LDAP server’s administrator to determine the most appropriate server
bind method settings.

e Simple over SSL.: tells the digital send device to use credentials to access the LDAP server
and to enable the Secure Sockets Layer (SSL) protocol for communication between LDAP
server and the device. The SSL protocol encrypts the authentication credentials before
sending the credentials to the device.

2. Ifyou select Simple, type the complete specified name of a user who has access to the LDAP
server in Username and the password for the user name in Password and Repeat password.

3. You can specify the LDAP Server IP by providing a valid IP hostname or a valid IP address for the
LDAP server. To specify an IP hostname, select IP Hosthame and type the IP hostname in the
corresponding text box.

To specify an IP address, select the IP Address and type the full IP address in the corresponding
text boxes.

Bf NOTE: Some digital send device models only recognize |IP addresses. In this case, the host
names are converted to the equivalent IP address.

4. Type the number of the TCP/IP port on the server that receives LDAP requests in Port. Typically,
the port number is 389.

Bf NOTE: If you are unsure about the correct LDAP server host name or IP address and are
configuring a single device, click Find Server to search the network for a suitable LDAP server (if
one is available). The digital send device searches for all available LDAP servers and the results
display in a separate window.
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5. Set how you will search through the LDAP database to find the credential.

6. To test the settings, click Test Settings.

Digital Sending Service

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

The digital sending service is an independent HP product that allows you to configure digital sending.
Selecting Allow use of digital send service lets the Digital Sending Service manage the device.
Selecting Allow transfer to new digital send service lets any Digital Send Service manage the device
even if another Digital Send Service is currently managing the device

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Email Attachment Settings

B

NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the default email attachment settings for each email sent from the digital
send device. The digital send device uses the email attachment settings as the initial settings for each
email message the device generates. Set the default attachment settings to the preferences used most
often for email attachments on the digital send device. This increases user efficiency because the user
does not need to spend additional time manually configuring the attachment settings as often.

NOTE: The default values can be changed as necessary when sending emails from the device.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. Select the file format used for email attachments from Default file format.

2. Select black and white or color from Default color preference.

B NOTE: Color attachments are larger in size and take more time to send.

3. Select the resolution for email attachments from Default resolution.

4. Select the attachment file size from Default file size.

Email Message Text

B
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NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the information that initially appears in the body of all email messages sent
from the digital send device. The digital send device uses the email message settings as the initial
content text for each email message it generates. The initial information provided can serve as a
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template for the email or provide instructions to the user. For example, you can type the following
message in the body text of the email: Type the body of the email here.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

1. To use the default message for the email, select Message language and then select a language
from the drop-down list. The device generates an email message containing the default message
in the selected language.

2. Tocompose a custom message, select Use a custom message and then type a custom message
into the text box.

3. To allow the users to change the message text of the email, select Editable by user.

Send to Network Folder

Bf NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you send documents to a network folder. There is a list of predefined folders. You can
set the default document setting to apply to documents sent to a network folder.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

1. To enable this option select Enable send to folder.

2. To add folders to the list of predefined folders, click Add and enter the shared folder or FTP site.
3. To edit an existing folder click Edit.

4. To remove all of the predefined folders in the list click Remove All.

5

To determine whether you have access to a folder click Test Folder Access and enter a domain,
username, and password for the credentials to use to access public folders.

6. Select settings from the drop-down lists: Color preference, Resolution, Default file size, File
format, TIFF version, and NTLM authentication setting.

SMTP Gateway Settings

Ef NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over
the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify the SMTP gateway settings for the digital send device. The device uses the
SMTP gateway settings to connect to an email server to send scanned documents directly from the
digital send device to an email address.

Ef NOTE: The SMTP gateway settings of the digital send device must be specified before scanned
documents can be sent through email.
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Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:
1. Send emails

2. You can specify the SMTP gateway IP by providing a valid IP hostname or a valid IP address for
the gateway server in IP hostname or IP address.

B NOTE: If you are unsure about the correct SMTP gateway IP address or hostname, click Find
Gateway to search the network for a suitable SMTP gateway server (if one is available).

3. Select the maximum size the SMTP gateway server allows for email attachments from the
Maximum attachment size drop-down list.

4. Totestthe connection to the gateway server, click Test. The digital send device attempts to connect
to the SMTP gateway server using the specified IP hostname or IP address. The results of the test
display in a separate window.

Time-outs

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

The timeout settings determine how long the digital send device waits after a digital sending operation
is complete to revert to the specified default settings. Some users may need to specify settings other
than the default settings for a digital sending operation. If they need to send multiple jobs, it can be very
time consuming to specify the settings for each additional job. Setting a timeout allows the user additional
time to send another document before the settings revert to default.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.

Following are steps to configure this option:

1. To have the digital device reset to the default settings immediately after each digital send job,
select Immediately reset to default settings.

To allow a delay before the digital send device resets to the default settings after each digital send
job, select Delay before resetting the default settings.

2. Ifyou selected the Delay before resetting the default settings, type a timeout value between 10
and 300 seconds in Number of seconds (10-300) to delay.

Use MFP User Credentials

B NOTE: To see a list of devices that a specific configuration option can apply to, hold your cursor over

ENWW

the configuration option name above where you define the settings (not in the left menu that lists all of
the configuration options).

This option lets you specify whether the user is required to provide credentials in order to use the digital
send features of the device. For security purposes, you can require that the user provide proper
credentials whenever trying to use the digital send features of the device.

Setting this option remotely saves the time it takes to physically go to the printer. This is particularly
useful if your organization has multiple buildings or sites.
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To configure this option, select Use MFP user credentials.
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8 End User License Agreement

Following is the End User License Agreement for HP Web Jetadmin 10.0.
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End User License Agreement

PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User License
Agreement (“EULA”) is a contract between (a) you (either an individual or the entity you represent) and
(b) Hewlett-Packard Company (“HP”) that governs your use of the software product (“Software”). This
EULA does not apply if there is a separate license agreement between you and HP or its suppliers for
the Software, including a license agreement in online documentation. The term “Software” may include
(i) associated media, (ii) a user guide and other printed materials, and (iii) “online” or electronic
documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO
ALL TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING, OR
OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU DO
NOT ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE
SOFTWARE. IF YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA, PLEASE
RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN DAYS FOR A
REFUND OF THE PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR MADE
AVAILABLE WITH ANOTHER HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED
PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software
(“HP Software”), software under licenses from third parties (“Third Party Software” and “Third Party
License”). Any Third Party Software is licensed to you subject to the terms and conditions of the
corresponding Third Party License. Generally, the Third Party License is located in a file such as
license.txt; you should contact HP support if you cannot find any Third Party License. If the Third Party
Licenses include licenses that provide for the availability of source code (such as the GNU General
Public License) and the corresponding source code is not included with the Software, then check the
product support pages of HP’s website (hp.com) to learn how to obtain such source code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and
conditions of this EULA:

a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing, copying,
storing, loading, executing, displaying, or otherwise using the HP Software. You may not modify the
HP Software or disable any licensing or control feature of the HP Software. If this Software is provided
by HP for Use with an imaging or printing product (for example, if the Software is a printer driver,
firmware, or add-on), the HP Software may only be used with such product (“HP Product”). Additional
restrictions on Use may appear in the User Documentation. You may not separate component parts of
the HP Software for Use. You do not have the right to distribute the HP Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the HP Software,
provided each copy contains all the original HP Software’s proprietary notices and is used only for back-
up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement (collectively
“Upgrade”), you must first be licensed for the original HP Software identified by HP as eligible for the
Upgrade. To the extent the Upgrade supersedes the original HP Software, you may no longer use such
HP Software. This EULA applies to each Upgrade unless HP provides other terms with the Upgrade. In
case of a conflict between this EULA and such other terms, the other terms will prevail.

4. TRANSFER.

a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer of the
HP Software to another end user. Any transfer will include all component parts, media, User
Documentation, this EULA, and if applicable, the Certificate of Authenticity. The transfer may not be an
indirect transfer, such as a consignment. Prior to the transfer, the end user receiving the transferred
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Software will agree to this EULA. Upon transfer of the HP Software, your license is automatically
terminated.

b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for commercial
timesharing or bureau use. You may not sublicense, assign or otherwise transfer the HP Software except
as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation are
owned by HP or its suppliers and are protected by law, including applicable copyright, trade secret,
patent, and trademark laws. You will not remove any product identification, copyright notice, or
proprietary restriction from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or
disassemble the HP Software, except and only to the extent that the right to do so is allowed under
applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information you
provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of support
services related to the Software or the HP Product. All such information will be subject to HP’s privacy
policy. HP will not use such information in a form that personally identifies you except to the extent
necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability of
HP and its suppliers under this EULA and your exclusive remedy under this EULA will be limited to the
greater of the amount actually paid by you for the Product or U.S. $5.00. TO THE MAXIMUM EXTENT
PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR
ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES (INCLUDING
DAMAGES FOR LOST PROFITS, LOST DATA, BUSINESS INTERRUPTION, PERSONAL INJURY,
OR LOSS OF PRIVACY) RELATED IN ANY WAY TO THE USE OF OR INABILITY TO USE THE
SOFTWARE, EVEN IF HP OR ANY SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES AND EVEN IF THE ABOVE REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some states
or other jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so
the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. If you are a U.S. Government entity, then consistent with FAR
12.211 and FAR 12.212, Commercial Computer Software, Computer Software Documentation, and
Technical Data for Commercial Items are licensed under the applicable HP commercial license
agreement.

10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)
applicable to the export or import of the Software, or (ii) restricting the Use of the Software, including
any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to you
in this EULA.

12. HP Web Jetadmin Software is not licensed for Commercial Use under the End User License
Agreement. Unless you obtain a Commercial License from HP you may not redistribute HP Web
Jetadmin software to third parties, bundle the software in products intended for resale, or use HP Web
Jetadmin software to generate revenue by providing third party management, support or consulting
services related to printers, printer supplies or other devices. To obtain Commercial License terms
contact HP using this email address: webjetadminlicensing@hp.com.

(c) 2007 Hewlett-Packard Development Company, L.P.
Rev. 11/06
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